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Software End User License Agreement
IMPORTANT: PLEASE READ CAREFULLY. The software product provided to you by Topcon Positioning Sys-
tems, Inc. ("TPS") along with its associated manuals and documentation (collectively, the “Software”) is owned
by TPS and your use is subject to the terms and conditions of this Software License End-User Agreement (“Agree-
ment”) set forth below. If you are entering into this agreement on behalf of a company or other legal entity, you
represent that you have the authority to bind such entity to these terms and conditions, in which case the terms
"you" or "your" shall refer to such entity. If you do not have such authority, or if you do not agree with these terms
and conditions, you may not use the service. TPS also reserves the right to immediately terminate this agreement
and suspend, cancel or delay the service for failure to comply with the terms provided herein.

By clicking the “ACCEPT” button below, or by installing or using the Software, you agree to be bound by the
terms and conditions of this Agreement. In addition, by clicking the “ACCEPT” button below, you agree to be
bound by the terms and conditions of the Terms of Use of the Web site www.magnet-enterprise.com (the “TPS
Site”). If you do not agree, exit out of the TPS Site and you will not be authorized to use the Software or oth-
erwise utilize the documentation accompanying the Software.

Safety. IMPROPER USE OF A TOPCON PRODUCT CAN LEAD TO INJURY TO PERSONS OR
PROPERTY AND/OR MALFUNCTION OF THE PRODUCT. THE PRODUCT SHOULD ONLY BE
REPAIRED BY AUTHORIZED TPS WARRANTY SERVICE CENTERS. USERS SHOULD REVIEW AND
HEED THE SAFETY WARNINGS IN THE MANUAL ACCOMPANYING THE PRODUCT.

Ownership of the Software. The Software and the accompanying documentation are owned by TPS and its respect-
ive licensors and are protected by United States and international copyright laws and other intellectual property
laws.

Professional Use. The Software is designed to be used by a professional. The user is required to be a professional
surveyor or have a good knowledge of surveying and be familiar with the safe use of such products, in order to
understand the user instructions before operating the Software.

Restrictions on Use and Transfer. You may not modify, adapt, translate, reverse engineer, decompile, or dis-
assemble the Software or create derivative works from the Software, any component thereof or any related doc-
umentation, nor may you remove, modify or hide or otherwise make unreadable or non-viewable any notice,
legend, advice, watermark trademark, service mark, or other designation contained on the Software, component
thereof, documentation, or output therefrom. You may not distribute registered copies of the Software to third
parties, including, without limitation rent, lease, or lend the Software to third parties. You agree to not use, permit
the use, or use the Software in violation of any U.S. Federal, state, or local laws or regulations or any foreign law
or regulation, including laws regarding intellectual property rights in or laws or regulations regarding the trading or
exchange of securities or concerning the Software. You further agree to use the Software solely for its intended
purpose. The Software and all related information you may come to learn related to the Software and TPS’ oper-
ations in connection therewith is confidential in nature. You agree to take all reasonably necessary precautions to
protect TPS’ confidential information and exercise at least the same degree of care in safeguarding the con-
fidential information as you would with your own most valuable confidential information.

Support Services. TPS may provide you with support services related to the Software ("Support Services"). Any
supplemental software code provided to you as part of the Support Services shall be considered part of the Soft-
ware and subject to the terms and conditions of this Agreement.

Grant of License to Software. If you have purchased or otherwise received Software from TPS, TPS grants you
the right to install and use copies of the Software on your computer running a validly licensed copy of the oper-
ating system for which the Software was designed (e.g., Windows CE 6.0, Windows Mobile, Windows XP, Win-
dows Vista, Windows 7). This license is coterminous with the Term set forth in the Master Subscription
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Agreement for the Magnet Terms of Use and is a personal, non-exclusive, non-transferable (except as expressly
set forth herein) license to use such Software under the terms stated herein and in any case only with a single
Device. A “Device” means a personal computer or the product upon which the Software is intended (pursuant to
its applicable documentation) to be installed and used. You may permanently transfer rights under this Agreement
only as part of a permanent sale or transfer of the Device, and only if the recipient agrees to this Agreement. If
the Software is an upgrade, any transfer must also include all prior versions of the Software. The license is effect-
ive until terminated. You may terminate the license at any time by destroying the Software and related doc-
umentation. Without prejudice to any other rights of TPS, TPS may terminate your license if you fail to comply
with the terms and conditions of this Agreement. In such event, you must destroy all copies of the Software in
your possession.

Maintenance of the Software. TPS agrees to provide Maintenance (as defined herein) to you for the first year
from the date you enter into this Agreement, at no additional charge, pursuant to the terms and conditions set forth
herein. Following the first year, and for successive years thereafter (“each year defined as a Term(s)”), in order
to receive continued Maintenance, you must pay the Maintenance Fee at the start of each Term as set forth by
TPS. Failure to renew Maintenance for a new Term may result in you having to enter into a new Agreement in
order to receive Maintenance.

Maintenance is defined as any improvements or modifications to the Software that TPS makes generally avail-
able. Any such improvements or modifications shall become part of the Software for all purposes of this Agree-
ment. You acknowledge and agree that the Maintenance to be provided by TPS hereunder is limited to the most
current version of the Software and the immediately preceding version. Activation of your Software is required in
order to receive the most currently available Maintenance features.

Disclaimers. EXCEPT FOR ANY WARRANTIES IN A WARRANTY CARD ACCOMPANYING THE
SOFTWARE (AND ALL MAINTENANCE), THE SOFTWARE IS PROVIDED “AS IS.” TPS MAKES NO
PROMISES, REPRESENTATIONS OR WARRANTIES, WHETHER EXPRESSED OR IMPLIED,
REGARDING OR RELATING TO THE SOFTWARE (INCLUDING, WITHOUT LIMITATION, THAT THE
SOFTWARE WILL BE ERROR-FREE OR AVAILABLE FOR USE AT ALL TIMES) OR CONTENT
THEREIN OR TO ANY OTHER MATERIAL FURNISHED OR PROVIDED TO YOU PURSUANT TO
THIS AGREEMENT OR OTHERWISE, AND TPS SPECIFICALLY DISCLAIMS ALL IMPLIED
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR
PURPOSE WITH RESPECT TO SAID MATERIALS OR THE USE THEREOF. TO THE MAXIMUM
EXTENT ALLOWABLE BY LAW, THE UNIFORM COMMERCIAL CODE OR OTHER UNIFORM LAWS
SHALL NOT APPLY TO THIS AGREEMENT.

Trademarks. The TPS name, the TPS logo, and the product names associated with the Service are trademarks of
TPS and no right or license is granted to use them. Product and company names mentioned herein may be trade-
marks of their respective owners.

Microsoft® Bing™ maps is used in Magnet™. Microsoft® Terms of Use for Bing™ maps can be found at:
http://www.microsoft.com/maps/assets/docs/terms.aspx#11. © 2011 Microsoft Corporation. All rights reserved.

RealDWG ™ and Autodesk® RealDWG by Autodesk, Inc are used in Magnet™. Copyright © 1998-2011
Autodesk, Inc. All rights reserved. Information can be found at www.autodesk.com/autodeskrealdwg

Limitation of Liability. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR
EDITORIAL ERRORS OR OMISSIONS CONTAINED IN THE SOFTWARE OR ITS DOCUMENTATION.
TO THE MAXIMUM EXTENT ALLOWABLE BY LAW, IN NO EVENT SHALL TPS OR ITS
PERSONNEL BE LIABLE UNDER ANY CLAIM, DEMAND OR ACTION ARISING OUT OF OR
RELATING TO THE SOFTWARE, ITS USE, INSTALLATION OR TPS'S PERFORMANCE OR LACK
THEREOF UNDER THIS AGREEMENT FOR ANY SPECIAL, INDIRECT, INCIDENTAL, EXEMPLARY
OR CONSEQUENTIAL DAMAGES, WHETHER OR NOT TPS HAS BEEN ADVISED OF THE
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POSSIBILITY OF SUCH CLAIM, DEMAND OR ACTION. UNDER NO CIRCUMSTANCES, INCLUDING
BUT NOT LIMITED TO A NEGLIGENT ACT, WILL TPS OR ITS AFFILIATES, AGENTS, EMPLOYEES,
OR LICENSORS BE LIABLE FOR ANY DAMAGES OF ANY KIND THAT RESULT FROM (i) THE USE
OR THE INABILITY TO USE THE SOFTWARE; (ii) THE TIMELINESS, DELETION, MISDELIVERY, OR
FAILURE TO STORE ANY DATA, COMMUNICATIONS OR SETTINGS; (iii) THE COST OF GETTING
SUBSTITUTE GOODS AND SERVICES; OR (iv) UNAUTHORIZED ACCESS TO OR ALTERATION OF
YOUR TRANSMISSIONS OR DATA EVEN IF SUCH PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN ADDITION, WITHOUT LIMITING THE FOREGOING, IN ALL
EVENTS THE REMEDIES AVAILABLE TO YOU SHALL BE LIMITED TO THE GREATER OF THE
AMOUNT PAID BY YOU TO TPS FOR THE RIGHT TO USE THE SOFTWARE OR $100.

Indemnification. YOU SHALL INDEMNIFY AND HOLD TPS AND ITS AGENTS, OFFICERS,
MANAGERS, EMPLOYEES AND MEMBERS HARMLESS FROM AND AGAINST ANY AND ALL
CLAIMS, DEMANDS, SUITS, JUDGMENTS AND EXPENSES (INCLUDING REASONABLE LEGAL
FEES AND EXPENSES) ARISING OUT OF OR RELATING TO THE BREACH BY YOU OF YOUR
OBLIGATIONS UNDER THIS AGREEMENT OR TO INTELLECTUAL PROPERTY
MISAPPROPRIATION OR INFRINGEMENT CLAIMS BY ANY THIRD PARTY BASED ON OR
RELATING TO YOUR USE OF THE SOFTWARE. YOU AGREE TO GIVE TPS PROMPT NOTICE OF
SUCH CLAIMS AND TO PERMIT TPS TO CONTROL THE DEFENSE OR SETTLEMENT THEREOF.

Export Restrictions. You agree with all international and national laws that apply to the Software, including the
U.S. Export Administration Regulations, as well as end-user, end use and country destination restrictions issued
by U.S. and other governments.

Website; Other Statements. No statement contained at the TPS Website (or any other web site) or in any other
advertisements or TPS literature or made by an employee or independent contractor of TPS modifies these Terms
and Conditions (including the Software License Agreement, Disclaimer of Warranty and limitation of liability).

General. The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by
TPS. The Agreement shall be governed by and construed and enforced in accordance with the laws of the state of
California, without regard to conflicts of laws provisions. Any action concerning this Agreement shall take place
in the state or federal courts located in San Francisco, California. If for any reason any provision of this Agree-
ment, or a portion thereof, shall be unenforceable, that provision shall be enforced to the maximum extent per-
missible so as to effect the intent of this Agreement, and the remainder of this Agreement shall continue in full
force and effect. This Agreement constitutes the entire agreement between us and you with respect to the Soft-
ware and it supersedes all prior or contemporaneous communications, agreements and understandings between
TPS and you with respect to the subject matter hereof. No joint venture, partnership, employment, or agency rela-
tionship exists between you and TPS as a result of this agreement or use of the Service. The failure of TPS to
enforce any right or provision in this Agreement shall not constitute a waiver of such right or provision unless
acknowledged and agreed to by TPS in writing. A printed version of this Agreement shall be admissible in judicial
or administrative proceedings.

BY CLICKING ON THE “ACCEPT” BUTTON BELOW YOU ACKNOWLEDGE THAT YOU HAVE
READ AND UNDERSTOOD THIS AGREEMENT AND AGREE TO BE BOUND BY ITS TERMS. YOU
FURTHER AGREE THAT THIS AGREEMENT SUPERSEDES ANY PREVIOUS AGREEMENT,
WHETHER WRITTEN OR ORAL, RELATING TO THE SOFTWARE BETWEEN YOU AND TPS.
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Introduction
MAGNET Tools provides a full-featured environment for the calculation and adjustment of coordinates based on
observations created with the family of Topcon and Sokkia instruments.

All experience levels of surveyors/geodesists can use MAGNET Tools for:
l Processing TS, DL and/or RTK and GPS observations,
l Least Squares Network adjustment,
l Instant reporting of unadjusted traverse closures,
l Compass rule, including angle balance, adjustments,
l Performing Localization using any defined projection,
l Uploading and downloading data to a project on the MAGNET Enterprise service,
l Receiving “Real-Time” data from MAGNET Field products,
l Importing files on a computer or from a device,
l Exporting data to files on a computer or to a device,
l Direct export of data to Civil 3D drawing,
l Direct export of data to MAGNET Office
l Creating, viewing and editing a digital terrain model (“surface”),
l Creating, viewing and editing road and X-section templates.
l Creating, viewing and editing of horizontal and vertical alignment data.
l Viewing and edition of MAGNET Field Road String Sets

MAGNET Tools has tabular and graphical representations of data:
l Use the Tabular view for viewing points information, viewing vector or occupation information, viewing
data with the same names, and sorting lines in alphabetical order by time or by increasing or decreasing val-
ues.

l Use the Observation view for displaying a common network configuration, multiple background images,
estimating the mutual position of points and vectors, and finding the necessary vector or point.

l Use the Map view for displaying view of lines, surfaces and roads.
l Use MAGNET Enterprise service to get the possibility to communicate with the company members in the
using the chat function

l Use MAGNET Enterprise to transfer data between the field and office.
l Use MAGNET Enterprise to locate and monitor company assets while in use.

Changes made in either the Observation, Map or Tabular view are applied and reflected to the other views, provid-
ing faster, more convenient, and more effective viewing and editing of data.
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MAGNET Tools Activation
To use full functionality of the application you have to activate it. Online activation of the application requires an
Internet connection of the computer where the application was installed.

When you first start the application, the Product Activation dialog prompts you to select the activation method.
Select one of the following radiobuttons:

l Online — to perform the online activation. See "Online activation" section below for details.
l Network — to perform the network activation. See "Network activation" section on page 23 for details.
l Offline — to perform the offline activation. See "Offline activation" section on page 24 for details.

Also you may close the dialog to postpone activation and use the application in demo mode. In this mode, the Post
Processing module is omitted and the import and processing of GPS raw data are disabled. You can view, edit, cal-
culate/recalculate and adjust no more than five points (RTK, TS and DL) in a job. If the imported file contains
more than 5 points, the application will import only first five points.

Online activation
At the Online activation page you may activate the MAGNET Tools by using your Enterprise account; also you
may change or reset your enterprise password.

To perform an online activation:
1. At the Activation type page, select the Online radiobutton and click Next.

The Mange account page is displayed.
2. Select the Logon with MAGNET Enterprise account radiobutton and click Next.

The Enterprise logon page is displayed.
NOTE
An e-mail which you have received from Topcon, when your company's account administrator adds you
into the user list, contains only a temporary password. The temporary password does not allow you to
establish the connection with MAGNET Enterprise. Please follow the recommendation from the e-mail to
update your password.

3. Specify you login (e-mail) and password in the respective fields.
4. Click Next.

The Online activation page is displayed.
5. In the Serial number field, specify your serial number.
6. From the Device-id drop-down list, select the device to which your serial number will be assigned. You

may select one of the following:
l An identification number of the computer. In this case, the serial number ties to the computer and
operation system (OS) of this computer. If the OS is reinstalled, the system identical number
changes and activation is disabled.

l An identification number of the computer's network card. In this case, the serial number ties to the
network adapter. A reinstallation of the OS does not affect the application activation.

l An identification number of the external USB flash drive. The type of the given driver must be
approved by Topcon company to use in MAGNET activation procedure. In this case, the serial num-
ber ties to the external USB flash drive. You can use the given serial number and the given USB
flash drive for activation of the application on any computer.
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NOTE
The application is activated only if the USB flash drive is plugged to the USB port. Removing of the
USB flash drive will disable the ativation. Youmay re-plug the USB flash drive and any time – the
activation will be restored after the next launch.

7. Click Next.

The License agreement page is displayed.
8. Carefully read the End User License Agreement.
9. Tick the I have read, understand and agree with license checkbox.
10. Click Next.

The application checks the entered serial number. If the number is correct, the MAGNET Tools is activ-
ated and the table, listing available modules is displayed.

If you do not have an Enterprise account, contact your Administrator to obtain it. Only Administrators may create
accounts. If you are going to work in a team of the Company, you should not create an account yourself — the
Administrators are unable to add account, created by user to the Company account.

Changing password
To change a password:

1. At the Activation type page, select the Change password radiobutton.
2. Click Next.

The Change Password page is displayed.
3. In the Login (email) editbox, type your Enterprise login.
4. In the Old password editbox, type your current password.
5. In the New password editbox, type your new password.
6. In the Confirm New editbox, re-type your new password.
7. Click Next.

Reseting password
To reset a password:

1. At the Activation type page, select the Forgot password radiobutton.
2. Click Next.

The Reset password page is displayed.
3. In the Login (email) editbox, type your Enterprise login.
4. Click Next.

Topcon will send you a temporary password to your e-mail address.

The confirmation message is displayed.
5. Click OK.

The Change Password page is displayed.
6. In the Login (email) editbox, type your Enterprise login.
7. In the Old password editbox, type temporary password from the e-mail.
8. In the New password editbox, type your new password.
9. In the Confirm New editbox, re-type your new password.
10. Click Next.
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Creating account
To create a company account:

1. At the Activation type page, select the Create account radiobutton.
2. Click Next.

The warning page is displayed.
3. Carefully read the information.
4. Click Next.

The Create company account - contact information page is displayed.
5. Fill in all fields and click Next.

The Create company account - billing address page is displayed.
6. Specify your billing address and click Next.

The Create company account - shipping address page is displayed.
7. Do one of the following:

l Tick Same as billing address checkbox to use your billing address as the shipping one.
l Specify your shipping address.

8. Click Next.

The Create company account - review information page is displayed.
9. Carefully review information, which you have specified. If needed, click Back to change it.
10. Click Next.

The Master Subscription Agreement page is displayed.
11. Carefully read End User License Agreement.
12. Tick I accept the terms of the license agreement checkbox.
13. Click Next.

Account is created. Your temporary password is send to the email address. The Change password page is
displayed.

14. Change your temporary password. See Changing password section above for details.

Network activation
When the several users from one company simultaneously work with MAGNET Tools, we recommend to perform
the software activation via network activation. This way supposes:

l the users computers are joined in a local subnet
l a server is organized.

This server (a computer) should be located in the same subnet. The special software should be installed on the
server for the coordination the use of a licensed application by multiple computers. You must know the server net-
work address and port for connection to the server. Contact your Administrator to get this information.

Before running MAGNET Tools, all users have not activated MAGNET Tools on their computers. After running
the software, the user selects the network activation. During activation the software sends a request for a license
across the network to the license server. The server will grant license authorization to the requesters after veri-
fying licensing conditions for the given product or will deny requests when all available licenses are in use.
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To perform the network activation:
1. At the Activation type page, select the Network radiobutton and click Next.

The Network Server Setup page is displayed.
2. In the Server editbox, type the server address network.
3. In the Port editbox, type the port name.
4. From the Product Name drop-down list, select the required product.
5. Click Next.

The License agreement page is displayed.
6. Carefully read the End User License Agreement.
7. Tick the I have read, understand and agree with license checkbox.
8. Click Next.

The application checks the license availability at the server. If the license is available the MAGNET Tools
is activated and the table, listing available modules is displayed.

Offline activation
You must have the activation code to perform the offline activation. Contact your Administrator to obtain it.

To perform the offline activation:
1. At the Activation type page, select the Offline radiobutton.
2. Click Next.

The Offline activation page is displayed.
3. In the Serial number field, specify your serial number.
4. From the Device-id drop-down list, select the device to which your serial number will be assigned. You

may select one of the following:
l An identification number of the computer. In this case, the serial number ties to the computer and
operation system (OS) of this computer. If the OS is reinstalled, the system identical number
changes and activation is disabled.

l An identification number of the computer's network card. In this case, the serial number ties to the
network adapter. A reinstallation of the OS does not affect the application activation.

l An identification number of the external USB flash drive. The type of the given driver must be
approved by Topcon company to use in MAGNET activation procedure. In this case, the serial num-
ber ties to the external USB flash drive. You can use the given serial number and the given USB
flash drive for activation of the application on any computer.

NOTE
The application is activated only if the USB flash drive is plugged to the USB port. Removing of the
USB flash drive will disable the ativation. Youmay re-plug the USB flash drive and any time – the
activation will be restored after the next launch.

5. Specify the activation code. Do one of the following:
l Select the Use activation code radiobutton and specify the code in the appropriate editbox.
l Select the Import activation code from file radiobutton and click Browse to define the license (*.lic)
file, containing and activation code.

6. Click Next.
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The License agreement page is displayed.
7. Carefully read the End User License Agreement.
8. Tick the I have read, understand and agree with license checkbox.
9. Click Next.

The application is activated and the table, listing available modules is displayed.

Fields of the Offline activation page
Field Description

Serial Number Defines your serial number for the software.

Device ID Defines the device, to which your serial number will be assigned.

Use activation
code

Defines manual input of the activation code, by typing it or copying from the
clipboard.

Import activation
code from file Defines the automatic import of the activation code from a license (*.lic) file.
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Ribbon Icon Functions
The ribbon for the application has eleven tabs: Job, Edit, View, Window, Add, Select, Process, Report, COGO,
Enterprise, and Help. Each ribbon tab contains groups, and each group contains icons. See the descriptions of tabs
in the appropriate sections:

l "Job tab" section below
l "Edit tab" section on page 38
l "View tab" section on page 41
l "Window tab" section on page 46
l "Add tab" section on page 49
l "Select tab" section on page 62
l "Process tab" section on page 72
l "Report tab" section on page 76
l "Calculate tab" section on page 76
l "Enterprise tab" section on page 84
l "Help tab" section on page 88

Job tab
The Job tab of the MAGNET Tools ribbon is separated to four groups, described in the corresponding sections:

l "Job group" section below
l "Exchange group" section on page 34
l "Print group" section on page 37
l "Information group" section on page 38

Job group
The Job group from the Job tab of the MAGNET Tools ribbon allows you to perform basic operations with pro-
jects. The group contains five icons:

New Job icon

Click it to create a new job.

Open Job icon

Click it to open an existing job.

Save Job icon

Click it to save the current job.
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Save Job As icon

Click it to save the current job under a new name and/or in a new dir-
ectory.

Close icon

Click it to close the current job without closing the MAGNET Tools
application.

New Job icon
The New Job icon of the Job group allows you to create a new job.

To create a new job:
1. In the Job group of the Job tab, click the New Job icon.

The Create a new job dialog is displayed.
2. In the Job name edibox, type the name of the new job.
3. In the Job location field, define the location of the job, by clicking Browse.
4. In needed, configure the additional parameters. Fields are described in the table below.
5. Do one of the following:

l Click Next to see more additional parameters. The dialog contains three pages.
l Click Create to create the job.

Fields of the first page of the Create a new job dialog
Field Description

Job name Defines the name of the new job.

Job location Defines the location of the new job. Click Browse to navigate to the required
location.

Created by Defines the name of person who created the job.

Date Created Displays the data of the job creation.

Comment Type any additional text information about the job.



Ribbon Icon Functions

28

Field Description

Configurations

This field contains a list of default configurations, where each configuration
has specific set of job parameters. The default configurations differ in the cur-
rent coordinate type (Ground or Datum Lat,Lon, Ell. H), precisions and auto-
matic test for Points, GPS Obs, TS Obs, DL Obs, and Loop Closure:

l Design — for viewing and edit road data.
l DGPS — for processing and adjustment GNSS raw data with meter
accuracy. The threshold value of RTK horizontal precision is 1 meter
and RTK vertical precision is 3 meters.

l GPS+ — for processing and adjustment GNSS raw data with centimeter
accuracy. The threshold value of RTK horizontal precision is 0.02 meter
and RTK vertical precision is 0.05 meter.

l Imaging — for processing Total Station raw data with image data. The
threshold value of precision for a distance is 0.03 meter and for vertical
angle /horizontal angle is 0°00'10.0000"

l TS — for processing and adjustment Total Station and Digital Level raw
data. The threshold value of precision for a distance is 0.03 meter and
for vertical angle /horizontal angle is 0°00'10.0000"

l GIS configuration — for processing and adjustment GIS data with meter
accuracy. The threshold value of RTK horizontal precision and PP kin-
ematic horizontal precision is 1 meter and RTK vertical precision and
PP kinematic vertical precision is 3 meters.

l GIS Advanced configuration — for processing and adjustment GIS data
with centimeter accuracy. The threshold value of RTK horizontal pre-
cision and PP kinematic horizontal precision is 0.02 meter and RTK ver-
tical precision and PP kinematic vertical precision is 0.05 meter.

Fields of the second page of the Create a new job dialog
Field Description

Angles
Defines the format for such angular units as Azimuth, Horizontal Circle, Ver-
tical Angle, Zenith Angle, Azimuth Residual, Horizontal Angle Residual, Ver-
tical Angle Residual, Zenith Angle Residual.

Lat. Lon Defines the format for such angular units as Latitude and Longitude.

Azimuth As

Defines the directions displaying format. Select the appropriate radiobutton:
l Bearing— the directions is displayed as angles in quadrants. Quadrants
are pictured at the figure below. Angles are counted clockwise within
each quadrant.

For example: azimuth angle of 130 degrees will be displayed as S 50° E.
l Azimuth— the directions is displayed as azimuth angles. The North axis
is zero and angles are counted clockwise.

Distances Defines the quantity of digits displayed after the decimal for distances. The
default values is 3.
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Field Description

Coordinates
(N,E;X,Y,Z)

Defines the quantity of digits displayed after the decimal for plane and
Cartesian coordinates (northing and easting, or X, Y, Z). The default value is
3.

Heights Defines the quantity of digits displayed after the decimal for all height meas-
urements. The default value is 3.

Angles (seconds)
Defines the quantity of digits displayed after the decimal for seconds of angu-
lar observations represented in degrees, minutes, and seconds. The default
value is 4.

Angles (dec.
degrees)

Defines the quantity of digits displayed after the decimal for angular obser-
vation format in decimal degrees (dd.ddd). The default value is 7.

Lat. Lon (seconds) Defines the quantity of digits displayed after the decimal for the seconds in lat-
itudes and longitudes. The default value is 5.

Lat. Lon (dec.
degrees)

Defines the quantity of digits after the decimal for the latitude and longitude
format in decimal degrees (dd.ddd). The default value is 8.

Area Defines the quantity of digits displayed after the decimal for all area data. The
default value is 0.

Volumes Defines the quantity of digits displayed after the decimal for all volume data.
The default value is 1.

Time (seconds) Defines the quantity of digits displayed after the decimal for time. The default
value is 0.
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Field Description

Station display
format

Defines the distance view for the center line position.
l Stationing— the number of the station is a value equal to the ratio of dis-
tance from the start point of the road and the interval for the station.
This number consists of two parts — the first part is an integer, defined
by the following formula:

Where "i" is the number of elements in the alignment; "Length" is a dis-
tance of “i-element” from the start point; and the “Interval for Station”
is equal to 100 current linear units. (This parameter is not editable).

The second part is a remainder from this ratio.

For example: the length of the line is 1288.50 meters; the number of the
end station for this line is 12+88.5.

You may use the following stationing formats:
l US Stationing — 1+234 (US feet)
l EU Stationing — 1+234 (meters)
l Sweden Stationing — 1/234 (meters)

l Chainage — the number of the station is a value equal to the distance
from the start point.

For example: the length of the line is 1288.50 meters; the number of the
end station for this line is 1288.5.

Fields of the third page of the Create a new job dialog
Field Description

Convert to/from
NAD27 using

Defines the conversion option:
l NAD27 Datum — the application will apply parameters NAD27 from
the its own database for transformation between NAD27 and NAD83_
NO_TRANS datums,

l NADCON — the application will apply the Federal standard
(NADCON program) for NAD 27 to NAD83_NO_TRANS datum trans-
formations.

Convert to/from
NAD27(CSRS)

using

Defines the conversion option:
l NAD27 Datum — the application will apply parameters NAD27 from
the its own database for transformation between NAD27(CSRS) and
NAD83_NO_TRANS datums,

l NTv2 NAD27 Canada — the application will apply the Canadian stand-
ard for NAD27(CSRS) to NAD83_NO_TRANS datum transformations.

Datum NAD27
(CSRS) Data File

Defines the file, containing NAD27 datum data. Click Browse Data to open
the required file.
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Field Description

Datum NAD83
(CSRS) Data File

Defines the file, containing NAD83 datum data. Click Browse Data to open
the required file.

Projection

Displays the in-use grid projection for the current job. The Projection drop-
down list contains the pre-defined and user defined grid projections for the job.

Select the required projection from the drop-down list, or click Custom to cre-
ate your own one. See "Adding custom projection to the projection list" section
on page 334 for details.

Datum

Displays the corresponding datum for the grid projection, defined in the Pro-
jection drop-down list.

When either None, or UTMNorth, or UTMSouth, or UPS grid projections is
used, you can select any predefined or custom datum from the drop-down list;
or create your own custom datum. See "Adding custom datum to the datum list"
section on page 333 for details.

When any other projection is used, only the corresponding datum is shown and
you cannot open the datum list.

The MAGNET Tools supports two following datums for projections with
NAD-83 as the reference datum:

l NAD83 — has the following transformation parameters (shifts, rotations
and scale) to WGS-84 datum:

l NAD83_NO_TRANS — has zero values of transformation parameters
(shifts, rotations and scale) to WGS-84 datum.

Grid->Ground

Tick to perform the grid to ground transformation for the job. Click ... to select
the desired transformation method and set the corresponding parameters for
each method. See "Grid->Ground dialog" section on page 361 for details

NOTE
The checkbox only enabled when a projection is selected in the Pro-
jection drop-down list. Otherwise the checkbox is disabled. Also it is
disabled if the Localization projection is selected.
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Field Description

Geoid

Defines the used geoid for the current job. You can manually select a cor-
responding geoid type from the geoid list. Also you can add a geoid to the list.
See "Adding geoid to the job" section on page 335. After importing a
MAGNET Field job into the current job, the geoid which was selected in the
MAGNET Field job will be automatically set as current in the MAGNET
Tools job, if the geoid list contains this file.

NOTES
A geoid transforms the ellipsoidal heights measured by GPS to heights
based on a physical reference surface, if the geoid covers the area where
file’s points are located.
The orthometric heights will be equal to ellipsoidal heights if a geoid file is not
downloaded to the application and/or the geoid does not cover the area
where file’s points are located.

Coordinate type

Displays the used coordinate type for the current job. The following coordinate
types are available:

l Ground
l Grid
l WGS84 Lat, Lon, Ell.H
l WGS84 X, Y, Z
l Datum Lat, Lon, Ell.H
l Datum Lat, Lon, Elevation

The coordinate system types are available depending on the projection and
datum settings. See table of the coordinate system types availability for details.

GPS Time Zone
Offset

Select the local time zone. If a zone is defined the application will display the
local time instead of the GPS time.

Daylight Saving
Time Tick to perform daylight saving time automatically.

Linear Unit Defines the linear units for the current job. Select the required unit from the
drop-down list.

Angular Unit Defines the angular units for the current job. Select the required unit from the
drop-down list.
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Bearing quadrants

Open Job icon
The Open Job icon of the Job group allows you to open an existing job.

After clicking the icon, the Open a job dialog is displayed. Select the desired job in the list of the window and
click Open job. If the desired job is not present in the list, click Browse and select the job on the corresponding
disk/folder.

To close the Open a job dialog, click the Close button.

Save Job icon
The Save Job icon of the Job group allows you to save the current job.

After clicking the icon, all changes are saved, and the icon becomes gray until any change is made in the job.

Save Job As icon
The Save Job As icon of the Job group allows you to save the current job under a new name and/or in another dir-
ectory.

After clicking the icon, the Save As dialog is displayed. Enter a new name and select the desired folder, if
required. Click Save to save the job.

Close icon
The Close Job icon of the Job group allows you to close the current job without closing the application.

If all made changes were saved, after clicking the icon, the job will be closed. If a job was modified without
being saved, after clicking the icon, a dialog box prompts to save the job. After clicking Yes, the job will be saved
and closed.
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Exchange group
The Exchange group from the Job tab of the MAGNET Tools ribbon allows you to import/export data to/from the
current job. The group contains six icons:

Import icon

Click it to import data to the current job.

Export icon

Click it to export data from the current job.

Create AutoCAD drawing icon

Click it to export data to an AutoCAD job.

Create MAGNET drawing icon

Click it to export data to a MAGNET Office job.

Import from Internet icon

Click it to find RINEX files in the Internet.

Assist Import from Internet icon

Click it to select an external server for downloading RINEX and eph-
emeris files.

Import icon
The Import icon of the Exchange group allows you to import a file from the computer or a connected device to
the current job.

To import a file from your computer:
1. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.
2. From the Format name drop-down list, select the required format of the file.
3. Navigate to the required file and open it.

To import a file from device:
1. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.
2. From the Format name drop-down list, select the required format of the file.
3. From the Look in drop-down list, select the required device.

l If you have selected the Topcon/Sokkia GNSS Receiver, the application will automatically search
for receivers connected to the computer COM or USB port. When finished, all the receivers
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connected to the computer will be displayed in the Import dialog.
l If you select the Mobile Device, Microsoft ActiveSync (for Window XP computer) automatically
establishes a connection with the controller, then double-click Mobile Device or My Windows
Mobile -Based Device in the Import dialog.

l If you select the Topcon/Sokkia Total Station:
1. From the Format name drop-down list, select the required format type.
2. Double click the file1.txt file.
3. The Download file from Total Station dialog is displayed.
4. Take all the steps listed in the Download File From Total Station dialog to prepare the Total

Station.
5. Select the required file in the Total Station for downloading to the computer.

l If you select the Topcon/Sokkia digital level:
1. From the Format name drop-down list, select the required format type.
2. Double click the file1.dl file.
3. The Download file from Digital Level dialog is displayed.
4. Take all the steps listed in the Download File From Digital Level dialog to prepare the

Digital Level.
5. Select the required file in the Digital Level for downloading to the computer.

4. Navigate to the required file and open it.

To add a new Topcon/Sokkia Total Station:
1. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.
2. From the Look in drop-down list, the Topcon Total Station or Sokkia Total Station.
3. Double click Add New Station.

The Create Station dialog is displayed.
4. Define the personal parameters for the Total Station.
5. Click OK.

To add a new Topcon/Sokkia Digital Level:
1. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.
2. From the Look in drop-down list, the Topcon Digital Levels or Sokkia Digital Levels.
3. Double click Add New Station.

The Create Station dialog is displayed.
4. Define the personal parameters for the Total Station.
5. Click OK.

NOTES
GNSS receivers of Topcon family collects raw data to the TPS (*.tps) file format.

GNSS receivers of Sokkia family collects raw data to PDC(*.pdc) and SDR (*. sdr) file formats.

Microsoft® ActiveSync needs to be installed on the computer withWindowsXP. If the user’s computer
operates under WindowsVista, ActiveSync is not needed. A connection between the computer and an
external device withWindowsCE will be automatically established after connecting your device to your
computer physically.
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The application supports importingMAGNET Field job (*.mjf), TopSURV job (*. tsj) and SpectrumSur-
vey Field job (*. tsj) files.

Auto Import of GPS occupation to the current job

MAGNET Tools allows you to automatically download a reference station occupation from the Internet to the job.
For a GPS occupation, which does not have corresponding data from any base station, the application will find an
appropriate RINEX file from the Internet, import the file to the current job and process that GPS observation.

To activate the option:
1. In the Information group of the Job tab, click the Job Configuration icon.

The Job configuration dialog is displayed.
2. In the left panel, select the GPS+ PostProcess item.
3. At the General tab, tick the Use auto import checkbox.
4. Click OK.
5. In the GPS group of the Process tab, click the GPS+ PostProcessing icon.

MAGNET Tools transmits the coordinates and time interval for the given GPS occupation to the Topcon
Server.

Then the Topcon Server will find a reference station presented on the Topcon Server database by the cri-
terion of the minimal distance from the GPS occupation. If this reference station is found and the collected
raw data file of the reference station covers the given time interval, the RINEX file will be imported to the
job and the created GPS observation will be automatically processed with the parameters defined in the
GPS+ PostProcess item of the Job configuration dialog. See "GPS+ PostProcess item" section on page 105
for details.

NOTE
If the current job contains aGPS observation, the Auto Import will not be performed for the occupation.
To run Auto Import, delete or disable the GPS observation(s) at theGPSObservation tab from the Tab-
ular view.

Export icon
The Export icon of the Exchange group allows you to export a data from the current job to another file on the com-
puter, a connected controller or Topcon/Sokkia Total Station.

To export data from the job:
1. In the Exchange group of the Job tab, click the Export icon.

The Export dialog is displayed.
2. In the Select objects to export list, select objects to be exported.
3. Click Next >.
4. From the Save in drop-down list, select the required format of the file.

l If you have selected the Topcon/Sokkia GNSS Receiver, the application will automatically search
for receivers connected to the computer COM or USB port. When finished, all the receivers con-
nected to the computer will be displayed in the Export dialog.

l If you select the Mobile Device, Microsoft ActiveSync (for Window XP computer) automatically
establishes a connection with the controller, then double-click Mobile Device or My Windows
Mobile -Based Device in the Export dialog.

5. From the Format name drop-down list, select the required format of the file.
6. If needed, expand the Advanced options panel to configure the additional export parameters.
7. Navigate to the required directory.
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8. In the File name editbox, type the name for the data file.
9. Click Save.

Create AutoCAD drawing icon
If AutoCAD Civil 3D is installed on the computer, you can directly export data (points, lines, surfaces) of the cur-
rent job into the current Civil 3D drawing. After clicking the icon, the Export to Civil 3D dialog is appeared. In
the dilaog, you can select the metric unit, coordinate type, datum/projection, coordinate order, point/line style and
labels text size for displaying in Civil 3D.

Create MAGNET drawing icon
The Import from Internet icon of the Exchange group allows you to export your MAGNET Tools job to a
MAGNET Office job.

It is active only if the MAGNET Tools application was opened from the MAGNET Office applicaltion.

If the MAGNET Office is not installed on your computer, the icon will not be displayed.

Import from Internet icon
The Import from Internet icon of the Exchange group allows you to find RINEX files (with broadcast/precise
ephemeris) from the Internet according to your request and to download the files to the current job.

After clicking the icon MAGNET Tools automatically requests the Topcon Server. Then this server generates the
Web Import page and the Web Import page is displayed in MAGNET Tools.

NOTE
The type of theWeb Import page depends on the version of Topcon Sever’s software and can be
updated regardless of MAGNET Tools version.

To obtain information about how to find the desired RINEX/ephemeris file, click the Help link on the Web Import
page.

Assist Import from Internet icon
The Assist Import from Internet icon of the Exchange group allows you to select an external server to down-
load a RINEX and ephemeris files. An external server is a server that does not belong to Topcon. Only the selec-
ted server will perform searching data using its own rules and techniques.

Print group
The Print group from the Job tab of the MAGNET Tools ribbon allows you to print any view or tab and update the
print parameters. The group contains three icons:

Print icon

Click it to print the current view.

Print Preview icon

Click it to preview the print.
Page Setup icon

Click it to configure the paper settings for printing.

Print icon
The Print icon of the Print group allows you to print the current view or tab.
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After clicking the icon, the Print dialog is displayed. Select the required printer, the print range and the number of
the copies before printing. Click OK to start printing the selected view or tab.

Print Preview icon
The Print Preview icon of the Print group allows you to view a final result of page settings before printing.

After clicking the icon, the Print Preview is shown. You can zoom the view. Also you can print from the view.

Page Setup icon
The Page Setup icon of the Print group allows you to set the size, orientation and margins of the page.

After clicking the icon, the Page Setup dialog is displayed. The parameters entered in this dialog will be used for
all next printouts.

Information group
The Information group from the Job tab of the MAGNET Tools ribbon allows you to configure the current job and
see the information about the opened job. The group contains two icons:

Job Configuration icon

Click it to configure the current job.

Job Info icon

Click it to view the basic info about the current job.

Job Configuration icon
The Job Configuration icon of the Information group allows you to configure the current job.

After clicking the icon, the Job Configuration dialog is displayed. See "Job Configuration dialog" section on
page 91 for details.

Job Info icon
The Job Info icon of the Information group allows you to configure the current job.

You can see the information about the opened job. After clicking the icon, the Properties dialog for the current job
is displayed. The General tab of the dialog contains the whole path to the file, date of creating, the person who
created the job and comments. The Objects tab contains the quantities of objects of each type.

Edit tab
The Edit tab of the MAGNET Tools ribbon contains control icon for work flow operations. It is separated to five
groups, described in the corresponding sections:

l "Actions group" section on the facing page
l "Clipboard group" section on the facing page
l "Delete group" section on page 40
l "Enable group" section on page 40
l "Properties group" section on page 41
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Actions group
The Actions group from the Edit tab of the MAGNET Tools ribbon allows you to reverse the last action and return
the last action. The group contains two icons:

Undo icon

Click it to cancel the last performed action.

Redo icon

Click it to restore the last canceled action.

Undo icon
The Undo icon of the Actions group allows you to cancel last performed action.

The icon will be enabled if any action is performed in the job. The name of the last action is shown on the icon.
After clicking the icon, the last action will be undone. You can undo all actions, which you made after opening the
job.

Redo icon
The Redo icon of the Actions group allows you to restore the last cancelled action.

The icon will be enabled after performing the undo action. The name of the previously undone action is shown on
the icon. After clicking the icon, the undone action will be redone. You can redo any action, which you undid after
opening the job.

Clipboard group
The Clipboard group from the Edit tab of the MAGNET Tools ribbon allows you to copy any selected object and
put the object to the Windows clipboard, place an objects from the Windows clipboard in the current cursor pos-
ition, cut any selected object from any view or tab. The group contains three icons:

Paste icon

Click it to insert an object from the clipboard to the job.

Cut icon

Click it to cut an object to the clipboard.
Copy icon

Click it to copy an object to the clipboard.

Paste icon
The Paste icon of the Clipboard group allows you to place objects from the Windows clipboard in the current
cursor position.
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The icon will be enabled if any object is present in the clipboard. After clicking the icon, the selected objects will
be inserted in the corresponding place. The combination Copy and Paste can be used to transfer the selected
objects from one job to another.

Cut icon
The Cut icon of the Clipboard group allows you to cut any selected object from any view or tab and put the object
to the Windows clipboard. The icon will be enabled if any object is present in the clipboard. After clicking the
icon, the object will be removed from the job, the icon will be disabled, but the Paste icon will be enabled to past
the object. The command is present in the pop up menu for the given object.

Copy icon
The Copy icon of the Clipboard group allows you to copy any selected object and put the object to the Windows
clipboard. The icon will be enabled if an object is selected. After clicking the icon, the selected object will be put
to the clipboard, the Paste and Cut icons will be enabled. The command is present in the pop up menu for the
given object.

Delete group
The Delete group from the Edit tab of the MAGNET Tools ribbon allows you to remove any selected object from
any view or tab. The group contains one icon:

Delete icon

Click it to delete a selected object.

Delete icon
The Delete icon of the Delete group allows you to remove any selected object from any view or tab. The icon will
be enabled if any object is selected. After clicking the icon, the object will be removed from the job, the icon will
be disabled. The command is present in the pop up menu for the given object.

Enable group
The Enable group from the Edit tab of the MAGNET Tools ribbon allows you to enable or disable any selected
object in any view or tab. The group contains two icons:

Enable icon

Click it to enable any selected object in any view
Disable icon

Click it to disable any selected object in any view

Enable icon
The Enable icon of the Enable group allows you to enable any selected object in any view or tab. The icon will be
enabled after selection of an object. After clicking the icon, the selected object is included in adjustment, coordin-
ate calculation and export. The command is present in the pop up menu for the given object.
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Disable icon
The Disable icon of the Enable group allows you to disable any selected object in any view or tab. The icon will
be enabled after selection of an object. After clicking the icon, the adjustment, coordinate calculation and export
will ignore the object. A disabled object is grayed-out in all views. The command is present in the pop up menu
for the given object.

Properties group
The Properties group from the Edit tab of the MAGNET Tools ribbon allows you to see the Properties window for
selected object(s) in any view or tab. The group contains one icon:

Properties icon

Click it to view/edit properties of the selected object.

Properties icon
The Properties icon of the Properties group allows you to view the Properties dialog for selected objects in any
view or tab. The icon will be enabled if any object is present in the clipboard.

After clicking the icon, the Properties dialog is displayed. If you select more than one object, the Properties dia-
log will display the fields, where the selected objects have the same parameters (code, layer, color, point symbol
and so on). The fields for every parameter (name, coordinates, errors and so on) will be empty. See
"MAGNET Tools Entities Properties" section on page 218 for details.

View tab
The View tab of the MAGNET Tools ribbon contains control icons for layout configuring. It contains six groups:

l "Spatial group" section below
l "GPS group" section on page 44
l "Equipment group" section on page 44
l "CAD group" section on page 45
l "Filters group" section on page 45
l "Options group" section on page 45

Spatial group
The Spatial group from the View tab of the MAGNET Tools ribbon allows you to show or hide different viewers
of the observations or objects of the job. The group contains nine icons:

Observation View icon

Click it to display the Observation view.

Map View icon

Click it to display the Map view.
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3D View icon

Click it to display the 3D view.

Map View on Google Earth icon

Click it to display the data from job in Google Earth application.

Switch to AutoCAD icon

Click it to open your job in AutoCAD.

Switch to MAGNET Office icon

Click it to open your job in MAGNET Office.

Background images icon

Click it to manage background images.
Contour Lines icon

Click it to manage contour lines.
Bing Map view icon

Click it to display the data from job on Bing maps.

Observation View icon
The Observation View icon of the Spatial group opens a graphic representation of the GPS, RTK, TS and DL sur-
vey data. In the Observation View the following information displays:

l GPS, RTK, TS and DL measured points with survey symbols and manual points
l Unprocessed and processed GPS observations in both static and kinematic modes, and also RTK and TS
observations

l Background image in the selected coordinate system

In the Observations View Options dialog you can:
l show or hide the coordinate grid, scale bar, legend window, background image, graphic accuracy indicators
for the adjusted points

l change the background color

See "Observations View Options dialog" section on page 317 for details.

Map View icon
The Map View icon of the Spatial group opens a graphic representation of the points, lineworks, surfaces and
roads. In the Map View you can select a different plotting style for drawing these objects using separate layers.

In the Map View Options window you can:
l show or hide the coordinate grid, scale bar, legend window, background image
l change the background color
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See "Map View Options dialog" section on page 319 for details.

3D View icon
The 3D View icon of the Spatial group opens a three-dimensional graphical representation of the points, line-
works, surfaces and roads. You can turn the object clockwise /counterclockwise in the screen plane and increase/-
decrease the vertical scale in 3D View.

In the 3D View Options window you can:
l display either the solid model or the wireframe model or both the solid and a wireframe models
l show or hide the coordinate grid, scale bar, legend window, background image
l change the background color

See "3D View Options dialog" section on page 319 for details.

Map View on Google Earth icon
The Map View on Google Earth icon of the Spatial group opens a graphic representation of the points, line-
works, surfaces and roads in Google Earth. To see this view you

need the following:
l an Internet connection
l the Google Earth program installed on the computer

Switch to AutoCAD icon
The Switch to AutoCAD icon of the Spatial group opens Civil 3D window. This icon will be enabled when
AutoCAD Civil 3D is installed on the computer.

Background images icon
The Background images icon of the Spatial group opens Background Images dialog, where you can:

l see all available images for the current job
l add any georeferenced image to the list of the available images for the current job
l select from the list an image to display in the current job
l convert an existing image to any coordinate system
l georeference an image

TIP
The georeferenced image - an image for which the relationship between pixel coordinates and real
datum/grid/ground /local coordinates is established.

See "Creating background map for work area" section on page 336 for details.

Contour Lines icon
The Contour Lines icon of the Spatial group opens Contour Lines dialog to plot contour lines for an existing sur-
face. The Map View and 3D View display the contour lines.

TIP
Contour lines are lines joining the surface’s points of equal elevation.

See "Drawing Contour Lines for surface" section on page 343 for details.

Bing Map view icon
The Bing Map view icon of the Spatial group opens Bing maps for Map View. The Bing maps will be displayed
in WebSphereMercator map projection only to display the job objects on the Bing maps, MAGNET Tools
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automatically transforms the objects coordinates from the current coordinate system to the WebSphereMercator
projection. In the Points tab of the Tabular view, the coordinates of all objects of the job are displayed in the cur-
rent coordinate system.

Switch to MAGNET Office icon
The Switch to MAGNET Office icon of the Spatial group opens MAGNET Office application. This icon will be
enabled when MAGNET Office is installed on the computer.

GPS group
The GPS group from the View tab of the MAGNET Tools ribbon allows you to see a time-scale graph of the GPS
occupations and list of the ephemeris which were imported to the current job. The group contains two icons:

Occupation View icon

Click it to display the occupation view.

Ephemeris View icon

Click it to display the ephemeris view.

Occupation View icon
The Occupation View icon of the GPS group allows you to open the Occupation view. See "Occupation View"
section on page 211 for details.

Ephemeris View icon
The Ephemeris View icon of the GPS group allows you to open the Ephemeris view. See "Ephemeris View" sec-
tion on page 213 for details.

Equipment group
The Equipment group from the View tab of the MAGNET Tools ribbon allows you to see parameters of all GPS
antennas which were calibrated either by NGS, or TPS, Total Station parameters and classes of Total Station
measurements. The group contains three icons:

Antenna List

Click it to display the list of all available antennas.
TS Instruments

Click it to display the list of all available Total Stations.
Classes View

Click it to display the list of all available total station measurement
classes.
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CAD group
The CAD group from the View tab of the MAGNET Tools ribbon allows you to see all codes and their attributes,
all layers and their plotting styles used in the job. The group contains two icons:

Codes

Click it to display the list of all available survey codes.

Layers

Click it to display the list of all available layers.

Filters group
The Filters group from the View tab of the MAGNET Tools ribbon allows you to select or create a filter to hide
or display points, occupations, and observations in all MAGNET Tools viewers. The group contains one icon:

Filters icon

Click it to manage MAGNET Tools data filters.

Filters icon
The Filters icon of the Filters group allows you to access the Filters dialog, where you can manage MAGNET
Tools data filters. See "Filters dialog" section on page 387 for details.

Options group
The Options group from the View tab of the MAGNET Tools ribbon allows you to display or hide different
columns in the Tabular View and elements in Observation/ Map/Occupation/Image/Stereopair/Google Earth Map
View. The group contains two icons:

View Options icon

Click it to open an Options dialog for any view.

Options icon

Click it to open an Options dialog for MAGNET Tools.

View Options icon
The View Options icon of the Options group allows you to open an Options dialog for any MAGNET Tools view-
ers from the list.

See "Options dialog" section on page 316 for details.

Options icon
The Options icon of the Options group allows you to open an Options dialog where you may configure
MAGNET Tools preferences.
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The Options dialog appears after clicking. It contains two panels. The left panel lists items of the job con-
figuration. The right panel displays parameters for the selected item. Configuration items are described in the sec-
tions below.

Product update item

It allows you to configure the auto check for MAGNET Tool updates.

Fields of the Product Update item
Field Description

Check for updates When ticked, the application will automatically check for available updates
within interval, defined in the Update checking interval drop-down list.

Update checking
interval Defines the interval for automatic update check.

Show or hide dialogs item

It allows you to configure the displaying of several MAGNET Tools dialogs.

Fields of the Show or hide dialogs item
Field Description

Show Startup Wiz-
ard

When ticked, the MAGNET Tools will display the Startup Wizard dialog each
time when application is launched.

Show Startup Wiz-
ard for External

Start

When ticked, the MAGNET Tools will display the Startup Wizard dialog each
time when application is launched from other application.

Allow to Select
Objects for Export

When ticked, the Export dialog will be preceded by the selection of objects to
export.

Dispaly item

It allows you to configure the layout of all MAGNET Tools views.

See "Options dialog" section on page 316 for details.

Window tab
The Window tab of the MAGNET Tools ribbon contains control icons which allows you to operate with the
MAGNET Tools views. It is separated to two groups, described in the corresponding sections:

l "Zoom group" section below
l "Windows group" section on page 48

Zoom group
The Zoom group from the Window tab of the MAGNET Tools ribbon allows you to set Zoom and Pan Modes for
Observation View, Map View, 3D View and Occupation View, and can set Rotate Mode for 3D View. The
group contains seven icons:
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Zoom In icon

Click it to zoom in the current view.

Zoom Out icon

Click it to zoom out the current view.

Zoom Previous icon

Click it to return the previous scale of the current view.

Restore All icon

Click it to fit all data to the screen in the current view.

Zoom to Selection icon

Click it to fit the selected objects to the screen in the current view.

Pan Mode icon

Click it to manually move the current view.

Rotate Mode icon

Click it to manually rotate the current view.

Zoom In icon
The Zoom In icon of the Zoom group allows you to change the magnification of the selected area in the Obser-
vation View, Map View, 3D View and Occupation View. Clicking on the icon changes the cursor into 'zoom

in' cursor. Click on a point in the View and extend the rectangle for the desired area. MAGNET Tools will
redraw the selected area with scaling up.

Zoom Out icon
The Zoom Out icon of the Zoom group allows you to change the magnification of the selected area in the Obser-
vation View, Map View, 3D View and Occupation View. Clicking on the icon changes the cursor into 'zoom

out' cursor. Click on a point in the View and extend the rectangle for the desired area. MAGNET Tools will
redraw the selected area with scaling down.
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Zoom Previous icon
The Zoom Previous icon of the Zoom group allows you to restore the previous scale of the Observation View,
Map View, 3D View and Occupation View. The icon will be enabled after using Zoom In, Zoom Out or Zoom to
Selection procedure. After clicking the icon, automatically the previous scale of the View will be set. You can
restore all actions with Zoom, which you made after opening the job.

Restore All icon
The Restore All icon of the Zoom group allows you to fit all data in the Observation View, Map View, 3D View
and Occupation View into the viewable extents of the given view.

Zoom to Selection icon
The Zoom to Selection icon of the Zoom group allows you to zoom in / zoom out to the selected object(s) in the
Observation View, Map View, 3D View and Occupation View. Clicking on the icon moves the selected object(s)
to the center of the View. For a point object selected, the view will be scaled to display the nearby objects.

Pan Mode icon
The Pan Mode icon of the Zoom group allows you to move the objects in the Observation View, Map View, 3D
View and Occupation View. Clicking on the icon changes the cursor into 'pan' cursor. Click on any place and
move.

Rotate Mode icon
The Rotate Mode icon of the Zoom group allows you to rotate an object in 3D View. Clicking on the icon
changes the cursor into 'rotate' cursor. Click on any place and rotate.

Windows group
The Windows group from the Window tab of the MAGNET Tools ribbon allows you to configure the window lay-
out. The group contains two icons:

Split Workspace Vertically icon

Click it to tile windows in the working area Vertically.

Split Workspace Horizontally icon

Click it to tile windows in the working area horizontally.

Split Workspace Vertically icon
The Split Workspace Vertically icon of the Windows group allows you to tile opened in the MAGNET Tool win-
dows vertically.

Split Workspace Horizontally icon
The Split Workspace Horizontally icon of the Windows group allows you to tile opened in the MAGNET Tools
windows horizontally.
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Add tab
The Add tab of the MAGNET Tools ribbon contains control icons which allows you to add various entities to your
job. It has two groups, described in the following sections:

l "Add group" section below
l "Snap group" section on page 59

Add group
The Add group from the Add tab of the MAGNET Tools ribbon contains twelve icons. It allows you to add a
point, line, area, surface, layer, code, X-section Template, Road, create a surface from a Geoid, and manually
insert TS occupation or/and DL run into the current job:

Point icon

Click it to create a new point.

Line icon

Click it to create a new line.

Area icon

Click it to create a new area.

Surface icon

Click it to create a new surface.

Surface from Geoid icon

Click it to convert a geoid into a new surface.

Layer icon

Click it to create a new layer.

Code icon

Click it to create a new survey code.

Road icon

Click it to create a new road.

X-section Template icon

Click it to create a new X-Section template for a road.



Ribbon Icon Functions

50

Manual TS Occupation icon

Click it to manually create a new TS occupations.

Manual DL Run icon

Click it to manually create a new DL run.

Text icon

Click it to create a new text object.

Add Station Equations Set icon

Click it to create a new station equation set.

Point icon
The Point icon of the Add group allows you to add a new point in the job.

To add a point:
1. In the Add group of the Add tab, click the Point icon.

The pointer is changed to
2. Click the required place in the Observation or Map view.

The Add Point dialog is displayed.

You can edit:
l name, code, layer, note for the point in the General tab of the Add Point dialog. See "General tab" section
on page 219 for details.

l coordinates in the current coordinate system in the Coordinates tab of the Add Point dialog. See "Coordin-
ates tab" section on page 220 for details.

l color and point symbol in the Code and Style tab of the Add Point dialog. See "Codes and Style tab" section
on page 224 for details.

Click OK to create the point in the Observation view, Map view and the Points tab of the Tabular view.

Click the icon again to deactivate "add point" mode and to return the pointer to a normal view.

Line icon
The Line icon of the Add group allows you to add a new polyline in the job. After clicking the icon, the pointer
will change ( ), “add line” mode will become active. Select the desired segment type for the polyline from

the list of the Segment type field in the Add Line dialog:
l Line
l Curve
l Curve by 2 points
l Curve by 3 points

For the Curve type, select a radius (in the current units) and a turn direction.

After “add line” mode is activated, you can use one way from the following ways to plot a polyline:
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l Between two and more existing points— click the ‘add line’ cursor on the first point on the Map View,
then click on the second point. The polyline will be created between those points.

l Between selected points— select the desired points in the Map View or Points tab of the Tabular view.
Then the polyline will be automatically created by connecting the points in the order of the point num-
bers/names.

l Without points— click the ‘add line’ cursor on any area within the Map view. Repeat this step as needed.
Vertexes of the polyline will be appended to the line. These vertexes have no name, and the Points tab does
not display the coordinates for them. The right panel of the Lines tab displays only the icon and the order
for the vertexes.

The Lines tab of the Tabular view contains information about the created polyline. In the left panel of the tab you
can edit the layer of the polylines. See "Lines tab" section on page 159 for details.

Area icon
The Area icon of the Add group allows you to add a new area in the job. The area is closed a polyline. After
clicking the icon, the pointer will change ( ), “add area” mode will become active. Select the desired seg-

ment type for the area from the list of the Segment type field on the Add Area window:
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l Line
l Curve
l Curve by 2 points
l Curve by 3 points

For the Curve type, select a radius (in the current units) and a turn direction.

After “add area” mode is activated, you can use one way from the following ways to plot the area:
l For existing points and non existing points— click the ‘add area’ cursor on the first point or any place
within the Map view, then click on the second point / any place. A polyline will be created between those
points. Then click on the third point/any place, and all three points will be connected by the line. The area
defined by the three points is created. Any click on an existing or non existing point will automatically cre-
ate a area with the given set of points.

NOTE
When you click the cursor on any place of theMap View, the vertexes of the polyline have no name, and
the Points tab of the Tabular view does not display the coordinates for them. The right panel of the Lines
tab of the Tabular view displays only the icon and the order for the vertexes.

l For selected points— select the desired points in the Map View or Points tab of the Tabular view. Then
the area will be automatically created for three and more selected points. The points will be connected in
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the order of the point numbers/names.

The Lines tab of the Tabular view contains information about the created area. In the left panel of the tab you can
edit the layer of the polylines. See "Lines tab" section on page 159 for details.

Surface icon
The Surface icon of the Add group allows you to add a new surface in the job. Before creating a new surface,
open the Map View, set either the grid or ground coordinates using the Status bar and select (on the Map View or
the Points tab of the Tabular view) the desired points which will enter into the surface.

After clicking the icon, the Add Surface dialog is displayed. In the General tab of the dialog, enter a name of the
surface being created, if needed set the focus point and select a layer for the surface. To automatically update the
surface if changes are made, tick the Auto Update checkbox. See "Surface Properties dialog" section on page 269
for details.

In the Option tab of the dialog, set constraints for creating triangles inside the surface:
l minimal allowable interior angle of a triangle in the with Interior Angle< editbox.
l minimal allowable area of a triangle in the with Area> editbox.

The parameters, which are set in the Options tab, will define the number of triangles in the Surface. See "Options
tab" section on page 271 for details.

Click OK. The new surface is created. The Surfaces tab of the Tabular view displays the parameters of the cre-
ated surface.

The application displays the surface in the Map View and/or in the 3D View.
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Surface from Geoid icon
The Surface from Geoid icon of the Add group allows you to create a surface of undulations of the selected
geoid and then view the surface image in Map View or 3D View. Before creating such a surface:

l Be sure that the desired geoid is the current geoid of the opened job: the Geoid field at the Setup tab of the
Coordinate Systems item from the Job Configuration dialog displays the given geoid.

l Be sure that the geoid covers the work area.
l In the Points tab of the Tabular view enter and highlight the boundary points for the desired area. A min-
imal number of two boundary points must be selected. These points will define the opposite diagonal points
of the rectangular surface being created. You can use points from the job.

l Set Grid coordinates in the Status bar.

After clicking the icon, the Add Surface dialog is displayed. In the General tab of the dialog, enter a name of the
surface being created, if needed set the focus point and select a layer for the surface. To automatically update the



Layer icon

55

surface if changes are made, tick the Auto Update checkbox. See "Surface Properties dialog" section on page 269
for details.

Click OK. The new surface is created. The Surfaces tab of the Tabular view displays the parameters of the cre-
ated surface.

The application displays the surface in the Map View and/or in the 3D View.

Layer icon
The Layer icon of the Add group allows you to open the Add Layer dialog to set layer properties.

Code icon
The Code icon of the Add group allows you to open the New Code dialog to set the properties of the new code.

Road icon
The Road icon of the Add group allows you to activate the Add Road dialog to create a new road. Before creating
a new road, set Grid or Ground coordinates in the Status bar and create a start point for this road in the Points tab
of the Tabular view. Clicking the icon opens the Add Road dialog.

At the General tab of the dialog, enter the following parameters:
l A name for the road being created in the Name editbox.
l Select the start point of the road from the Start Point drop-down list.
l The starting station or chainage in the Start Station / Chainage editbox.
l The stationing stakeout interval in the Station Stakeout Interval editbox.
l The layer in which the road resides in the Layer drop-down list.

In the Alignment names tab of the Add Road dialog, you can select a pre-defined horizontal alignment, vertical
alignment and cross-section template to design the road. See "Road Properties" section on page 274 for details.

Click OK. The left panel of the Roads tab of the Tabular view displays the name of the road being created; the
right panel displays the horizontal/ vertical alignments and the x-sections of the road in table and graphic modes.
The Add Horz Element window is displayed to continue or to begin if a horizontal alignment is not selected in the
Alignment names tab of the Properties dialog for the road creating a horizontal alignment. You can close the win-
dow or enter the desired parameters in the window.

X-section Template icon
The X-section Template icon of the Add group allows you to activate the Add X-Section Template dialog to cre-
ate a cross-section Template. At the General tab of the dialog, enter the following parameters:

l A name for the new template in the Name editbox.
l A cut slope value in the Cut Slope field.
l A fill slope value in the Fill Slope field.

See "X-Section station Properties dialog" section on page 294 for details.

Click OK to create the cross section template. The left panel of the X-section Template tab of the Tabular view
displays the name of the created template.

The created template has zero values of offsets. To edit the offsets, right click the created template in the left
panel of the X-section Template tab. Select the Add Offset command from the pop-up menu and specify the
required parameters in the General tab of the Add Offset dialog.
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Manual TS Occupation icon
The Manual TS Occupation icon of the Add group allows you to activate the Add Manual TS Occupation dialog
to add a new TS Occupation manually to the current job. At the General tab of the dialog, enter the following para-
meters:

l A name of the point at which the Total Station is set in the Point Name field.
l A vertical distance from the Instrument Center Mark to the ground in the current linear units in the Instru-
ment Height field.

At the Accuracy tab you can enter the following parameters, in the current linear units:

• An error of centering the Total Station position over the mark in the Instrument Centering Error
field.
• A measurement error of the Total Station height over the mark in the Instrument Height Error field.
• An error of centering the reflector position over the mark in the Reflector Centering Error field.
• A measurement error of the reflector height over the mark in the Reflector Height Error field.

In the Instrument Type tab you can select the desired instrument type from the list or create a custom instrument
type by clicking the Custom button. See "TS Obs Properties dialog" section on page 246 and "Adding TS Instru-
ment Type" section on page 331 for more details.

Click OK in the Add Manual TS Occupation dialog to close it and open the Add Manual TS Obs dialog.

In the Observation tab you can enter the following parameters, in the current linear units:
l A name of the point at which the reflector is set in Point To field.
l Select the type of the measured point in the Type field.
l A vertical distance from the Reflector Center Mark to the ground in the Reflector Height field.
l An azimuth value that defines orientation of TS measurements by the backsight from the station in the hori-
zontal plane in the Azimuth field.

l A measured horizontal angle from the previous to the next observation in the Horizontal Circle field.
l A vertical angle to the reflector measured from zenith in the Zenith Angle field.
l A slope distance between the TS station (Point From) and the TS occupation (Point To) in the Slope
Distance field.

l A vertical angle to the reflector measured from horizon in the Vertical Angle field.
l A distance between the TS station (Point From) and the TS occupation (Point To) in the horizontal plane in
the Horizontal Distance field.

l A distance between the TS station (Point From) and the TS occupation (Point To) in the vertical plane in
the Vertical Distance field.

Clicking OK in the Add Manual TS Obs dialog saves the observation at the TS Obs tab of the Tabular view. The
next Add Manual TS Obs dialog will display to add a new observation, if the Add Next Obs checkbox was ticked.

Manual DL Run icon
The Manual DL Run icon of the Add group allows you you to activate the Add Manual DL Run dialog to add a
new DL Run manually to the current job. In the General tab of the dialog, enter the following parameters:

l a name of the leveling job created in a digital level, in the Level Run field.
l the number of the DL run (DL occupation) contained in the current job in the # field.
l any user's comment in the Note field.

and tick the Enabled checkbox.



Text icon

57

Clicking OK in the Add Manual DL Run window closes this window and opens the Add Manual DL Obs win-
dow. See "DL Obs Properties dialog" section on page 257 for details.

At the Observation tab you can enter data for a manual observation, in the current linear units:
l a current type of the Digital Level observation in the Type field. This field contains the list of the DL obser-
vation types. You can select a type from the list:

l SS- sideshot — the measurement to a sideshot point.
l BS - backsight — the measurement to the previous occupation point in the DL run.
l FS - foresight — the measurement to the next occupation point in the DL run.
l End of Changing Pt — the end measurement (of the given DL run) to the point that is used to carry
the measurements forward in the DL run.

l End of Bench Mark — the end measurement (of the given DL run) to a point of known elevation.
l a name of the turning or sideshot point in the Point field. You can select a point from the list.
l a rod reading at the given point in the current linear units in the Ht. Measurements field.
l a vertical offset from the horizontal plane for traverse and sideshot points in the Vert Offset field.
l a measured distance from DL to the given point in the Distance field.
l a standard deviation for the level measurement in the Std Dev field.

Clicking OK in the Add Manual DL Obs window saves the observation in the DL Obs tab. The next Add
Manual DL Obs window will display to add a new observation, if the Add Next Obs checkbox was ticked.

Text icon
The Text icon of the Add group allows you to add a new text object into the current job. After clicking the icon,

the pointer will change ( ), “add text” mode will become active.

Click anywhere in the Map view to create the object. You can edit:
l contents, layer, color, angle, text height in the current linear units, font name, font style (bold, italic, under-
line) of the text and insertion point of the text box at the Text tab of the Add Text dialog. See "Text tab" sec-
tion on page 309 for details.

l a name and coordinates (in the current coordinate system) of the start point of the of the text box in the
Location tab of the Add Text dialog. See "Location tab" section on page 310 for details.

After clicking OK the text object is created. The Map View displays the object and the Text tab from the Tabular
view displays the properties of the text . See "Text tab" section on page 197 for details.

Click the icon again to deactivate "add text" mode and to return the pointer to a normal view.

Add Station Equations Set icon
While designing a road there may be a situation when the original stationing does not fit to the actual alignment,
and a new center line stationing may be needed. Station Equations are a method to link an old and a new roadway
stationing. Station equations are used to change the stationing forward or back from a some spot along the align-
ment. Approaching stationing, behind the spot, where station equation applied is called Back Station, departing sta-
tioning, which is after this spot is called Ahead Station.
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Original stationing — second segment is 5 meters long, the third station is 0+15.00, and the end station is 0+19.00.

The second segment has been prolonged to 7 meters. Third station became 0+17.00, and the end station became
0+21.00.

The Station Equation is applied to the third station. Its formula is Back Station = 0+17.00, Ahead Station =
0+15.00. The end station is 0+19.00 again.

The Add Station Equations Set icon of the Add group allows you to create a new set station equations. A set
may contains several station equations for a road. You may assign only one set for one road, so you have to create
all necessary equations for a road in one set.

To add a new station equations set:
1. In the Add group of the Add tab, click the Add Station Equations Set icon.

The Add Station Equations Set dialog is displayed.
2. In the Name editbox, type the name of the station equations set.
3. Click OK.
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The newly created station equations set is displayed in the left panel of the Station Equations tab from the
Tabular view.

To add a new station equation to the set:
1. In the left panel of the Station Equations tab from the Tabular view, select the required station equations

set.
2. In the right panel of the Station Equations tab, right click and select Add Station Equation from the context

menu.

The Add Station Equation dialog is displayed.
3. In the Name editbox, specify the name of the station equation.
4. In the Back Station editbox, specify the stationing for the approaching segment.
5. In the Ahead Station editbox, specify the stationing for the departing segment.
6. Click OK.

Snap group
When creating entities in the survey view, they supposed to be on their right places. For example, you might need
to place the end point of a line exactly to the start point of another line. It might be easy to do at the small scale,
but at large scales it is easy to miss the required point, and place your entity near it. Snap modes are created to
help you to place points exactly to the required locations.

The Snap group from the Add tab of the MAGNET Tools ribbon contains one icon, which gives you access to the
snap modes.

Snap Mode icon
Click it to open the snap modes panel.

NOTE
Snapmodes aremutually exclusive – when onemode is selected, others are disabled

Snap Mode icon
The Snap Mode icon of the Snap group allows you to open the Snap Mode panel. It contains six icons of snap
modes, described in the table below.

End Point snap mode
Creates either point at the end of segment, or node of the segment/curve/area

using the end points of the existing segment.

Middle Point snap mode
Creates either point, or node of the line/curve/area in the center of the segment.

Circle Center snap mode
Creates either point, or node of the line/curve/area in the center of a curve.
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Intersection snap mode
Creates either point, or node of the line/curve/area at the intersection point of two

lines/curve.

Perpendicular snap mode
Creates a polyline perpendicular to an existing polyline.

Circle Quadrants snap mode
Creates points at the circle quadrants.

End Point snapmode

Creates either point at the end of segment, or node of the segment/curve/area using the end points of the existing
segment.

To use the End Point snap mode:
1. In the Add group of the Add tab, click the required icon:

l Point— to create a single point.
l Line — to create a node of a line/curve.
l Area— to create a node of an enclosed area.

2. In the Snap group of the Add tab, click the Snap Mode icon.

The Snap Mode panel is displayed.
3. Click the End Point snap mode icon.
4. In the Map View, click the required line or curve.

The new point or line/curve/area node is created at the end point of the selected line/curve.

Middle Point snapmode

Creates either point, or node of the line/curve/area in the center of the segment.

To use the Middle Point snap mode:
1. In the Add group of the Add tab, click the required icon:

l Point— to create a single point.
l Line — to create a node of a line/curve.
l Area— to create a node of an enclosed area.

2. In the Snap group of the Add tab, click the Snap Mode icon.

The Snap Mode panel is displayed.
3. Click the Middle Point snap mode icon.
4. In the Map View, click the required line or curve.

The new point or line/curve/area node is created in the center of the selected segment.

Circle Center snapmode

Creates either point, or node of the line/curve/area in the center of a curve/circle.



Intersection snap mode

61

To use the Circle Center snap mode:
1. In the Add group of the Add tab, click the required icon:

l Point— to create a single point.
l Line — to create a node of a line/curve.
l Area— to create a node of an enclosed area.

2. In the Snap group of the Add tab, click the Snap Mode icon.

The Snap Mode panel is displayed.
3. Click the Circle Center snap mode icon.
4. In the Map View, click the required curve.

The new point or line/curve/area node is created in the center of curve.

Intersection snapmode

Creates either point, or node of the line/curve/area at the intersection point of two lines/curves.

To use the Intersection snap mode:
1. In the Add group of the Add tab, click the required icon:

l Point— to create a single point.
l Line — to create a node of a line/curve.
l Area— to create a node of an enclosed area.

2. In the Snap group of the Add tab, click the Snap Mode icon.

The Snap Mode panel is displayed.
3. Click the Intersection snap mode icon.
4. In the Map View, continuously click the required lines/curves.

The new point or line/curve/area node is created at the intersection of lines/curves.

Perpendicular snapmode

Creates a line segment, perpendicular to an existing line segment.

To use the Perpendicular snap mode:
1. In the Add group of the Add tab, click the required icon:

l Line — to create a node of a line/curve.
l Area— to create a node of an enclosed area.

2. In the Snap group of the Add tab, click the Snap Mode icon.

The Snap Mode panel is displayed.
3. Click the Circle Quadrants snap mode icon.
4. In the Map View, click the line/curve to which the new segment will be perpendicular.
5. In the Map View, click the end point of the new segment.

The new perpendicular segment is created.

Circle Quadrants snapmode

Creates a point or a line/area node at the circle quadrant.

To use the Circle Quadrants snap mode:
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1. In the Add group of the Add tab, click the required icon:
l Point— to create a single point.
l Line — to create a node of a line/curve.
l Area— to create a node of an enclosed area.

2. In the Snap group of the Add tab, click the Snap Mode icon.

The Snap Mode panel is displayed.
3. Click the Circle Quadrants snap mode icon.
4. In the Map View, click the required curve.

The new point is created at the quadrant, nearest to the click point.

Select tab
The Select tab of the MAGNET Tools ribbon contains one group of nine icons. It is described in the following sec-
tion — "Select group" section below.

Select group
The Selectgroup from the Select tab of the MAGNET Tools ribbon allows you to perform operations with object
selections. It contains nine icons:

Select All icon

Click it to select all objects in the map/observation view.

Select None icon

Click it to remove selection from all objects in the map/observation
view.

Invert Selection icon

Click it to invert the selection in the map/observation view.

Select Points icon

Click it to select points in the map/observation view by a certain cri-
teria.

Select TS Occupations icon

Click it to select TS Occupations in the map/observation view by a
certain criteria.

Select GPS Occupations icon

Click it to select GPS Occupations in the map/observation view by a
certain criteria.

Select TS Obs icon

Click it to select TS Observations in the map/observation view by a
certain criteria.
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Select GPS Obs icon

Click it to select GPS Observations in the map/observation view by a
certain criteria.

Arrange tables by selection icon

Click it to arrange Tabular view by selection

Select All icon
The Select All icon of the Select tab allows you to select all active data of your job. Its shortcut is Ctrl+A.

Click the icon to select all active objects in the Map/Observation view.

Select None icon
The Select None icon of the Select tab allows you to deselect all currently selected objects.

TIP
Other way to cancel any selection is to do the left click outside of the selection area.

Invert Selection icon
The Invert Selection icon of the Select tab allows you to invert current selection.

Click the icon to deselect all currently selected objects, and select all other objects.

Select Points icon
The Select Points icon of the Select tab allows you to select points in the job by a certain criteria.

To select points:
1. In the Select group of the Select tab, click the Select Points icon.

The Select Points dialog is displayed.
2. Configure the selection criteria as you need. Fields are descried in the table below.
3. Click OK.

Fields of the Select Points dialog
Field Description

Name

Defines a name or a part of a point name for a selection criteria.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Name editbox contains the asterisk (*) character, selecting all
Points with names.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.
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Field Description

Note

Defines a note or a part of a point's note for a selection criteria.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Note editbox contains the asterisk (*) character, selecting all
Points with notes.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.

Code

Defines a code or a part of a point's code for a selection criteria.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Code editbox contains the asterisk (*) character, selecting all
Points with notes.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.

Layer

Defines a layer or a part of a layer's name for a selection criteria. All point
from the matching layer will be selected.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Layer editbox contains the asterisk (*) character, selecting
points from all layers.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.

Source

Defines the raw data file's path from which these points were imported as the
search criteria.

Select a path from the list box or set a name or a part of a name with the aster-
isk (*) or question mark (?) wildcards.You can select a group of objects, using
comma as a separator, another way to select the group of objects to set a range
in ascending order, using minus as a separator. All objects inside this range
will be selected.
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Field Description

Std Dev Hori-
zontal

Selects points according to the standard deviation of a point's adjusted hori-
zontal coordinate .Select one of the three modes: Less than, Greater than, or
Do not use. Specify the deviation value in the editbox on the right.

Std Dev Vertical
Selects points according the standard deviation of a point's adjusted vertical
coordinate. Select one of the three modes: Less than, Greater than, or Do not
use. Specify the deviation value in the editbox on the right

Point Type Defines the type of the points as the selecting criteria.

Enabled for adjust-
ment

Selects points according to three modes: Enabled for adjustment, Disabled for
adjustment, Do not use.

Clear current
selection Tick to perform the selection only within points that are currently selected.

Select TS Occupations icon
The Select TS Occuaptions icon of the Select tab allows you to activate the Select TS Occupations dialog.

To select TS occupations:
1. In the Select group of the Select tab, click the Select TS Occupations icon.

The Select TS Occupations dialog is displayed.
2. Configure the selection parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Select TS Occupations dialog
Field Description

Point Name

Defines a name or a part of a point name for a selection criteria.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Name editbox contains the asterisk (*) character, selecting all
occupations with names.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.

Source

Selects Occupations according to the raw data file's path from which these
occupations were imported.

Sets a name or a part of a name with the asterisk (*) or question mark (?) wild-
cards. You can select a group of objects, using comma as a separator, another
way to select the group of objects to set a range in ascending order, using
minus as a separator. All objects inside this range will be selected.
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Field Description

Instrument Height
Selects points according to the instrument height above the station. Select one
of the four modes: Less than, Greater than, Equal to, or Do not use.Set the
Instrument height value in the editbox on the right.

Related Point Check to select TS occupations together with related points.

Related Obs Check to select TS occupations together with related observations.

Clear current
selection Tick to clear the previous selection.

Select GPS Occupations icon
The Select GPS Occupations icon of the Select tab allows you to activate the Select GPS Occupations dialog.

To select TS occupations:
1. In the Select group of the Select tab, click the Select GPS Occupations icon.

The Select GPS Occupations dialog is displayed.
2. Configure the selection parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Select GPS Occupations dialog
Field Description

Point Name

Defines a name or a part of a point name for a selection criteria.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Name editbox contains the asterisk (*) character, selecting all
occupations with names.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.

Original Name

Selects GPS occupations according to initial names of the occupations as indic-
ated in the source file.

You can use the asterisk (*) or question mark (?) wildcards.These wildcards
represent one or more real characters when selecting a point or points, and are
used instead of one or more unknown characters, any characters in a name, or
to select a group of points. You can use the asterisk as a substitute for zero or
more characters.

By default, the Original Name editbox contains the asterisk (*) character,
selecting all occupations with names.

You can select a group of objects, by using comma as a separator, another way
to select the group of objects to set a range in ascending order, using minus
sign as a separator. All objects inside this range will be selected.
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Field Description

Point Code

Selects GPS occupations according to the Point Code.

Sets a name or a part of a name with the asterisk (*) or question mark (?) wild-
cards. You can selec ta group of objects, using comma as a separator, another
way to select the group of objects to set a rangein ascending order, using minus
as a separator. All objects inside this range will be selected.

Source

Selects Occupations according to the raw data file's path from which these
occupations were imported.

Sets a name or a part of a name with the asterisk (*) or question mark (?) wild-
cards. You can select a group of objects, using comma as a separator, another
way to select the group of objects to set a range in ascending order, using
minus as a separator. All objects inside this range will be selected.
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Field Description

Method

Selects GPS occupations according to the surveying method.

Choose the appropriate method from the list:
l Base — occupations obtained on the base station.
l Topo— Topo occupations are static phase measurements created in
TopSurv and exported from the TopSurv Job. The measurements in
TopSurv are collected during some time and after that they are aver-
aged.

l Auto Topo— AutoTopo Occuptions are kinematic phase measurements
created in TopSurv and exported from the TopSurv Job. AutoTopo Points
are points corresponding to the AutoTopo Occupation. It is possible in to
view these points and to recalculate them from the Base Station (not to
process).

l Autonomous— coordinates of such point are calculated in the Stan-
dalone mode (i.e. using code measurements from own receiver only).
When the coordinates of the point were calculated the code and phase
corrections had not been used.

l CodeDiff— Topo andAuto Topo code measurements;
l DGPS VBS— submeter positioning obtained by OmniStar Virtual Base
Station technology providing users with accurate positioning with a cor-
rection message further enhanced for their location.This multiply ref-
erence station solution can provide accuracy to within one meter;

l DGPS HP— decimeter positioning HP (High Performance) obtained by
the OmniStar's HP solution is a dual frequency GPS augmentation ser-
vice that provides robust and reliable high performance GPS positioning
of unmatched accuracy (decimeter level);

l Static — occupations obtained by the static method of relative
(baselines) measurements, when by means of phase method during the
long-duration session (near one hour or longer) the delta of coordinate
(vector) between base station and rover station is defined.

l Stop— the static occupation in the Stop and Go session;
l Kinematic — the type of measurements made when rover is moving.
The motion trajectory is obtained during these measurements.

l Go— the kinematic occupation in the Stop and Go session.

Antenna Height
Selects GPS Occupations according to the antenna height. Select one of the
four modes: Less than, Greater than, Equal to, or Do not use. Specify the
antenna height value in the editbox on the right.

Start Time
Selects GPS occupations according to the Start time (date and time). Select
one of the four modes: Less than, Greater than, Equal to, or Do not use. Spe-
cify the time and date in the fields on the right.

End Time
Selects GPS occupations according to the End time (date and time). Select one
of the four modes: Less than, Greater than, Equal to, or Do not use. Specify the
time and date in the fields on the right.
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Field Description

Duration
Selects GPS occupations according to the duration. Select one of the four
modes: Less than, Greater than, Equal to, or Do not use. Set an absolute value
for the Duration in the editboxes on the right.

Related Point Tick to select GPS occupations together with related points.

Related Obs Tick to select GPS occupations together with related observations.

Clear current
Selection Tick to clear the previous selection.

Select TS Obs icon
The Select TS Obs icon of the Select tab allows you to activate the Select TS Observations dialog.

To select TS observations:
1. In the Select group of the Select tab, click the Select TS Obs icon.

The Select TS Obs dialog is displayed.
2. Configure the selection parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Select TS Obs dialog
Field Description

From Point

Selects TS observations according to Point From names.

Set a name or a part of a name using the asterisk (*) or question mark (?) wild-
cards.These wildcards represent one or more real characters when selecting a
point or points, and are used in place of one or more unknown characters,any
characters in a name, or to select a group of points. You can use the asterisk as
a substitute for zero or more characters.Initially, the Name field contains the
asterisk (*) character, selecting all observations with names. You can select a
group of objects, using comma as a separator, another way to select the group
of objects to set a range in ascending order, using minus as a separator. All
objects inside this range will be selected.

To Point

Selects TS observations according to Point To names.

Set a name or a part of a name using the asterisk (*) or question mark (?) wild-
cards.These wildcards represent one or more real characters when selecting a
point or points, and are used in place of one or more unknown characters,any
characters in a name, or to select a group of points. You can use the asterisk as
a substitute for zero or more characters.Initially, the Name field contains the
asterisk (*) character, selecting all observations with names. You can select a
group of objects, using comma as a separator, another way to select the group
of objects to set a range in ascending order, using minus as a separator. All
objects inside this range will be selected.
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Field Description

Source

Selects Occupations according to the raw data file's path from which these
occupations were imported.

Sets a name or a part of a name with the asterisk (*) or question mark (?) wild-
cards. You can select a group of objects, using comma as a separator, another
way to select the group of objects to set a range in ascending order, using
minus as a separator. All objects inside this range will be selected.

Enabled Selects points if they are set as Enabled in the Properties dialog for TS occu-
pation. Select one of the three modes: Enabled, Disabled, Do not use.

Hz residuals
Selects TS observations according to the Horizontal residuals. Select one of
the three modes for the horizontal residual: Less than, Greater than, or Do not
use. Specify the horizontal residual value in the editbox on the right.

V residuals
Selects TS observations according to the Vertical residuals. Select one of the
three modes: Less than, Greater than, or Do not use. Specify the vertical resid-
ual value in the editbox on the right.

Reflector Height
Selects TS observations according to the reflector height above the point being
observed. Select one of the three modes: Less than, Greater than, or Do not
use. Specify the reflector height value in the editbox on the right.

Hz angle
Selects TS observations according to the horizontal angle. Select one of the
three modes: Less than, Greater than, or Do not use. Specify the horizontal
angle value in the editbox on the right.

V angle
Selects TS observations according to the vertical angle. Select one of the three
modes: Less than, Greater than, or Do not use. Specify the vertical angle value
in the editbox on the right.

Z angle
Select TS observations according to the Zenith angle. Sets one of the three
modes: Less than, Greater than, or Do not use. Specify the Zenith angle value
in the editbox on the right.

Hz dist
Selects TS observations according to the horizontal distance. Select one of the
three modes: Less than, Greater than, or Do not use. Specify the horizontal dis-
tance value in the editbox on the right.

V dist
Selects TS observations according to the vertical distance. Select one of the
three modes: Less than, Greater than, or Do not use. Specify the vertical dis-
tance value in the editbox on the right.

Slope Dist
Selects TS observations according to the Slope distance. Select one of the
three modes: Less than, Greater than, or Do not use. Specify the slope distance
value in the editbox on the right.

Related Point Tick it to select TS observations together with related points.

Clear current
selection Tick it to clear the previous selection.

Select GPS Obs icon
The Select GPS Obs icon of the Select tab allows you to activate the Select GPS Obs dialog.

To select GPS observations:
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1. In the Select group of the Select tab, click the Select GPS Obs icon.

The Select GPS Obs dialog is displayed.
2. Configure the selection parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Select GPS Obs dialog
Field Description

From Point

Selects GPS observations according to Point From names.

Set a name or a part of a name using the asterisk (*) or question mark (?) wild-
cards.These wildcards represent one or more real characters when selecting a
point or points, and are used in place of one or more unknown characters,any
characters in a name, or to select a group of points. You can use the asterisk as
a substitute for zero or more characters.Initially, the Name field contains the
asterisk (*) character, selecting all observations with names. You can select a
group of objects, using comma as a separator, another way to select the group
of objects to set a range in ascending order, using minus as a separator. All
objects inside this range will be selected.

To Point

Selects GPS observations according to Point To names.

Set a name or a part of a name using the asterisk (*) or question mark (?) wild-
cards.These wildcards represent one or more real characters when selecting a
point or points, and are used in place of one or more unknown characters,any
characters in a name, or to select a group of points. You can use the asterisk as
a substitute for zero or more characters.Initially, the Name field contains the
asterisk (*) character, selecting all observations with names. You can select a
group of objects, using comma as a separator, another way to select the group
of objects to set a range in ascending order, using minus as a separator. All
objects inside this range will be selected.

Type Selects GPS observations according to the Observation type.Choose an appro-
priate type from the list.

Start Time
Select one of the three modes for the Start time: Less than, Greater than, or Do
not use. Set an absolute value for the Start time (time and date) in the field on
the right.

Duration

Selects GPS observations according to the duration. Select one of the three
modes for the duration: Less than, Greater than, or Do not use. Set an absolute
value for the duration (days, hours, minutes and seconds ) in the editboxes on
the right

Solution Type Selects GPS observations according to the Solution type. Choose an appro-
priate type from the list.

Hz precision
Selects GPS observations according to the horizontal precision. Select one of
the three modes: Less than, Greater than, or Do not use. Set an absolute value
of the horizontal precision in the editbox on the right.

V precision
Selects GPS observations according to the vertical precision. Select one of the
three modes: Less than, Greater than, or Do not use. Set an absolute value of
the vertical precision in the editbox on the right.
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Field Description

Hz residuals
Selects GPS observations according to the horizontal residual. Select one of
the three modes: Less than, Greater than, or Do not use. Set an absolute value
of the horizontal residual in the editbox on the right.

V residuals
Selects GPS observations according to the vertical residual. Select one of the
three modes: Less than, Greater than, or Do not use.Set an absolute value of
the vertical residual in the editbox on the right.

Length
Selects GPS observations according to the length. Select one of the three
modes: Less than, Greater than, or Do not use. Set an absolute value of the
length in the editbox on the right.

Enabled Selects points if they are set as Enabled in the Properties dialog for GPS obser-
vation. Select one of the three modes: Enabled, Disabled, or Do not use.

Slope Dist
Select one of the three modes for the slope distance: Less than, Greater than,
or Do not use.Set an absolute value for the slope distance in the editbox on the
right.

Clear current
selection Tick it to clear the previous selection.

Arrange tables by selection icon
The Arrange tables by selection icon icon of the Select tab allows you to arrange Tabular View by selection.

All tables will be sorted by selection. If currently activetable does not have any selection, the table with the
largest number of selected items will be activated.When this command is checked, selecting any data that is dis-
played in the Tabular View leads to thefollowing: all tables with changed selection will be sorted by selection, if
no selection was addedin the currently active table, the table with the largest number of newly selected lines will
be activated.

Process tab
The Process tab of the MAGNET Tools ribbon allows you to work with the data processing. It contains five
groups, described in the appropriate sections:

l "GPS group" section below
l "Adjustment group" section on the facing page
l "Coordinate systems group" section on page 74
l "Surfaces group" section on page 75
l "Properties group" section on page 75

GPS group
The GPS group from the Process tab of the MAGNET Tools ribbon allows you to run the post processing of all
enabled GPS observations of the job.The group contains one icon:

GPS+ Post Processing icon

Click it to to run the post processing of GPS observations.
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GPS+ Post Processing icon
The GPS+ Post Processing icon of the GPS group allows you to run the post processing of all enabled GPS obser-
vations of the job. After this procedure is finished, the Observation View will display green/red static processed
baselines.

NOTE
The post processing is not final procedure to obtain the coordinates of the network points from a control
points. We recommend using the adjustment procedure to obtain the final coordinates of the network
points with estimation errors.

Adjustment group
The Adjustment group from the Process tab of the MAGNET Tools ribbon allows you to perform:

l adjustment of GPS, TS and DL observations with obtaining estimating accuracy for each point of the net-
work,

l compute coordinates of the network point from base coordinates,
l loop closure test for GPS observations which form enclosed figures.

It contains three icons:

Adjustment icon

Click it to perform the adjustment of the TS/GPS/DL observations.

Compute Coordinates icon

Click it to recalculate the network point coordinates.

Loop Closures icon

Click it to perform loop closures test for the post-processed GPS obser-
vations that form a closed loop

Adjustment icon
The Adjustment icon of the Adjustment group allows you to perform the adjustment of the TS observations, GPS
observations, and DL observations, either together or separately and either constrained or free. The Least Squares
method of adjustment by default is used for adjustment any network. Also for TS networks, you can select tra-
verse adjustment by Compass Rule or traverse unadjusted closure techniques by clicking on the arrow under the
icon:

See "Performing Adjustment" section on page 355 for more details.
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Compute Coordinates icon
The Compute Coordinates icon of the Adjustment group allows you to recalculate the network point coordinates
from the original base coordinates without any estimate of accuracy. If the network has duplicate measurements,
only one measurement will be used in compute coordinates.

Loop Closures icon
The Loop Closures icon of the Adjustment group allows you to perform loop closures test for the post-processed
GPS observations that form a closed loop.

After clicking the icon, the Loop Closures dialog is displayed. Select all desired GPS observations of the network
that form closed figures and click Finish. The Loop Closures report is shown. The report contains the residuals in
the horizontal and vertical planes which are calculated for each closed loop of the network. If a residual value for
a figure is more than a threshold value (horizontal tolerance and vertical tolerance) , the residual is highlighted in
red in the report. You can edit the threshold value at the Loop Closure Precisions tab of Quality Control item from
the Job configuration dialog. See "Loop Closure Precisions tab" section on page 118 for details.

Coordinate systems group
The Coordinate systems group from the Process tab of the MAGNET Tools ribbon allows you to perform cal-
culation of transformation parameters between any datum or any grid and ground coordinate systems or determine
an unknown datum parameters with respect to the WGS84 datum. The group contains three icons:

Localization icon

Click it to calculate transformation between any datum/grid and ground
coordinate systems.

Datum Transformation icon

Click to perform a datum transformation with respect to the WGS84
datum.

Geoids icon

Click it to manage geoids.

Localization icon
The Localization icon of the Coordinate systems group allows you to calculate transformation parameters
between any datum or any grid and ground coordinate systems to determine the point coordinates in the
given coordinate system. After clicking the icon, the Localization dialog is displayed. Click Add Point to select a
localization points which will use in localization. To start the localization click Compute Parameters.

See "Performing Localization" section on page 368 for more details.

Datum Transformation icon
The Datum Transformation icon of the Coordinate systems group allows allows you to:

l determine an unknown datum parameters with respect to the WGS84 datum,
l redefine the parameters of the existing datum with respect to the WGS84 for a local area.
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After clicking the icon, the Datum Transformation dialog is displayed. Click Add Point to select a points which
will use in datum transformation. To start this transformation click Compute Parameters.

See "Performing Datum Transformation" section on page 376 for more details.

Geoids icon
The Geoids icon of the Coordinate systems group allows you to:

Click it to open the Geoids List dilaog, where you can:
l view downloaded geoids in the current job,
l add a geoid to the list. See "Adding geoid to the job" section on page 335 for details.
l convert a selected geoid to the Topcon Geoid (*.gff) file format, by clicking Export.
l remove the selected geoid from the list, by clicking Remove.

See "Geoid List dialog" section on page 335 for details.

Surfaces group
The Surfaces group from the Process tab of the MAGNET Tools ribbon allows you to update a surface if a
change of the surface is made. The group contains one icon:

Update Surface(s) icon

Click to update surfaces in the current job.

Update Surface(s) icon
The Update Surface(s) icon of the Surfaces group allows you to update a surface. The icon is available when:

l a change of the surface is made
l the Auto Update checkbox is not ticked in the Properties dialog for surfaces.

Properties group
The Properties group from the Process tab of the MAGNET Tools ribbon allows you to select the adjustment
parameters, parameters for calculating TS point coordinates from TS raw data, parameters for post-processing
GPS observations.  The group contains one icon:

Process Properties icon

Click it to configure the processing properties.

Process Properties icon
The Process Properties icon of the Properties group allows you to open the Process Properties dialog, where
you can select:

l the adjustment parameters for Least Squares adjustment type. See "Adjustment item" section on page 100
for details.

l a method of traverse adjustment in the Total Station network and parameters for calculating TS point
coordinates from TS raw data. See "TS Computations item" section on page 104 for details.
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l parameters for post-processing GPS observations. See "GPS+ PostProcess item" section on page 105 for
details.

Report tab
The Report tab of the MAGNET Tools ribbon allows you to get the job information. It contains one group. See
Report group for details.

Report group
The Report group from the Report tab of the MAGNET Tools ribbon allows you to open the Report Configuration
dialog and execute any type's report from the list. The group contains two icons:

Report Configuration icon

Click it to configure a report.

Execute Report icon

Click it to execute a report.

Report Configuration icon
The Report Configuration icon of the Report group allows you to configure a report.

After clicking the icon, the Report Configuration dialog is displayed. In the window you can create your own type
of report to include or exclude certain information from already generated reports

See "Creating custom report" section on page 340 for details.

Execute Report icon
The Execute Report icon of the Report group allows you to execute a report.

By clicking on the arrow under the icon you can see the list of the available reports. This list does not contain the
reports created by the New Adj report button. You can start the executing of any type's report from the list.

Calculate tab
The Calculate tab of the MAGNET Tools ribbon contains one group of four icons. It is described in the following
section — Calculate group.

Calculate group
The Calculate group from the Calculate tab of the MAGNET Tools ribbon allows you to calculate the coordinate
geometry. The group contains four icons:

Inverse icon

Click it to calculate the distance and azimuth between any two points of
the job.



Inverse icon

77

Compare Surfaces icon

Click it to compute difference between existing surfaces.

Translate Points icon

Click it to translate a selection of points from one position to another.

Rotate Points icon

Click it to rotate a selection of points around specified point.

Inverse icon
The Inverse icon of the Calculate group allows you to calculate the distance and azimuth between any two points
of the job.

You may calculate these parameters between:
l any two points,
l a point and a set of points (if the points have names)
l the start and end points of a selected line’s segment or a horizontal alignment of a road

To calculate the distance and azimuth between points:
1. In the COGO group of the Report tab, click the Inverse icon.

The Inverse panel is displayed. By default it is located above the Map/Observation view.
2. In the From and To editboxes, specify the points for the Inverse. There are three ways to specify a point in

the editbox:
l Enter the point name or enter point coordinates using format {123.456,322.778} for the Grid and/or
Ground coordinate system and {11 12 14.555N, 07 08 09.444E} for the Datum coordinate system:

l Selecting the point from a list which will appear after entering the first common letter or digit of the
point name.

l Using the drug-and-drop technique the select points or/and segment of line or/and alignment of road
in the Tabular and/or Map/CAD View.

You can specify either a single point or multiple points. To select multiple points, do one of the fol-
lowing:

l Use a comma as the delimiter. For example: A,A2,A3,A4.
l Use a semicolon as the delimiter. For example: A;A2;A3;A4.
l Use a range of point names. For example: A-A4.

NOTE
If you specifymultiple points, the software will calculate the inverse task for all point com-
binations.

3. Click Calculate.

Calculated values are displayed at the Inverse tab from the Tabular view.
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Compare Surfaces icon
The Compare Surfaces icon of the Calculate group allows you to compute one of the following:

l difference between the volumes of two surfaces;
l difference between the volumes of a road and a surface;
l the volume of a surface/road relative to the horizontal plane of the defined level.

To compare surfaces:
1. In the GOGO group of the Report tab, click the Compare Surfaces icon.

The Compare Surfaces panel is displayed.
2. From the Design drop-down list, select the first surface or road for comparison.
3. Do one of the following:

l Select a surface for comparison. To do so:
1. From the Existing drop-down list, select Surface.
2. From the adjacent drop-down list, select the required surface.

l Define a horizontal plane for comparison. To do so:
1. From the Existing drop-down list, select Level.
2. In the adjacent editbox, type the required level of the plane.

4. If needed, tick the Save as Surface checkbox, to save the result as an independent surface.
5. Click Calculate.

If you have selected a road in the step 2, MAGNET Tools automatically converts road to surface and dis-
plays theConvert road to surface dialog. You need to define the interval between the points in that surface.
To do so:

1. In the Interval editbox, specify the required interval.
2. Click OK.

The Compare Surface tab from the tabular view displays the result of comparing. Fields are described in
the table below.

Fields of the Compare Surfaces tab
Field Description

Design Displays the name of the first surface/road from comparison.

Existing Displays the name of the second surface from comparison.

Level Displays the level of the horizontal pane from comparison.

Cut

If two surfaces were compared — displays the cut volume to correct the exist-
ing surface to the design surface. See Comparing two surfaces picture below.

If a surface and a level were compared — displays the cut volume to correct
the design surface to the specified level. See Comparing surfaces and a level
picture below.

Fill

If two surfaces were compared — displays the fill volume to correct the exist-
ing surface to the design surface. See Comparing two surfaces picture below.

If a surface and a level were compared — displays the fill volume to correct
the design surface to the specified level. See Comparing a surface and a level
picture below.
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Field Description

Area Displays the common area of two surfaces or a surface and a horizontal pane.

Note Defines any additional notes about comparison.

Save as Surface Tick to save the result of comparison as a new surface.

Comparing two surfaces
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Comparing a surface and a level

Translate Points icon
The Translate Points icon of the Calculate group allows you to translate a selection of points from one position to
another. You may define the data translation in one of the following ways:

l specifying the offset of translation in the current coordinate system;
l specifying defining origin and destination point of translation;
l specifying bearing and distance of translation.

To translate points by translation offset:
1. In the COGO group of the COGO tab, click the Translate Points icon.

The Translate Points panel is displayed.
2. In the Offset group box, specify the translation offset for each coordinate in the appropriate editboxes.
3. In the Treat result group box, define the treatment of the result points, by selecting the appropriate radi-

obutton:
l Overwrite existing points— to delete the original points, and use their names for points at the new
position.

l Rename existing points— to keep the original points on their positions, and create new points with
prefix or/and suffix added to the original name. In that case, specify the required prefix/suffix in the
Prefix or Suffix editboxes respectively.

4. In the either Map view, or Observation view, or in the Points tab of the tabular view, select the points for
translation.
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5. Click Translate.

The points are translated.

To translate points by original and destination points:
1. In the COGO group of the COGO tab, click the Translate Points icon.

The Translate Points panel is displayed.
2. In the Original Point group box, specify the original point. Do one of the following:

l In the Name editbox, type the name of the job's point. The rest of the group box's fields are displayed
the coordinates of the selected point in the current coordinate system.

l Drag the required point to the Name editbox from either Map view, or Observation view, or from the
Points tab of the tabular view. The rest of the group box's fields are displayed the coordinates of the
selected point in the current coordinate system.

l In the appropriate editboxes, type the required coordinates in the current coordinate system.
3. In the Destination Point group box, specify the destination point in a same way.

The fields of the Offset group box display the coordinate offsets of the translation.

The fields of the Define by distance/angle group box display the bearing and distance of the translation.
4. In the Treat result group box, define the treatment of the result points, by selecting the appropriate radi-

obutton:
l Overwrite existing points— to delete the original points, and use their names for points at the new
position.

l Rename existing points— to keep the original points on their positions, and create new points with
prefix or/and suffix added to the original name. In that case, specify the required prefix/suffix in the
Prefix or Suffix editboxes respectively.

5. In the either Map view, or Observation view, or in the Points tab of the tabular view, select the points for
translation.

The points are translated.

To translate points by bearing and distance:
1. In the COGO group of the COGO tab, click the Translate Points icon.

The Translate Points panel is displayed.
2. In the Define by distance/angle group box, specify the azimuth and distance of the translation in the appro-

priate editboxes.

The fields of the Offset group box display the coordinate offsets of the translation.
3. In the Treat result group box, define the treatment of the result points, by selecting the appropriate radi-

obutton:
l Overwrite existing points— to delete the original points, and use their names for points at the new
position.

l Rename existing points— to keep the original points on their positions, and create new points with
prefix or/and suffix added to the original name. In that case, specify the required prefix/suffix in the
Prefix or Suffix editboxes respectively.

4. In the either Map view, or Observation view, or in the Points tab of the tabular view, select the points for
translation.

5. Click Translate.

The points are translated.
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Fields of the Translate Points panel
Field Description

Offset Defines the offset of each coordinate in the current coordinate system.

Original Point Defines the origin point of translation by its name or coordinates in current
coordinate system.

Destination Point Defines the destination point of translation by its name or coordinates in cur-
rent coordinate system.

Define by dis-
tance/angle Defines the bearing and distance of translation.

Treat result

Defines the treatment of the result points. You may choose one of the fol-
lowing options:

l Overwrite existing points— deletes the original points, and uses their
names for points at the new position.

l Rename existing points— keeps the original points on their positions,
and creates new points with prefix or/and suffix added to the original
name. In that case, specify the required prefix/suffix in the appropriate
editboxes.

Rotate Points icon
The Rotate Points icon of the Calculate group allows you to rotate a selection of points around a reference point.
See picture below for details.

Points rotation

You may straightly specify the rotation angle or define it as an angle between reference and the destination bear-
ings.

To rotate points by specifying the rotation angle:
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1. In the COGO group of the COGO tab, click the Rotate Points icon.

The Rotate Points panel is displayed.
2. In the Rotation Point group box, specify the rotation point. Do one of the following:

l In the Point Name editbox, type the name of the job's point.
l Drag the required point to the Point Name editbox from either Map view, or Observation view, or
from the Points tab of the tabular view.

3. In the Angle editbox, from the Rotation angle group box, specify the rotation angle. Positive direction is
clockwise.

4. In the Treat result group box, define the treatment of the result points, by selecting one of the following radi-
obuttons:

l Overwrite existing points— to delete the original points, and use their names for points at the new
position.

l Rename existing points— to keep the original points on their positions, and create new points with
prefix or/and suffix added to the original name. In that case, specify the required prefix/suffix in the
Prefix or Suffix editboxes respectively.

5. In the either Map view, or Observation view, or in the Points tab of the tabular view, select the points for
rotation.

6. Click Rotate.

The points are rotated.

To rotate points by specifying original and destination bearings:
1. In the COGO group of the COGO tab, click the Rotate Points icon.

The Rotate Points panel is displayed.
2. In the Rotation Point group box, specify the rotation point. Do one of the following:

l In the Point Name editbox, type the name of the job's point.
l Drag the required point to the Point Name editbox from either Map view, or Observation view, or
from the Points tab of the tabular view. The rest of the group box's fields are displayed the coordin-
ates of the selected point in the current coordinate system.

l In the appropriate editboxes, type the required coordinates in the current coordinate system.
3. In the Original azimuth/bearing group box, specify the original bearing. Do one of the following:

l In the Azimuth editbox, specify the required original bearing.
l Specify the "from" and "to" points in the appropriate editboxes in one of the following ways:

l Type the name of the point.
l Drag the required point to the editbox from either Map view, or Observation view, or from the
Points tab of the tabular view.

4. In the Destination azimuth/bearing group box, specify the destination bearing in the same way.

The rotation angle is calculated as the difference between the original and destination bearings its value is
displayed in the Rotation angle group box.

5. In the Treat result group box, define the treatment of the result points, by selecting one of the following radi-
obuttons:

l Overwrite existing points— to delete the original points, and use their names for points at the new
position.

l Rename existing points— to keep the original points on their positions, and create new points with
prefix or/and suffix added to the original name. In that case, specify the required prefix/suffix in the
Prefix or Suffix editboxes respectively.
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6. In the either Map view, or Observation view, or in the Points tab of the tabular view, select the points for
rotation.

7. Click Rotate.

The points are rotated

Enterprise tab
The Enterprise tab of the MAGNET Tools ribbon contains control icons for using MAGNET Enterprise service.
It contains three groups, described in the appropriate sections:

l "Common group" section below
l "Files group" section on the facing page
l "Realtime group" section on page 87
l "Tasks group" section on page 87
l "Redlines group" section on page 88

Common group
The Common group from the Enterprise tab of the MAGNET Tools ribbon allows you to connect with the Enter-
prise server, send a text message to a user or a group of users of your company, create a Project, and edit your
account (e-mail and password) and options of connection with the Enterprise server. The group contains four
icons:

Logon icon

Click it to connect to the Enterprise server.

Chat icon

Click it to chat with your colleagues.

Connect to Project icon

Click it to connect to the project at the Enterprise server.

Options icon

Click it to configure the connection options.

Logon icon
The Logon icon of the Common group allows you to connect to the MAGNET Enterprise server.

After clicking the icon, the Logon dialog is displayed. In this window you can connect with the Enterprise server.
To do it, you need enter login (e-mail) and password provided by the Enterprise administrator of your company or
by dealer.
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Chat icon
The Chat icon of the Common group allows you to communicate via the text messages with the MAGNET users
in your company.

After clicking the icon, the Chatdialog is displayed. In this window you can send a text message to a user or a
group of users of your company. Also you can receive a text message from any user of the company.

Connect to Project icon
The Connect to Project icon of the Common group allows you to upload/download data of your project to the
Enterprise server.

After clicking the icon, the Project window is displayed. In this window you can create a Project on the Enterprise
service. Only after creating a project you can upload / download data to the project. You can create unlimited num-
ber of projects. To create a project, enter a name in the New project field and click the Create button.

Options icon
The Options icon of the Common group allows you to edit your account (e-mail and password) and options of con-
nection to the Enterprise server.

After clicking the icon, the Options dialog is displayed. In this window you can edit your account (e-mail and pass-
word) and options of connection with the Enterprise server.

Files group
The Files group from the Enterprise tab of the MAGNET Tools ribbon allows you to upload selected files to the
server, and download a file from the server to the computer. The group contains three icons:

Upload files icon

Click it to upload files to the Enterprise server.

Download files icon

Click it to download files from the Enterprise server.

Upload current job icon

Click it to upload current job to the Enterprise server.

Upload current job as .MJF icon

Click it to upload current job to the Enterprise server as the
MAGNET Field job.

Upload current job as .TP3 icon

Click it to upload current job to the Enterprise server as the Topcon
3DMC project.

Upload files icon
The Upload files icon of the Files group allows you to upload your files to the Enterprise server.
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After clicking the icon, the Upload files dialog is displayed. In the dialog you can upload selected files to the
server. In the left panel of the window you can select the desired files. In the right panel check the folder where
you want to store the files. Click Upload to start uploading selected files to the selected Inboxes. The Progress
dialog displays the uploading to the server in progress.

Download files icon
The Download files icon of the Files group allows you to download files from the Enterprise server.

After clicking the icon, the Download files dialog is displayed. In the dialog you can download a file from the
server to the computer. In the left panel of the dialog you can select the corresponding Inbox. The right panel of
the dialog displays the files located in the Inbox.

Upload current job icon
The Upload current job icon of the Files group allows you to upload current job to the Enterprise server.

To upload a job to the Enterprise server:
1. In the Files group of the Enterprise tab, click the Upload current job as .MJF icon.

The Upload Current Job dialog is displayed.
2. In the Recipients list, tick the required inboxes where you want to store the files.
3. Click Upload.

The Progress dialog displays the progress of uploading.

Upload current job as .MJF icon
The Upload current job as .MJF icon of the Files group allows you to upload current job to the Enterprise server
as the MAGNET Field job (*.mjf) file.

To upload a job to the Enterprise server:
1. In the Files group of the Enterprise tab, click the Upload current job as .MJF icon.

The Upload Current Job dialog is displayed.
2. In the Recipients list, tick the required inboxes where you want to store the files.
3. Click Upload.

The Progress dialog displays the progress of uploading.

Upload current job as .TP3 icon
The Upload current job as .TP3 icon of the Files group allows you to upload current job to the Enterprise server
as the Topcon 3DMC project (*.tp3) file.

To upload a job to the Enterprise server:
1. In the Files group of the Enterprise tab, click the Upload current job as .TP3 icon.

The Upload Current Job dialog is displayed.
2. In the Recipients list, tick the required inboxes where you want to store the files.
3. Click Upload.

The Progress dialog displays the progress of uploading.
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Realtime group
The Realtime group from the Enterprise tab of the MAGNET Tools ribbon allows you to automatically receive
the coordinates of measured or added points from MAGNET Field in real time. The group contains one icon:

Real Time icon

Click it to get coordinates from the MAGNET Field in real-time.

Real Time icon
The Real Time icon of the Realtime group allows you to automatically receive the coordinates of measured or
added points from MAGNET Field in real time.

After clicking the icon, the Real time dilaog is displayed. In the window you can automatically receive the
coordinates (not raw data and observations) of measured or added points from MAGNET Field in real time. The
measured/added points will automatically send from the MAGNET Field to the MAGNET Enterprise and then
send to the current job of the application. The Points tab displays the points.

Tasks group
The Tasks group from the Enterprise tab of the MAGNET Tools ribbon allows you to use the working time track-
ing feature of MAGNET Enterprise. The group contains two icons:

Tasks icon

Click it to view Enterprise tasks.

Timecards icon

Click it to submit a timesheet card.

Tasks icon
The Tasks icon of the Tasks group allows you to view the tasks for Enterprise project.

After clicking the icon the Tasks dialog is displayed. To view tasks, from the Project drop-down list, select the
required project and click Connect. Tasks from the project will be displayed in the table from Tasks group box.
For each task its name, start date, end date, and completed percentage are displayed.

Timecards icon
The Timecards icon of the Tasks group allows you to track the time spent for tasks from an Enterprise project.

To submit a timesheet:
1. In the Tasks group of the Enterprise tab, click the Timecards icon.

The Timecards dialog is displayed.
2. From the Project drop-down list, select the required project and click Connect.

Tasks are displayed in the table from the Tasks group box.
3. Select the required week, using the Prev and Next buttons.



Ribbon Icon Functions

88

NOTE
To return to the current week, click Current.

4. Select the required task and specify daily working hours spent for it.
5. Click Submit.

NOTES
If you specify only working hours, the Completed percentage will be calculated by Enterprise service
after submitting timecard. If you specify the Completed percentagemanually, Enterprise will set this
value for task and automatic calculations for this taskwill stop.

The task has a completed status, when completion percentage reaches 100%. You can submit working
hours for completed task.

Redlines group
Redlines are small sketches generated by a manager to communicate with field engineers and to use in processing
data in MAGNET Tools. They are stored in projects at the Enterprise server, and may only be displayed in the
Map View, when connected to the Enterprise project.

To display redlines connect to the Enterprise project. All existing redlines will be displayed in Map View. auto-
matically. You may switch them on/off, by ticking the required checkboxes in the drop-down list in the Redlines
group.

Help tab
The Help tab of the MAGNET Tools ribbon contains control icons, which allows you to display help and licenses
information. It contains four groups, described in the appropriate sections:

l "Help group" section below
l "Feedback group" section on the facing page
l "Information group" section on the facing page
l "Licensing and Version group" section on page 90

Help group
The Help group from the Help tab of the MAGNET Tools ribbon allows you to update a cursor function to get
help for any tab/window/field/icon of MAGNET Tools and open MAGNET Tools help. The group contains two
icons:

Context Help icon

Click it to call for a context help.

Help Topics icon

Click it to open the MAGNET Tools help.

Context Help icon
The Context Help icon of the Help group allows you to get help for any tab/window/field/icon /view of
MAGNET Tools.
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After clicking the icon, the cursor changes. Navigate the cursor on any objects and right click to open the cor-
responding help topic.

Help Topics icon
The Help Topics icon of the Help group allows you to open MAGNET Tools help.

Feedback group
The Feedback group from the Help tab of the MAGNET Tools ribbon allows you to send an e-mail with attached
log files and an e-mail with question to Topcon Technical Support.

Send Bug Report icon

Click it to send an email with attached log files to Topcon Technical Sup-
port.

Question to Support icon

Click it to send a technical question to Topcon Technical Support.

Send Bug Report icon
The Send Bug Report icon of the Feedback group allows you to send an email with attached log files to Topcon
Technical Support.

After clicking the icon, an email opens with short descriptions of the current version of MAGNET Tools, activ-
ated modules and OS of the computer, and log files for the job are automatically attached. You can add a descrip-
tion of your activities being performed when an issue occurred and send to Topcon Technical Support.

Question to Support icon
The Question to Support icon of the Feedback group allows you to send a technical question to Topcon Tech-
nical Support.

After clicking the icon, an email opens with short descriptions of the current version of MAGNET Tools, activ-
ated modules and OS of the computer. You can write a question, describing activities in detail, and send the email
to Topcon Technical Support.

Information group
The Information group from the Help tab of the MAGNET Tools ribbon allows you to browse one of the folders
where program data is located in Windows Explorer. The group contains one icon:

Browse Folder icon

Click it to open project related folders in Windows explorer.

Browse Folder icon
The Browse Folder icon of the Information group allows you to browse one of the folders from the following list:



Ribbon Icon Functions

90

l User folder. This folder contains user text format, user datum, user projection, user antenna parameters,
user device (for TS and DL instrument), user job configuration, user class for TS.

l Temp folder.
l Application folder. This folder contains MAGNET Tools program files.
l Current job folder. This folder contains MAGNET Tools jobs.

Licensing and Version group
The Licensing and Version group from the Help tab of the MAGNET Tools ribbon allows you to receive inform-
ation about the program's activated modules and expiration date for each module, MAGNET Tools version, serial
number and device ID for which the serial number will work. The group contains two icons:

Check for Updates icon

Click it to check for available updates for MAGNET Tools.

Licenses icon

Click it to receive information about the program's activated modules and
expiration date for each module.

About MAGNET Tools icon

Click it to display application info.

Check for Updates icon
The Check for Updates icon of the Licensing and Version group allows you to check whether any updates are
available for your MAGNET Tools application.

Licenses icon
The Licenses icon of the Licensing and Version group allows you to receive information about the program's activ-
ated modules and expiration date for each module.

After clicking the icon, the Product Activation dialog opens. You can run the procedure of reactivation for any
module from the list. See "MAGNET Tools activation" section on page 21 for details.

About MAGNET Tools icon
The About MAGNET Tools icon of the Licensing and Version group allows you to receive information about
MAGNET Tools version, the program's activated modules, serial number and device ID for which the serial num-
ber will work.
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Job Configuration Dialog
The Job configuration dialog allows you to define application settings for data viewing, adjusting and analysis. To
open the dialog in the Information group of the Job tab, click the Job Configuration icon

The dialog contains two panels. The left panel lists items of the job configuration. The right panel displays para-
meters for the selected item. Configuration items are described in the appropriate sections:

l "Display item" section on the next page
l "Coordinate Systems item" section on page 95
l "Units item" section on page 98
l "Equipment item" section on page 98
l "Save item" section on page 99
l "Process item" section on page 99
l "Quality Control item" section on page 114

You can save any settings defined in any items in your configuration and then use this configuration in your further
jobs. To do so:

1. Make the required configurations.
2. Click Save configuration.

The Enter configuration name dialog is displayed.
3. In the Configuration name editbox, type the name for your set.
4. Click OK.

The configuration set is saved. You may access it in the List configurations dialog. See section below for
details.

List configurations
MAGNET Tools contains a list of default configurations, where each configuration has specific set of job para-
meters and set of the threshold values of precision for points, GPS/TS/DL observations for the specific survey
task. Click List configurations to view this list.

l Design — for viewing and edit road data.
l DGPS — for processing and adjustment GNSS raw data with meter accuracy. The threshold value of RTK
horizontal precision is 1 meter and RTK vertical precision is 3 meters.

l GPS+ — for processing and adjustment GNSS raw data with centimeter accuracy. The threshold value of
RTK horizontal precision is 0.02 meter and RTK vertical precision is 0.05 meter.

l Imaging — for processing Total Station raw data with image data. The threshold value of precision for a
distance is 0.03 meter and for vertical angle /horizontal angle is 0°00'10.0000"

l TS — for processing and adjustment Total Station and Digital Level raw data. The threshold value of pre-
cision for a distance is 0.03 meter and for vertical angle /horizontal angle is 0°00'10.0000"

l GIS configuration — for processing and adjustment GIS data with meter accuracy. The threshold value of
RTK horizontal precision and PP kinematic horizontal precision is 1 meter and RTK vertical precision and
PP kinematic vertical precision is 3 meters.

l GIS Advanced configuration — for processing and adjustment GIS data with centimeter accuracy. The
threshold value of RTK horizontal precision and PP kinematic horizontal precision is 0.02 meter and RTK
vertical precision and PP kinematic vertical precision is 0.05 meter.
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To delete a configuration set from the list, select it and click Delete.

To rename a configuration set, select it and click Rename.

To use a configuration set in the current job, select it and click Load.

Display item
The Display item of the Job Configuration dialog contains four tabs in the right panel:

l Precision tab allows you to set the viewing number of digits after the decimal for the various meas-
urements. See "Precisions tab" section below for details

l Time tab allows you to set the GPS time zone offset and automatic fixing clock for daylight saving
changes. See "Time tab" section on the facing page for details.

l Roads tab allows you to set the type of number to use for the center line position. See "Roads tab" section
on the facing page for details.

l Angles tab allows you to set the format of angular values. See "Angles tab" section on page 94 for details.

Precisions tab
The Precisions tab of the Display item from the Job configuration dialog allows you to set the viewing number of
digits to display after the decimal for various measurements.

To configure the displaying precision, type the required quantity of digits after decimal in the appropriate edit-
boxes.

Fields of the Precisions tab of the Display item
Field Description

Distances Defines the quantity of digits displayed after the decimal for distances. The
default values is 3.

Coordinates
(N,E;X,Y,Z)

Defines the quantity of digits displayed after the decimal for plane and
Cartesian coordinates (northing and easting, or X, Y, Z). The default value is
3.

Heights Defines the quantity of digits displayed after the decimal for all height meas-
urements. The default value is 3.

Angles (seconds)
Defines the quantity of digits displayed after the decimal for seconds of angu-
lar observations represented in degrees, minutes, and seconds. The default
value is 4.

Angles (dec.
degrees)

Defines the quantity of digits displayed after the decimal for angular obser-
vation format in decimal degrees (dd.ddd). The default value is 7.

Lat. Lon (seconds) Defines the quantity of digits displayed after the decimal for the seconds in lat-
itudes and longitudes. The default value is 5.

Lat. Lon (dec.
degrees)

Defines the quantity of digits after the decimal for the latitude and longitude
format in decimal degrees (dd.ddd). The default value is 8.

Area Defines the quantity of digits displayed after the decimal for all area data. The
default value is 0.
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Field Description

Volumes Defines the quantity of digits displayed after the decimal for all volume data.
The default value is 1.

Time (seconds) Defines the quantity of digits displayed after the decimal for time. The default
value is 0.

Time tab
The Time tab of the Display item from the Job configuration dialog allows you to select a time zone and display
the local time instead of the GPS time. Also you can set performing the daylight saving time automatically.

Fields of the Time tab of the Display item
Field Description

GPS Time Zone
Offset

Select the local time zone. If a zone is defined the application will display the
local time instead of the GPS time.

Daylight Saving
Time Tick to perform daylight saving time automatically.

Roads tab
The Road tab of the Display item from the Job configuration dialog allows you to set the type of distance view to
use for the center line position.
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Fields of the Roads tab of the Display item
Field Description

Station display
format

Defines the distance view for the center line position.
l Stationing – the number of the station is a value equal to the ratio of dis-
tance from the start point of the road and the interval for the station.
This number consists of two parts—The first part is an integer, defined
by the following formula:

Where "i" is the number of elements in the alignment; "Length" is a dis-
tance of “i-element” from the start point; and the “Interval for Station”
is equal to 100 current linear units. (This parameter is not editable).

The second part is a remainder from this ratio. For example: the length
of the line is 1288.50 meters; the number of the end station for this line
is 12+88.5.

You may use the following stationing formats:
l US Stationing — 1+234 (US feet)
l EU Stationing — 1+234 (meters)
l Sweden Stationing — 1/234 (meters)

l Chainage – the number of the station is a value equal to the distance
from the start point. For example: the length of the line is 1288.50
meters; the number of the end station for this line is 1288.5.

Angles tab
The Angles tab of the Display item from the Job configuration dialog allows you to set the format of angular val-
ues.

Fields of the Angles tab of the Display item
Field Description

Angles
Defines the format for such angular units as Azimuth, Horizontal Circle, Ver-
tical Angle, Zenith Angle, Azimuth Residual, Horizontal Angle Residual, Ver-
tical Angle Residual, Zenith Angle Residual.

Lat. Lon Defines the format for such angular units as Latitude and Longitude.
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Field Description

Azimuth As

Defines the directions displaying format. Select the appropriate radiobutton:
l Bearing— the directions is displayed as angles in quadrants. Quadrants
are pictured at figure below. Angles are counted clockwise within each
quadrant.

For example: azimuth angle of 130 degrees will be displayed as S 50° E.
l Azimuth— the directions is displayed as azimuth angles. The North axis
is zero and angles are counted clockwise.

Bearing quadrants

Coordinate Systems item
The Coordinate Systems item of the Job Configuration dialog contains the two tabs in the right panel:

l Setup tab allows you to set the current coordinate system and the desired geoid for the current job. See
"Setup tab" section below for details.

l Conversion tab allows you to select the way of transformation between NAD27 and NAD83_NO_TRANS
datums. See "Conversion tab" section on page 97 for details.

Setup tab
The Setup tab of the Coordinate Systems item from the Job configuration dialog allows you to set the current
coordinate system, the parameters of grid to ground transformation, the corresponding geoid and select the desired
coordinate type for the current job.
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Fields of the Setup tab of the Coordinate Systems item
Field Description

Projection

Displays the in-use grid projection for the current job. The Projection drop-
down list contains the pre-defined and user defined grid projections for the job.

Select the required projection from the drop-down list, or click Custom to cre-
ate your own one. See "Adding custom projection to the projection list" section
on page 334 for details.

Datum

Displays the corresponding datum for the grid projection, defined in the Pro-
jection drop-down list.

When either None, or UTMNorth, or UTMSouth, or UPS grid projections is
used, you can select any predefined or custom datum from the drop-down list;
or create your own custom datum. See "Adding custom datum to the datum list"
section on page 333 for details.

When any other projection is used, only the corresponding datum is shown and
you cannot open the datum list.

The MAGNET Tools supports two following datums for projections with
NAD-83 as the reference datum:

l NAD83 – has the following transformation parameters (shifts, rotations
and scale) to WGS-84 datum:

l NAD83_NO_TRANS – has zero values of transformation parameters
(shifts, rotations and scale) to WGS-84 datum.

Grid->Ground

Tick to perform the grid to ground transformation for the job. Click ... to select
the desired transformation method and set the corresponding parameters for
each method. See "Grid->Ground dialog" section on page 361 for details

NOTE
The checkbox only enabled when a projection is selected in the Pro-
jection drop-down list. Otherwise the checkbox is disabled. Also it is
disabled if the Localization projection is selected.
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Field Description

Geoid

Defines the used geoid for the current job. You can manually select a cor-
responding geoid type from the geoid list. Also you can add a geoid to the list.
See Adding geoid to the job. After importing a MAGNET Field job into the cur-
rent job, the geoid which was selected in the MAGNET Field job will
be automatically set as current in the MAGNET Tools job, if the geoid list con-
tains this file.

NOTES
A geoid transforms the ellipsoidal heights measured by GPS to heights
based on a physical reference surface, if the geoid covers the area where
file’s points are located.
The orthometric heights will be equal to ellipsoidal heights if a geoid file is not
downloaded to the application and/or the geoid does not cover the area
where file’s points are located.

Coordinate type

Displays the used coordinate type for the current job. The following coordinate
types are available:

l Ground
l Grid
l WGS84 Lat, Lon, Ell.H
l WGS84 X, Y, Z
l Datum Lat, Lon, Ell.H
l Datum Lat, Lon, Elevation

The coordinate system types are available depending on the projection and
datum settings. See table of the coordinate system types availability for details.

Table of the coordinate system types availability
Projection

Not defined (None or Localization is set) Defined

Datum
Defined

lGround
lWGS84 Lat, Lon, Ell.H

lWGS84 X, Y, Z
lDatum Lat, Lon, Ell.H

lDatum Lat, Lon, Elevation

lGrid
lWGS84 Lat, Lon, Ell.H

lWGS84 X, Y, Z
lDatum Lat, Lon, Ell.H
lDatum Lat, Lon, Elev-

ation

Not defined lGround

Conversion tab
The Conversion tab of the Coordinate Systems item from the Job configuration dialog allows you to select the
way of transformation between NAD27 and NAD83_NO_TRANS datums.
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Fields of the Conversion tab of the Coordinate Systems item
Field Description

Convert to/from
NAD27 using

Defines the conversion option:
l NAD27 Datum — the application will apply parameters NAD27 from
the its own database for transformation between NAD27 and NAD83_
NO_TRANS datums,

l NADCON — the application will apply the Federal standard
(NADCON program) for NAD 27 to NAD83_NO_TRANS datum trans-
formations.

Convert to/from
NAD27(CSRS)

using

Defines the conversion option:
l NAD27 Datum — the application will apply parameters NAD27 from
the its own database for transformation between NAD27(CSRS) and
NAD83_NO_TRANS datums,

l NTv2 NAD27 Canada— the application will apply the Canadian stand-
ard for NAD27(CSRS) to NAD83_NO_TRANS datum transformations.

Datum NAD27
(CSRS) Data File

Defines the file, containing NAD27 datum data. Click Browse Data to open
the required file.

Datum NAD83
(CSRS) Data File

Defines the file, containing NAD83 datum data. Click Browse Data to open
the required file.

Units item
The Units item of the Job Configuration dialog allows you to set linear and angular units of measurement as cur-
rent units for the job.

Fields of the Units item
Field Description

Linear Unit Defines the linear units for the current job. Select the required unit from the
drop-down list.

Angular Unit Defines the angular units for the current job. Select the required unit from the
drop-down list.

Equipment item
The Equipment item of the Job Configuration dialog allows you to select the default type of GPS antenna cal-
ibrations. The initial set is "Default absolute". Also you can import any other antenna calibration from a file to the
job.

To import antenna calibration set:
1. In the left panel of the Job configuration dialog, select the Equipment item.
2. In the right panel, click Import antenna clibration.
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The Open dialog is displayed.
3. Navigate to the required file and open it.

The NGS and TPS calibration contains the absolute and relative calibrations:
l Relative — the antenna offsets and phase center variations are computed with respect to the AOAD/M_T
antenna.

l Absolute — the recalculated relative calibration that takes into account the absolute values for AOAD/M_
T antenna.

NOTES
The custom antenna contains only the absolute calibration.

You can change the default type of GPS antenna calibration for anyGPS antenna in the Antenna Type
of the Antenna tab in the tabular view. See "GPS Occupations tab" section on page 133 for details.

Save item
The Save item of the Job Configuration dialog allows you to set the interval for automatic saving (AutoSave) of
the current job.

The AutoSave feature is useful in case a job crashes. Any unsaved data of this job (not saved by the user) will be
lost. But if you turn on the AutoSave feature, then in case of crash, the application will offer to open the last auto-
matically saved job condition.

If the checbox is ticked (default setting), any changed data of the job will be automatically saved within the
defined interval time. The minimal Interval is one (1) minute. Untick the checkbox to disable this option.

NOTE
After manual saving the job, the autosave copy is automatically deleted. A new autosave copy is cre-
ated at the end of the next time interval.

When the job (or system) is closed accidentally, the next time the application is run, you will be promp-
ted to open the autosave copy.

Process item
The Process item of the Job Configuration dialog have four items, described in the approrpriate sections:

l "Linework item" section below — you may disable/enable the creating a polyline for points which have the
same code and string combination here.

l "Adjustment item" section on the next page — you may configure adjustment of both Total Station and GPS
networks here.

l "TS Computations item" section on page 104 — you may configure computation and adjustment of Total
Station coordinates here.

l "GPS+ PostProcess item" section on page 105 — you may configure post-processing GPS observations
here.

Linework item
The Linework item of the Job Configuration dialog allows you to disable/enable the creating a polyline for points
which have the same code and string combination.
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Tick the Process feature codes checkbox to create a polyline for points which have the same code and string com-
bination.

Adjustment item
The Adjustment item of the Job Configuration dialog allows you to select the adjustment parameters for Least
Squares adjustment type for Total Station and GPS networks. It contains two tabs in the right panel, described in
the appropriate sections:

l "General tab" section below
l "A priori UWE tab" section on page 103

General tab
The General tab of the Adjustment item of the Job configuration dialog allows you to select the adjustment para-
meters.

Fields of the General tab of the Adjustment item
Field Description

Confidence Level

Defines the current value of the confidence level for rejecting suspect obser-
vations during adjustment when Tau Criterion is selected in the Rejection Cri-
terion field group box. You can select either 68%, 95%, or 99%. The less the
value of the confidence level, the less the Tau_critical value and accordingly
the more suspect observations will be rejected from the adjusted procedure.
The default confidence level is 95%.
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Field Description

Rejection Cri-
terion

Defines the current criterion for rejecting bad observations. You can select
either By Quality Control or Tau Criterion. The default criterion is By Quality
Control.

If you have selected the By Quality Control test, the application will reject the
following network components from adjustment with residuals worse than the
values set for the current job. These residuals are calculated in the process of
adjustment for the closed figures and/or for repeated observations in the net-
work:

l all plane components of the GPS observations and distances and/or hori-
zontal angles of the TS observations for the plane adjustment,

l all height components of the GPS observations and vertical angles of the
TS observations for the vertical adjustment.

If you have selected the Tau Criterion test, the application will reject the
following network components from the adjustment with a Tau value more
than Tau_critical. These residuals are calculated in the process of adjust-
ment for the closed figures and/or for repeated observations in the network:

l all plane components of the GPS observations and distances and/or hori-
zontal angles of the TS observations for the plane adjustment,

l all height components of the GPS observations and vertical angles of the
TS observations for the vertical adjustment.

The formula for calculating Tau is the following:
Tau = (RES) / δRes
Where

l (RES) — designates the residual calculated for the corresponding com-
ponent of the observation,

l δRes — the RMS residual error.

NOTE
The value of Tau_critical depends on the number of degrees of
freedom and the selected level of confidence in the Confidence
Level group box.
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Field Description

Adjust Dimension

Defines the current dimension for adjustment. You can select one of the fol-
lowing values:

l 1D — adjustment is performed ONLY in the vertical plane
l 2D — adjustment is performed ONLY in the horizontal plane
l 2D +1D — adjustment is performed separately in the horizontal and ver-
tical planes.

l 3D — adjustment is simultaneously performed in 3D space.
l AUTO — the adjustment will run either in 1D, or 2D, or 2D +1D mode
for each component depending on presence of control points:

l If control points are not selected, the plane and vertical adjust-
ments (2D+1D) are performed from an arbitrary point.

l If control points are fixed only in the horizontal plane, only the
horizontal adjustment (2D) is performed. The vertical adjustment
are not performed.

l If control points are fixed only in the vertical plane, only the ver-
tical adjustment (1D) is performed. The horizontal adjustment are
not performed.

l If control points are fixed in both planes, the adjustment (2D+1D)
will be done for both planes, respectively.

l When a job contains one or more GPS observations with the
baseline length more than 200 km, the adjustment is sim-
ultaneously performed in 3D space for all GPS observations.

The default value is "Auto".

NOTE
Inner constraint adjustment— adjustment is performed in the hori-
zontal or vertical plane from an arbitrary point (selected byMAGNET
Tools).

Constraint adjustment— adjustment is performed in the plane, in
which you fixed a point of the job.

Adjustment Type

Defines the current adjustment type. You can select one of the following
options:

l Automatic Blunder Rejection— the application will automatically reject
a blunder observation from adjustment and calculate the final residuals
for all adjusted points without the blunder components.

l Interactive Blunder Rejection— the application will interrupt the adjust-
ment process and show a list of blunders. You can manually delete any
blunder component from the adjustment or continue the adjustment pro-
cess.

The default type is Automatic Blunder Rejection.
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Field Description

Analyse Repeated
Observation

Tick to perform the test of the repeated observations. The repeated obser-
vations are two ore more observations with common start/end names. The
observations N1-N2 and N2-N1 are assumed to be repeated.

A successful test is where the difference between any two repeated obser-
vations is less than the horizontal/vertical observation precision set in the Qual-
ity Control item of the Job Configuration dialog.

A failed test is where the difference is more than the horizontal/vertical obser-
vation precision set in the Quality Control item of the Job Configuration dia-
log. The network adjustment process will be interrupted and the Adjustment
Diagnostic dialog will display.

Analyse Identical
Points

Tick to perform the test of the identical points:

A successful test is where the coordinate difference for a pair of identical
points is more than horizontal/vertical point precision set in the Quality Control
item of the Job Configuration dialog.

A failed test is where the difference is less than the values set in the Quality
Control item of the Job Configuration dialog. The network adjustment process
will be interrupted and the Adjustment Diagnostic dialog will display.

Control Tie Ana-
lysis

Tick to perform the test of the coordinates of the control points. The Control
Tie Analysis test compares the control coordinates with the corresponding
coordinates computed using GPS/ TS/DL observations.

A successful test is where the difference is less than horizontal/vertical point
precision set in the Quality Control item of the Job Configuration dialog.

A failed test is where the difference is more than the value of hori-
zontal/vertical point precision set in the Quality Control item of the Job Con-
figuration dialog. The network adjustment process will be interrupted and the
Control Tie Analysis dialog will display.

A priori UWE tab
The A priori UWE tab of the Adjustment item of the Job configuration dialog allows you to select a priory the
unit of weight error for the GPS vector in vertical, horizontal or 3D adjustment, and for slope distance, horizontal
angle, vertical angle of TS measurements in network adjustment. The default confidence level is 1.

Fields of the A priori UWE tab of the Adjustment item
Field Description

GPS vector (3D)
or GPS Horiz

Definess the current value of the unit of weight error for the vector in hori-
zontal adjustment or in 3D-adjustment.

GPS vector, Vert Defines the current value of the unit of weight error for the vector in vertical
adjustment.

TS Measurement,
SD

Defines the current value of the unit of weight error for the Slope Distance in
Total Station measurement.
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Field Description

TS Measurement,
HA

Defines the current value of the unit of weight error for the Horizontal Angle
in Total Station measurement.

TS Measurement,
VA

Defines the current value of the unit of weight error for the Vertical Angle in
Total Station measurement.

NOTE
Changing a priory UWE affects the blunder search algorithm and does not affect the final point pre-
cision.

TS Computations item
The TS Computations item of the Job Configuration dialog allows you to set the Refraction Coefficient for cal-
culating TS point coordinates from TS raw data, and can select a method of traverse adjustment in the Total Sta-
tion network.

Fields of the TS Computation item
Field Description

Refraction Coef-
ficient

Defines the current value of the coefficient of refraction. This coefficient is
used to correct the horizontal and vertical distances measured by Total Station
for refraction and earth curvature. You can select either 0, or 0.14, or 0.2
depending on the measured distance and survey conditions.

TS-Traverse
Adjustment Type

Defines the current type of traverse adjustment in the Total Station network.
You may select one of the following adjustment types:

l Least Squares— statistical method for providing a best fit for survey
point positions, and detecting and automatic rejecting error meas-
urements (blunders) by minimizing the sum of the squares of meas-
urement residuals.

l Compass Rule — this method assumes that the precision in angles or dir-
ections is equivalent of the precision in distances. This method works
for closed traverses or traverses between two fixed control points.

l Unadjusted closure — calculates the network coordinates from the ori-
ginal station coordinates without estimating the accuracy. If the network
has duplicate measurements, only one measurement will be used to com-
pute the coordinates.

Use Elevation

This checkbox is available when Compass Rule or Unadjusted closure adjust-
ment type is selected.

Tick to perform one of the following operations:
l If the Compass Rule is selected — adjustment in the vertical plane with
displaying the elevation precision for each network point.

l If the Unadjusted closure is selected — calculating elevation for each
network point.

NOTE
The application uses only the least-squaresmethod for adjustment of GPS observations.
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GPS+ PostProcess item
The GPS+ PostProcess Properties item of the Job Configuration dialog allows you to configure the parameters
for post-processing GPS observations. It contains three tabs, described in the appropriate sections:

l General tab
l Engine tab
l Troposphere tab

General tab
The General tab of the GPS+ PostProcess item of the Job configuration dialog allows you to configure the para-
meters for post processing GPS observations.

Fields of the General tab of the GPS+ PostProcess item
Field Descriptions

Elevation Mask Defines the elevation mask level to discard satellites with elevations less than
this value during post processing the enabled GPS observations of the job.

System
Defines the current navigation system, which will be used for post processing
of the enabled GPS observations of the job. You can select either GPS+ (GPS
and Glonass), or GPS only option.

Save Residuals

When ticked, MAGNET Tools will create double-difference residuals for
static GPS-observations in the job after processing. To view the residuals dia-
gram for a GPS observation, right click it in the GPS Obervations tab of the tab-
ular view and select Residual View from the pop-up menu. See "GPS Obs
tab" section on page 140 for details.

By using this plot you can see the satellites which were used in post processing
of this GPS observation.

NOTE
The double-difference residuals are not saved for the GPS observation
which was post processed in Code Diff or VLBL EngineMode.

Max length of vec-
tor (km)

When ticked, you may specify a value in the appropriate editbox to limit the
GPS observation distance. MAGNET Tools will not create static GPS obser-
vation with distance longer than this value.

Minimum duration

Defines the way of creating GPS observation in MAGNET Tools. You may
select one of the following options:

l Auto— MAGNET Tools will create a static GPS observation for a pair
of occupations that have common observation time (duration) needed for
starting the post processing. The time depends on the distances between
two points, the number of common satellites observed at these points,
the type of the receiver (L1/L2 or L1 only and GPS and GLONASS or
GPS only), and so on.

l Fixed Time — MAGNET Tools will create a static GPS observation
for a pair of occupations that have common observation time (duration)
more than the value set in the Min observation time editbox. This feature
is useful to remove short in time baseline(s) from post processing.
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Field Descriptions

Min observation
time (sec)

Defines the minimum observation time for static mode. MAGNET Tools will
automatically create a GPS observation for two static occupations, if the com-
mon time of these occupations is more than the minimum observation time.

TIP
This field is available when the Fixed Time is selected in theMinimum dur-
ation drop-down list.

Enable continuous
kinematic

When ticked, the GPS Obs tab of the Tabular view displays the PP Kin
GPS observations, the Points tab of the tabular view displays the kinematic
points and the Observations View displays the kinematic trajectory.

NOTE
A PP Kin G PS Observation is an observation created from one Static and
one Kinematic occupations.

Enable go kin-
ematic

When ticked, the GPS Obs of the data panel displays PP Go GPS observations,
the Points tab of the tabular view displays the static and kinematic points and
the Observations View displays the kinematic trajectory to/from static points.

NOTE
A GoGPS Observation is an observation created from one Static and
sequence of Stop andGo occupations.

Compute DOPs

When ticked, the values of HDOP, VDOP, and PDOP are automatically cal-
culated during post processing of each GPS observation. The
GPS Observations tab of the tabular view displays these values in the cor-
responding fields.

Use auto import

When ticked, the procedure of auto downloading a reference station occupation
from the Internet to the current job is activated. Click Setup to set the Auto
Import options.

NOTE
This option requires the Internet connection.

Engine tab
The Engine tab of the GPS+ PostProcess item of the Job configuration dialog allows you to select the engine type
for processing static, stop-and-go or kinematic survey data. For each survey you can select Engine Type and
Engine Mode. See details in the appropriate sections, listed below.

l "Static survey" section below
l "StopGo survey" section on page 108
l Kinematic survey

Static survey

For the Static survey, you may select one of the following engine types from the appropriate drop-down list:
l BaseLine — standard processing two Static GPS occupations. You may select the following Engine Modes
for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS code measurements (no ambi-
guity resolution). The final solution type of the processed GPS observation is "Code Diff".
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l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). This mode is ‘default’ when using single frequency receivers). The final solu-
tion type of the processed GPS observation is "Fixed, L1 / Float, L1".

l L2 Only — Processing of L2 GPS/GLONASS code and carrier phase measurements only. The final
solution type of the processed GPS observation is "Fixed, L2 / Float, L2".

l L1&L2 — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) for GPS observation length is shorter than 10 km. L1 and L2 observables will
be treated by the engine as independent data sets. The final solution type of the processed GPS obser-
vation is "Fixed / Float".

l L1&L2, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with dual frequency meas-
urements, ionofree combinations will be created and ionospheric error is eliminated. The final solu-
tion type of the processed GPS observation is "Fixed, IonoFree / Float, IonoFree".

l Wide Lane, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements integer ambiguity resolution
for L1 and L2 observables is performed with assistance of L1-L2 (Wide Lane) combination. The
final solution type of the processed GPS observation is "Fixed, Wide Lane / Float, Wide Lane".

l Float IonoFree — Processing is performed using dual frequency measurements (L1/L2
GPS/GLONASS code and carrier phase measurements) with ionofree combination for ionospheric
error elimination. The final solution type of the processed GPS observation is only Float, IonoFree.

l VLBL — the processing of very long baselines using triple differences (No ambiguity resolution).
The final solution type of the processed GPS observation is "VLBL".

l AUTO — MAGNET Tools automatically selects an optimal processing mode:
l L1 Only — if only single frequency measurements available
l L1&L2 — if GPS observation length is shorter than 10 km
l L1&L2, Fixed IonoFree — if GPS observation length falling into the 10 km to 30 km interval
l Wide Lane — if GPS observation length falling into the 30 km to 1500 km interval
l VLBL — if GPS observation length is more than 1500 km

l MultiSite — simultaneous processing a Static GPS occupation of unknown point and Static GPS occupation
of several base stations. This type allows you to improve position accuracy by using more satellite raw data
for processing. You may select the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS code measurements (no ambi-
guity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). This mode is ‘default’ when using single frequency receivers). The final solu-
tion type of the processed GPS observation is "Fixed, L1 / Float, L1".

l L2 Only — Processing of L2 GPS/GLONASS code and carrier phase measurements only. The final
solution type of the processed GPS observation is "Fixed, L2 / Float, L2".

l L1&L2 — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) for GPS observation length is shorter than 10 km. L1 and L2 observables will
be treated by the engine as independent data sets. The final solution type of the processed GPS obser-
vation is "Fixed / Float".

l L1&L2, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with dual frequency



Job Configuration dialog

108

measurements, ionofree combinations will be created and ionospheric error is eliminated. The final
solution type of the processed GPS observation is "Fixed, IonoFree / Float, IonoFree".

l Wide Lane, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements integer ambiguity resolution
for L1 and L2 observables is performed with assistance of L1-L2 (Wide Lane) combination. The
final solution type of the processed GPS observation is "Fixed, Wide Lane / Float, Wide Lane".

l Float IonoFree — Processing is performed using dual frequency measurements (L1/L2
GPS/GLONASS code and carrier phase measurements) with ionofree combination for ionospheric
error elimination. The final solution type of the processed GPS observation is only Float, IonoFree.

l VLBL — the processing of very long baselines using triple differences (No ambiguity resolution).
The final solution type of the processed GPS observation is "VLBL".

l AUTO — MAGNET Tools automatically selects a processing mode:
l L1 Only — if only single frequency measurements available
l L1&L2, Fixed IonoFree — for dual frequency data

l Extended RTK— Real Time Kinematic type of processing two Static GPS occupations. You may select
the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS only code measurements (no
ambiguity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). The final solution type of the processed GPS observation is "Fixed, L1 /
Float,L1".

l Iono Free — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, after integer L1/L2 ambiguity resolution, ionosphere-free (IF) com-
binations are formed to produce IF positioning results. The final solution type of the processed GNSS
observations is "Fixed, IonoFree / Float, IonoFree". The mode is recommended for baselines within
10-50 km, or shorter, if ionosphere is disturbed.

l Wide Lane — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, “Wide Lane” (WL) carrier phase combinations (L1 minus L2) are
formed and used in ambiguity resolution and positioning. The final solution type of the processed
GNSS observations is “WL Fixed / WL Float”. The mode is recommended for baselines longer 50
km.

l Auto — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, after integer L1/L2 ambiguity resolution, “standard” L1/L2 solution is
formed. The final solution type of the processed GNSS observations is “ Fixed / Float”. The mode is
recommended for baselines shorter 10 km, and "calm" ionosphere.

l Auto— the Baseline type will be applied.

StopGo survey

For the stop and go survey, you may select one of the following engine types from the appropriate drop-down list:
l Baseline — standard processing a sequence of Stop and Go GPS occupations and Static GPS occupation of
a base station. You may select the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS code measurements (no ambi-
guity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). This mode is ‘default’ when using single frequency receivers). The final solu-
tion type of the processed GPS observation is "Fixed, L1 / Float, L1".
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l L2 Only — Processing of L2 GPS/GLONASS code and carrier phase measurements only. The final
solution type of the processed GPS observation is "Fixed, L2 / Float, L2".

l L1&L2 — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) for GPS observation length is shorter than 10 km. L1 and L2 observables will
be treated by the engine as independent data sets. The final solution type of the processed GPS obser-
vation is "Fixed / Float".

l L1&L2, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with dual frequency meas-
urements, ionofree combinations will be created and ionospheric error is eliminated. The final solu-
tion type of the processed GPS observation is "Fixed, IonoFree / Float, IonoFree".

l Wide Lane, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements integer ambiguity resolution
for L1 and L2 observables is performed with assistance of L1-L2 (Wide Lane) combination. The
final solution type of the processed GPS observation is "Fixed, Wide Lane / Float, Wide Lane".

l Float IonoFree — Processing is performed using dual frequency measurements (L1/L2
GPS/GLONASS code and carrier phase measurements) with ionofree combination for ionospheric
error elimination. The final solution type of the processed GPS observation is only Float, IonoFree.

l VLBL — the processing of very long baselines using triple differences (No ambiguity resolution).
The final solution type of the processed GPS observation is "VLBL".

l AUTO — MAGNET Tools automatically selects a processing mode:
l L1 Only — if only single frequency measurements available
l L1&L2, Fixed IonoFree — for dual frequency data

l MultiSite — simultaneous processing a sequence of Stop and Go GPS occupation(s) and Static GPS occu-
pation of several base stations. This type allows you to improve position accuracy by using more satellite
raw data for processing. You may select the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS code measurements (no ambi-
guity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). This mode is ‘default’ when using single frequency receivers). The final solu-
tion type of the processed GPS observation is "Fixed, L1 / Float, L1".

l L2 Only — Processing of L2 GPS/GLONASS code and carrier phase measurements only. The final
solution type of the processed GPS observation is "Fixed, L2 / Float, L2".

l L1&L2 — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) for GPS observation length is shorter than 10 km. L1 and L2 observables will
be treated by the engine as independent data sets. The final solution type of the processed GPS obser-
vation is "Fixed / Float".

l L1&L2, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with dual frequency meas-
urements, ionofree combinations will be created and ionospheric error is eliminated. The final solu-
tion type of the processed GPS observation is "Fixed, IonoFree / Float, IonoFree".

l Wide Lane, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements integer ambiguity resolution
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for L1 and L2 observables is performed with assistance of L1-L2 (Wide Lane) combination. The
final solution type of the processed GPS observation is "Fixed, Wide Lane / Float, Wide Lane".

l Float IonoFree — Processing is performed using dual frequency measurements (L1/L2
GPS/GLONASS code and carrier phase measurements) with ionofree combination for ionospheric
error elimination. The final solution type of the processed GPS observation is only Float, IonoFree.

l VLBL — the processing of very long baselines using triple differences (No ambiguity resolution).
The final solution type of the processed GPS observation is "VLBL".

l AUTO — MAGNET Tools automatically selects a processing mode:
l L1 Only — if only single frequency measurements available
l L1&L2, Fixed IonoFree — for dual frequency data

l Extended RTK— Real Time Kinematic type of processing a sequence of Stop and Go GPS occupations
from a base station. You may select the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS only code measurements (no
ambiguity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). The final solution type of the processed GPS observation is "Fixed, L1 /
Float,L1".

l Iono Free — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, after integer L1/L2 ambiguity resolution, ionosphere-free (IF) com-
binations are formed to produce IF positioning results. The final solution type of the processed GNSS
observations is "Fixed, IonoFree / Float, IonoFree". The mode is recommended for baselines within
10-50 km, or shorter, if ionosphere is disturbed.

l Wide Lane — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, “Wide Lane” (WL) carrier phase combinations (L1 minus L2) are
formed and used in ambiguity resolution and positioning. The final solution type of the processed
GNSS observations is “WL Fixed / WL Float”. The mode is recommended for baselines longer 50
km.

l Auto — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, after integer L1/L2 ambiguity resolution, “standard” L1/L2 solution is
formed. The final solution type of the processed GNSS observations is “ Fixed / Float”. The mode is
recommended for baselines shorter 10 km, and "calm" ionosphere.

l AUTO — the Baseline type will be applied.

Kinematic survey

For the kinematic survey, you may select one of the following engine types from the appropriate drop-down list:
l Baseline — standard processing Kinematic and Static GPS occupations. You may select the following
Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS code measurements (no ambi-
guity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). This mode is ‘default’ when using single frequency receivers). The final solu-
tion type of the processed GPS observation is "Fixed, L1 / Float, L1".

l L2 Only — Processing of L2 GPS/GLONASS code and carrier phase measurements only. The final
solution type of the processed GPS observation is "Fixed, L2 / Float, L2".

l L1&L2 — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) for GPS observation length is shorter than 10 km. L1 and L2 observables will
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be treated by the engine as independent data sets. The final solution type of the processed GPS obser-
vation is "Fixed / Float".

l L1&L2, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with dual frequency meas-
urements, ionofree combinations will be created and ionospheric error is eliminated. The final solu-
tion type of the processed GPS observation is "Fixed, IonoFree / Float, IonoFree".

l Wide Lane, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements integer ambiguity resolution
for L1 and L2 observables is performed with assistance of L1-L2 (Wide Lane) combination. The
final solution type of the processed GPS observation is "Fixed, Wide Lane / Float, Wide Lane".

l Float IonoFree — Processing is performed using dual frequency measurements (L1/L2
GPS/GLONASS code and carrier phase measurements) with ionofree combination for ionospheric
error elimination. The final solution type of the processed GPS observation is only Float, IonoFree.

l VLBL — the processing of very long baselines using triple differences (No ambiguity resolution).
The final solution type of the processed GPS observation is "VLBL".

l AUTO — MAGNET Tools automatically selects a processing mode:
l L1 Only — if only single frequency measurements available
l L1&L2, Fixed IonoFree — for dual frequency data

l MultiSite — simultaneous processing Kinematic GPS occupation and Static GPS occupation of several
base stations. This type allows you to improve position accuracy by using more satellite raw data for pro-
cessing. You may select the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS code measurements (no ambi-
guity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). This mode is ‘default’ when using single frequency receivers). The final solu-
tion type of the processed GPS observation is "Fixed, L1 / Float, L1".

l L2 Only — Processing of L2 GPS/GLONASS code and carrier phase measurements only. The final
solution type of the processed GPS observation is "Fixed, L2 / Float, L2".

l L1&L2 — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) for GPS observation length is shorter than 10 km. L1 and L2 observables will
be treated by the engine as independent data sets. The final solution type of the processed GPS obser-
vation is "Fixed / Float".

l L1&L2, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with dual frequency meas-
urements, ionofree combinations will be created and ionospheric error is eliminated. The final solu-
tion type of the processed GPS observation is "Fixed, IonoFree / Float, IonoFree".

l Wide Lane, Fixed IonoFree — Processing of dual frequency measurements (L1/L2 GPS/GLONASS
code and carrier phase measurements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements integer ambiguity resolution
for L1 and L2 observables is performed with assistance of L1-L2 (Wide Lane) combination. The
final solution type of the processed GPS observation is "Fixed, Wide Lane / Float, Wide Lane".

l Float IonoFree — Processing is performed using dual frequency measurements (L1/L2
GPS/GLONASS code and carrier phase measurements) with ionofree combination for ionospheric
error elimination. The final solution type of the processed GPS observation is only Float, IonoFree.
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l VLBL — the processing of very long baselines using triple differences (No ambiguity resolution).
The final solution type of the processed GPS observation is "VLBL".

l AUTO — MAGNET Tools automatically selects a processing mode:
l L1 Only — if only single frequency measurements available
l L1&L2, Fixed IonoFree — for dual frequency data

l Extended RTK — the RTK (Real Time Kinematic) type of processing Kinematic and Static GPS occu-
pations. You may select the following Engine Modes for this type:

l Code Diff — Processing of dual frequency L1/L2 GPS/ GLONASS only code measurements (no
ambiguity resolution). The final solution type of the processed GPS observation is "Code Diff".

l L1 Only — Processing of single frequency measurements (L1 GPS/GLONASS code and carrier
phase measurements). The final solution type of the processed GPS observation is "Fixed, L1 /
Float,L1".

l Iono Free — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, after integer L1/L2 ambiguity resolution, ionosphere-free (IF) com-
binations are formed to produce IF positioning results. The final solution type of the processed GNSS
observations is "Fixed, IonoFree / Float, IonoFree". The mode is recommended for baselines within
10-50 km, or shorter, if ionosphere is disturbed.

l Wide Lane — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, “Wide Lane” (WL) carrier phase combinations (L1 minus L2) are
formed and used in ambiguity resolution and positioning. The final solution type of the processed
GNSS observations is “WL Fixed / WL Float”. The mode is recommended for baselines longer 50
km.

l Auto — Processing of dual frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) so that, after integer L1/L2 ambiguity resolution, “standard” L1/L2 solution is
formed. The final solution type of the processed GNSS observations is “ Fixed / Float”. The mode is
recommended for baselines shorter 10 km, and "calm" ionosphere.

l AUTO — the Baseline type will be applied.

Troposphere tab
MAGNET Tools allows you to select from three standard tropospheric models: Goad-Goodman, Niell and UNB-
abc. The post-processing engine uses each model with a default parameters set. However, using the actual meteo
parameters for the time of data collection can improve the final solution, especially in problem situations (long
baselines, noisy data etc.)

The Troposphere tab of the GPS+ PostProcess item of the Job configuration dialog allows you to either specify
measured meteo parameters or use the Meteo model option.

Fields of the Troposphere tab of the GPS+ PostProcess item
Field Description

Troposphere
model

Defines the current troposphere model. You can select one of the three stand-
ard tropospheric models:

l Goad-Goodman
l Niell
l UNBabc
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Field Description

Meteo Model

In the group box, you may define meteo model of the troposphere. There are
three available options:

l None — select if you have information about actual values of meteo
parameters such as temperature, pressure and humidity; and fill in the
appropriate parameters manually.

l NRLMSISE — This model describes the neutral temperature and dens-
ities in Earth's atmosphere from ground to thermospheric heights as func-
tions of solar activity, geomagnetic activity, latitude, longitude and
altitude, day of year and time of day.

l GPT — Global Pressure and Temperature model — this model is based
on spherical harmonics up to degree and order nine, and provides pres-
sure and temperature at any site in the vicinity of the Earth's surface.
Input parameters of GPT are the station coordinates and the day of the
year, this also allows modeling the annual variations of the parameters.

The troposphere parameters will correspond to a point, defined in the Default
meteo parameter at height editbox (default is 0 meters). You can specify the
real value of the height for the point where the meteo parameters were meas-
ured. Then, by using the meteo parameters specified for the known height, the
engine will calculate the troposphere model for each occupation of the job with
the given height for the occupation.

Default meteo
parameter at
height(m)

Defines the height where the actual meteo parameters for the time of data col-
lection were measured. The MAGNET Tools engine will calculate the tro-
posphere model for each occupation of the job with the given height for the
occupation.

Dry temperature Defines the temperature for the time of data collection. The editbox only avail-
able when None is selected in the Meteo Model group box.

Pressure Defines the pressure for the time of data collection. The editbox only available
when None is selected in the Meteo Model group box.

Humidity Defines the humidity for the time of data collection.

Use

When ticked, the option Estimate Zenith Troposphere Delay is activated. In
this case, MAGNET Tools will estimate the zenith troposphere delay basing
on the available raw data measurements and troposphere parameters (dry tem-
perature, pressure, humidity). It is assumed that the actual troposphere can be
adequately described by scaling the a priori (computed) troposphere with a cer-
tain unknown factor. This unknown factor has to be estimated using the col-
lected raw data measurements.

If vector length
exceeds

You can specify a value to limit the GPS observation distance here. MAGNET
Tools will not apply the option Estimate Zenith Troposphere Delay for
GPS observation with distance less than this value.

And session time
exceeds

You can specify a value to limit the GPS observation duration here. MAGNET
Tools will not apply the option Estimate Zenith Troposphere Delay for
GPS observation with duration less than this value.
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Field Description

Zenith delay is
considered con-
stant over

You can set the minimum time during which the zenith delay is considered to
be constant here.

Quality Control item
The Quality Control item of the Job Configuration dialog allows you to set:

l the threshold value of precision for points, GPS/TS/DL observations,
l the horizontal and vertical tolerances for loop closures,
l enable / disable of performing of quality control tests from the predefined list.

There are two ways to change the values in the tabs:
l manually: open the corresponding tab and enter the desired value.
l automatically: load the corresponding job configuration which contains the desired values for all tabs.

The Quality Control item contains six tabs, described in the appropriate sections:
l "TS Obs Precisions tab" section below
l "GPS Observation Precisions tab" section on the facing page
l "Automatic Tests tab" section on page 116
l "Loop Closure Precisions tab" section on page 118
l "Point Precisions tab" section on page 118
l "DL Observation Precisions tab" section on page 120

TS Obs Precisions tab
The TS Obs Precisions tab of the Quality Control item from the Job configuration dialog allows you to set the
threshold value of precision for a slope distance and horizontal/vertical angle of Total Station observations.

Fields of the TS Obs Precisions tab of the Quality Control item
Field Description

TS Distance Pre-
cision

Defines the current threshold value of the slope distance precision for the Total
Station observations. If the slope distance residuals for a Total Station obser-
vation after adjusting the network is worse than the value in the settings, the
TS observation will be highlighted in red in the TS Obs tab, Observation View
and Report. When Allowed is set in the AutoReject field of the TS Obs tab the
TS observation will be automatically reject from the adjustment process.

TS VA Precision

Defines the current threshold value of the vertical angle precision for the Total
Station observations. If the vertical angle residuals for a Total Station obser-
vation after adjusting the network is worse than the value in the settings, the
TS observation will be highlighted in red in the TS Obs tab, Observation View
and Report. When Allowed is set in the AutoReject field of the TS Obs tab the
TS observation will be automatically reject from the adjustment process.
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Field Description

TS HA Precision

Defines the current threshold value of the horizontal angle precision for the
Total Station observations. If the horizontal angle residuals for a Total Station
observation after adjusting the network is worse than the value in the settings,
the TS observation will be highlighted in red in the TS Obs tab, Observation
View and Report. When Allowed is set in the AutoReject field of the TS Obs
tab the TS observation will be automatically reject from the adjustment pro-
cess.

GPS Observation Precisions tab
The GPS Obs Precisions tab of the Quality Control item from the Job configuration dialog allows you to set the
threshold value of horizontal and vertical precisions for the post-processed and RTK GPS Observations.

Fields of the GPS Observation Precisions tab of the Quality Control item
Field Description

RTK Horizontal
Precision

Defines the current threshold value of the horizontal precision for the
RTK vectors (GPS Observations). If the horizontal precision for a RTK vector
is worse than the value in the settings, both RTK Topo and RTK Auto Topo
GPS Observation will be highlighted in red in the GPS Obs tab, Observation
View and Report, when you tick the RTK Precisions checkbox at the Auto-
matic Test of the Quality Control item. See "Automatic Tests tab" section on
the next page for details.

RTK Vertical Pre-
cision

Defines the current threshold value of the vertical precision for the
RTK vectors (GPS Observations). If the vertical precision for a RTK vector is
worse than the value in the settings, both RTK Topo and RTK Auto Topo
GPS Observation will be highlighted in red in the GPS Obs tab, Observation
View and Report, when you tick the RTK Precisions checkbox at the Auto-
matic Test of the Quality Control item. See "Automatic Tests tab" section on
the next page for details.

PP Static Hori-
zontal Precision

Defines the current threshold value of the horizontal precision for the static
post-processed GPS observation. If the horizontal precision for a static post-pro-
cessed GPS observation is worse than the value in the settings, the
GPS observation will be highlighted in red in the GPS Obs tab, Observation
View and Report, when you tick the RTK Precisions checkbox at the Auto-
matic Test of the Quality Control item. See "Automatic Tests tab" section on
the next page for details.

PP Static Vertical
Precision

Defines the current threshold value of the verticall precision for the static post-
processed GPS observation. If the vertical precision for a static post-processed
GPS observation is worse than the value in the settings, the GPS observation
will be highlighted in red in the GPS Obs tab, Observation View and Report,
when you tick the RTK Precisions checkbox at the Automatic Test of the Qual-
ity Control item. See "Automatic Tests tab" section on the next page for
details.
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Field Description

PP Kinematic
Horizontal Pre-

cision

Defines the current threshold value of the horizontal precision for the kin-
ematic post-processed GPS observation. If the horizontal precision for a kin-
ematic post-processed GPS observation is worse than the value in the settings,
the GPS observation will be highlighted in red in the GPS Obs tab, Observation
View and Report, when you tick the RTK Precisions checkbox at the Auto-
matic Test of the Quality Control item. See "Automatic Tests tab" section
below for details.

PP Kinematic Ver-
tical Precision

Defines the current threshold value of the vertical precision for the kinematic
post-processed GPS observation. If the vertical precision for a kinematic post-
processed GPS observation is worse than the value in the settings, the
GPS observation will be highlighted in red in the GPS Obs tab, Observation
View and Report, when you tick the RTK Precisions checkbox at the Auto-
matic Test of the Quality Control item. See "Automatic Tests tab" section
below for details.

Automatic Tests tab
The Automatic Tests tab of the Quality Control item from the Job configuration dialog allows you to set which of
the quality control tests will automatically run and will mark points and/or observations that fail the Quality Con-
trol test in red. Clearing any of these checkboxes will also clear red marks and descriptions on the Quality Control
tabs of the Property dialog boxes. To perform the test, tick the appropriate checkbox.

Fields of the Automatic Tests tab of the Quality Control item
Field Description

Warm Float solu-
tions

When ticked, the GPS observations which have the Float solution are high-
lighted in red in the GPS Observation tab, Observation View and Reports.

RTK Precisions

When ticked, the application will compare the current precision of the RTK
GPS Observation with the values that are set in the RTK Horizontal Precision
and RTK Vertical Precision editboxes at the GPS Observation Precisions tab
correspondingly See "GPS Observation Precisions tab" section on the previous
page for details. If the horizontal or vertical precision for an RTK vector is
worse than the value in the settings, both RTK Topo and RTK Auto Topo
GPS observation will be highlighted in red in the GPS Obs tab, Observation
View and Report.

PP Static Pre-
cisions

When ticked, the application will compare the current precision of the static
GPS Observation with the values that are set in the PP Static Horizontal Pre-
cision and PP Static Vertical Precision editboxes at the GPS Observation Pre-
cisions tab correspondingly See "GPS Observation Precisions tab" section on
the previous page for details. If the horizontal or vertical precision for a static
GPS observation is worse than the value in the settings,the GPS observation
will be highlighted in red in the GPS Obs tab, Observation View and Report.
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Field Description

PP Kinematic Pre-
cisions

When ticked, the application will compare the current precision of the kin-
ematic GPS Observation with the values that are set in the PP Kinematic Hori-
zontal Precision and PP Kinematic Vertical Precision editboxes at the GPS
Observation Precisions tab correspondingly See "GPS Observation Precisions
tab" section on page 115 for details. If the horizontal or vertical precision for a
kinematic GPS observation is worse than the value in the settings,the
GPS observation will be highlighted in red in the GPS Obs tab, Observation
View and Report.

Point Standard
Deviations

When ticked, during adjustment the application will compare a point precision
with the values that are set in the Static Horizontal Precision and Static Ver-
tical Precision editboxes of the Point Precisions tab. See "Point Precisions tab"
section on the next page for details. If the horizontal or vertical precision for a
point after adjustment is worse than the value in the settings, the point will be
highlighted in red in the Points tab, Observation View and Reports.

Identical Points

When checked, the application will compare the distance between two points
with the values that are set in the Static Horizontal Precision and Static Ver-
tical Precision editboxes of the Point Precisions tab. See "Point Precisions tab"
section on the next page for details. If the distance is less than the value, both
points will be highlighted in red in the Points tab, Observation View and
Report.

Misnamed GPS
Occupations

When ticked, the application will compare the coordinates of the GPS static
occupation with the coordinates of the corresponding point (for this occu-
pation). If the difference is more than 30 meters, the point and GPS occupation
are highlighted in red on the tables, Observation View and Report.

Misnamed Auto-
topo Rovers

When ticked, the application will compare the coordinates of the GPS kin-
ematic occupation with the coordinates of the corresponding point (for this
occupation). If the difference is more than 30 meters, the point and
GPS occupation are highlighted in red on the tables, Observation View and
Report.

Invalid Antenna
Parameters

When ticked, the application will search for an empty Antenna Type or/and
Antenna Height or/and Antenna Height Method fields for the all GPS occu-
pations of the job. If one of the fields is empty, the occupation is highlighted in
red on the GPS Occupations tab and Report.

Refer to "GPS Occupations tab" section on page 133 and "Antenna tab" section
on page 230 for more information.

DL Test

When ticked, the application will compare the precision for digital level meas-
urements with the values that are set at the DL Observation Precisions tab of
the Quality Control item. See "DL Observation Precisions tab" section on
page 120 for details. If the precision for a digital level measurement is worse
than the value in the settings, the DL observation will be highlighted in red in
the DL Obs tab and Report after clicking the Compute Coordinates or the
Adjustment icons.
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Loop Closure Precisions tab
The Loop Closure Precisions tab of the Quality Control item from the Job configuration dialog allows you to set a
threshold value of precision for the Loop Closures test. You can run the Loop Closures test for post-processed
GPS observations that form a loop, by clicking Loop Closures icon from the Adjustment group of the Process tab.
The threshold value (horizontal and vertical) for the test is computed by a formula:

If the residual (in the corresponding plane) after performing the Loop Closures test for the closed figure is worse
than the computed tolerance, the residual will be highlighted in red in the Loop Closures Report.

Fields of the Loop Closure Precision tab of the Quality Control item
Field Description

Horz Tolerance
abs

Defines the current value of the absolute tolerance in the horizontal plane. You
can edit the value. This value is used in the formula for computing the
threshold value. See the formula above.

Vert Tolerance
abs

Defines the current value of the absolute tolerance in the vertical plane. You
can edit the value. This value is used in the formula for computing the
threshold value. See the formula above.

Horz Tolerance
rel

Defines the current value of the relative tolerance in the horizontal plane. You
can edit the value. This value is used in the formula for computing the
threshold value. See the formula above.

Vert Tolerance rel
Defines the current value of the relative tolerance in the vertical plane. You
can edit the value. This value is used in the formula for computing the
threshold value. See the formula above.

Point Precisions tab
The Point Precisions tab of the Quality Control item from the Job configuration dialog allows you to set the
threshold value of horizontal and vertical precisions for the coordinates of points of the processed GPS obser-
vations in static and kinematic modes, and localization points. All values are in the current linear units.
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Fields of the Point Precisions tab of the Quality Control item
Field Description

Static Horizontal
Precision

Defines the current threshold value of the horizontal precision for the pro-
cessed or adjusted or RTK coordinates of the static points. If the horizontal pre-
cision for a point is worse than the value in the settings, the point will be
highlighted in red in the Points tab, Observation View and Reports.

l When you tick the PP Static Precisions checkbox at the Automatic Test
tab, the application will highlight only worse point(s) after post - pro-
cessing the network.

l When you tick the Point Standard Deviations checkbox at the Automatic
Test tab and select the By Quality Control radiobutton in the Rejection
Criterion group box at the General tab of the Adjustment item, the applic-
ation will highlight only worse point(s) after adjusting the post-processed
network and worse Topo point(s) of RTK survey.

Static Vertical Pre-
cision

Defines the current threshold value of the vertical precision for the processed
or adjusted or RTK coordinates of the static points. If the vertical precision for
a point is worse than the value in the settings, the point will be highlighted in
red in the Points tab, Observation View and Reports.

l When you tick the PP Static Precisions checkbox at the Automatic Test
tab, the application will highlight only worse point(s) after post - pro-
cessing the network.

l When you tick the Point Standard Deviations checkbox at the Automatic
Test tab and select the By Quality Control radiobutton in the Rejection
Criterion group box at the General tab of the Adjustment item, the applic-
ation will highlight only worse point(s) after adjusting the post-processed
network and worse Topo point(s) of RTK survey.

Kinematic Hori-
zontal Precision

Defines the current threshold value of the horizontal precision for the pro-
cessed or adjusted or RTK coordinates of the kinematic points. If the hori-
zontal precision for a point is worse than the value in the settings, the point will
be highlighted in red in the Points tab, Observation View and Reports.

l When you tick the PP Kinematic Precisions checkbox at the Automatic
Test tab, the application will highlight only worse point(s) after post -
processing the network.

l When you tick the Point Standard Deviations checkbox at the Automatic
Test tab and select the By Quality Control radiobutton in the Rejection
Criterion group box at the General tab of the Adjustment item, the applic-
ation will highlight only worse point(s) after adjusting the post-processed
network and worse Topo point(s) of RTK survey.
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Field Description

Kinematic Ver-
tical Precision

Defines the current threshold value of the vertical precision for the processed
or adjusted or RTK coordinates of the kinematic points. If the vertical pre-
cision for a point is worse than the value in the settings, the point will be high-
lighted in red in the Points tab, Observation View and Reports.

l When you tick the PP Kinematic Precisions checkbox at the Automatic
Test tab, the application will highlight only worse point(s) after post -
processing the network.

l When you tick the Point Standard Deviations checkbox at the Automatic
Test tab and select the By Quality Control radiobutton in the Rejection
Criterion group box at the General tab of the Adjustment item, the applic-
ation will highlight only worse point(s) after adjusting the post-processed
network and worse Topo point(s) of RTK survey.

Localization Hori-
zontal Precision

Defines the current threshold value of the horizontal precision for the loc-
alization point(s). If the horizontal precision for a localization point is worse
than the value in the settings, the localization point will be highlighted in red in
the Localization window, Map View and Reports after clicking Compute
Parameters in the Localization dialog.

Localization Ver-
tical Precision

Defines the current threshold value of the vertical precision for the localization
point(s). If the vertical precision for a localization point is worse than the value
in the settings, the localization point will be highlighted in red in the Local-
ization window, Map View and Reports after clicking Compute Parameters
in the Localization dialog.

DL Observation Precisions tab
The DL Observation Precisions tab of the Quality Control item from the Job configuration dialog allows you to
set the threshold value of precision for digital level measurements. For selection of the desired precisions you
select the corresponding precision order from the Precision Order / Class drop-down list. Each precision order
(except Custom) has a predefined set of the not editable precision values of the DL observations. All values are in
the current linear units.

Fields of the DL Observation Precisions tab of the Quality Control item
Field Description

Precision
Order
/ Class

Defines the current precision order for digital level measurements. You can select the desired order
from the list. Each precision order (except Custom) has a predefined set of the not editable pre-
cision values of the DL observations in the current linear units.

To create your own set of DL precisions, select Custom from the list and specify any values.

Sighting
Distance
Tolerance

Defines the maximum length of the DL sight.

If the maximum length of a DL observation is greater than the value in the settings and you have
ticked the DL Test checkbox at the Automatic Test tab, the DL observation will be highlighted in red
at the DL Obs tab, Observation View and Report after clicking the Compute Coordinates or the
Adjustment icons.
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Field Description

Sighting
Balance
Tolerance

Defines the maximum difference between the foresight and backsight distances per setup (balance
of sighting).

If a balance of sighting is greater than the value in the settingsand you have ticked the DL Test
checkbox at the Automatic Test tab, the DL observation will be highlighted in red in the DL Obs
tab, Observation View and Report after clicking the Compute Coordinates or the Adjustment
icons.

Sighting
misclosure
Tolerance

Defines the current threshold value of the level measurement precision.

If a level measurement has the precision worse than the Sighting Misclosure Tolerance values and
you have ticked the DL Test checkbox at the Automatic Test tab, a BS or FS observation will be
highlighted in red at the DL Obs tab, Observation View and Report and rejected after adjusting the
DL occupation(s).

Section /
Loop

Distance
Tolerance

Defines the current threshold value of the section/loop distance.

If a distance of the section/loop is greater than the specified value and you have ticked the DL Test
checkbox at the Automatic Test tab, a DL run (DL occupation) will be highlighted in red at the DL
Obs tab after clicking the Compute Coordinates or the Adjustment icons.

Section /
Loop Bal-
ance Tol-
erance

Defines the current threshold value of the balance of the section/loop.

If a balance of the section/loop is greater than the specified value and you have ticked the DL Test
checkbox at the Automatic Test tab, the DL run (DL occupation) will be highlighted in red at the DL
Obs tab after clicking the Compute Coordinates or the Adjustment icons.

Section
misclosure
factor

Defines the current value of the factor in meters, which is used in the calculation of the Section Mis-
closure Tolerance:

If a section misclosure has the precision worse than the specified value and you have ticked the DL
Test checkbox at the Automatic Test tab, the DL run (DL occupation) will be highlighted in red at
the DL Obs tab after clicking the Compute Coordinates or the Adjustment icons.

Loop or
line mis-
closure
factor

Defines the current value of the factor in meters, which is used in the calculation of the Loop Mis-
closure Tolerance:

If a loop misclosure has the precision worse than the Loop Misclosure Tolerance value and you
have ticked the DL Test checkbox at the Automatic Test tab, the DL run (DL occupation) will be
highlighted in red at the DL Obs tab after clicking the Compute Coordinates or the Adjustment
icons.
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Data Views
MAGNET Tools provides several data views for showing, editing and processing data.

l The Tabular view contains tabs representing the different types of information. The data in the job defines
which tabs will be displayed. See "Tabular View" section below for details.

l The Observation View displays a graphic representation of the GPS, RTK, TS and DL survey data in the
horizontal plane of the current coordinate datum or projection. See "Observations View" section on
page 205 for details.

l The Map View displays graphic representation of the points, lineworks, surfaces and roads in the hori-
zontal plane of the current coordinate datum or projection. See "Map View" section on page 205 for details.

l The 3 D View displays points, lines, surfaces, roads and lineworks using a three-dimensional rep-
resentation of the data. See "3D View" section on page 206 for details.

l The Antenna List window displays parameters of all GPS antennas which were calibrated either by NGS,
or TPS. See "Antenna List" section on page 207 for details.

l The TS Instrument window displays Total Station parameters. See "TS Instruments" section on page 209
for details.

l The Classes displays the list of the classes for Total Station measurements. See "Classes View" section on
page 210 for details.

l The Occupation View displays a time-scale graph of the GPS occupations used in the job. See "Occupation
View icon" section on page 44 for details.

l The Ephemeris View displays the list of the ephemeris which were imported to the current project. See
"Ephemeris View icon" section on page 44 for details.

l The Codes view displays the list of codes and their attributes. See "Codes" section on page 214 for details.
l The Layers view displays the list of layers and their plotting styles. See "Layers" section on page 216 for
details.

Tabular View
The Tabular view contains tabs representing the different types of information. The data in the job determines the
tabs that will be displayed. By default these tabs are displayed at the bottom of the MAGNET Tools window.

See the description of each tab in the appropriate section, listed below:
l "Points tab" section on the facing page — this tab always displays.
l "GPS Occupations tab" section on page 133
l "GPS Obs tab" section on page 140
l "TS Obs tab" section on page 148
l "DL Obs tab" section on page 156
l "Lines tab" section on page 159
l "Surfaces tab" section on page 163
l "Roads tab" section on page 165
l "X-Section Templates tab" section on page 196
l "Text tab" section on page 197
l "Inverse tab" section on page 198
l "Field Report tab" section on page 202
l "Compare Surfaces tab" section on page 200
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Points tab

This tab is always presented in the Tabular View. The tab displays the coordinates in the current coordinate sys-
tem and the currents unit, set in the Status Bar. By using the Status Bar you can perform coordinate transformation
to any predefined datum/projection and unit transformation.

You may manually add points right from the tab. To do so:

1. In the bottom row of the table, click .

The row for the new point is displayed.
2. Specify the required parameters and press Enter.

Fields of the Points tab
Field Description

Icon Displays a symbol assigned to a point. See "Symbols for the Points tab" section
on page 390 for details.

Name Displays the point's name. To edit the name, click on the highlighted field and
enter a new name. The point name is unique and the field cannot be empty.

WGS-84 Latitude

Displays the point's latitude coordinate in WGS84 coordinate system. To edit
the value, click on the highlighted field and type a new value.

The coordinates in WGS-84 coordinate system are available whenWGS84 Lat,
Lon, Ell.H is selected in the Status bar or in the Job Configuration dialog.

WGS-84 Longitude

Displays the point's longitude coordinate in WGS84 coordinate system. To edit
the value, click on the highlighted field and type a new value.

The coordinates in WGS-84 coordinate system are available whenWGS84 Lat,
Lon, Ell.H is selected in the Status bar or in the Job Configuration dialog.

WGS-84
Ell.Height

Displays the point's ellipsoidal (geodetic) height in WGS84 coordinate system.
To edit the value, click on the highlighted field and type a new value.

The coordinates in WGS-84 coordinate system are available when "WGS84
Lat, Lon, Ell.H" is selected in the Status bar or in the Job Configuration win-
dow.

X

Displays X coordinate in Cartesian geocentric (WGS-84) coordinate system in
the current units. To edit the value, click on the highlighted field and enter a
new value.

The Cartesian coordinates are available whenWGS84 X, Y, Z is selected in the
Status bar or in the Job Configuration dialog .

Y

Displays Y coordinate in Cartesian geocentric (WGS-84) coordinate system in
the current units. To edit the value, click on the highlighted field and enter a
new value.

The Cartesian coordinates are available whenWGS84 X, Y, Z is selected in the
Status bar or in the Job Configuration dialog .
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Field Description

Z

Displays Z coordinate in Cartesian geocentric (WGS-84) coordinate system in
the current units. To edit the value, click on the highlighted field and enter a
new value.

The Cartesian coordinates are available whenWGS84 X, Y, Z is selected in the
Status bar or in the Job Configuration dialog .

Latitude

Displays the point's latitude coordinate in the selected Datum coordinate sys-
tem. To edit the value, click on the highlighted column and type a new value.

The Datum coordinates are available when Datum Lat, Lon, Ell.H or Datum
Lat, Lon, Elevation is selected in the Status bar or in the Job Configuration dia-
log.

Longitude

Displays the point's longitude coordinate in the selected Datum coordinate sys-
tem. To edit the value, click on the highlighted column and type a new value.

The Datum coordinates are available when Datum Lat, Lon, Ell.H or Datum
Lat, Lon, Elevation is selected in the Status bar or in the Job Configuration dia-
log.

Ell.Height

Displays the point's ellipsoidal height in the selected Datum coordinate system.
To edit the value, click on the highlighted column and type a new value.

The Datum coordinates are available when Datum Lat, Lon, Ell.H is selected
in the Status bar or in the Job Configuration dialog.

Elevation

Displays the point's orthometric height in the selected Datum coordinate sys-
tem, if the corresponding geoid file is added to the job and the geoid covers the
area where the job’s points are located. If the corresponding geoid file is not
added to the job, or it does not cover the desired area, the column will display
ellipsoidal height for all points of the job.

To edit the value, click on the highlighted column and type a new value.

This column will be displayed if you have selected either Ground | None or
Ground | Localization or Grid or Datum Lat, Lon, Elevation coordinate systems
in the Job Configuration dialog or in the Status Bar.

Ground Northing

Displays the point's northing coordinate in Ground coordinates. To edit the
value, click on the highlighted column and enter a new value.

The Ground coordinates are available when Ground | None or Ground | Local-
ization coordinate systems are selected in the Status bar or in the Job Con-
figuration dialog.

Ground Easting

Displays the point's easting coordinate in Ground coordinates. To edit the
value, click on the highlighted column and enter a new value.

The Ground coordinates are available when Ground | None or Ground | Local-
ization coordinate systems are selected in the Status bar or in the Job Con-
figuration dialog.
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Field Description

Grid Northing

Displays the point's northing coordinate in Grid coordinates. To edit the value,
click on the highlighted column and enter a new value.

The Grid coordinates are available when a projection is defined for the job and
Grid coordinate system is selected in the Status bar or in the Job Con-
figuration dialog.

Grid Easting

Displays the point's easting coordinate in Grid coordinates. To edit the value,
click on the highlighted column and enter a new value.

The Grid coordinates are available when a projection is defined for the job and
Grid coordinate system is selected in the Status bar or in the Job Con-
figuration dialog.

Code

Displays codes of the point. If a point has multiple codes, all codes of the point
will be displayed using a comma as separator, for example "1,AA,BB".

To edit a code, click on the highlighted field and either select a new one from
the drop-down list of existing codes; or type a new code(s); or set the Code to
empty.

Control

Displays the status of the point's coordinates. You can select one of the fol-
lowing statuses from the drop-down list:

l None — all coordinates can be changed after adjustment or coordinate
calculation.

l Vertical — the elevation/ellipsoidal height is left unchangeable after
adjustment or coordinate calculation. The symbol is set in the
Icon column for this status.

l Horizontal — the horizontal coordinates are left unchangeable after
adjustment or coordinate calculation.The symbol is set in the
Icon column for this status.

l Both — the horizontal and vertical coordinates are left unchangeable
after adjustment or coordinate calculation.The symbol is set in
the Icon column for this status.

Note Displays any additional notes for the point. To edit the value, click on the high-
lighted field and type any necessary information.

Photo Notes

Displays the number of photo notes per point. This quantity is read-only and
sortable.

You can add/remove/view a picture for the point at the Photo Notes tab of the
Properties window for a point. See "Photo Notes tab" section on page 223 for
details.

Layer
Displays the Layer where the point resides. The Layer sets the plotting
style for the point. Every point has a non-empty Layer. In this field, you can
select any Layer from the list of user-created layers.

Source Displays the path of the raw data on the computer disk drive, local area net-
work, or storage media.
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Field Description

Std Dev n Displays the standard deviation of the northing coordinate for the point after
adjustment in Grid coordinate system.

Std Dev e Displays the standard deviation of the easting coordinate for the point after
adjustment in Grid coordinate system.

Std Dev u Displays the standard deviation of the height coordinate for the point after
adjustment in Grid coordinate system.

Std Dev Hz Displays the standard deviation of the coordinate in the horizontal plane for the
point after adjustment in Grid coordinate system.

String
Displays the string for the point. A complex of strings and codes allows you to
create a line in the job automatically. The software will automatically create a
line between points with the same Code and String value.

Control Code Displays the control code for the point. See "Control Code field" section on the
facing page for details.

Control Code 2 Displays the control code 2 for the point. See "Control Code 2 field" section on
page 129 for details.

Combined Grid to
Ground Scale

Factor

Displays Combined Grid to Ground Scale Factor for the point. The scale factor
applied to convert grid distances to ground distances. Its formula is following:

Where R is the mean Earth radius.

Convergence Displays Convergence for the given point.The convergence is a angle between
geodetic north and grid north.

Color
Displays point color for Map View. The color can be chosen from the list. If
you set BYCODE or BYLAYER, the color of the point automatically will be
set in the color that was selected for the point's code or point's layer.

Point Symbol

Displays a point symbol for Map View. The symbol can be chosen from the
list. If you set BYCODE or BYLAYER, the symbol of the point  will be auto-
matically set to the symbol that was selected for the point's code or the point's
layer.

Geoid Separation

Displays some constant, which is the characteristic of the current geoid model
and is calculated for the given point. To get the orthometric height of the point,
subtract the value of this constant from the value of ellipsoidal height. This
Geoid Separation value is displayed when the corresponding geoid is selected
for this job in the Coordinate System item of the Job Configuration dialog.

Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into two groups:
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l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the Points tab. See "Pop-up menu for the Point tab" section on page 129 for details.

If the corresponding geoid file is added to the job and the geoid covers the area where the job’s points are located,
orthometric heights will be displayed in the Elevation column, when you select Ground or/and Grid or/and Datum
with Elevation coordinate systems in the Job Configuration dialog or in the Status Bar.

If the corresponding geoid file is not added to the job, or it does not cover the desired area, the Elevation column
will display ellipsoidal height for all points of the job.

Control Code field
Displays the control code used for the point. The Control Code list can contain the following codes:

l Codes, created by Topcon programmers (default codes). Using these codes will modify the existing line-
work or add a line to the existing linework. You can apply the control codes only to the points which have
the same Code and String value. You select the following default control code from the list:

l Arc Start
l Arc End
l Close
l Rectangle

l Codes, created by a user. Using these codes do not modify the existing linework.

Let's see how the default code can modify an existing line.

None — does not change an existing linework

Name Code String Control Code

A4 DD 1

A5 DD 1

A6 DD 1

Arc Start — defines the start point of an arc:
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Name Code String Control Code

A4 DD 1 Arc Start

A5 DD 1

A6 DD 1

Arc End — defines an end point of the arc:

Name Code String Control Code

A4 DD 1 Arc Start

A5 DD 1 Arc End

A6 DD 1

Close — automatically add a line to close the figure. This option will work only for a figure that contains more
than two points:

Name Code String Control Code

A4 DD 1

A5 DD 1

A6 DD 1 Close

Rectangle — automatically adds point to close the figure. This option will work only for a figure that contains
three points:
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Name Code String Control Code

A4 DD 1 Rectangle

A5 DD 1

A6 DD 1

The field appears at the Points tab of the tabular view and the Codes and Style tab of the Properties window for a
point.

Control Code 2 field
Control Code 2 displays the control code used for the point. It has the same properties as Control Code. See "Con-
trol Code field" section on page 127 for details. MAGNET Tools allows you to simultaneously use two different
values of Control Code and Control Code 2:

Name Code String Control Code Control Code 2

A4 DD 1 Arc Start

A5 DD 1

A6 DD 1 Close

The field appears at the Points tab of the tabular view and the Codes and Style tab of the Properties window for a
point.

Pop-up menu for the Point tab
In the Point tab of the Tabular view you can highlight a line, right click it and perform the following point-specific
commands:
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l Rename Points — changes the names for the highlighted points. To do so:
1. Select Rename Points.

The Points renaming window is displayed.
2. Change point names by using two following methods:

l Changing the point name. To do so, select the Use starting number radiobutton, and specify
the starting number in the editbox and click OK. The software will automatically:

l alphanumerically sort the selected points
l set this name for the first point of the sorted points
l add the increment 1 to the name of the next point

l Adding a prefix and/or suffix to the existing point's name. To do so, select the Use prefix
and/or suffix radiobutton, and specify the prefix/suffix in the appropriate editbox and click
OK. The software will automatically add the prefix and/or suffix to the existing point names.

IMPORTANT
The points will not be renamed, if the current job already has points with the same names.

l Delete from Surface — deletes the highlighted points from the existing surface. The points will be
removed from the Surface, but still be displayed in the CAD View window:

l Disable/Enable — disables/enables the highlighted points and all related objects from the adjustment, cal-
culating coordinates and export. Disabled points are grayed-out in all views:
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l Add point— adds a new point. See "Point icon" section on page 50 for details
l Add to Surface — this command is available when the job contains a surface. It adds points to an existing
surface.

l Insert Points to Line — this command is available when the job contains a line. It inserts points to an
existing line. See "Insert Point(s) to Line command" section below for details.

l Append Points to Line — this command is available when the job contains a line. It adds points to and
existing line. See "Append Point(s) to Line command" section on the next page for details.

l Zoom the selection— automatically zooms in the highlighted points in the Map View.
l Select Points — opens the Select Point window. In this window you can set different criterions to select
points at this tab. If you apply default set, all points of the job will be selected.

l Report— automatically creates a report for the highlighted points. You can edit this report in Report Con-
figuration window By default this report contains the following information:

l Name
l Coordinates in the current coordinates system
l Code

Insert Point(s) to Line command

This command is available when the job contains a line. To use it, select Insert Point(s) to Line command
in the pop-up menu for the "Points tab" section on page 123 and the "Lines tab" section on page 159.
The function inserts points to a line segment. When inserting a point to a segment, the software deletes the selec-
ted segment between the start point and end point, and creates two new segments: from the start point to the exist-
ing /or a new point and from the existing /or a new point to the end point.

Two options are available for inserting points to the line — either to select the line first and then the point; or to
select the point first, and then the line.

To insert a point to a line, selecting point first:
1. At the Points tab of the Tabular view, highlight the required point.
2. Right click and select the Insert Point(s) to Line command.

The pointer is changed to . The Insert Point(s) to Line panel is displayed above the CAD view.
3. At the Insert Point(s) to Line panel, from the Segment type drop-down list, select the segment type for the

new line.
4. In the CAD view, select a line to which the point should be inserted; or any place to create a line nod here.

The previous segment is deleted and two new segments are created.
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5. Close the Insert Point(s) to Line panel.

To insert a point to a line, selecting line first:
1. At the Lines tab of the Tabular view, highlight the required line.
2. Right click and select the Insert Point(s) to Line command.

The pointer is changed to . The Insert Point(s) to Line panel is displayed above the CAD view.
3. At the Insert Point(s) to Line panel, from the Segment type drop-down list, select the segment type for the

new line.
4. In the CAD view, select a point which should be inserted to the line,

The previous segment is deleted and two new segments are created.

5. Close the Insert Point(s) to Line panel.

Append Point(s) to Line command

This command is available when the job contains a line. To use it, select Append(s) Point to Line command in
the pop-up menu for the "Points tab" section on page 123 and the "Lines tab" section on page 159.

The function adds points to a line segment. Two options are available — either to select the line first and then the
point; or to select the point first, and then the line.

To append a point to a line, selecting point first:
1. At the Points tab of the Tabular view, highlight the required point.
2. Right click and select the Append Point(s) to Line command.

The pointer is changed to . The Append Point(s) to Line panel is displayed above the CAD view.
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3. At the Append Point(s) to Line panel, from the Segment type drop-down list, select the segment type for the
new line.

4. In the CAD view, select a line to which the point should be added; or any place to create a line nod here.

The new segment is created.

5. Close the Append Point(s) to Line panel.

To insert a point to a line, selecting line first:
1. At the Lines tab of the Tabular view, highlight the required line.
2. Right click and select the Append Point(s) to Line command.

The pointer is changed to . The Append Point(s) to Line panel is displayed above the CAD view.
3. At the Append Point(s) to Line panel, from the Segment type drop-down list, select the segment type for the

new line.
4. In the CAD view, select a point which should be added to the line.

The new segment is created.

5. Close the Append Point(s) to Line panel.

GPS Occupations tab

The GPS Occupations tab is displayed in the Tabular View only when the job contains GPS data. It displays the
GPS occupation information. See also "GPS Obs tab" section on page 140.
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Fields of the GPS Occupations tab
Field Description

Icon Displays a symbol assigned to a GPS Occupation. See "Symbols for the GPS
Occupations tab" section on page 392 for details.

Point Name
Displays the name of the occupied point. For all types of the RTK occupation
and for static GPS occupation, this column cannot be empty. To edit the name,
click on the highlighted column and type a new value.

Original Name
Displays the initial name of the occupation as indicated in the source file. The
column cannot be empty for all types of occupation. To edit the name, click on
the highlighted column and type a new value.

Antenna Type

Displays the model of the GPS antenna used for the occupation. To change the
antenna type, click and select other antenna type from the drop-down list. Also
you can create a custom antenna by clicking the Custom button. See "Adding
Custom Antenna Type" section on page 328 for details.

NOTE
If theNone antenna type is selected, the software will use zero values for
A1/A2 parameters and in this case, the antenna phase center for L1 and L2
frequencies coincides with the Antenna Reference Point.

Antenna Height Displays the GPS antenna's height for the occupation, in the current units. To
edit the value, click on the highlighted column and type a new value.

Antenna Height
Method

Displays the method used to measure the antenna height. Select the requiered
method from the drop-down list. The following methods are available:

l Vertical — measured from the ground point to the antenna reference
point (ARP) located on the bottom of the receiver.

l Slant — measured from the ground point to the antenna slant height
measure mark (SHMM).

See Antenna Height picture below.

Antenna Centering
Error

Displays the centering error of Antenna Reference Point (ARP) position over
the mark, in the horizontal plane. This error will be taken into account when
estimating adjustment results. To edit the value, click on the highlighted
column and type a new value.

Start Time Displays the first epoch time of the GPS occupation. The column cannot be
empty.

Stop Time Displays the end epoch time of the GPS occupation. The column cannot be
empty.

Duration Displays the duration of time in which the observational data was logged for
the given GPS occupation (Duration = Stop Time - Start Time).
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Field Description

Method

Displays the surveying method for the occupation. The following methods are
presented for the GPS occupations:

l Base — data collected on the base station during RTK measurements.
l Topo — data collected during static RTK measurements. (The rover
antenna remains motionless during data collection for the point.) The
point name is the name of a ground point. This name is entered manu-
ally.

l AutoTopo — data collected during kinematic RTK measurements. (The
rover antenna is movable during collection data.) The point name is the
name of a current epoch. This name is created by the field software auto-
matically.

l Autonomous — the rover receiver does not receive the correction data
from a base during RTK measurements.

l Static — data collected on the base or rover receiver during static GPS
measurements. (The GPS antenna of the base / rover receiver remains
motionless during data collection for the point.) The point name is the
name of a ground point.

l Stop — data collected on the rover receiver during static part of the Stop
and Go measurements. (The GPS antenna of the rover receiver remains
motionless during data collection for the point.) The point name is the
name of a ground point.

l Go — data collected on the rover receiver during kinematic part of the
Stop and Go measurements. (The rover antenna is movable during col-
lection data.) The point name is empty.

l Kinematic — data collected on the rover receiver during kinematic
measurements. (The rover antenna is movable during collection data.)
The point name is empty.

Note Displays any additional notes for the selected GPS occupation. To edit the
value, click on the highlighted field and enter your comments, if necessary.

Source Displays the path of the raw data to the computer disk drive, local area net-
work, or storage media.

NEpoch Displays the number of epochs for the given occupation.

Interval Displays the occupation logging interval, in milliseconds.

GPS week, day Displays GPS week and day of occupation start time (the time from January, 6
1980: the day of GPS launch). The column cannot be empty.

Receiver Displays the receiver's serial number.

Receiver's Vendor

Displays the name of the vendor which developed this GPS receiver. You can
select a desired company from the list. This selects a vendor of the receiver to
accommodate differences in post - processing of the GLONASS measurements
by different companies.

H RMS Displays the horizontal precision estimate of the GPS occupation in the current
linear units.



Data Views

136

Field Description

V RMS Displays the vertical precision estimate of the GPS occupation in the current
linear units.

Azimuth

Displays the horizontal angle to the offset point, in current angular units. The
field displays non-zero values when the imported MAGNET Field job contains
Azimuth & Offsets data and this offset was performed from the measured
point. See "Editing and viewing MAGNET Field Offsets in the Job" section on
page 345 and Azimuth and Offset picture below for details. To edit the para-
meter, click on the highlighted column and type a new value.

Offset Dist

Displays the distance from the Start Point to the offset point, in current linear
units. The field displays non-zero values when the imported MAGNET Field
job contains Azimuth & Offsets data and this offset was performed from the
measured point. See "Editing and viewing MAGNET Field Offsets in the Job"
section on page 345 and Azimuth and Offset picture below for details. To edit
the parameter, click on the highlighted column and type a new value.

Offset Ht

Displays the height difference between the ground point and the offset point, in
curreknt linear units.

The field displays non-zero values when the imported MAGNET Field job con-
tains Azimuth & Offsets data and this offset was performed from the measured
point. See "Editing and viewing MAGNET Field Offsets in the Job" section on
page 345 and Azimuth and Offset picture below for details. To edit the para-
meter, click on the highlighted column and type a new value.

Antenna Height

Azimuth and Offset
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Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands. They can be
divided into two groups:

l Common commands for all tabs of the Tabular View. See Common pop-up menu of the Tabular View for
details.

l Specific commands for the GPS Occupations tab. See "Pop-up menu for the GPS Occupations tab" section
below for details.

Pop-up menu for the GPS Occupations tab
In the GPS Occupations tab you can perform the special (only for GPS occupation) commands:

l Decimation— changes the record interval of a selected non-RTK GPS occupation for a greater fixed
value, such as 5, 10, 15, 30 and 60 sec. In the process of decimation the first epoch in the created file has
to be a multiple of the selected interval.

For example, it is needed to change the record interval of the file with 1 sec interval to 10 sec interval. The
start time of the original file is 12:22:11 and final 12:22: 59. The first epoch in the created file will be recor-
ded at 12:22:20 and the final epoch - at 12:22:50. To decimate an occupation:

1. Right click the required occupation
2. Select Decimation from the pop-up menu.

The Decimation of Occupation dialog is displayed.
3. From the Interval drop-down list, select the required interval.
4. Click OK.

The original occupation are replaced with the created one.
l Merge — merges two and more selected non-RTK GPS occupations. This operation will be done when the
following rules for selected occupations are met:

l one type occupation (either kinematic or static)
l static occupations correspond to the same point
l kinematic occupations belong to the same Stop and Go file
l occupations have the same record interval
l occupations have the same antenna type
l occupations have the same receiver ID
l occupations have the same antenna height type
l occupations have the same offsets in the horizontal and vertical planes

To merge GPS occupations:
1. Select the required occupations.
2. Right click and selectMerge from the pop-up menu.

The Merge GPS Occupations dialog is displayed.
3. In the Merged GPS Occupations name editbox, type the name for merged occupation.
4. Click OK.

Occupations are merged.
l Split— splits a selected non-RTK GPS occupation. Depends on the occupation duration and the number of
epochs, the following ways for dividing can be used — by time, by duration, by hour and by day.

l by time — if the occupation has more than one epoch, you can divide the selected occupation by
time. By default, this time is equal to half of the time of the occupation. To split an occupation by
time:
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1. Select the required occupations.
2. Right click and select Split from the pop-up menu.

The Split GPS Occupations dialog is displayed.
3. From the Split by: drop-down list, select Time.
4. In the Split Time filed specify the start time of the new GPS occupation.
5. Click OK.

Occupation is split. Two occupations are created. The Occupation tab displays two occu-
pations instead of the original occupation. The original occupation names for the created occu-
pations are “<original occupation name>(Head)” and “<original occupation name>(Tail)”. All
created occupation will have the same occupation name.

l by duration — if the occupation duration is more than 1 minute, you can divide the selected occu-
pation by duration. You can edit the split duration in the corresponding field. After clicking OK in
the Split GPS Occupation window, N +1 occupations will be created, where N is integer part of the
formula "Occupation duration (in minutes) / split duration value (in minutes)". The duration of the
created occupation is equal to the split duration value (except the last occupation). The Occupation
tab displays N+1 occupations instead of the original occupation. The originaloccupation names for
the created occupations are “<original occupation name>(Head)” , and from “<original occupation
name>(Tail_1)” to “<original occupation name>(Tail_N)”

1. Select the required occupations.
2. Right click and select Split from the pop-up menu.

The Split GPS Occupations dialog is displayed.
3. From the Split by: drop-down list, select Duration.
4. In the Split Duration filed specify the duration of the new GPS occupation.
5. Click OK.

Occupation is split. In the Split GPS Occupation window, N +1 occupations will be created,
where N is integer part of the formula "Occupation duration (in minutes) / split duration value
(in minutes)". The duration of the created occupation is equal to the split duration value
(except the last occupation). The Occupation tab displays N+1 occupations instead of the ori-
ginal occupation. The original occupation names for the created occupations are “<original
occupation name>(Head)” , and from “<original occupation name>(Tail_1)” to “<original
occupation name>(Tail_N)”

l by hour — if the occupation duration is more than 1 hour or occupation time includes the moment
HH:00:00 for the occupation with duration less than one hour, you can divide the selected occupation
by hour. To do so:

1. Select the required occupations.
2. Right click and select Split from the pop-up menu.

The Split GPS Occupations dialog is displayed.
3. From the Split by: drop-down list, select Hour.
4. Click OK.

The occupation is splited. In the Split GPS Occupation window, either N, or N+1 or N+2 occu-
pations will be created, where N is integer part of the formula "Start Time of the selected
occupation (in hour) / Stop Time of the selected occupation (in hour)". The duration of the cre-
ated occupation is equal to one hour (except the first and last occupation). The start / stop
time of these occupations (except the first and last occupations) will be equal to the full hour.
The Occupation tab displays these occupations instead of the original occupation. The
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originaloccupation names for the created occupations are “<original occupation name>
(Head)” , and from “<original occupation name>(Tail_1)” to “<original occupation name>
(Tail_N)”.

l by day — if the occupation duration is more than 1 day or occupation time includes the moment
00:00:00 for the occupation with duration less than one day, you can divide the selected occupation
by day. To do so:

1. Select the required occupations.
2. Right click and select Split from the pop-up menu.

The Split GPS Occupations dialog is displayed.
3. From the Split by: drop-down list, select Hour.
4. Click OK.

The occupation is split. In the Split GPS Occupation window, either N, or N+1 or N+2 occu-
pations will be created, where N is integer part of the formula "Start Time of the selected
occupation (in day) / Stop Time of the selected occupation (in day)". The duration of the cre-
ated occupation is equal to one day (except the first and last occupation). The start / stop time
of these occupations (except the first and last occupations) will be equal to 00:00:00. The
Occupation tab displays these occupations instead of the original occupation. The originaloccu-
pation names for the created occupations are “<original occupation name>(Head)” , and from
“<original occupation name>(Tail_1)” to “<original occupation name>(Tail_N)” .

l Disable — disables the highlighted GPS occupation and the corresponding GPS observation where the
given GPS occupation is used; from the adjustment, calculating coordinates and export. Disabled GPS occu-
pation and GPS observation are grayed-out in all views.

l Enable — enables the highlighted GPS occupation and the corresponding GPS observation where the given
GPS occupation is used; for the adjustment, calculating coordinates and export.

l Show related objects — shows the list of tabs (Points tab and GPS Observations tab), where the objects
(in the given case - points and GPS observations) can be displayed. After selecting the desired tab, the
object is selected in the given tab.

l RawData Plot— opens a graphic raw data view. You may configure various combinations of displaying.
To view raw data:

1. Select the required occupation.
2. Right click and select RawData Plot.

The Select Plot: Functions dialog is displayed.
3. Select the information for X- and Y-axis from the appropriate drop-down lists.
4. Click Next.

The RawData Plot view is opened.
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l Epoch View — opens the Epoch View window for non-RTK GPS occupation. This window contains all
raw data available for the given occupation in the text format. There are two panels in the window. The left
panel displays all collected epochs for the occupation. For each epoch you can see: date and time, coordin-
ates in the cartesian system (WGS84), the receiver clock offsets (in seconds), the components of velocity
for each axis (in m/sec), the position dilution of precision, the common number of the obtained satellites
(GPS, Glonass, Galileo, SBAS, QZSS, BDS), and solution type. Solution type for an occupation can be:

l Hardware, Standalone
l Hardware, Code Differential
l Hardware, Phase differential float
l Hardware, Phase differential fixed

For the selected epoch in the left panel, the right panel displays satellite number, type of slot (for L1
receiver displays only CA, for L1&L2 receiver – CA, L1P, L2P), elevation angle, the channel signal
to noise ratios relating to the delay lock loops (in dB*Hz’s), the pseudorange (in meter) and carrier
phase for each slot, the doppler shifts for L1 and L2, the smoothing correction (in meters) to the
pseudo range measured.

NOTE
The coordinate values recorded in the header of the RINEX file will display for every epoch in the
left panel of the window.

l Select GPS Occupation— opens the Select GPS Occupations window. In this window you can set dif-
ferent criterions to select GPS occupation in this tab. If you apply default set, all GPS occupations of the
job will be selected.

l Convert to static — converts a kinematic occupation to static occupation. This command will be available
only for kinematic GPS (not RTK) occupation.

l Convert to kinematic — converts a static occupation to kinematic occupation. This command will be avail-
able only for static GPS (not RTK) occupation.

GPS Obs tab

The GPS Obs tab is shown only if the job contains GPS data. The tab displays the values in the current unit, set in
the Status Bar. The tab displays the GPS observation (vector) information. See also "GPS Occupations tab" sec-
tion on page 133.

Fields of the GPS Obs tab
Field Description

Icon Displays a symbol assigned to a GPS Observation. See "Symbols for the GPS
Obs tab" section on page 393 for details.

Point From
Displays the name of the base station point for GPS observation (vector). The
column cannot be empty. You can edit the name only at the GPS Occupation
tab.

Point To
Displays the name of the rover station point for GPS observation (vector). The
column cannot be empty. You can edit the name only in the GPS Occupation
tab.
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Field Description

Start Time Displays the first epoch time of common interval for the GPS observation (vec-
tor). The column cannot be empty.

End Time Displays the end epoch time of common interval for the GPS observation (vec-
tor). The column cannot be empty.

Duration Displays duration of common time interval for base and rover occupations for
the given GPS observation (Duration = Stop Time - Start Time).

Note Displays any additional notes for the selected GPS observation. To edit the
value, click on the highlighted field and enter comments, if necessary.

GPS Week, Day Displays GPS week and day of observation start time (the time from January, 6
1980: the day of GPS launch). The column cannot be empty.

Method

Displays the observation method. The following methods are presented:
l RTK Topo — an RTK observation is created from a Base and aTopo
occupations

l RTK Auto Topo — an RTK observation is created from a Base and a
AutoTopo occupations

l PP — an observation is created from two Static occupations
l PP Stop — an observation is created from one Static and one Stop occu-
pations

l PP Go — an observation is created from one Static and one Go occu-
pations

l PP Kinematic — an observation is created from one Static and one
Kinematic occupations.

Horizontal Pre-
cision

Displays the horizontal precision estimate of the GPS observation, in current
linear units.

Vertical Precision Displays the vertical precision estimate of the GPS observation, in current lin-
ear units.
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Field Description

Solution Type

Displays the type of solution for RTK and GPS observations.

For RTK vectors or trajectory:
l Fixed, Phase Diff— the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) of the base (or VRS) and a rover. All ambiguities have been
fixed to integers.

l Fixed, Phase Diff, mmGPS+— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS), a rover and mmGPS aided
rover receiver. All ambiguities have been fixed to integers.

l Fixed, Phase Diff, Degraded— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS) and a rover with the spe-
cified level of vertical/horizontal positional accuracy in the rover
receiver's option. All ambiguities have been fixed to integers.

l Fixed, Phase Diff, Degraded, mmGPS+— the solution is computed by
using dual frequency measurements (L1/L2 GPS/GLONASS code and
carrier phase measurements) of the base (or VRS) and a rover with the
specified level (in the rover receiver's option) of vertical/horizontal pos-
itional accuracy, and the mmGPS aided. All ambiguities have been fixed
to integers.

l Float, Phase Diff— the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) of the base (or VRS) and a rover. All ambiguities are float
numbers.

l Float, Phase Diff, mmGPS+— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS), a rover and mmGPS aided
rover receiver. All ambiguities are float numbers

l Float, Phase Diff, Degraded— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS) and a rover with the spe-
cified level (in the rover receiver's option) of vertical/horizontal pos-
itional accuracy. All ambiguities are float numbers.

l Float, Phase Diff, Degraded, mmGPS+— the solution is computed by
using dual frequency measurements (L1/L2 GPS/GLONASS code and
carrier phase measurements) of the base (or VRS) and a rover with the
specified level (in the rover receiver's option) of vertical/horizontal pos-
itional accuracy. The mmGPS aided rover receiver. All ambiguities are
float numbers.

l Code Diff— the solution is computed by using L1/L2 GPS/GLONASS
code measurements when positioning.

For GPS observation:
l Fixed, L1— the solution is computed by using L1 frequency meas-
urements (L1 GPS/GLONASS code and carrier phase measurements).
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Field Description

All ambiguities have been fixed to integers.
l Fixed,L2— the solution is computed by using L2 frequency meas-
urements (L2 GPS/GLONASS code and carrier phase measurements).
All ambiguities have been fixed to integers.

l Fixed— the solution is computed by using dual frequency meas-
urements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length is shorter than 10 km. L1 and L2
observables will be treated by the engine as independent data sets. All
ambiguities have been fixed to integers.

l Fixed, IonoFree — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with
dual frequency measurements, ionofree combinations will be created
and ionospheric error is eliminated. All ambiguities have been fixed to
integers.

l Fixed, Wide Lane — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements
integer ambiguity resolution for L1 and L2 observables is performed
with assistance of L1-L2 (Wide Lane) combination. All ambiguities
have been fixed to integers.

l VLBL— the solution is computed by using dual frequency meas-
urements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for very long baselines using triple differences (No ambiguity
resolution).

l Float, L1— the solution is computed by using L1 frequency meas-
urements (L1 GPS/GLONASS code and carrier phase measurements).
All ambiguities are float numbers.

l Float, L2— the solution is computed by using L2 frequency meas-
urements (L2 GPS/GLONASS code and carrier phase measurements).
All ambiguities are float numbers.

l Float— the solution is computed by using dual frequency measurements
(L1/L2 GPS/GLONASS code and carrier phase measurements) for GPS
observation length is shorter than 10 km. L1 and L2 observables will be
treated by the engine as independent data sets. All ambiguities are float
numbers.

l Float, IonoFree — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with
dual frequency measurements, ionofree combinations will be created
and ionospheric error is eliminated. All ambiguities are float numbers.

l Float, Wide Lane — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
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Field Description

urements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements
integer ambiguity resolution for L1 and L2 observables is performed
with assistance of L1-L2 (Wide Lane) combination. All ambiguities are
float numbers.

l Code Diff— the solution is computed by using L1/L2 GPS/GLONASS
code measurements only.

l Failed, No Ephemeris— the GPS observation is not processed; the cor-
responding navigation file is absent,

l Failed, No Satellites— the GPS observation is not processed; the data
from satellites are absent.

Epochs Displays number of epochs in the common data time interval.

Orbit

Displays the ephemerides are used for processing the given GPS observation:
l Broadcast — for RTK and GPS observations, when only broadcast eph-
emerides were used.

l Precise — for GPS observations only, when only precise ephemerides
were used.

l Absent — for GPS observations only.

If the ephemerides are absent for the GPS observation time interval, the given
GPS observation are not post-processed.

GPS Satellites Displays the number of GPS satellites. It is the maximum number of common
GPS satellites observed by the base and rover in the common interval.

GLONASS Satel-
lites

Displays the number of GLONASS satellites. It is the maximum number of
common GLONASS satellites observed by the base and rover in the common
interval.

PDOP
Displays the average value of total position dilution of precision (PDOP) for
common epochs interval. PDOP is equal to square root of sum-of-squares of
the HDOP and VDOP values.

HDOP Displays the average value of position dilution of precision in the horizontal
plane (HDOP), for common epochs interval.

VDOP Displays the average value of position dilution of precision in the vertical plane
(VDOP), for common epochs interval.

dX Displays the GPS observation's dX component (in Cartesian geocentric coordin-
ate system), in current units.

dY Displays the GPS observation's dY component (in Cartesian geocentric coordin-
ate system), in current units.

dZ Displays the GPS observation's dZ component (in Cartesian geocentric coordin-
ate system), in current units.

dN Displays the GPS observation's dN component (in topocentric coordinates), in
current units.
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dE Displays the GPS observation's dE component (in topocentric coordinates), in
current units.

dHt Displays the GPS observation's vertical component (in topocentric coordin-
ates), in current units.

Azimuth Displays the GPS observation azimuth.

Elevation Angle Displays the GPS observation's elevation angle.

Distance Displays the GPS observation's distance, in current units.

Res X Displays the residual of the X component (in Cartesian geocentric coordinate
system) of the GPS observation after adjustment.

Res Y Displays the residual of the Y component (in Cartesian geocentric coordinate
system) of the GPS observation after adjustment.

Res Z Displays the residual of the Z component (in Cartesian geocentric coordinate
system) of the GPS observation after adjustment.

Res n Displays the residual of the n component (in topocentric coordinates) of the
GPS observation after adjustment.

Res e Displays the residual of the e component (in topocentric coordinates) of the
GPS observation after adjustment.

Res u Displays the residual of the u component (in topocentric coordinates) of the
GPS observation after adjustment.

Res D Displays the residual of the GPS observation's distance after adjustment.

Res A Displays the linear residual of the GPS observation's azimuth after adjustment.
See Azimuth residual picture below.

Res El Displays the residual of the GPS observation's elevation after adjustment.

Base Antenna
Type

Displays the model of the GPS antenna used at the base. To change the
antenna type, click and select other antenna type from the drop-down list. Also
you can create a custom antenna by clicking the Custom button. See "Adding
Custom Antenna Type" section on page 328 for more details.

NOTE
If the None antenna type is selected, the software will use zero values for
A1/A2 parameters, and in this case, the antenna phase center for L1 and L2
frequencies coincides with the Antenna Reference Point.

Base Antenna
Height

Displays the GPS antenna's height at the base station, in current units. To edit
the value, click on the highlighted column and enter a new value.

Base Antenna
Height Method

Displays the method used to measure the antenna height. You can change the
type of the method (slant or vertical) with the help of the drop-down list. See
picture Base Antenna Height Method below for details.

l Vertical— measured from the ground point to the antenna reference
point (ARP) located on the bottom of the receiver.

l Slant— measured from the ground point to the antenna slant height
measure mark (SHMM).
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Field Description

Rover Antenna
Type

Displays the model of the GPS antenna used for the rover. To change the
antenna type, click and select other antenna type from the drop-down list. Also
you can create a custom antenna by clicking the Custom button. See "Adding
Custom Antenna Type" section on page 328 for more details.NOTE: If the
None antenna type is selected, the software will use zero values for A1/A2
parameters and in this case the antenna phase center for L1 and L2 frequencies
coincides with the Antenna Reference Point.

Rover Antenna
Height

Displays the GPS antenna's height for the rover in the current units. To edit the
value, click on the highlighted column and enter a new value.

AutoReject

In this field you can select the status of the given GPS observation for adjust-
ment:

l Allowed— the GPS observation will be used in adjustment.
l Not Allowed— the GPS observation will not be used in adjustment.

Adjustment Status

Displays the status of the given GPS observation after adjustment:
l Not Adjusted— the GPS observation is not adjusted.
l Adjusted— the GPS observation is adjusted.
l AutoRejected— the GPS observation is not adjusted, because the vector
had the status Not Allowed before the adjustment procedure.

l Disable — the GPS observation is not adjusted, because the vector was
disabled before the adjustment procedure.

Engine/Mode

Display the Engine Type and Engine Mode that were selected in the GPS+
PostProcess (the Engine tab) Process sub-menu option for last post-processing
of the GPS observation.

This field relates to the post-processed GPS observation only. For RTK GPS
observation, the field is empty

Elevation Mask

Displays an elevation cut-off angle (in degrees) for satellites used in data pro-
cessing. This parameter was entered in the GPS+ PostProcess (the General
tab) Process sub-menu option for the last post-processing of the GPS obser-
vation.

This field relates to the post-processed GPS observation only. For RTK GPS
observation, the field is empty

Satellite System

Displays the navigation system (either GPS and GLONASS or only GPS satel-
lites) that is used for postprocessing the GPS observation. This selection was
entered in the GPS+ PostProcess (the General tab) Process sub-menu option
for the last post-processing of the GPS observation.

This field relates to the post-processed GPS observation only. For RTK GPS
observation, the field is empty

Troposphere
Model

Displays the current Troposphere model. This model was entered in the GPS+
PostProcess (the Troposphere tab) Process sub-menu option for the last post-
processing of the GPS observation.

This field relates to the post-processed GPS observation only. For RTK GPS
observation, the field is empty
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Field Description

Meteo Model

Displays the current Meteo model. This model was entered in the GPS+
PostProcess (the Troposphere tab) Process sub-menu option for the last post-
processing of the GPS observation.

This field relates to the post-processed GPS observation only. For RTK GPS
observation, the field is empty

Constant Zenith
delay (hours)

Displays the period of time in hours (defined by the user in the Troposphere tab
of the Process sub-menu) during which the zenith delay is applied as constant.

This field relates to the post-processed GPS observation only. For RTK GPS
observation, the field is empty

Azimuth residual

Base antenna height method

NOTE 2
Zero value in the Res fieldsmeans that the GPS observation is included in the unclosed network, and
does not contain repeatedGPS observations.

Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into two groups:
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l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the GPS Obs tab. See "Pop-up menu for the GPS Obs tab" section below for
details.

Pop-up menu for the GPS Obs tab
In GPS Obs tab you can perform the special (only for GPS observation) commands:

l Disable/ Enable — allows disable/enable the highlighted GPS observations from the adjustment, cal-
culating coordinates and export. Disabled GPS observation is grayed-out in all views.

l Select GPS Obs — opens the Select GPS Obs dialog. In this dialog you can set different criterions to
select GPS observations in this tab. If you apply default set, all GPS observations of the job will be selec-
ted.

l Compute Coordinate — this command activates function of calculating coordinate the rover points from
the corresponding base of the highlighted GPS observations.

l Report— automatically creates a report for the highlighted GPS observations. You can edit this report in
Report Configuration window. By default it contains the following information:

l Base station name
l Rover station name
l components of the GPS observations in topocentric coordinates
l Horizontal and vertical precessions in the current units.

TS Obs tab

The TS Obs tab is displayed only if the job contains TS raw data. The TS Obs tab displays a table containing two
panels. The left panel contains all TS occupations, and the right panel displays all TS observations from the selec-
ted occupation.

You may manually add TS observations right from the tab. To do so:
1. In the left panel of the tab, select the required TS occupation.

2. In the bottom row of the right panel's table, click .

The row for the new observation is displayed.
3. Specify the required parameters and press Enter.

Fields of the left panel
Field Description

Icon Displays a symbol assigned to a TS Occupation. See "Symbols for the left
panel of the TS Obs tab" section on page 394 for details.

# Displays the number of a TS occupation contained in the raw file. You can set
any number from the list.

Point Name Displays the name of the point where the Total Station was set. You can set
any point's name from the list.
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Field Description

Instrument Height
Displays the instrument height — the vertical distance from the Instrument
Center Mark to the ground, in current linear units. To edit the value, click on
the highlighted field and enter a new value.

Instrument Type

Displays the Instrument Type for the given TS occupation. To change the instru-
ment type, click and select other instrument type from the drop-down list. Also
you can create a custom instrument type by clicking the Custom button. See
"Adding TS Instrument Type" section on page 331 for details.

Instrument
Centering Error

Displays the error of centering the Total Station position over the mark. This
error will be taken into account during adjustment of the network with the
given TS occupation. To edit the value, click on the highlighted field and enter
a new value.

Instrument Height
Error

Displays the measurement error of the Total Station height over the mark. This
error will be taken into account during adjustment of the network with the
given TS occupation. To edit the value, click on the highlighted field and enter
a new value.

Reflector Cen-
tering Error

Displays the error of centering the reflector position over the mark. This error
will be taken into account during adjustment of the network with the given TS
occupation. To edit the value, click on the highlighted field and enter a new
value.

Reflector Height
Error

Displays the measurement error of the reflector height over the mark. This
error will be taken into account during adjustment of the network with the
given TS occupation. To edit the value, click on the highlighted field and enter
a new value.

Fields of the right panel
Field Description

Icon Displays a symbol assigned to a TS Observation. See "Symbols for the right
panel of the TS Obs tab" section on page 394 for details.

# Displays the number of the TS observation contained in the raw file.

Point From Displays the date and time of the total station measurement. You cannot edit
this field.

Code

Displays code of the TS observation. A TS observation can have only one
code. To edit the code, click on the highlighted field and select a new one from
the drop-down list of existing codes or enter a new codes, or remove the Code
and leave the field empty.

String

Displays the string for the TS observation. The string entered for a TS occu-
pation is automatically displayed as string for the corresponding point in the
Points tab. Using a complex of string and codes allows you to automatically
create a line in the job. The software will automatically create a line between
points with the same Code and String values.

Control Code Displays the control code for the TS observation. See "Control Code field" sec-
tion on page 152 for details.
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Field Description

Control Code2 Displays the second control code for the TS observation. See "Control Code2
field" section on page 154 for details.

Source Displays the path of the raw data on the computer disk drive, local area net-
work, or storage media.

Point To Displays the name of the point at which the reflector was set. You can set any
point's name from the list.

Type Displays the current type of the Total Station occupation. See "Type field" sec-
tion on page 154 for details.

Reflector Height
Displays the vertical distance from the center of the prism to a ground point, in
current linear units. To edit the value, click on the highlighted field and enter a
new value.

Azimuth

Displays the azimuth value that defines orientation of TS measurements by
backsight from the station in the horizontal plane. The field displays non-zero
values only for BKB type. If you set a point as backsight in the field, the azi-
muth value is calculated using the coordinates of the station point and the back-
sight point. In this case, you cannot edit the azimuth value. If you set an
azimuth as backsight, in the field, then you directly enter the azimuth value. In
this case, you can edit the azimuth value in the software.

The software allows editing the azimuth value for BKB observation type only
if the Point To field is empty.

Horizontal Circle

For the SS, FS, Horizontal Resection/Vertical Resection/Resection types of
Total Station observation, the field displays the measured horizontal angle from
the previous to the next observation. For BKB type, the field displays the hori-
zontal circle reading when pointing to the backsight point. You cannot edit this
parameter.

Zenith Angle Displays the vertical angle to the reflector measured from zenith. You cannot
edit this parameter.

Slope Distance Displays the slope distance between the TS station (Point From) and the TS
occupation (Point To). You cannot edit this parameter.

Vertical Angle Displays the vertical angle to the reflector measured from horizon. You cannot
edit this parameter.

Horizontal
Distance

Displays the distance between the TS station (Point From) and the TS occu-
pation (Point To) in the horizontal plane. You cannot edit this parameter.

Vertical Distance Displays the distance between the TS station (Point From) and the TS occu-
pation (Point To) in the vertical plane. You cannot edit this parameter.

Note Displays any additional TS occupation's note. To edit the note, click on the
highlighted field and enter comments, if needed.
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Field Description

Offset Along

Displays the distance from the "To Point" to the projection of the offset point
along the line "From Point-To Point", in current linear units. The field displays
non-zero values when the imported MAGNET Field job contains the Distance
Offset and the Line Offset. See "Editing and viewing MAGNET Field Offsets
in the Job" section on page 345 for details. To edit the value, click on the high-
lighted filed and enter a new value.

Offset Across

Displays the distance from the offset point to the line "From Point-To Point", in
current linear units. The field displays non-zero values when the imported
MAGNET Field job contains the Distance Offset and the Line Offset. See
"Editing and viewing MAGNET Field Offsets in the Job" section on page 345
for details. To edit the value, click on the highlighted filed and enter a new
value.

Offset Ht

Displays the height difference between the ground point or the top of "To
Point"and the offset point, in current linear units. The field displays non-zero
values when the imported MAGNET Field job contains the Distance Offset
and the Line Offset. See "Editing and viewing MAGNET Field Offsets in the
Job" section on page 345 for details. To edit the value, click on the highlighted
filed and enter a new value.

Offset Type
Displays the current type of the given offset. For the Distance Offset and the
Line Offset created in MAGNET Field, you see "From Observation Line"
type.

AutoReject

In this field you can select the status of the given TS observation for Adjust-
ment:

l Allowed - the TS observation will be used in Adjustment.
l Not Allowed - the TS observation will not be used in Adjustment.

Adjustment Status

Displays the status of the given TS observation after Adjustment:
l Not Adjusted - the TS observation is not adjusted.
l Adjusted - the TS observation is adjusted.
l AutoRejected - the TS observation is not adjusted, because the vector
had the status Not Allowed before the adjustment procedure.

l Disable - the TS observation is not adjusted, because the vector was dis-
abled before the adjustment procedure.

SDist Residual Displays the residual of the slope distance after adjustment for both enabled
and disabled TS observations.

HAngle Residual Displays the residual of the horizontal angle after adjustment for both enabled
and disabled TS observations.

Azimuth Residual Displays the residual of azimuth after adjustment for both enabled and disabled
TS observations.

VAngle Residual Displays the residual of the vertical angle after adjustment for both enabled
and disabled TS observations.

ZAngle Residual Displays the residual of the zenith angle after adjustment for both enabled and
disabled TS observations.
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Field Description

HDist Residual Displays the residual of the horizontal distance after adjustment for both
enabled and disabled TS observations.

VDist Residual Displays the residual of the vertical distance after adjustment for both enabled
and disabled TS observations.

Cross Residual Displays the residual of the horizontal angle represented in the linear measure
after adjustment for both enabled and disabled TS observations.

Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into three groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the left panel of the TS Obs tab. See "Pop-up menu for the left panel of the TS Obs
tab" section on page 155,

l Specific commands for the right panel of the TS Obs tab. See "Pop-up menu for the right panel of the TS
Obs tab" section on page 156 for details.

Control Code field
The Control Code list can contain the following codes:

l Codes, created by Topcon programmers (default codes). Using these codes will modify the existing line-
work or add a line to the existing linework. You can apply the control codes only to the points which have
the same Code and String value. You select the following default control code from the list:

l Arc Start
l Arc End
l Close
l Rectangle

l Codes, created by a user. Using these codes do not modify the existing linework.

Let's see how the default code can modify an existing line.

None — does not change an existing linework

Name Code String Control Code

A4 DD 1

A5 DD 1

A6 DD 1

Arc Start — defines the start point of an arc:
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Name Code String Control Code

A4 DD 1 Arc Start

A5 DD 1

A6 DD 1

Arc End — defines an end point of the arc:

Name Code String Control Code

A4 DD 1 Arc Start

A5 DD 1 Arc End

A6 DD 1

Close — automatically add a line to close the figure. This option will work only for a figure that contains more
than two points:

Name Code String Control Code

A4 DD 1

A5 DD 1

A6 DD 1 Close

Rectangle — automatically adds point to close the figure. This option will work only for a figure that contains
three points:



Data Views

154

Name Code String Control Code

A4 DD 1 Rectangle

A5 DD 1

A6 DD 1

The field appears it the right panel of the TS Obs tab and the General tab of the Properties dialog for the right
panel of the TS Obs tab.

Control Code2 field
Control Code 2 displays the control code used for the TS observation. It has the same properties as Control Code.
See "Control Code field" section on page 152 for details. MAGNET Tools allows you to simultaneously use two
different values of Control Code and Control Code 2:

Name Code String Control Code Control Code 2

A4 DD 1 Arc Start

A5 DD 1

A6 DD 1 Close

The field appears it the right panel of the TS Obs tab and the General tab of the Properties dialog for the right
panel of the TS Obs tab.

Type field
Displays the current type of the Total Station occupation. The types can be divided into two groups:

The types which can be replaced by the other type from the list in the MAGNET Tools:
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l SS (side shot) — the measurement from the station to the reflector. This measurement contains the hori-
zontal and vertical angles and slope distance data.

l BS (backsight) — can be used in two cases:
l The start measurement which used as a reference line for orientation of the further measurements
from the station together with BKB. This measurements can contain the vertical angle and slope dis-
tance data.

l The measurement to the previous occupation point in traverse survey. This measurements can con-
tain the horizontal and vertical angles and slope distance data.

l FS (foresight) — the measurement to the next occupation point in traverse survey. This measurements can
contain the horizontal and vertical angle and slope distance data.

l Resection — the measurement from an unknown point at which the total station is set to the known point.
This measurements can contain the horizontal and vertical angle and slope distance data.

l Horizontal Resection — the measurement from an unknown point at which the total station is set to the
known point. This measurements can contain the horizontal angle data.

l Vertical Resection — the measurement from an unknown point which the total station is set to the known
point. This measurements can contain the vertical angle data.

The types which cannot edited in the MAGNET Tools. See "Editing and viewing MAGNET Field Offsets in the
Job" section on page 345 for details.

l BKB ( backsight bearing point) — the start measurement used as a reference line for orientation of next
measurements from the station. This measurements contain the horizontal angle data.

l Side — the measurement from the station to the reflector in process of performing Horizontal Angle Off-
set. This measurements contain the horizontal angle and slope distance data.

l Center —the measurement from the station to a center of pipe in process of performing Horizontal Angle
Offset. This measurements contain the horizontal angle data.

l Vertical — the measurement from the station to the reflector in process of performing Horizontal/Vertical
Angle Offset. This measurements contain the horizontal and vertical angle and slope distance data.

l Horz.Vertical — the measurement from the station to an offset point in process of performing Hori-
zontal/Vertical Angle Offset. This measurements contain the horizontal and vertical angle.

l Missing Pt. — the measurement from the station to an one prism from two prisms in process of performing
Hidden Point offset. This measurements contain the horizontal and vertical angle and slope distance data.

l Line — the measurement from the station to a point of the line in process of performing Two Lines Inter-
section and/or Lines and Corner offset. This measurements contain the horizontal and vertical angle and
slope distance data.

l Corner — the measurement from the station to an offset point in process of performing Lines and Corner
and/or Plane and Corner offset. This measurements contain the horizontal and vertical angle data.

l Plane — the measurement from the station to one point from three points of a plane in process of per-
forming Plane and Corner offset. This measurements contain the horizontal and vertical angle and slope dis-
tance data.

The field appears it the right panel of the TS Obs tab and the Observation tab of the Properties dialog for the right
panel of the TS Obs tab.

Pop-up menu for the left panel of the TS Obs tab
In the left panel of the TS Obs tab you can perform the special (only for TS occupation) commands:

l Disable/ Enable — allows disable/enable the highlighted TS occupations from the adjustment, calculating
coordinates and export.

l Add Manual TS Occupation— allows you to manually add a new TS Occupation.
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l Select TS Obs — opens the Select TS Obs dialog. In this window you can set different criterions to select
TS observations in this tab (in the right panel). If you apply default set, all TS observations of the job will
be selected.

l Select TS Occupation— opens the Select TS Occupations dialog. In this window you can set different cri-
terions to select TS occupations in this tab (in the left panel). If you apply default set, all TS occupations of
the job will be selected.

l Compute Coordinate — this command activates function of calculating coordinate the reflector points
from the highlighted stations.

Pop-up menu for the right panel of the TS Obs tab
In the right panel of the TS Obs tab you can perform the special (only for TS observation) commands:

l Disable/Enable — disables/enables the highlighted TS observations from the adjustment, calculating
coordinates and export.

l Zoom to Selection— automatically zooms in the highlighted TS observations on Map View
l Select TS Obs — opens the Select TS Obs window. In this window you can set different criterions to
select TS observations in this tab (in the right panel). If you apply default set, all TS observations of the job
will be selected.

l Compute Coordinate — this command activates function of calculating coordinate the reflector points
from the highlighted stations.

l Report— automatically creates a report for the highlighted TS observations. By default this report con-
tains the following information: the numbers of the TS observation, Point From, Point To, Instrument and
Reflector Height, Horizontal Circle, Zenith Angle and Slope Distance.

DL Obs tab

The DL Obs tab is shown only if the job contains DL (digital level) raw data. The DL Obs tab displays a table
containing two panels. The left panel displays all DL Run (or DL occupations), and the right panel displays all DL
observations.

You may manually add DL observations right from the tab. To do so:
1. In the left panel of the tab, select the required DL occupation.

2. In the bottom row of the right panel's table, click .

The row for the new observation is displayed.
3. Specify the required parameters and press Enter.

Fields of the left panel
Field Description

Icon Displays a symbol assigned to a DL Occupation. See "Symbols for the left
panel of the DL Obs tab" section on page 394 for details.

# Displays the number of the DL run (DL occupation) contained in the current
job. You can set any number from the list.
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Field Description

From Displays the start leveling point of the job. You cannot select other point as
start point.

To Displays the finish leveling point of the job. You cannot select other point as
finish point.

Level Run Display the name of the leveling job created in a digital level.

Date Displays the start date (day/month/year) and time of the job creation. You can-
not edit the value.

Note Displays any additional DL run's note. To edit the note, click on the highlighted
field and enter your comments.

Distance Displays the sum of all backsight and foresight distances. You cannot edit the
parameter.

Balance Display the sum of differences between DL to BS point and DL to FS point of
the job. You cannot edit the value.

Fields of the right panel
Field Description

Icon Displays a symbol assigned to a DL Obsersvation. See "Symbols for the right
panel of the DL Obs tab" section on page 395 for details.

# Displays the number of the DL observation contained in the current job. You
cannot set any number from the list.

Point Displays the name of turning or side shot point. You can select a point from the
list.

Type

Displays the current type of the Digital Level observation. This field contains
the list of the DL observation types. You cannot select the other type from the
list:

l SS (side shot) — the measurement to a point that is not a BS/FS point,
or Changing Point/ Bench Mark point.

l BS (backsight) — the measurement to the previous occupation point in
the DL run.

l FS (foresight) — the measurement to the next occupation point in the
DL run.

l End of Changing Pt — the end measurement of the DL run to the point
that is used to carry the measurements forward in the DL run.

l End of Bench Mark — the end measurement of the DL run to the point
with known elevation.

Ht. Measurements Displays the rod reading on the given point, in current linear units. You cannot
edit the measurement.

Vert Offset Displays the vertical offset from the horizontal plane for traverse and sideshot
points.

Distance Displays the measured distance from DL to the given point. You cannot edit
the measurement.
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Field Description

Instrument Elev-
ation

Displays the elevation of sight that includes the elevation of BS point and the
rod reading on BS point. You cannot edit the measurement.

Std Dev Displays the standard deviation for the level measurement. This value is cre-
ated in the Digital Level. You cannot edit the parameter.

Note Display any additional DL observation's note. To edit the note, click on the
highlighted field and enter comments, if needed.

Date Displays the start date (day/month/year) and time of creating the measurement.
You cannot edit the value.

Source Displays the path of the raw data to the computer disk drive, local area net-
work, or storage media.

Ht Residual Displays the adjustment residuals for the level measurements. You cannot edit
the value.

Elevation Displays the elevation on FS point that includes the elevation of sight and rod
reading on FS point. You cannot edit the value.

AutoReject

In this field you can select the status of the given DL observation for Adjust-
ment:

l Allowed — the DL observation will be used in Adjustment.
l Not Allowed — the DL observation will not be used in Adjustment.

Adjustment Status

Displays the status of the given DL observation after Adjustment:
l Not Adjusted — the DL observation is not adjusted.
l Adjusted — the DL observation is adjusted.
l AutoRejected — the DL observation is not adjusted because the vector
had the status Not Allowed before the adjustment procedure.

l Disable — the DL observation is not adjusted because the vector was
disabled before the adjustment procedure.

Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into three groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the left panel of the DL Obs tab. See "Pop-up menu for the left panel of the DL Obs
tab" section below for details.

l Specific commands for the right panel of the DL Obs tab. See "Pop-up menu for the rignt panel of the DL
Obs tab" section on the facing page for details.

Pop-up menu for the left panel of the DL Obs tab
In the left panel of the DL Obs tab you can perform the special (only for DL run) commands:

l Disable/Enable — disables/enables the highlighted DL runs from the adjustment, calculating coordinates
and export.
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l Add Manual DL run— allows you to manually add a new DL run (DL occupation).
l Compute Coordinate — activates function of calculating elevation of the turning and sideshot points.

Pop-up menu for the rignt panel of the DL Obs tab
In the right panel of the DL Obs tab you can perform the special (only for DL observation) commands:

l Disable/Enable — disables/enables the highlighted DL observations from the adjustment, calculating
coordinates and export.

l Zoom to Selection— automatically zooms in the highlighted DL observations on Map View

Lines tab

The Lines tab is shown only if the job contains polyline data. The Lines tab displays a table containing two panels.
The left panel displays all polylines (type, layers, plotting styles, codes and string) in the job, and the right panel
displays all segments for the selected polyline.

Fields of the left panel
Field Description

Icon Displays a symbol assigned to a polyline. See "Symbols for the left panel of the
Lines tab" section on page 395 for details.

Name Defines the name of the line. It can be empty. If specified, the name should be
unique.

Type

In this field you can select the type of the polyline:
l Line — unclosed polyline.
l Area — closed polyline.

When you select Area for a polyline with the Line type, the application auto-
matically adds a segment to close the existing polyline if the existing polyline
has more than one segment. When you select Line for a polyline which has the
Area type, the application automatically removes a segment to unclose the
area.

Layer

Displays the Layer in which the polyline resides. The Layer sets the plotting
style for the polyline (and all segments of the polyline). Every polyline has its
non-empty Layer. In this field, you can select any Layer from the list of user-
created layers.

Line Style

Displays the polyline style for Map View. The style can be chosen from the
list. If you set BYCODE or BYLAYER, the style of the polyline will be set
automatically to the style that was selected for the polyline's code, or polyline's
layer. See Map View for more information.

Line Width

Displays the polyline width for Map View. The width can be chosen from the
list. If you set BYCODE or BYLAYER, the width of the polyline will be set
automatically to the width that was selected for the polyline's code, or poly-
line's layer.
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Field Description

Line Color

Displays the polyline color for Map View. The color can be chosen from the
list. If you set BYCODE or BYLAYER, the color of the polyline will be set
automatically to the color that was selected for the polyline's code, or poly-
line's layer.

Area Fill Style

Displays the fill stile for closed polyline (area) in Map View. The fill style can
be chosen from the list. If you set BYCODE or BYLAYER, the fill style for
the polyline will be set automatically to the fill style that was selected for the
polyline's code, or polyline's layer.

Point Type

Displays the symbol for the point of the polyline in Map View. The symbol can
be chosen from the list. If you set BYCODE or BYLAYER, the point symbol
will be set automatically to the symbol that was selected for the polyline's
code, or polyline's layer.

Fill Transparency

Displays the transparency value for closed polyline (area) in Map View.
The value can be chosen from the list. If you set BYCODE or
BYLAYER, the value will be set automatically to the symbol that was
selected for the polyline's code, or polyline's layer.

Area Color

Displays the color for the closed polyline (area) in Map View. The color can
be chosen from the list. If you set BYCODE or BYLAYER, the area color
will be set automatically to the color that was selected for the polyline's code,
or polyline's layer.

Point Color

Displays the color for the point of the polyline in Map View. The color can be
chosen from the list. If you set BYCODE or BYLAYER, the point color will
be set automatically to the color that was selected for the polyline's code, or
polyline's layer.

Fields of the right panel
Field Description

Icon Displays a symbol assigned to a polyline. See "Symbols for the left panel of the
Lines tab" section on page 395 for details.

Order
Displays the order of the start point of the selected polyline / end point of the
segment in the selected polyline. You can set any number from the list of the
point's number.

Point
Displays the name of the start point of the selected polyline, or end point of a
segment (vertex of a segment). You can select a point from the list of the job's
points.

Distance from
start

Displays the total distance from the start point of the selected polyline to this
point (vertex), in current linear units. You cannot edit this value.

Distance from
prev

Displays the distance of the segment (from the previous point to this point), in
current linear units. You cannot edit this value.

Entry Azimuth Displays the azimuth of the tangent to the given point (vertex) for the current
segment. You cannot edit this value. See picture below for details.

Exit Azimuth Displays the end azimuth of the tangent to the given point (vertex) of the seg-
ment. You cannot edit this value.
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Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into three groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the left panel of the Lines tab. See "Pop-up menu for the left panel of the Lines tab"
section below for details.

l Specific commands for the right panel of the Lines tab. See "Pop-up menu for the right panel of the Line
tab" section on the next page for details.

Pop-up menu for the left panel of the Lines tab
In the left panel of the Lines tab you can perform the special (only for polyline) commands:

l Delete — deletes the selected polylines from the current job. The command does not delete the points of
the polylines.

l Convert to Road— converts a polyline to a Road. In this case:
l A start point of the line will be a start point of the road.
l Horizontal projections of lines and curves will be used for creating the horizontal alignment of the
road.

l Height difference of the segment vertices forms up a vertical alignment. Only the grade will be used
for creating the vertical alignment of the road.

l The current layer of the line will be the current layer of the road.

To convert a line to a road:
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1. Right-click the required line and select Convert.
2. From the additional menu, select To Road.

The Convert Line to Road dialog is displayed.
3. In the Name editbox, type the name of the new road.
4. In the Start Sta/Chainage editbox, specify the start chainage of the new road.
5. From the Layer drop-down box, select the layer to which the road will belong to.
6. Click OK.

l Merge Lines — this command will be available when you selects two separate polylines that do not have
a common point. An additional line will be automatically created between the End point of the first selected
line and the Start point of the second line. The created line has a plotting style of the first line:

l Reverse Line — flips the order of the segments in the polyline.
l Add to Surface — this command will be available when a surface is present in the current job. The high-
lighted polylines will be added to the surface if a polyline is within the surface boundaries. If the current
job contains more than one surface, choose the desired Surface to add polylines.

l Insert Point(s) to Line — inserts a point to the selected segment. See "Insert Point(s) to Line command"
section on page 131 for details.

l Append Point(s) to Line — adds a point to the selected segment. See "Append Point(s) to Line command"
section on page 132 for details.

l Zoom to Selection— automatically zoom in the highlighted polylines in the Map View.

Pop-up menu for the right panel of the Line tab
In the right panel of the Lines tab you can perform the special (only for segment) commands:

l Delete — deletes the selected polylines from the current job. The command does not delete the points of
the polylines.

l Convert to Road— converts a polyline to a Road. In this case:
l A start point of the line will be a start point of the road.
l Horizontal projections of lines and curves will be used for creating the horizontal alignment of the
road.

l Height difference of the segment vertices forms up a vertical alignment. Only the grade will be used
for creating the vertical alignment of the road.

l The current layer of the line will be the current layer of the road.
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To convert a line to a road:
1. Right-click the required line and select Convert.
2. From the additional menu, select To Road.

The Convert Line to Road dialog is displayed.
3. In the Name editbox, type the name of the new road.
4. In the Start Sta/Chainage editbox, specify the start chainage of the new road.
5. From the Layer drop-down box, select the layer to which the road will belong to.
6. Click OK.

l Split— this command will be available for all segments except the first and last segment of the polyline.
The highlighted segment(s) will be deleted from the polyline. Two separate polylines will be created:

l Reverse Line — flips the order of the segments in the polyline.
l Add to Surface — this command will be available when a surface is present in the current job. All seg-
ment(s) will be added to the surface if the segments are within the surface boundaries. If the current job
contains more than one surface, choose the desired Surface to add polylines.

l Insert Point(s) to Line — inserts a point to the selected segment. See "Insert Point(s) to Line command"
section on page 131 for details.

l Append Point(s) to Line — adds a point to the selected segment. See "Append Point(s) to Line command"
section on page 132 for details.

l Zoom to Selection— automatically zooms in the highlighted segments in the Map View.

Surfaces tab

The Surfaces tab is shown only if the job contains a digital terrain model.

Field Description

Icon Displays a symbol assigned to a surface. See "Symbols for the Surfaces tab"
section on page 395 for details.

Name
Displays the name of the surface. To edit the name, click on the high-
lighted field and enter a new name. The surface name is unique and the
field cannot be empty.
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Field Description

Focus Point

Displays the name of a focus point. If the column is empty, the triangulation is
completed in relation to the ground plane. If set to some existing point, the tri-
angulation will be done with respect to that point, that is as if the surface is
viewed from that point. You can select a point from the list of the job's points.

Layer
Displays the name of the Layer in which the surface resides. The Layer sets
the plotting style for the surface. Every surface has to have a Layer. In this
field, you can select any Layer from the list of user-created layers.

Number of Points Displays the quantity of points in the surface, including intersection points of
lines forming this model. You cannot edit this parameter.

Number of Tri-
angles

Displays the quantity of triangles created on the surface. You cannot edit this
parameter.

Area

Displays the sum of areas of the triangle projections on the horizontal plane (if
the triangulation is done with respect to the ground plane) and the vertical
plane (if the triangulation is done with respect to a vertical plane from a focus
point for the given surface). You cannot edit this parameter.

Minimum Nor-
thing

Displays the minimum value of northing coordinates of points included in the
surface. You cannot edit this parameter.

Maximum Nor-
thing

Displays the maximum value of northing coordinates of points included in the
surface. You cannot edit this parameter.

Minimum Easting Displays the minimum value of easting coordinates of points included in the sur-
face. You cannot edit this parameter.

Maximum Easting Displays the maximum value of easting coordinates of points included in the
surface. You cannot edit this parameter.

Minimum Elev-
ation

Displays the minimum value of elevation coordinates of points included in the
surface. You cannot edit this parameter.

Maximum Elev-
ation

Displays the maximum value of elevation coordinates of points included in the
surface. You cannot edit this parameter.

Comment Displays any additional information about the surface.

Need Update
Displays the current status of the surface. If set to "No", the surface is not
changed, or automatic update is done. If set to "Yes", the surface is changed,
and automatic update of the changed surface is disabled.

Auto Update When unticked (default setting), automatic update of the changed surface is dis-
abled. If ticked, automatic update of the changed surface is enabled.

Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the Surfaces tab. See "Pop-up menu for Surfaces tab" section below for details.

Pop-up menu for Surfaces tab
In Surfaces tab you can execute the special (only for surface) commands:
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l Add to this Surface — adds the selected object (point, line) to this surface.
l Contour Lines — this command is available for a surface which does not have a focus point. This com-
mand opens Contour Lines window. This window allows contouring the surface with intervals and layers
specified for the major and minor lines. See "Drawing Contour Lines for surface" section on page 343 for
details.

l 3D View — opens and displays the surface on 3D View.
l Map View — opens and displays the surface on Map View.
l Zoom to Selection— automatically zooms in the highlighted surface(s) on Map View.
l Update Surface — starts the automatic updating the changed surface. After updating the Need Update
field displays "No".

Roads tab

The Roads tab is shown only if the job contains road data. MAGNET Tolls allows you to create a road using one
of  following two ways:

l Through horizontal and vertical projections of the center line (alignment) and lines representing the surface
of the road and lying in the planes perpendicular to the center line — X-Section.

l Through a set of several strings — String Set. Every separate string in the set is defined by one or several
pairs of the horizontal and vertical alignments.

The application allows you to edit/view any road created in MAGNET Field, and allows you to create a new road
with X-Section.

The left panel of the Roads tab contains the list of roads in the job. Each road involves horizontal alignment, ver-
tical alignment and either X-section or Road String Set :

Road with X-Section Road with String Set

For detailed description see the appropriate section:
l "Road content" section on the next page
l "Horizontal alignment content" section on the next page
l "Vertical alignment content" section on page 175
l "X-Section content" section on page 178
l "Road String Set content" section on page 179

The right panel displays the parameters of the object, selected in the left panel:
l Road — the right panel displays the horizontal and vertical alignment in the table and 2D graphic views.
l Horizontal or vertical alignment — the right panel displays the horizontal or vertical alignment in the table
and 2D graphic views.

l Table or graphic view of the horizontal or vertical alignment — the right panel displays the corresponding
view only.

l X-Sections — the right panel displays the X-Sections in the table and 2D graphic views.
l String Set — the right panel displays the list of road strings which form the given String Set.
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l Single Road String — the right panel displays the list of the pairs of the horizontal/vertical alignments for
that string.

l Single pair of the horizontal/vertical alignments — the right panel displays the horizontal and vertical align-
ment in the table and 2D graphic views.

l Horizontal alignment or vertical alignment of the road string — the right panel displays the horizontal or
vertical alignment in the table and 2D graphic views.

l Table or graphic view of the horizontal or vertical alignment of the road string — the right panel displays
the corresponding view only.

Right-click on a highlighted object in the left panel, to display a pop-up menu. This menu contains a set of com-
mands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for a single road. See "Pop-up menu for a road" section on page 192 for details.
l Specific commands for the horizontal alignment. See "Horizontal alignment content" section below for
details.

l Specific commands for the vertical alignment. See "Vertical alignment content" section on page 175 for
details.

l Specific commands for the X-Section. See "X-Section content" section on page 178 for details.

Road content
A road is the root item in the tree that displays a road name. You can edit the road name. The tree involves a hori-
zontal alignment, a vertical alignment and either a X-section or a Road String Set:

Road with X-Section Road with String Set

Right-click on a highlighted road object in the left panel, to display a pop-up menu. This menu contains a set of
commands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for a single road. See "Pop-up menu for a road" section on page 192 for details.

Horizontal alignment content
The root tree item displays a horizontal alignment name. You can edit its name. The tree of the horizontal align-
ment consists of table and graphic views:

See "Table view of the horizontal alignment" section on the facing page and "Graphic view of the horizontal align-
ment" section on page 175 for details.
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When you select the horizontal alignment, the right panel of the Road tab from the Tabular view displays the hori-
zontal alignment in the table and 2D graphic views. When you select a desired view, the right panel will display
only this view.

Right-click on a highlighted object in the left panel, to display a pop-up menu. This menu contains a set of com-
mands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific command for the horizontal alignment. See below.

AddHorz element command of the pop-upmenu

Adds the horizontal alignment to the road. Horizontal alignment is created through line, curve, spiral, intersection.
Opens Add Horz Element dialog. In the General tab of the dialog select a desired horizontal alignment type from
the Type drop-down list.

See "General tab" section on page 281 for details.

Table view of the horizontal alignment

When you select the table view in the left panel, the right panel will display the parameters of the horizontal align-
ment in the table view only. Fields are described in the table below. All information are displayed in current units.

Field Description

Icon Displays a symbol assigned to a horizontal alignment. See Symbols in the table view of
horizontal alignment for details.

Order Defines the order of the element in the horizontal alignment. You can set any number
from the list of element numbers.
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Field Description

Type

Defines the type of a road horizontal element. In this field you can select one of the fol-
lowing types:

l Line
l Curve
l Spiral TS to SC “Traverse-Spiral to Spiral-Curve“ direction means that the start
station of the spiral is the end station of the line, and the end station of the spiral
is the start station of the curve:

l Spiral CS to ST “Curve-Spiral to Spiral-Traverse“ direction means that the start
station of the spiral is the end station of the curve, and the end station of the spiral
is the start station of the line:
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Field Description

l Spiral CS to SC “Curve-Spiral to Spiral-Curve“ direction means that the start sta-
tion of the spiral is the end station of one curve, and the end station of the spiral is
the start station of the other curve.
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Field Description

l Intersection

Azimuth

Defines the azimuth of the tangent to the start point of the horizontal alignment. You can
edit this value only for the starting element of the road (in this case the Tangential to pre-
vious element checkbox is disabled). To change the azimuth of all other elements, untick
the Tangential to previous element checkbox and type the desired value in the filed.

Length Defines the length of the horizontal element.

Turn Defines the direction of turn of the curve/spiral. The Right value stands for clockwise
direction and the Left value, for counter-clockwise direction.

Start Radius Defines either the radius of the curve or the start radius of the spiral. See General tab
for details.

End Radius Defines the end radius of the spiral of TS to SC or CS to SC type.

Northing
Defines the intersection point's or compound curve end point's northing coordinate in the
current coordinate system. You can edit the value, if a point is not selected in the Inter-
section Pt list.

Easting
Defines the intersection point's or compound curve end point's easting coordinate in the
current coordinate system. You can edit the value, if a point is not selected in the Inter-
section Pt list.
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Field Description

Spiral 1 Length

Defines the length of the first spiral of the compound curve. You can edit the value.

Spiral 2 Length

Defines the length of the second spiral of the compound curve.

End Sta-
tion/Chainage

Displays the number of the end station/ chainage for the horizontal element. You cannot
edit this value.

Intersection Point

Defines the name of the intersection point or the end point of the compound curve. You
can select the desired point from the list. After selecting the point, the Northing and the
Easting fields displays the coordinates of the selected point. These coordinates cannot
be changed for the selected point.
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Field Description

Tangential to pre-
vious

If this parameter is ticked (default setting for all horizontal element types except the
first road element), the defined value of the azimuth will be used for the next alignment
as start azimuth, and you cannot edit the azimuth. Untick the checkbox to edit the azi-
muth.

End Northing Displays the northing coordinate of the end point of the horizontal element in Ground /
Grid coordinate system.

End Easting Displays the eastigng coordinate of the end point of the horizontal element in Ground /
Grid coordinate system.

End Azimuth Displays the azimuth of the tangent to the given point for the horizontal element.

End Azimuth Displays the azimuth of the tangent to the given point for the horizontal element. See pic-
ture below for details.

Delta Displays the angle between the radii corresponding to the curve. See picture below for
details.

Chord Displays the length of the segment joining start and end points of a curve in the current
linear units. See picture below for details.

Tangent Defines the length of the segment which touches the given curve in the current linear
units. See picture below for details.

Mid Ord Defines the distance from the midpoint of a chord to the midpoint of the corresponding
curve (Middle Ordinate) in the current linear units. See picture below for details.

External Defines the distance from the midpoint of the curve to the intersection point of the tan-
gents in the current linear units. See picture below for details.

Spiral Const
Defines the spiral constant value. The spiral constant is the square root of the
length multiplied by the radius of the spiral. The value is used to define a compound
curve.

Spiral Const 1 Displays the square root of the length multiplied by the radius of the first spiral for the
compound curve. See picture from the Spiral 1 Length field.

Spiral Const 2 Displays the square root of the length multiplied by the radius of the second spiral for
the compound curve. See picture from the Spiral 1 Length field.
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Field Description

Start Deg Chord

Defines the angle in degrees used to compute either the radius of the curve or the start
radius of the spiral of the CS to ST or the CS to SC type, whose chord is 100 units long:

Using the degree of chord (DCH) parameter, the radius of the curve can be calculated
as follows:

Start Deg Curve

Defines the angle in degrees used to compute either the radius of the curve or the start
radius of the spiral of the CS to TS or CS to SC type whose curve is 100 units long:

Using the degree of curve (DCV) parameter, the radius of the curve can be calculated
as follows:
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Field Description

End Deg Chord

Displays the angle in degrees used to compute either the radius of the curve or the end
radius of the spiral of the TS to SC or the CS to SC type whose chord is 100 units long.
See picture from the Start Deg Chord field.

Using the degree of chord (DCH) parameter, the radius of the curve can be calculated
as follows:

End Deg Curve

Defines the angle in degrees used to compute either the radius of the curve or the start
radius of the spiral of the TS to SC or the CS to SC whose curve is 100 units long. See
picture from the Start Deg Curve field.

Using the degree of curve (DCV) parameter, the radius of the curve can be calculated
as follows:

Entry and exit azumuth
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Curve parameters

Graphic view of the horizontal alignment

When you select the graphic view in the left panel, the right panel of the Road tab of the Tabular view will display
all elements of the horizontal alignment in the graphic view in the Grid or Ground coordinate system. You can
select any element of the alignment. The start and end stations of any element and intersection points are dis-
played. The alignment is displayed using the plotting style of the layer for the given road.

Vertical alignment content
The root tree item displays a vertical alignment name. You can enter / edit the name of the alignment. The tree of
the vertical alignment consists of table and graphic views:

See "Table view of the vertical alignment" section on the next page and "Graphic view of the vertical alignment"
section on page 178 for details.

When you select the vertical alignment, the right panel of the Road tab from the Tabular view displays the vertical
alignment in the table and 2D graphic views. When you select a desired view, the right panel will display only this
view.

Right-click on a highlighted object in the left panel, to display a pop-up menu. This menu contains a set of com-
mands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific command for the vertical alignment. See below.
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Add Vert Element command of the pop-upmenu

Adds the vertical alignment to the road. Vertical alignment is created through grade, circular arc and parabolas, or
long sections. When adding the first element to a horizontal alignment, all vertical elements are available. Opens
the Add Vert Element dialog. At the General tab of the window select a desired vertical alignment type from the
Type drop-down list. If selecting a grade or parabola as the first element, only a grade or parabola or a circular
arc can be the next element added to the vertical alignment. If selecting a long section as the first element, only a
parabola long sections or arc long sections can be the next element of the vertical alignment.

See "General tab" section on page 291 for details.

Table view of the vertical alignment

When you select the table view of the vertical alignment in the left panel, the right panel will display the para-
meters of the vertical alignment in the table view only. Fields are described in the table below.

Field Description

Icon Displays a symbol assigned to a vertical alignment. See "Symbols in the ver-
tical alignment table view" section on page 396 for details.

Order Defines the order of the element in the vertical alignment. You can set any
number from the list.

Type

Defines the type of a road vertical alignment. You can select one of the fol-
lowing types:

l Grade,
l Parabola,
l Circular Arc,
l Parabola Long Section,
l Arc Long Section.

If selecting a grade or parabola as the first element, then either a grade, or
parabola, or a circular arc can be the next element added to the vertical align-
ment.

If selecting a long section as the first element, the only either a parabola long
sections, or arc long sections can be the next element of the vertical alignment.

See pictures below for details.

Sta/Chainage

Defines the number of the start station or chainage for a vertical element. You
can edit this parameter for a parabola long section and an arc long section and
cannot edit this parameter for grade, parabola, circular arc.

You can select chainage or station to use for the road center line position at the
Roads tab of the Display item from the Job Configuration dialog. See "Roads
tab" section on page 93 for details.

Length

Defines the length of the vertical element. You can edit this parameters for the
grade, parabola and parabola long section. The length of the circular arc is auto-
matically calculated taking into account entered values of the Radius, Start
Grade and End Grade parameters. For the long section element, set 0 for the
start and end elements of the long section.
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Field Description

Start Grade

or grade vertical alignment type, displays the ratio of the grade length and delta
H (the difference between the elevations at the end station and the start station
of the grade element) multiplied by 100% .

For parabola and circular arc displays the start grade of the element, in per-
cents.

You can edit this parameter. If the grade is rising, the value should be set pos-
itive; if the grade is falling, the value should be set negative.

See pictures below for details.

End Grade

For parabola and circular arc displays the end grade of the element, in per-
cents. You can edit this parameter. If the grade is rising, the value should be
set positive; if the grade is falling, the value should be set negative.

See pictures below for details.

Elevation Defines the elevation on the station used for creating the long section.

Radius
Defines the radius of the Circular Arc and Arc Long Section vertical element.
For the arc long section element, set 0 for start and end element of the long sec-
tion.

Rising and falling grades

Parabola
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Compound curve in the vertical plane

Graphic view of the vertical alignment

When you select the graphic view in the left panel, the right panel of the Roads tab from the Tabular view dis-
plays all elements of the vertical alignment in the graphic view. You can select any element of the alignment. The
start and end stations of any element are displayed. The alignment is displayed using the plotting style of the layer
for the given road.

X-Section content
The root tree item displays a X-Section name. You can enter / edit the name of the X-Section. The tree of the X-
Section consists of table view:

When you select the X-Section, the right panel of the Road tab from the Tabular view displays the X-Section in
the table and 2D graphic views. When you select a table view, the right panel will display only table. See Table
view of the X-Section for details.

Right-click on a highlighted object in the left panel, to display a pop-up menu. This menu contains a set of com-
mands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific command for the vertical alignment. See below.

Add X-Section command of the pop-upmenu

Adds a cross-section to the center line. X- section are the lines representing the surface of the road and lying in
the plane perpendicular to the center line. Opens the Add X-Section dialog.

See General tab for details.

Table view of the X-Section

When you select the table view in the left panel, the right panel will display the parameters of the X-Section in
the table view only. Fields are described in the table below.
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Field Description

Icon Displays a symbol assigned to a X-Section. See "Symbols for the X-Section
table view" section on page 395 for details.

Sta/Chainage
Defines the station or chainage where the template is to be applied. If you set
"0", the selected template is applied from the road start point to the road end
point or to the point where a new template is applied.

Side Defines the left or right side of the road relative to the center line where this
template is to be used.

Template Displays the name of the current template. You can select other template from
the list of existing templates in the current job.

Road String Set content
The root tree item displays a Road String Set name. You can edit the name. The tree of the Road String Set
involves a set of separate Road Strings , each Road string consists of the pair pairs of the horizontal and vertical
alignments (HA-VA). The tree of the horizontal/vertical alignment consists of the table and graphic views:

See "Road String content" section below and "Pairs of the horizontal and vertical alignments content" section on
the next page for details.

When you select a Road String Set in the left panel, the right panel displays the list of separate Road strings
which are included into the given string set. Fields are described in the table below.

Field Description

Icon
Displays a symbol associated with the Road String. For any Road String type
the icon is used.

Name
Display a Road String name. To edit the name, click on the highlighted field
and enter a new name. The Road String name is unique and the field cannot be
empty.

Order Displays the order of a separate Road String in the selected Road String Set.
You can set any number from the list of Road String numbers.

Road String content

The root tree item displays a name of the separate Road String. You can edit the name. Each Road String consists
of the pairs of the horizontal and vertical alignments (HA-VA). The tree of the horizontal/vertical alignment con-
sists of the table and graphic views:
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When you select a single Road String in the left panel, the right panel displays the list of horizontal and vertical
alignments which are included into the given Road String. Fields are described in the table below.

Field Description

Horizontal Align-
ment Name

Defines the current horizontal alignment name for the Road String. You can
select other horizontal alignment from the list for the given road.

Vertical Align-
ment Name

Defines the current vertical alignment name for the Road String. You can
select other vertical alignment from the list for the given road.

Pairs of the horizontal and vertical alignments content
The root tree item displays a name of the pair horizontal and vertical alignments (HA-VA). The tree of the hori-
zontal/vertical alignment consists of the table and graphic views:

When you select a single pair of the horizontal and vertical alignments of the road string in the left panel, the
right panel displays the horizontal and vertical alignment in the table and 2D graphic views. See "Horizontal
alignment from the road string content" section below and "Vertical alignment from the road string content"
section on page 189 for details.
Horizontal alignment from the road string content

The root tree item displays a horizontal alignment name. You can enter / edit the name of the alignment. The tree
of the horizontal alignment consists of table and graphic views:

See Table view of the horizontal alignment from the road string and Graphic view of the horizontal alignment
from the road string for details.

When you select the horizontal alignment, the right panel of the Road tab from the Tabular view displays the hori-
zontal alignment in the table and 2D graphic views. When you select a desired view, the right panel will display
only this view.
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When you select the horizontal alignment, the right panel of the Road tab from the Tabular view displays the hori-
zontal alignment in the table and 2D graphic views. When you select a desired view, the right panel will display
only this view.

Right-click on a highlighted object in the left panel, to display a pop-up menu. This menu contains a set of com-
mands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific command for the horizontal alignment. See below.

AddHorz element command of the pop-upmenu

Adds the horizontal alignment to the road. Horizontal alignment is created through line, curve, spiral, intersection.
Opens Add Horz Element dialog. In the General tab of the dialog select a desired horizontal alignment type from
the Type drop-down list.

See "General tab" section on page 281 for details.

Table view of the horizontal alignment from the road string

When you select the table view in the left panel, the right panel will display the parameters of the horizontal align-
ment in the table view only. Fields are described in the table below. All information are displayed in current units.

Field Description

Icon Displays a symbol assigned to a horizontal alignment. See Symbols in the table view of
horizontal alignment for details.

Order Defines the order of the element in the horizontal alignment. You can set any number
from the list of element numbers.
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Field Description

Type

Defines the type of a road horizontal element. In this field you can select one of the fol-
lowing types:

l Line
l Curve
l Spiral TS to SC “Traverse-Spiral to Spiral-Curve“ direction means that the start
station of the spiral is the end station of the line, and the end station of the spiral
is the start station of the curve:

l Spiral CS to ST “Curve-Spiral to Spiral-Traverse“ direction means that the start
station of the spiral is the end station of the curve, and the end station of the spiral
is the start station of the line:
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Field Description

l Spiral CS to SC “Curve-Spiral to Spiral-Curve“ direction means that the start sta-
tion of the spiral is the end station of one curve, and the end station of the spiral is
the start station of the other curve.
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Field Description

l Intersection

Azimuth

Defines the azimuth of the tangent to the start point of the horizontal alignment. You can
edit this value only for the starting element of the road (in this case the Tangential to pre-
vious element checkbox is disabled). To change the azimuth of all other elements, untick
the Tangential to previous element checkbox and type the desired value in the filed.

Length Defines the length of the horizontal element.

Turn Defines the direction of turn of the curve/spiral. The Right value stands for clockwise
direction and the Left value, for counter-clockwise direction.

Start Radius Defines either the radius of the curve or the start radius of the spiral. See General tab
for details.

End Radius Defines the end radius of the spiral of TS to SC or CS to SC type.

Northing
Defines the intersection point's or compound curve end point's northing coordinate in the
current coordinate system. You can edit the value, if a point is not selected in the Inter-
section Pt list.

Easting
Defines the intersection point's or compound curve end point's easting coordinate in the
current coordinate system. You can edit the value, if a point is not selected in the Inter-
section Pt list.
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Field Description

Spiral 1 Length

Defines the length of the first spiral of the compound curve. You can edit the value.

Spiral 2 Length

Defines the length of the second spiral of the compound curve.

End Sta-
tion/Chainage

Displays the number of the end station/ chainage for the horizontal element. You cannot
edit this value.

Intersection Point

Defines the name of the intersection point or the end point of the compound curve. You
can select the desired point from the list. After selecting the point, the Northing and the
Easting fields displays the coordinates of the selected point. These coordinates cannot
be changed for the selected point.
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Field Description

Tangential to pre-
vious

If this parameter is ticked (default setting for all horizontal element types except the
first road element), the defined value of the azimuth will be used for the next alignment
as start azimuth, and you cannot edit the azimuth. Untick the checkbox to edit the azi-
muth.

End Northing Displays the northing coordinate of the end point of the horizontal element in Ground /
Grid coordinate system.

End Easting Displays the eastigng coordinate of the end point of the horizontal element in Ground /
Grid coordinate system.

End Easting Displays the azimuth of the tangent to the given point for the horizontal element.

End Azimuth Displays the azimuth of the tangent to the given point for the horizontal element. See pic-
ture below for details.

Delta Displays the angle between the radii corresponding to the curve. See picture below for
details.

Chord Displays the length of the segment joining start and end points of a curve in the current
linear units. See picture below for details.

Tangent Defines the length of the segment which touches the given curve in the current linear
units. See picture below for details.

Mid Ord Defines the distance from the midpoint of a chord to the midpoint of the corresponding
curve (Middle Ordinate) in the current linear units. See picture below for details.

External Defines the distance from the midpoint of the curve to the intersection point of the tan-
gents in the current linear units. See picture below for details.

Spiral Const
Defines the spiral constant value. The spiral constant is the square root of the
length multiplied by the radius of the spiral. The value is used to define a compound
curve.

Spiral Const 1 Displays the square root of the length multiplied by the radius of the first spiral for the
compound curve. See picture from the Spiral 1 Length field.

Spiral Const 2 Displays the square root of the length multiplied by the radius of the second spiral for
the compound curve. See picture from the Spiral 1 Length field.
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Field Description

Start Deg Chord

Defines the angle in degrees used to compute either the radius of the curve or the start
radius of the spiral of the CS to ST or the CS to SC type, whose chord is 100 units long:

Using the degree of chord (DCH) parameter, the radius of the curve can be calculated
as follows:

Start Deg Curve

Defines the angle in degrees used to compute either the radius of the curve or the start
radius of the spiral of the CS to TS or CS to SC type whose curve is 100 units long:

Using the degree of curve (DCV) parameter, the radius of the curve can be calculated
as follows:
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Field Description

End Deg Chord

Displays the angle in degrees used to compute either the radius of the curve or the end
radius of the spiral of the TS to SC or the CS to SC type whose chord is 100 units long.
See picture from the Start Deg Chord field.

Using the degree of chord (DCH) parameter, the radius of the curve can be calculated
as follows:

End Deg Curve

Defines the angle in degrees used to compute either the radius of the curve or the start
radius of the spiral of the TS to SC or the CS to SC whose curve is 100 units long. See
picture from the Start Deg Curve field.

Using the degree of curve (DCV) parameter, the radius of the curve can be calculated
as follows:

Entry and exit azumuth
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Curve parameters

Graphic view of the horizontal alignment from the road string

When you select the graphic view in the left panel of the Roads tab, the right panel will display the horizontal
alignment in the graphic view only.

Vertical alignment from the road string content

The root tree item displays a vertical alignment name. You can enter / edit the name of the alignment. The tree of
the vertical alignment consists of table and graphic views:

See Table view of the vertical alignment from the road string and Graphic view of the vertical alignment from the
road string for details.

When you select the vertical alignment, the right panel of the Road tab from the Tabular view displays the vertical
alignment in the table and 2D graphic views. When you select a desired view, the right panel will display only this
view.

Right-click on a highlighted object in the left panel, to display a pop-up menu. This menu contains a set of com-
mands and they can be divided into two groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific command for the vertical alignment. See below.
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Add Vert Element command of the pop-upmenu

Adds the vertical alignment to the road. Vertical alignment is created through grade, circular arc and parabolas, or
long sections. When adding the first element to a horizontal alignment, all vertical elements are available. Opens
the Add Vert Element dialog. At the General tab of the window select a desired vertical alignment type from the
Type drop-down list. If selecting a grade or parabola as the first element, only a grade or parabola or a circular
arc can be the next element added to the vertical alignment. If selecting a long section as the first element, only a
parabola long sections or arc long sections can be the next element of the vertical alignment.

See "General tab" section on page 291 for details.

Table view of the vertical alignment from the road string

When you select the table view of the vertical alignment in the left panel, the right panel will display the para-
meters of the vertical alignment in the table view only. Fields are described in the table below.

Field Description

Icon Displays a symbol assigned to a vertical alignment. See "Symbols in the ver-
tical alignment table view" section on page 396 for details.

Order Defines the order of the element in the vertical alignment. You can set any
number from the list.

Type

Defines the type of a road vertical alignment. You can select one of the fol-
lowing types:

l Grade,
l Parabola,
l Circular Arc,
l Parabola Long Section,
l Arc Long Section.

If selecting a grade or parabola as the first element, then either a grade, or
parabola, or a circular arc can be the next element added to the vertical align-
ment.

If selecting a long section as the first element, the only either a parabola long
sections, or arc long sections can be the next element of the vertical alignment.

See pictures below for details.

Sta/Chainage

Defines the number of the start station or chainage for a vertical element. You
can edit this parameter for a parabola long section and an arc long section and
cannot edit this parameter for grade, parabola, circular arc.

You can select chainage or station to use for the road center line position at the
Roads tab of the Display item from the Job Configuration dialog. See "Roads
tab" section on page 93 for details.

Length

Defines the length of the vertical element. You can edit this parameters for the
grade, parabola and parabola long section. The length of the circular arc is auto-
matically calculated taking into account entered values of the Radius, Start
Grade and End Grade parameters. For the long section element, set 0 for the
start and end elements of the long section.
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Field Description

Start Grade

or grade vertical alignment type, displays the ratio of the grade length and delta
H (the difference between the elevations at the end station and the start station
of the grade element) multiplied by 100% .

For parabola and circular arc displays the start grade of the element, in per-
cents.

You can edit this parameter. If the grade is rising, the value should be set pos-
itive; if the grade is falling, the value should be set negative.

See pictures below for details.

End Grade

For parabola and circular arc displays the end grade of the element, in per-
cents. You can edit this parameter. If the grade is rising, the value should be
set positive; if the grade is falling, the value should be set negative.

See pictures below for details.

Elevation Defines the elevation on the station used for creating the long section.

Radius
Defines the radius of the Circular Arc and Arc Long Section vertical element.
For the arc long section element, set 0 for start and end element of the long sec-
tion.

Rising and falling grades

Parabola
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Compound curve in the vertical plane

Graphic view of the vertical alignment from the road string

When you select the graphic view in the left panel, the right panel will display the vertical alignment in the
graphic view only.

Pop-up menu for a road
In Road tab you can perform the special commands:

l Convert
l To Points
l To Line
l To Surface

l Add Vert element
l Add Herz element
l Add X-Section

See below for detailed descriptions.

Convert

to Points — converts the selected road to points. See "Convert road to points dialog" section on the facing page
for details.

l To create only points of the center line, do not tick checkboxes in the dialog.
l To create points of the center line and start/end points of the horizontal and vertical alignments, tick Create
Turn Points checkbox.

l To create points of the center line and points lying on the right and left of the center line, tick the Create
Offset Points checkbox.

to Line — converts the selected road to the lines. See "Convert road to lines dialog" section on page 194 for
details.
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l To create only the lines for the road’s center line, do not check the boxes in the dilaog.
l To create the lines for the road’s center line and for two offset lines which are set on the right and left from
the center line at an offset specified in the X-Section Offset dialog box, tick the Create Offset Lines check-
box.

l To create the lines for the road’s center line and X-section lines for start/end points of the horizontal and
vertical alignments, check the box Create X-Section Lines.

to Surface — converts the selected road to the surface with fixed interval between surface points. See "Convert
road to surface dialog" section on page 195 for details.The series of surface points will be created along the cen-
ter line and each offset line for the following places:

l a) for start/end points of horizontal and vertical alignments,
l b) for points where cross-sections are defined,
l c) for points of curve,
l d) for points with the given station interval.

Add Vert Element

Adds the vertical alignment to the road. Vertical alignment is created through grade, circular arc and parabolas, or
long sections. When adding the first element to a horizontal alignment, all vertical elements are available. Opens
the Add Vert Element dialog. At the General tab of the window select a desired vertical alignment type from the
Type drop-down list. If selecting a grade or parabola as the first element, only a grade or parabola or a circular
arc can be the next element added to the vertical alignment. If selecting a long section as the first element, only a
parabola long sections or arc long sections can be the next element of the vertical alignment.

See "General tab" section on page 291 for details.

AddHorz Element

Adds the horizontal alignment to the road. Horizontal alignment is created through line, curve, spiral, intersection.
Opens Add Horz Element dialog. In the General tab of the dialog select a desired horizontal alignment type from
the Type drop-down list.

See "General tab" section on page 281 for details.

Add X-Section

Adds a cross-section to the center line. X- section are the lines representing the surface of the road and lying in
the plane perpendicular to the center line. Opens the Add X-Section dialog.

See General tab for details.

Convert road to points dialog

To open the dialog, select the Convert -> To Points command from the pop-up menu for the selected road at the
Roads tab of the Tabular view. Fields of the dialog are described in the table below.

Fields of the Convert road to points dialog
Field Description

Create Turn
Points

When ticked, the application creates points of the center line and start/end
points of the horizontal and vertical alignments.

Create Offset
Points

When ticked, the application creates points of the center line and points lying
on the right and left of the center line at a distance specified in the X-Section
Offset window.
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Field Description

Start Name Defines the name of the first point of the point set which will be created after
converting the selected road to points.

Station Interval Defines the maximum length in the current units between points to be created.

When the both Create Turn Points and Create Offset Points checkboxes unticked, the application creates only
points of the center line.

When Create Turn Points checkbox is ticked

When Create Offset Points checkbox is ticked

When both checkbox unticked

Convert road to lines dialog

To open the dialog select the Convert -> To Lines command from the pop-up menu for the selected road at the
Roads tab of the Tabular view. Fields of the tab are described in the table below.

Field Description

Create Offset
Lines

When ticked, the application creates the lines for the road’s center line and for
two offset lines which are set on the right and left from the center line at an off-
set specified in the X-Section Offset dialog box.

Create X-Section
Lines

When ticked, the application creates the lines for the road’s center line and X-
section lines for start/end points of the horizontal and vertical alignments.

Station Interval Defines the maximum length (in the current units) of the line being created.

When the both boxes are unchecked, the application creates only the lines for the road’s center line:
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When Create Offset Lines checkbox is ticked

When Create X-Section Lines checkbox is ticked

When both checkboxes are unticked

Convert road to surface dialog

You can open this tab after selecting the Convert -> To Surface command from the pop-up menu for the selected
road at the Roads tab of the Tabular view. Fields of the dialog are described in the table below.

Fields of the Convert road to surface dialog
Field Description

Interval Defines the interval between the surface points.

Extended slopes to
the surface

Defines the territory surface adjacent to the road. You can select any existing
surface.

Surface Name Defines the name of the surface.

The series of surface points are created along the center line and each offset line for the following places:
l for start/end points of horizontal and vertical alignments,
l for points where cross-sections are defined,
l for points of curve,
l for points with the given station interval.
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X-Section Templates tab

The X-Section Templates tab is shown only if the job contains a road with X-Sections data. The tab has two pan-
els. The left panel displays a list of available X-Section templates and values of their cut and fill slopes in per-
cents. The right panel displays the offsets of the selected template in table and graphic mode. Fields of both
panels are described in the tables below.

Fields of the left panel of the X-Section Templates tab
Field Description

Icon Displays symbol assigned to the X-Section template. See "Symbols in the X-
Section Template tab" section on page 396 for details.

Name
Defines the X-Section template name. To edit the name, click on the high-
lighted filed and enter a new name. The X-Section template name is unique
and the field cannot be empty.

Cut Slope (1:n)
Defines the horizontal increment of the slope for a unit of the vertical incre-
ment. The cut slope is used when the road surface is below the terrain. By
default, cut slope equals 0 (units in percent). You can edit the parameter.

Fill Slope (1:n)
Defines the horizontal increment of the slope for a unit of the vertical incre-
ment. The fill slope is used when the road surface is above the terrain. By
default, fill slope equals 0 (units in percent). You can edit the parameter.

Fields of the right panel of the X-Section Templates tab
Field Description

Icon Displays symbol of the offset. For the offsets the icon is used.

Name Defines the offset name of the X-Section offset. To edit the name, click on the
highlighted filed and enter a new name. You can leave the field empty.

Order Displays the order of the offset in the template. You can set any number from
the list of offset number.

Hz. Dist Defines the horizontal offset (in the current linear units) from the center line
for the offset. You can edit the value.

V Dist
Defines the vertical offset from the horizontal plane for the offset. You can
edit the value. When you enter this parameter, the Grade will be automatically
calculated and displayed in the appropriate field.

Grade
Defines the ratio of horizontal offset and vertical offset multiplied by 100%.
When you enter this parameter, the Vertical distance will be automatically cal-
culated and displayed in the appropriate field.

Hz. Offset from
CL

Defines the horizontal offset from the center line (in the current linear units)
for the start point of the given offset. It is calculated using the corresponding
values of the previous offsets and it is not editable.

V. Offset from CL
Defines the vertical offset from the horizontal plane for the start point of the
offset. It is calculated using the corresponding values of the previous offsets
and it is not editable.
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Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into three groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section on page 204 for details.

l Specific commands for the left panel X-Section Templates tab. See "Pop-up menu for the left panel of the
X-Section Template tab" section below for details.

l Specific commands for the right panel X-Section Templates tab. See "Pop-up menu for the right panel of the
X-Section Template tab" section below for details.

Pop-up menu for the left panel of the X-Section Template tab
In the left panel of the X-Section tab you can perform the special (only for template) commands:

l Add X-Section Template — allows you to create a new X-Section Template and to save it in the job.
Opens the Add X-Section Template dialog. It is similar to the Properties dialog for the X-Section template.
See "Properties dialog for X-Section template" section on page 296 for details.

After clicking OK the new template is displayed in the left panel of the tab and automatically opens the
Add Offset dailog. You can create an offset for the template in this dialog.

l Add Offset— allows you to create an offset (segment) for the selected X-Section Template. Opens the
Add Offset dialog. It is similar to the Properties dialog for the offset. See "Properties dialog for X-Section
Offset" section on page 296 for details.

Pop-up menu for the right panel of the X-Section Template tab
In the right panel of the X-Section Template tab you can perform the special (only for offsets) command:

Add Offset— allows you to create an offset (segment) for the selected X-Section Template. Opens the Add Off-
set dialog. It is similar to the Properties dialog for the offset. See "Properties dialog for X-Section Offset" section
on page 296 for details.

Text tab

The Text tab from the Tabular view is shown only when the job contains text objects. The text object can be cre-
ated in the job or it can be imported in the job. Fields of the tab are described in the table below.

Field Description

Contents Defines the content of the text box. You can type any text here.

Layer
Defines the Layer in which the Text resides. The Layer sets the plotting style
for the text. You can select any Layer from the list of layers available in the
job. The field cannot be empty.

Color Defines the text color for the Map view. If you set BYLAYER, the color of
the text will be set automatically by layer settings.

Angle Defines the angle rotation of the text box in degrees. By default, the values is
zero, which means horizontal orientation of the text.

Text Height Defines the height of the text in the current linear units.

Font Name Defines the font for the text. You can select any font from the list of available
fonts.
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Field Description

Insertion Point Defines where the insertion point will be located on the text box.

Draw Box Defines whether to draw the frame around the text.

Start Point Defines the name of the start point of the text box. You can selected any exist-
ing point of the current job.

Inverse tab
The Inverse tab from the Tabular view displays a table that lists the results of the inverse calculations.

The table appears only when you click the Inverse icon from the COGO group at the Report tab of the ribbon.

The results will be displayed in the tab after clicking Calculate at the Inverse panel. This table stores the pre-
vious results of the inverse calculations. Fields of the tab are described in the table below.

Fields of the Inverse tab
Field Description

From Displays the name of the start point (if the point has name) in the Inverse task.

To Displays the name of the end point (if the point has name) in the Inverse task.

Forward Azimuth

The calculated value depends on the selected coordinate system. If the global
coordinate system (WGS Lat,Lon,Ell.H / Datum Lat,Lon,Ell.H / Datum
Lat,Lon,Elevation) is selected in the Status bar, the horizontal geodesic azi-
muth from the "From" point to the "To" point is displayed. For Grid/Ground
coordinate system, selected in the Status Bar, grid/ground azimuth (bearing)
from the "From" point to the "To" point is displayed.

Backward Azi-
muth

The calculated value depends on the selected coordinate system. If the global
coordinate system (WGS Lat,Lon,Ell.H / Datum Lat,Lon,Ell.H / Datum
Lat,Lon,Elevation) is selected in the Status bar, the horizontal geodesic azi-
muth from the "To" point to the "From" point is displayed. For Grid/Ground
coordinate system, selected in the Status Bar, grid/ground azimuth (bearing)
from the "To" point to the "From" point is displayed.

Geodetic Distance Displays the length of the geodetic line (the shortest distance) between the two
points on an ellipsoid in the current unit.

Ground Distance

The calculated value depends on whether the Grid-to-Ground transformation is
activated or not. If Grid to Ground transformation is not activated, it will be the
geodetic distance multiplied by the scale factor, which is automatically cal-
culated taking into account the height of the first point. If Grid to Ground trans-
formation is activated, the Ground Distance displays a grid distance multiplied
by the scale factor calculated, taking into account the average job height.

Grid Distance
Displays the shortest distance between two points on a projection plane in the
current unit. This value will be displayed when a "Grid" coordinate system is
selected in the Status bar.

Slop Distance Displays the 3D distance between the points, in current unit.

Delev
Displays the difference in orthometric heights, in current unit. This value will
be displayed, if Ground or Grid or Datum Lat, Lon, Elevation is selected in the
Status bar.
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Field Description

Delta Ell. H
Displays the difference in ellipsoidal heights, in current unit. This value will be
displayed, ifWGS84 Lat, Lon, Ell.H or Datum Lat, Lon, Ell.H is selected in the
Status bar.

dN Displays the difference in Norting coordinates, in current unit. This value will
be displayed when a projection is defined in the Job Configuration.

dE Displays the difference in Easting coordinates, in current unit. This value will
be displayed when a projection is defined in the Job Configuration.

Note Displays a user comment. To edit the note, click on the highlighted field and
enter a user's comments.

Right-click on a highlighted line to display a pop-up menu. This menu contains common commands for all tabs of
the Tabular View. See "Common pop-up menu of the Tabular View" section on page 204 for details.
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Drawing Different Distances calculated in Inverse window

Compare Surfaces tab
The Compare Surfaces tab from the Tabular view displays a table that lists the results of the surfaces comparison.

The tab appears only when the Compare Surfaces icon from the COGO group at the Report tab of the ribbon is
pressed.

The results will be displayed in the tab after clicking Calculate at the Compare Surfaces panel. This table stores
the previous results of the inverse calculations. Fields of the tab are described in the table below.

Fields of the Inverse tab
Field Description

Design Displays the name of the first surface/road from comparison.

Existing Displays the name of the second surface from comparison.

Level Displays the level of the horizontal pane from comparison.

Cut

If two surfaces were compared — displays the cut volume to correct the exist-
ing surface to the design surface. See Comparing two surfaces picture below.

If a surface and a level were compared — displays the cut volume to correct
the design surface to the specified level. See Comparing surfaces and a level
picture below.

Fill

If two surfaces were compared — displays the fill volume to correct the exist-
ing surface to the design surface. See Comparing two surfaces picture below.

If a surface and a level were compared — displays the fill volume to correct
the design surface to the specified level. See Comparing a surface and a level
picture below.

Area Displays the common area of two surfaces or a surface and a horizontal pane.

Note Defines any additional notes about comparison.

Save as Surface Tick to save the result of comparison as a new surface.
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Comparing two surfaces

Comparing surfaces and a level
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Right-click on a highlighted line to display a pop-up menu. This menu contains common commands for all tabs of
the Tabular View. See "Common pop-up menu of the Tabular View" section on page 204 for details.

Field Report tab
The Field Report tab from the Tabular view is shown only when the job contains reports imported from MAGNET
Field job. Fields of the tab are described in the table below.

Field Description

Icon Displays a symbol assigned to a field report.

Name Defines the name of the field report.

Author Defines the name of the field report's author.

Job name Defines the name of the job from which the report was imported.

Project name Defines the name of the Enterprise project to which the source job belongs to.

Note Defines any additional information about imported report

Time Displays the time of the report generation in MAGNET Field.

Latitude Defines the latitude coordinate from the field report.

Longitude Defines the longitude coordinate from the field report.

Height Defines the height coordinate from the field report.

Images Displays the quantity of the attached images.

Station Equations tab
While designing a road there may be a situation when the original stationing does not fit to the actual alignment,
and a new center line stationing may be needed. Station Equations are a method to link an old and a new roadway
stationing. Station equations are used to change the stationing forward or back from a some spot along the align-
ment. Approaching stationing, behind the spot, where station equation is applied is called Back Station, departing
stationing, which is after this spot is called Ahead Station.

Original stationing — second segment is 5 meters long, the third station is 0+15.00, and the end station is 0+19.00.
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The second segment has been prolonged to 7 meters. Third station became 0+17.00, and the end station became
0+21.00.

The Station Equation is applied to the third station. Its formula is Back Station = 0+17.00, Ahead Station =
0+15.00. The end station is 0+19.00 again.

The Station Equations tab is displayed only if the job contains at least one station equations set. The tab displays a
table containing two panels. The left panel contains all sets of station equations, and the right panel displays sta-
tion equations from the selected set.

Fields of the left panel
Field Description

Icon Displays a symbol assigned to a Station Equations set.

Name Defines the name of the station equation set.

Fields of the right panel
Field Description

Icon Displays a symbol assigned to a Station Equation.

Order Defines the order of the station equation in the set.

Name Defines the name of the station equation.

Back Station Defines stationing of the approaching segment, behind the spot, where station
equation is applied

Ahead Station Defines stationing of the departing segment, after the spot, where station equa-
tion is applied
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Right-click on a highlighted line to display a pop-up menu. This menu contains a set of commands and they can be
divided into three groups:

l Common commands for all tabs of the Tabular View. See "Common pop-up menu of the Tabular View"
section below for details.

Pop-up menu for the left panel of the Station Equations tab
In the left panel of the Station Equations tab you can perform the following special command:

Add Station Equations Set— adds station equations set.
1. In the left pane of the Station Equations tab, right-click and select Add Station Equations Set.

The Add Station Equations Set dialog is displayed.
2. In the Name editbox, type the name of the station equations set.
3. Click OK.

The newly created station equations set is displayed in the left panel of the Station Equations tab.

Pop-up menu for the right panel of the Station Equations tab
In the right panel of the Station Equations tab you can perform the following special command:

Add Station Equation— adds station equation to the selected set.
1. In the left pane of the Station Equations tab, select the required Station Equations Set.
2. In the right panel, right-click and select Add Station Equation.

The Add Station Equation dialog is displayed.
3. In the Name editbox, type the name of the station equation.
4. In the Back Station editbox, specify the stationing for the approaching segment.
5. In the Ahead Station editbox, specify the stationing for the departing segment.
6. Click OK.

Common pop-up menu of the Tabular View
In any tab of the Tabular view you can highlight a line, right click it and perform the following commands:

l Exporting data to Civil 3D format. Select Export to Civil 3D from the pop-up menu.
l Exporting data to an appropriate file format.

1. Select Export from the pop-up menu.

The Export dialog is displayed.
2. In the Name editbox, type the file name.
3. From the Format drop-down list, select the file format.
4. Click Save to start the export procedure.

l Cutting a line from the Tab. Select Cut from the pop-up menu. The highlighted line will be removed from
the tab, and the content of the line will be placed to the clipboard.

l Copying a line to a text editor such as Microsoft®Excel or Microsoft®Word. Select Copy from the pop-up
menu. Open the target application and paste the information.

l Deleting a line from the Tab. Select Delete from the pop-up menu. The highlighted line will be removed
from the tab.
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l Showing the related objects for the lines. This function will automatically highlight the related objects in
the corresponding tab. Select the Show related objects from the pop-up menu, and define the target tab:

l Open the Properties dialog. Select Properties from pop-up menu. See "MAGNET Tools Entities Prop-
erties" section on page 218 for details.

l Open the Options dialog for this tab. Right click in any place of the tab and select Options from pop-up
menu. See "Options dialog" section on page 316 for details.

The list of the available commands depends on the number of selected line . If ONE line is selected, you see the
list of commands which are related to ONLY one object. If several lines are selected, you see the list of com-
mands which are related to every object.

Observations View
The Observation View displays a graphic representation of the GPS, RTK, TS and DL survey data in the hori-
zontal plane of the current coordinate datum or projection. The displayed points and observations use symbols
described in the Legend window.

You can show or hide the coordinate grid, scale bar, legend window, background image and change the back-
ground color in the Observation View. See "Observations View Options dialog" section on page 317 for details.

In the window for any displayed point or/and observation you can open a menu of commands. These commands
are identical to the commands for these objects in the Tabular view.

Map View
The Map View displays graphic representation of the points, polylines, surfaces and roads in the horizontal plane
of the current coordinate datum or projection. Objects are displayed with the color/width/style of the cor-
responding layer. You can show or hide objects of the given layer by means of switching the corresponding attrib-
ute in the Layers window.

In the Map View Options dialog you can show or hide the coordinate grid, scale bar, legend window, background
image and change the background color in the Map View. See "Map View Options dialog" section on page 319
for details.

In the window you can switch on the Bing maps view by clicking the Bing Map view icon from the Spatial group
of the View tab. See "Bing Map view icon" section on page 43 for details.

NOTE
The Bingmapswill be displayed inWebSphereMercator map projection only to display the job objects
on the Bingmaps, MAGNET Tools automatically transforms the objects coordinates from the current
coordinate system to theWebSphereMercator projection. In thePoints tab of the Tabular view, the
coordinates of all objects of the job are displayed in the current coordinate system.

In the window for any displayed point or/and observation you can open a menu of commands. These commands
are identical to the commands for these objects in the Tabular view.
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3D View
The 3 D View displays points, lines, surfaces, roads and polylines using a three-dimensional representation of the
data. Surfaces and roads are displayed with the color of the layer. Lines are displayed in the color set for this
lines.

Pan mode
To activate the Pan mode use one of the following:

l Click and hold the mouse wheel.
l Right-click and select Pan mode from the pop-up menu.
l In the Zoom group of the Window tab, click the Pan Mode icon.
l Use the internal arrows of the Navigation Control:

Zoom mode
To activate the Zoom mode use one of the following:

l Scroll the mouse wheel of the mouse
l right-click and select Zoom from the pop-up menu.
l In the Zoom group of the Window tab, clickclick the desired zoom icons on
l Use the internal arrows of the Navigation Control:

Object rotation
To rotate an object use one of the following:

l Right-click and select Rotate from the pop-up menu.
l In the Zoom group of the Window tab, click the Rotate Mode icon.
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l use the internal arrows of the Navigation Control:

Vertical scaling
To increase/decrease the vertical scale in the 3D view, use one of the following

l Scroll the mouse wheel while holding the Ctrl + Alt keys.
l use the buttons of the Navigation Control:

Objects rotation
To turn the object clockwise /counterclockwise in the screen plane, use the buttons of the Navigation Control:

Restoring defaults
To restore the default scale and rotation in the window, click on the Navigation Control.

You can:
l display either the solid model or the wireframe model or both the solid and a wireframe models
l show or hide the coordinate grid, scale bar, legend window, background image
l change the background color

See "3D View Options dialog" section on page 319 for information about 3D view configuration.

Antenna List

The window displays parameters of all GPS antennas which were calibrated either by NGS, or TPS. These para-
meters are viewable, but not editable. Also the window displays the user-defined antenna types. You can edit and
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remove the custom antennas from the antenna list. Fields of the list are described in the table below.

Fields of the Antenna List
Field Description

NGS Name

Displays the standard NGS (http://www.ngs.noaa.gov/ANTCAL/) or TPS
antenna name. This name is editable only for the custom antenna type. This
name displays in the 'Antenna number and type' line of the RINEX observation
file and in the corresponding line of the TPS raw data file.

Name Displays the antenna name used in the software interface. This name is edit-
able only for the custom antenna type.

Antenna Cal-
ibration

Displays the type of antenna calibration. The absolute calibration is a default
setting. The user can select only the absolute calibration for the custom
antenna. The NGS and TPS calibration contains the absolute and relative cal-
ibrations:

l Relative – the antenna offsets and phase center variations are computed
with respect to the AOAD/M_T antenna

l Absolute – the recalculated relative calibration that takes into account
the absolute values for AOAD/M_T antenna.

Radius Displays the antenna's radius in millimeters. This parameter is editable only for
the custom antenna type. See picture below for details.

L1 Base Offset
(A1)

Displays the vertical offset measured from ARP (Antenna Reference Point) to
the phase center for GPS frequency L1 in millimeters. This parameter is edit-
able only for the custom antenna type. See picture below for datails.

L2 Base Offset
(A2)

Displays the vertical offset measured from ARP (Antenna Reference Point) to
the phase center for GPS frequency L2 in millimeters. This parameter is edit-
able only for the custom antenna type. See picture below for datails.

L1 Plane Offset
(C1)

Displays the vertical offset measured from the antenna slant height measure
mark (SHMM) to the phase center for GPS frequency L1 in millimeters. This
parameter is editable only for the custom antenna type. See picture below for
datails.

L2 Plane Offset
(C2)

Displays the vertical offset measured from the antenna slant height measure
mark (SHMM) to the phase center for GPS frequency L2 in millimeters. This
parameter is editable only for the custom antenna type. See picture below for
datails.

L1 Easting Offset
(E1)

Displays the easting offset of the phase center for GPS frequency L1 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters. This
parameter is editable only for the custom antenna type.

L2 Easting Offset
(E2)

L1 Northing Offset
(N1)

Displays the norting offset of the phase center for GPS frequency L1 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters. This
parameter is editable only for the custom antenna type.
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Field Description

L2 Northing Offset
(N2)

Displays the norting offset of the phase center for GPS frequency L2 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters. This
parameter is editable only for the custom antenna type.

Manufacturer Displays the antenna manufacturer. This parameter is editable only for the cus-
tom antenna type.

Note

Displays any additional information for the selected antenna. For NGS cal-
ibration this field contains a part number of the given antenna. For TPS cal-
ibration this filed contains "TPS Calibration". This parameter is editable only
for the custom antenna.

Antenna parameters

TS Instruments

The window displays Total Station parameters. These parameters are viewable, but not editable. Also the window
displays the user-defined instrument type. You can edit and remove the custom Total Station from the list. Fields
are described in the table below.

Field Description

Name Displays the unique name of the device. This parameter is editable only for the
custom instrument type.
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Field Description

EDM

Displays the value of the first component for the calculation of the distance
determination error when using this device. The distance determination error of
the instrument is calculated by the formula:

ppm

isplays the value of the second component for the calculation of the distance
determination error when using this device. The distance determination error of
the instrument is calculated by the formula:

Vert. Accuracy Displays the error of the vertical angle measurement, in seconds. This para-
meter is editable only for the custom instrument type.

Horz. Accuracy Displays the error of the horizontal angle measurement, in seconds. This para-
meter is editable only for the custom instrument type.

Max Distance Displays the maximum range for this device. This parameter is editable only
for the custom instrument type.

Note Displays any additional notes for the selected instrument. This parameter is
editable only for the custom instrument type.

Manufacturer Displays the instrument manufacturer. This parameter is editable only for the
custom instrument type.

Classes View

The window displays the list of the classes for Total Station measurements. Each class has a specified number of
measurements of horizontal angle / vertical angle / distance and tolerances of angle and distance measurements.
In this window you can edit any existing class and add a new class. Fields of the view are described in the table
below.

Field Description

Icon Displays a symbol assigned to a TS measurement class.

Name Defines the name of the class. The class name is unique and the field cannot
be empty.

Note Defines any additional note about class.

Num Sets
Defines the set number of horizontal angle (HA) measurements. You can
select either direct, or single direct and reverse, or multiple direct and reverse
measurements of HA.
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Field Description

VA
Defines when the vertical angle (VA) will be measured. You can select either
vertical angle measurement for direct measurements only, or for first direct
and reverse measurements, or for all direct and reverse measurements of HA.

Dist

Defines when the distance will be measured. You can select either do not
measure the distance, or perform the distance measurement for first direct
measurements only, or for first direct and reverse measurements, or for all dir-
ect or all direct and reverse measurements.

Num Dist
Defines the number of measurements for distance determination. You can
select either one, or multiple measurements. Only the first distance meas-
urement is used in position calculation.The other ones are just recorded.

Hz Defines the tolerance value in the horizontal plane in current angular units. The
field is available for one or more direct and reverse measurements of the HA.

Hz (r+l)
Defines the tolerance value of the oscillation of the direction in the horizontal
plane in current angular units. The field is available for one or more direct and
reverse measurements of the HA.

Hz (r-l)
Defines the tolerance value of the oscillation of the collimation error in the hori-
zontal plane in current angular units. The field is available for one or more dir-
ect and reverse measurements of the HA.

VA
Defines the tolerance value in the vertical plane in current angular units. This
field is available when VA is measured either for one direct and reverse meas-
urements or for all direct and reverse measurements of HA.

Distance
Defines the tolerance value for the repeated distance measurements during one
set. The field is available when the value of the Num Dist parameter is more
than 1.

Dist Sets Dev
Defines the tolerance value for the repeated distance measurements during sev-
eral sets. The field is available when the value in the filed Dist is either 1DR,
or D, or RD.

Occupation View
The Occupation View displays occupations for the current job.The Occupation View is a diagram window with
date and time displayed on the horizontal axis, and points or receivers on the vertical axis.Occupations are shown
as filled or unfilled rectangular plots. See the Legend window for more detailed information.

You can see the following occupations:

Static occupation. For this occupation, raw data was collected with the
base or rover receiver during static GPS measurements. The GPS antenna
of the base / rover receiver remains motionless during data collection for
the point.

Kinematic occupation. For this occupation, raw data was collected with
the rover receiver during kinematic GPS measurements. The rover
antenna is movable during data collection.
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Stop occupation. For this occupation, raw data was collected with the
rover receiver in the static part of the Stop and Go measurements. The
GPS antenna of the rover receiver remains motionless during data col-
lection for the point.

Go occupation. For this occupations, raw data was collected with the
rover receiver in the kinematic part of the Stop and Go measurements.
The rover antenna is movable during data collection.

Base occupation. For this occupation, data was collected at the base sta-
tion during RTK measurements. This occupation does not contain code
and carrier phase measurements.

Topo occupation. For this occupations, data was collected with the rover
receiver during kinematic RTK measurements. The rover antenna remains
motionless during data collection for the point. The rover antenna is mov-
able during data collection. This occupation does not contain code and car-
rier phase measurements.

AutoTopo occupation. For this occupations, data was collected during
static RTK measurements. . This occupation does not contain code and
carrier phase measurements.

The Occupation view option allows you to view a session’s occupations in two different modes — occupation by
receivers and occupation by points.

In the occupation by receivers mode the vertical axis of the occupation view graph represents the serial numbers
of the receivers used for data collection:

In the occupation by points mode the vertical axis of the occupation view graph represents the names of the points
where the data was collected:

To select the desired display mode:
1. In the Occupation view, right click and select Options from the pop-up menu.

The Occupation View Options dialog is displayed.
2. Open the Occupation View tab.
3. Select the display mode, by selecting the appropriate radiobutton.
4. Click OK.
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To view individual satellite epochs for a GPS occupation (not for RTK occupation), click the node ( ) for the
point/receiver. When the node is expanded, the satellite availability bars will be displayed for each occupation.

In the View you can disable any satellite's observation in whole or in part. The MAGNET Tools engine does not
use the disabled intervals for the satellites, when computing the corresponding baselines or trajectories. To disable
the satellite’s observations, select the required part of the observation for a satellite, right click on any place of
the View and select Disable from the pop-up menu:

Disabled observation

To recover the disabled part of the observation for a satellite, select the part of the observation, right click on any
place of the View and select Enable from the pop-up menu:

Ephemeris View
The Ephemeris View displays the list of the ephemeris which were imported to the current project. The right
panel of the view displays:

l the operational part of the broadcast navigation message for GPS, Glonass and Galileo ephemeris.
l the true coordinates and velocity of the GPS, Glonass and Galileo satellites for precise ephemeris.

You cannot edit any parameters in the view.
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Codes

The window displays the list of all codes and their attributes used in the job. The window contains two panels.
The left panel contains codes and the right panel contains code attributes.

To create a new code:
1. Right-click in the left panel and select New Code from the pop-up menu.

The New Code dialog is displayed.
2. In the Name editbox, type the name for the new code.
3. From the Type drop-down list, select the required type of the code.
4. If needed, configure the layout parameters of the code for lines, points areas and surfaces at the appro-

priate tabs.
5. Click OK.

To create a new code attribute:
1. In the left panel, select the required code.

NOTE
You can create an attribute for a code, if the code is not used for an object in the job.

2. Right-click in the right panel and select New Attrubute from the pop-up menu.
3. Select the required code type from the additional menu.

The New Attribute dialog is displayed.
4. In the Attribute Name editbox, type the name for the new attribute.
5. If needed, in the Default Value editbox, type the default value of the attribute.
6. In needed, tick the Required checkbox.
7. Click OK.

Fields of the left panel.
Field Description

Icon The icon is used.

Name Displays the name of the code. You can edit the code's name, if the code is not
used for an object of the job.

Description Displays any additional text information about the code.

Type

In this field you can select the type of the code:
l Point — if you apply this type for a points of the job, you can use or not
use the points in a surface.

l Line — if you apply this type for a lines of the job, you can use or not
use the lines in a surface, and use or not use the lines as breakline in a
surface.

l Area — if you apply this type for a areas of the job, you can use or not
use the areas in a surface, use or not use the areas as breakline, and use
or do not use the areas as exclusion area (hole) in a surface.
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Field Description

Layer

Displays the Layer where the code resides. The Layer sets the plotting style
for the code. Every code has a non-empty Layer. In this field, you can select
any Layer from the list of user-created layers. By default the selected Layer
sets the plotting style of the code and all plotting style (symbol and color for
point; color, style and width for line; color, fill style and fill transparency for
area) automatically are set to BYLAYER. You can change the plotting style.

Line Color Displays the polyline color for Map View. By default the parameter is set to
BYLAYER. You can choose any color from the list.

Line Style
Displays the polyline style (solid, dashed, dashed-and-doted, doted) for Map
View. By default the parameter is set to BYLAYER. You can choose any
style from the list.

Line Width Displays the polyline width (from 1 to 10 pixels) for MapView. By default the
parameter is set to BYLAYER. You can choose any width from the list.

Point Symbol Displays the point symbol in Map View. By default the parameter is set to
BYLAYER. You can choose any symbol from the list.

Point Color Displays the point color in Map View. By default the parameter is set to
BYLAYER. You can choose any color from the list.

Area Color Displays the color of the closed polyline (area) in Map View. By default the
parameter is set to BYLAYER. You can choose any color from the list.

Area Fill Style Displays the fill stile for closed polyline (area) in Map View. By default the
parameter is set to BYLAYER. You can choose any fill style from the list.

Fill Transparency Displays the transparency value for closed polyline (area) in 3D View. By
default the parameter is set to BYLAYER.

Use in Surface
When ticked, the points, lines or areas with the code may be used in a surface.

When unticked, the points, lines or areas with the code cannot be used in a sur-
face.

Breakline

When ticked, the lines or areas with the code may be used as breakline in a sur-
face.

When unticked, the lines or areas with the given code cannot be as breakline in
a surface.

Exclusion Area

When ticked, the areas with the code will be used as exclusion area (hole) in a
surface.

When unticked, the areas with the code will not be as exclusion area (hole) in
a surface.

Fields of the right panel.
Field Description

Icon The icon is used.

Attribute Name Displays the name of the attribute. You can edit the attribute's name, if the cor-
responding code is not used for an object of the job.
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Field Description

Default Value

In this field you can enter or select from the list the default value for each
attribute's type. You can edit the attribute's default values, if the corresponding
code is not used for a object of the job. The field cannot be empty if you the
Required checkbox is ticked.

Type

Displays the type of the attribute. You cannot edit the type for the created
attribute. You can select one of the following types when creating a new attrib-
ute:

l Integer — any integer number
l Real Number — any real number
l Text — any alpha-numeric string that contains up to 255 characters
l Menu — you can select any attribute from a list. You can add and
remove any value and text to/from the list

l Date/Time — the current date and time
l Boolean — you can select True or False values.

Required When ticked, the attribute's value must be defined for code.

NOTE
You can create a code of different type, but in MAGNET Tools you can apply the code only to a point. A
code of the line type or the area type can be assigned inMAGNET Field. MAGNET Tools will display
such codes after importing theMAGNET Field job.

Layers

The window displays the list of all layers and their plotting styles used in the job. By default, every MAGNET
Tools job includes a layer named "0" (zero). Layer 0 cannot be deleted or renamed. However, you can edit the
plotting style of the layer. In the window you can create a new layer.

To create a new layer:
1. In the Layers window, right-click and select Add Layer from the pop-up menu.

The Add Layer dialog is displayed.
2. In the Name editbox, type the name for the new layer.
3. Configure the rest of parameters as you need. See table below for field descriptions.
4. Click OK.

The layer is created.

Fields of the Layers window
Field Description

Name Displays the name of the layer. You can edit the layer's name for any layer,
except the layer with zero name.

Visible Defines the visibility of the layer. Layer is visible when checkbox is ticked.
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Field Description

Line Style Displays the polyline style (solid, dashed, dashed-and-doted, doted) for Map
View. You can choose any style from the list.

Line Width Displays the polyline width (from 1 to 10 pixels) for Map View. You can
choose any width from the list.

Color Displays the color for any objects with the given layer. You can choose any
color from the list for displaying in Map View.

Point Symbol Displays the point symbol in Map View. You can choose any symbol from the
list.

Breakline Type

In this field you can select one of the following types:
l Auto — when creating a surface, the polyline/area with the given layer
can be as boundary or breakline or exclusion,

l Breakline — when creating a surface, the polyline/area with the given
layer can be only breakline,

l Boundary — when creating a surface, the polyline/area with the given
layer can be only boundary,

l Exclusion — when creating a surface, the area with the given layer can
be only exclusion area.

Note Displays any additional text information about the layer.

Area Fill Style Displays the fill style for closed polyline (area) in Map View. You can choose
any fill style from the list.

Fill Transparency Displays the transparency value for closed polyline (area) in 3D View.
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MAGNET Tools Entities Properties
Each entity used in the MAGNET Tools projects has a set of properties, which allows you to configure them to
fits you needs. You may edit properties of any object at any time by using the Properties dialog.

To edit properties of an object, or a group of objects, select them, right-click select Properties from the pop-up
menu, or click the Properties icon from the Properties group of the Edit tab. For more information refer to the cor-
responding sections:

l "Point Properties dialog" section below
l "GPS Occupation Properties dialog" section on page 228
l "GPS Obs Properties dialog" section on page 234
l "TS Obs Properties dialog" section on page 246
l "DL Obs Properties dialog" section on page 257
l "Lines Properties dialog" section on page 261
l "Surface Properties dialog" section on page 269
l "Road Properties" section on page 274
l "X-Sections Template Properties dialog" section on page 296
l "Inverse Properties dialog" section on page 297
l "Code properties dialog" section on page 300
l "Code Attribute properties dialog" section on page 303
l "Layer properties dialog" section on page 304
l "Text properties dialog" section on page 309
l "Class properties dialog" section on page 311
l "Datum properties dialog" section on page 313
l "Projection properties dialog" section on page 314

Point Properties dialog
A point is a two- or three-dimensional in space.

The Point Properties dialog allows you to edit properties of the selected point. You may view and edit a vary of
parameters. The dialog has six tabs, described in the appropriate sections:

l "General tab" section on the facing page
l "Coordinates tab" section on page 220
l "Adjustment tab" section on page 222
l "Quality Control tab" section on page 223
l "Photo Notes tab" section on page 223
l "Codes and Style tab" section on page 224
l "Offset tab" section on page 226

To open the dialog:
1. Select the required point in one of the following views:

l Map view
l Observation view
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l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

General tab
The General tab of the Properties dialog for a point allows you to view and edit basic properties for a point.
Fields of the tab are described in the table below.

To open the tab:
1. Select the required point in one of the following views:

l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Name Displays the point's name. To edit the name, click on the highlighted field and
enter a new name. The point name is unique and the field cannot be empty.

Note Displays any additional notes for the point. To edit the value, click on the high-
lighted field and type any necessary information.

Control

Displays the status of the point's coordinates. You can select one of the fol-
lowing statuses from the drop-down list:

l None — all coordinates can be changed after adjustment or coordinate
calculation.

l Vertical — the elevation/ellipsoidal height is left unchangeable after
adjustment or coordinate calculation. The symbol is set in the
Icon column for this status.

l Horizontal — the horizontal coordinates are left unchangeable after
adjustment or coordinate calculation.The symbol is set in the
Icon column for this status.

l Both — the horizontal and vertical coordinates are left unchangeable
after adjustment or coordinate calculation.The symbol is set in
the Icon column for this status.

Code

Displays codes of the point. If a point has multiple codes, all codes of the point
will be displayed using a comma as separator, for example "1,AA,BB".

To edit a code, click on the highlighted field and either select a new one from
the drop-down list of existing codes; or type a new code(s); or set the Code to
empty.
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Field Description

Layer
Displays the Layer where the point resides. The Layer sets the plotting
style for the point. Every point has a non-empty Layer. In this field, you can
select any Layer from the list of user-created layers.

Source Displays the path of the raw data on the computer disk drive, local area net-
work, or storage media.

Enabled for Adjust-
ment

When ticked (default setting for all point types), the point and all objects
related to the given points is included in adjustment, coordinate calculation and
export. If this parameter is unchecked, adjustment, coordinate calculation and
export will ignore the points and all objects related to the given points. A dis-
abled point is grayed-out in all views.

Coordinates tab
The Coordinates tab of the Properties dialog for a point allows you to view and edit coordinates of a point. Fields
of the tab are described in the table below.

To open the tab:
1. Select the required point in one of the following views:

l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Coordinates tab.

Fields of the Coordinates tab
Field Description

WGS-84 Latitude

Displays the point's latitude coordinate in WGS84 coordinate system. To edit
the value, click on the highlighted field and type a new value.

The coordinates in WGS-84 coordinate system are available whenWGS84 Lat,
Lon, Ell.H is selected in the Status bar or in the Job Configuration dialog.

WGS-84 Longitude

Displays the point's longitude coordinate in WGS84 coordinate system. To edit
the value, click on the highlighted field and type a new value.

The coordinates in WGS-84 coordinate system are available whenWGS84 Lat,
Lon, Ell.H is selected in the Status bar or in the Job Configuration dialog.

WGS-84
Ell.Height

Displays the point's ellipsoidal (geodetic) height in WGS84 coordinate system.
To edit the value, click on the highlighted field and type a new value.

The coordinates in WGS-84 coordinate system are available when "WGS84
Lat, Lon, Ell.H" is selected in the Status bar or in the Job Configuration win-
dow.
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Field Description

X

Displays X coordinate in Cartesian geocentric (WGS-84) coordinate system in
the current units. To edit the value, click on the highlighted field and enter a
new value.

The Cartesian coordinates are available whenWGS84 X, Y, Z is selected in the
Status bar or in the Job Configuration dialog .

Y

Displays Y coordinate in Cartesian geocentric (WGS-84) coordinate system in
the current units. To edit the value, click on the highlighted field and enter a
new value.

The Cartesian coordinates are available whenWGS84 X, Y, Z is selected in the
Status bar or in the Job Configuration dialog .

Z

Displays Z coordinate in Cartesian geocentric (WGS-84) coordinate system in
the current units. To edit the value, click on the highlighted field and enter a
new value.

The Cartesian coordinates are available whenWGS84 X, Y, Z is selected in the
Status bar or in the Job Configuration dialog .

Latitude

Displays the point's latitude coordinate in the selected Datum coordinate sys-
tem. To edit the value, click on the highlighted column and type a new value.

The Datum coordinates are available when Datum Lat, Lon, Ell.H or Datum
Lat, Lon, Elevation is selected in the Status bar or in the Job Configuration
window.

Longitude

Displays the point's longitude coordinate in the selected Datum coordinate sys-
tem. To edit the value, click on the highlighted column and type a new value.

The Datum coordinates are available when Datum Lat, Lon, Ell.H or Datum
Lat, Lon, Elevation is selected in the Status bar or in the Job Configuration dia-
log.

Ell.Height

Displays the point's ellipsoidal height in the selected Datum coordinate system.
To edit the value, click on the highlighted column and type a new value.

The Datum coordinates are available when Datum Lat, Lon, Ell.H is selected
in the Status bar or in the Job Configuration dialog.

Elevation

Displays the point's orthometric height in the selected Datum coordinate sys-
tem, if the corresponding geoid file is added to the job and the geoid covers the
area where the job’s points are located. If the corresponding geoid file is not
added to the job, or it does not cover the desired area, the column will display
ellipsoidal height for all points of the job.

To edit the value, click on the highlighted column and type a new value.

This column will be displayed if you have selected either Ground | None or
Ground | Localization or Grid or Datum Lat, Lon, Elevation coordinate systems
in the Job Configuration dialog or in the Status Bar.
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Field Description

Ground Northing

Displays the point's northing coordinate in Ground coordinates. To edit the
value, click on the highlighted column and enter a new value.

The Ground coordinates are available when Ground | None or Ground | Local-
ization coordinate systems are selected in the Status bar or in the Job Con-
figuration dialog.

Ground Easting

Displays the point's easting coordinate in Ground coordinates. To edit the
value, click on the highlighted column and enter a new value.

The Ground coordinates are available when Ground | None or Ground | Local-
ization coordinate systems are selected in the Status bar or in the Job Con-
figuration dialog.

Grid Northing

Displays the point's northing coordinate in Grid coordinates. To edit the value,
click on the highlighted column and enter a new value.

The Grid coordinates are available when a projection is defined for the job and
Grid coordinate system is selected in the Status bar or in the Job Con-
figuration dialog.

Grid Easting

Displays the point's easting coordinate in Grid coordinates. To edit the value,
click on the highlighted column and enter a new value.

The Grid coordinates are available when a projection is defined for the job and
Grid coordinate system is selected in the Status bar or in the Job Con-
figuration dialog.

Geoid Separation

Displays some constant, which is the characteristic of the current geoid model
and is calculated for the given point. To get the orthometric height of the point,
subtract the value of this constant from the value of ellipsoidal height. This
Geoid Separation value is displayed when the corresponding geoid is selected
for this job in the Coordinate System item of the Job Configuration dialog.

Adjustment tab
The Adjustment tab of the Properties dialog for a point allows you to view point coordinates deviations. Fields of
the tab are described in the table below.

To open the tab:
1. Select the required point in one of the following views:

l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Adjustment tab.
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Fields of the Adjustment tab
Field Description

Std Dev n Displays the standard deviation of the northing coordinate for the point after
adjustment in Grid coordinate system.

Std Dev e Displays the standard deviation of the easting coordinate for the point after
adjustment in Grid coordinate system.

Std Dev u Displays the standard deviation of the height coordinate for the point after
adjustment in Grid coordinate system.

Std Dev Hz Displays the standard deviation of the coordinate in the horizontal plane for the
point after adjustment in Grid coordinate system.

Error Ellipses Azi-
muth

Displays the azimuth of the major semi-axis of the error ellipse for the given
point after adjustment. This value depends on the current Confidence Level.
See "General tab" section on page 100 for details about the Confidence Level.

Error Ellipse
major semi-axis

Displays the length of the major semi-axis of the error ellipse for the given
point after adjustment. This value depends on the current Confidence Level.

Error Ellipse
minor semi-axis

Displays the length of the minor semi-axis of the error ellipse for the given
point after adjustment. This value depends on the current Confidence Level.

Quality Control tab
The Quality Controlk tab of the Properties dialog for a point allows you to review points, which did not pass the
quality test. Fields of the tab are described in the table below.

To open the tab:
1. Select the required point in one of the following views:

l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality Control tab.

The pane displays information about highlighted points (marked in red in the views) that did not pass some of the
quality control checks.

Fields of the Quality Control tab
Field Description

Ignore QC When ticked, all quality control tests are not performed for the selected point.

Photo Notes tab
The Photo Notes tab of the Properties dialog for a point displays all images that were attached to the point. An
unlimited number of pictures can be attached to a point.

To open the tab:
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1. Select the required point in one of the following views:
l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Photo Notes tab.

To see a picture, select it from the Photo Note Number drop-down list.

To add a picture:
1. Click Add Photo Note.

The Open dialog is displayed.
2. Navigate to the required picture and open it.

To remove a picture:
1. Select the required picture from the Photo Note Number drop-down list.
2. Click Remove Photo Note.

Codes and Style tab
The Codes and Style tab of the Properties dialog for a point allows you to view and edit code, string, control
codes and plotting style for a point. Fields of the tab are described in the table below.

To open the tab:
1. Select the required point in one of the following views:

l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Codes and Style tab.

Fields of the Codes and Style tab
Field Description

Code

Displays codes of the point. If a point has multiple codes, all codes of the point
will be displayed using a comma as separator, for example "1,AA,BB".

To edit a code, click on the highlighted field and either select a new one from
the drop-down list of existing codes; or type a new code(s); or set the Code to
empty.

String
Displays the string for the point. A complex of strings and codes allows you to
create a line in the job automatically. The software will automatically create a
line between points with the same Code and String value.
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Field Description

Control Code

Displays the control code used for the point. The Control Code list can contain
the following codes:

l Codes, created by Topcon programmers (default codes). Using these
codes will modify the existing linework or add a line to the existing line-
work. You can apply the control codes only to the points which have the
same Code and String value. You select the following default control
code from the list:

l Arc Start — defines the start point of an arc
l Arc End — defines the end point of an arc
l Close — automatically add a line to close the figure. This option
will work only for a figure that contains more than two points

l Rectangle — automatically adds point to close the figure as a
rectangle. This option will work only for a figure that contains
three points

l Codes, created by a user. Using these codes do not modify the existing
linework.

Let's see how the default code can modify an existing line.

None — does not change an existing linework.

See "Control Code field" section on page 127 for details.

Control Code 2

Control Code 2 displays the control code used for the point. It has the same
properties as Control Code. MAGNET Tools allows you to simultaneously use
two different values of Control Code and Control Code 2.

See "Control Code field" section on page 127 for details.

Color
Displays point color for Map View. The color can be chosen from the list. If
you set BYCODE or BYLAYER, the color of the point automatically will be
set in the color that was selected for the point's code or point's layer.

Point Symbol

Displays a point symbol for Map View. The symbol can be chosen from the
list. If you set BYCODE or BYLAYER, the symbol of the point  will be auto-
matically set to the symbol that was selected for the point's code or the point's
layer.

To create a new code:
1. Right-click in the left panel of the Codes group box, and select New Code from the pop-up menu.

The New Code dialog is displayed.
2. In the Name editbox, type the name for the new code.
3. From the Type drop-down list, select the required type of the code.
4. If needed, configure the layout parameters of the code for lines, points areas and surfaces at the appro-

priate tabs.
5. Click OK.

To create a new code attribute:
1. In the Codes group box, select the required code.

NOTE
You can create an attribute for a code, if the code is not used for an object in the job.
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2. Right-click in the right panel and select New Attrubute from the pop-up menu.
3. Select the required code type from the additional menu.

The New Attribute dialog is displayed.
4. In the Attribute Name editbox, type the name for the new attribute.
5. If needed, in the Default Value editbox, type the default value of the attribute.
6. In needed, tick the Required checkbox.
7. Click OK.

To delete a cod:
1. In the Codes group box, select the required code.
2. Right click and select Delete from the pop-up menu.

The code will no longer be used for the point. Note, that deleting a code from the Codes and Style tab only
deletes the code from the list for this point, not the job.

Offset tab
The Offset tab of the Properties dialog for a point allows you to view point offsets. The tab is displayed only when
the imported MAGNET Field job contains offset data from a GPS point. The tab can have different fields depend-
ing on the offset type in the imported MAGNET Field job. Fields of the tab are described in the table below. See
"Editing and viewing MAGNET Field Offsets in the Job" section on page 345 for more information about offsets.

To open the tab:
1. Select the required point in one of the following views:

l Map view
l Observation view
l 3D view
l At the Points tab of the Tabular view.

2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Offset tab.

When the imported MAGNET Field job contains Offset Line from the GPS point, the point has the the symbol
and tab contains the following offset information:

Fields of the Offset tab
Field Description

Offset Dist
Displays the distance from the "To Point"to the projection of the offset point
along the line "From Point-To Point" in the current linear units. To edit the para-
meter, click on the highlighted column and type a new value.

Offset Ht
Displays the height difference between the ground point or the top of "To
Point"and the offset point, in the current linear units. To edit the parameter,
click on the highlighted column and type a new value.

Offset Across
Displays the distance from the offset point to the line "From Point-To Point" in
the current linear units. To edit the parameter, click on the highlighted column
and type a new value.
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Field Description

From Point Displays the start point of the line that contains offset point. You can select
any other point of the job from the list.

To Point Displays the end point of the line that contains offset point. You can select any
other point of the job from the list.

Relative/Absolute

Displays the method of height measuring. If you select Relative, the height of
the offset point is measured from the top of "To Point"(Antenna Reference
Point (ARP) of the receiver at "To Point"). If you select Absolute, the height of
the offset point is measured from the ground.

Offset line

When the imported MAGNET Field job contains Azimuth & Offsets from a GPS point, the point has the sym-
bol and the tab contains the following information:

Field Description

Azimuth

Displays the horizontal angle to the offset point, in current angular units. The
field displays non-zero values when the imported MAGNET Field job contains
Azimuth & Offsets data and this offset was performed from the measured
point. See picture below for details. To edit the parameter, click on the high-
lighted column and type a new value.

Offset Dist

Displays the distance from the Start Point to the offset point, in current linear
units. The field displays non-zero values when the imported MAGNET Field
job contains Azimuth & Offsets data and this offset was performed from the
measured point. See picture below for details. To edit the parameter, click on
the highlighted column and type a new value.

Offset Ht

Displays the height difference between the ground point and the offset point, in
current linear units.

The field displays non-zero values when the imported MAGNET Field job con-
tains Azimuth & Offsets data and this offset was performed from the measured
point. See picture below for details. To edit the parameter, click on the high-
lighted column and type a new value.

From Point Displays the start point of the line that contains offset point. You can select
any other point of the job from the list.

Relative/Absolute

Displays the method of height measuring. If you select Relative, the height of
the offset point is measured from the top of "To Point"(Antenna Reference
Point (ARP) of the receiver at "To Point"). If you select Absolute, the height of
the offset point is measured from the ground.



MAGNET Tools Entities Properties

228

See the picture of the Azimuth & Offsets

Height measuring method

To obtain the coordinates of the new offset point, click Compute Coordinates.

GPS Occupation Properties dialog
The GPS Occupation Properties dialog allows you to view and edit properties of the selected GPS Occupaiton.
You may view and edit a vary of parameters. The dialog has seven tabs, described in the appropriate sections

l General tab
l Occupation tab
l Antenna tab
l Survey Session tab
l Quality Control tab
l Offset tab
l Covariance Matrix tab

To open the dialog:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

General tab
The General tab of the Properties dialog for a GPS Occupation allows you to view and edit basic properties for
an occupation. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.
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Fields of the General tab
Field Description

Point Name
Displays the name of the occupied point. For all types of the RTK occupation
and for static GPS occupation, this column cannot be empty. To edit the name,
click on the highlighted column and enter a new value.

Original Name
Displays the initial name of the occupation as indicated in the source file. The
column cannot be empty for all types of occupation. To edit the name, click on
the highlighted column and type a new value.

Note Displays any additional notes for the selected GPS occupation. To edit the
value, click on the highlighted field and enter your comments, if necessary.

Method

Displays the surveying method for the occupation. The following methods are
presented for the GPS occupations:

l Base — data collected on the base station during RTK measurements.
l Topo — data collected during static RTK measurements. (The rover
antenna remains motionless during data collection for the point.) The
point name is the name of a ground point. This name is entered manu-
ally.

l AutoTopo — data collected during kinematic RTK measurements. (The
rover antenna is movable during collection data.) The point name is the
name of a current epoch. This name is created by the field software auto-
matically.

l Autonomous — the rover receiver does not receive the correction data
from a base during RTK measurements.

l Static — data collected on the base or rover receiver during static GPS
measurements. (The GPS antenna of the base / rover receiver remains
motionless during data collection for the point.) The point name is the
name of a ground point.

l Stop — data collected on the rover receiver during static part of the Stop
and Go measurements. (The GPS antenna of the rover receiver remains
motionless during data collection for the point.) The point name is the
name of a ground point.

l Go — data collected on the rover receiver during kinematic part of the
Stop and Go measurements. (The rover antenna is movable during col-
lection data.) The point name is empty.

l Kinematic — data collected on the rover receiver during kinematic
measurements. (The rover antenna is movable during collection data.)
The point name is empty.

Source Displays the path of the raw data to the computer disk drive, local area net-
work, or storage media.

Start Time Displays the first epoch time of the GPS occupation. The column cannot be
empty.

Stop Time Displays the end epoch time of the GPS occupation. The column cannot be
empty.
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Field Description

Duration Displays the duration of time in which the observational data was logged for
the given GPS occupation (Duration = Stop Time - Start Time).

Enabled

When ticked, the GPS observation is included in adjustment, coordinate cal-
culation and export. If this parameter is unchecked, adjustment, coordinate cal-
culation and export will ignore the vector. A disabled GPS observation is
grayed-out in all views.

Occupation tab
The Occupation tab of the Properties dialog for a GPS Occupation allows you to view and edit occupation prop-
erties for an GPS occupation. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Occupation tab.

Fields of the Occupation tab
Field Description

Orbit Displays the orbit of satellites during the occupation.

NEpoch Displays the number of epochs for the occupation.

Interval Displays the occupation logging interval, in milliseconds.

GPS week, day Displays GPS week and day of occupation start time (the time from January, 6
1980: the day of GPS launch). The field cannot be empty.

Receiver Displays the receiver's serial number.

Receiver Vendor

Displays the name of the vendor which developed this GPS receiver. You can
select a desired company from the list. This selects a vendor of the receiver to
accommodate differences in post - processing of the GLONASS measurements
by different companies.

RMS Displays the precision estimate of the GPS occupation in the current linear
units.

H RMS Displays the horizontal precision estimate of the GPS occupation in the current
linear units.

V RMS Displays the vertical precision estimate of the GPS occupation in the current
linear units.

Antenna tab
The Antenna tab of the Properties dialog for a GPS Occupation allows you to view and edit antenna information
for an occupation. Fields of the tab are described in the table below.

To open the tab:
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1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Antenna tab.

Fields of the Antenna tab
Field Description

Antenna Type

Displays the model of the GPS antenna used for the occupation. To change the
antenna type, click and select other antenna type from the drop-down list. Also
you can create a custom antenna by clicking Custom. See "Adding Custom
Antenna Type" section on page 328 for details.

NOTE
If theNone antenna type is selected, the software will use zero values for
A1/A2 parameters and in this case, the antenna phase center for L1 and L2
frequencies coincides with the Antenna Reference Point.

Antenna Height Displays the GPS antenna's height for the occupation, in the current units. To
edit the value, click on the highlighted column and type a new value.

Antenna Height
Method

Displays the method used to measure the antenna height. Select the requiered
method from the drop-down list. The following methods are available:

l Vertical — measured from the ground point to the antenna reference
point (ARP) located on the bottom of the receiver.

l Slant — measured from the ground point to the antenna slant height
measure mark (SHMM).

See picture below for details.

Antenna Centering
Error

Displays the centering error of Antenna Reference Point (ARP) position over
the mark, in the horizontal plane. This error will be taken into account when
estimating adjustment results. To edit the value, click on the highlighted
column and type a new value.

Antenna Height
Error

Displays the measurement error of the antenna height over the mark. This error
will be taken into account when estimating adjustment results. To edit the
value, click on the highlighted column and enter a new value.
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Survey Session tab
The Survey Session tab of the Properties dialog for a GPS Occupation allows you to view information about sur-
vey session conditions. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Survey Session tab.

Fields of the Survey Session tab
Field Description

Surveyor Displays the name of surveyor.

Temperature Displays the temperature during the survey session.

Pressure Displays the atmosphere pressure during the survey session.

Humidity Displays the atmosphere humidity during the survey session.

Weather Displays the weather during the survey session.

Wind Displays the wind during the survey session.

Offset tab
The Offset tab of the Properties dialog for a GPS Occupation allows you to view and edit an occupation offset
information. Fields of the tab are described in the table below. For more information about offsets, see "Editing
and viewing MAGNET Field Offsets in the Job" section on page 345.

The Original Name of this GPS occupation is "Start Point". The offset point calculated from the given GPS occu-
pation and the linear and angular offsets has the icon.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.
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The Properties dialog is displayed.
3. Click the Offset tab.

Fields of the Offset tab
Field Description

Azimuth

Displays the horizontal angle to the offset point, in current angular units. The
field displays non-zero values when the imported MAGNET Field job contains
Azimuth & Offsets data and this offset was performed from the measured
point. See picture below for details. To edit the parameter, click on the high-
lighted column and type a new value.

Offset Dist

Displays the distance from the Start Point to the offset point, in current linear
units. The field displays non-zero values when the imported MAGNET Field
job contains Azimuth & Offsets data and this offset was performed from the
measured point. See picture below for details. To edit the parameter, click on
the highlighted column and type a new value.

Offset Ht

Displays the height difference between the ground point and the offset point, in
current linear units.

The field displays non-zero values when the imported MAGNET Field job con-
tains Azimuth & Offsets data and this offset was performed from the measured
point. See picture below for details. To edit the parameter, click on the high-
lighted column and type a new value.

Offset Across Displays the distance from the offset point to the line "From Point-To Point" in
the current linear units

To obtain the coordinates of the new offset point, click Compute Coordinates.

Covariance Matrix tab
The Covariance Matrix tab of the Properties dialog for a GPS Occupation displays the six modified elements of
covariance matrix for the GPS observation and GPS Occupation. Fields of the tab are described in the table
below.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Covariance Matrix tab.
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Fields of the Covariance Matrix tab
Field Description

Sigma X Displays the square root of the Cov [X,X] diagonal element for the RTK GPS
observation in the current units.

Sigma Y Displays the square root of the Cov [Y,Y] diagonal element for the RTK GPS
observation in the current units.

Sigma Z Displays the square root of the Cov [Z,Z] diagonal element for the RTK GPS
observation in the current units.

Corr XY Displays the dimensionless correlation factor X-Y for the RTK GPS obser-
vation. Corr[X,Y] =Cov[X,Y]/(SigmaX*SigmaY).

Corr XZ Displays the dimensionless correlation factor X-Z for the RTK GPS obser-
vation. Corr[X,Z] =Cov[X,Z]/(SigmaX*SigmaZ).

Corr YZ Displays the dimensionless correlation factor Y-Z for the RTK GPS obser-
vation. Corr[Y,Z] =Cov[Y,Z]/(SigmaY*SigmaZ).

Quality Control tab
The Quality Control tab of the Properties dialog for a GPS Occupation allows you to review occupations, which
did not pass the quality test. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality Control tab.

The pane displays information about highlighted GPS Occupations (marked in red in the views) that did not pass
some of the quality control checks.

Fields of the Quality Control tab
Field Description

Ignore QC When ticked, all quality control tests are not performed for the selected occu-
pations.

GPS Obs Properties dialog
The GPS Obs Properties dialog allows you to view and edit properties of the selected GPS observation. You may
view and edit a vary of parameters. The dialog has nine tabs, described in the appropriate sections:

l "General tab" section on the facing page
l "Quality tab" section on page 236
l "Observation tab" section on page 240
l "Adjustment tab" section on page 240
l "Quality Control tab" section on page 242
l "Covariance Matrix tab" section on page 242
l "Base Antenna tab" section on page 243
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l "Rover Antenna tab" section on page 244
l "Last Processing tab" section on page 245

To open the dialog:
1. In the GPS Obs tab from the Tabular view, select the required observation.
2. Right-click and select Properties from the pop-up menu.

General tab
The General tab of the Properties dialog for a GPS Observation allows you to view and edit basic properties for
an observation. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Obs tab from the Tabular view, select the required observation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Point From
Displays the name of the base station point for GPS observation (vector). The
column cannot be empty. You can edit the name only at the GPS Occupation
tab.

Point To
Displays the name of the rover station point for GPS observation (vector). The
column cannot be empty. You can edit the name only in the GPS Occupation
tab.

Start Time Displays the first epoch time of common interval for the GPS observation (vec-
tor). The column cannot be empty.

Stop Time Displays the end epoch time of common interval for the GPS observation (vec-
tor). The column cannot be empty.

Duration Displays duration of common time interval for base and rover occupations for
the given GPS observation (Duration = Stop Time - Start Time).

Note Displays any additional notes for the selected GPS observation. To edit the
value, click on the highlighted field and enter comments, if necessary.

GPS week, day Displays GPS week and day of observation start time (the time from January, 6
1980: the day of GPS launch). The field cannot be empty.
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Field Description

Method

Displays the observation method. The following methods are presented:
l RTK Topo— an RTK observation is created from a Base and aTopo
occupations

l RTK Auto Topo— an RTK observation is created from a Base and a
AutoTopo occupations

l PP— an observation is created from two Static occupations
l PP Stop— an observation is created from one Static and one Stop occu-
pations

l PP Go— an observation is created from one Static and one Go occu-
pations

l PP Kinematic — an observation is created from one Static and one
Kinematic occupations.

The field cannot be empty.

Enabled

When ticked, the GPS observation is included in adjustment, coordinate cal-
culation and export. If this parameter is unchecked, adjustment, coordinate cal-
culation and export will ignore the vector. A disabled GPS observation is
grayed-out in all views.

Quality tab
The Quality tab of the Properties dialog for a GPS Observation allows you to view quality parameters of an obser-
vation. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Obs tab from the Tabular view, select the required observation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality tab.

Fields of the Quality tab
Field Description

Horizontal Pre-
cision

Displays the horizontal precision estimate of the GPS observation, in current
linear units.

Error Ellipses Azi-
muth

Displays the azimuth of the major semi-axis of the error ellipse for the given
GPS observation.

Error Ellipses
major semi-axis

Displays the length of the major semi-axis of the error ellipse for the given
GPS observation.

Error Ellipses
minor semi-axis

Displays the length of the minor semi-axis of the error ellipse for the given
GPS observation.

Vertical Precision Displays the vertical precision estimate of the GPS observation, in current lin-
ear units.
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Solution Type

Displays the type of solution for RTK and GPS observations.

For RTK vectors or trajectory:
l Fixed, Phase Diff— the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) of the base (or VRS) and a rover. All ambiguities have been
fixed to integers.

l Fixed, Phase Diff, mmGPS+— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS), a rover and mmGPS aided
rover receiver. All ambiguities have been fixed to integers.

l Fixed, Phase Diff, Degraded— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS) and a rover with the spe-
cified level of vertical/horizontal positional accuracy in the rover
receiver's option. All ambiguities have been fixed to integers.

l Fixed, Phase Diff, Degraded, mmGPS+— the solution is computed by
using dual frequency measurements (L1/L2 GPS/GLONASS code and
carrier phase measurements) of the base (or VRS) and a rover with the
specified level (in the rover receiver's option) of vertical/horizontal pos-
itional accuracy, and the mmGPS aided. All ambiguities have been fixed
to integers.

l Float, Phase Diff— the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) of the base (or VRS) and a rover. All ambiguities are float
numbers.

l Float, Phase Diff, mmGPS+— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS), a rover and mmGPS aided
rover receiver. All ambiguities are float numbers

l Float, Phase Diff, Degraded— the solution is computed by using dual
frequency measurements (L1/L2 GPS/GLONASS code and carrier
phase measurements) of the base (or VRS) and a rover with the spe-
cified level (in the rover receiver's option) of vertical/horizontal pos-
itional accuracy. All ambiguities are float numbers.

l Float, Phase Diff, Degraded, mmGPS+— the solution is computed by
using dual frequency measurements (L1/L2 GPS/GLONASS code and
carrier phase measurements) of the base (or VRS) and a rover with the
specified level (in the rover receiver's option) of vertical/horizontal pos-
itional accuracy. The mmGPS aided rover receiver. All ambiguities are
float numbers.

l Code Diff— the solution is computed by using L1/L2 GPS/GLONASS
code measurements when positioning.

For GPS observation:
l Fixed, L1— the solution is computed by using L1 frequency meas-
urements (L1 GPS/GLONASS code and carrier phase measurements).
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All ambiguities have been fixed to integers.
l Fixed,L2— the solution is computed by using L2 frequency meas-
urements (L2 GPS/GLONASS code and carrier phase measurements).
All ambiguities have been fixed to integers.

l Fixed— the solution is computed by using dual frequency meas-
urements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length is shorter than 10 km. L1 and L2
observables will be treated by the engine as independent data sets. All
ambiguities have been fixed to integers.

l Fixed, IonoFree — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with
dual frequency measurements, ionofree combinations will be created
and ionospheric error is eliminated. All ambiguities have been fixed to
integers.

l Fixed, Wide Lane — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements
integer ambiguity resolution for L1 and L2 observables is performed
with assistance of L1-L2 (Wide Lane) combination. All ambiguities
have been fixed to integers.

l VLBL— the solution is computed by using dual frequency meas-
urements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for very long baselines using triple differences (No ambiguity
resolution).

l Float, L1— the solution is computed by using L1 frequency meas-
urements (L1 GPS/GLONASS code and carrier phase measurements).
All ambiguities are float numbers.

l Float, L2— the solution is computed by using L2 frequency meas-
urements (L2 GPS/GLONASS code and carrier phase measurements).
All ambiguities are float numbers.

l Float— the solution is computed by using dual frequency measurements
(L1/L2 GPS/GLONASS code and carrier phase measurements) for GPS
observation length is shorter than 10 km. L1 and L2 observables will be
treated by the engine as independent data sets. All ambiguities are float
numbers.

l Float, IonoFree — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
urements) for GPS observation length falling into the 10 km to 30 km
interval. After integer ambiguity resolution for a GPS observation with
dual frequency measurements, ionofree combinations will be created
and ionospheric error is eliminated. All ambiguities are float numbers.

l Float, Wide Lane — the solution is computed by using dual frequency
measurements (L1/L2 GPS/GLONASS code and carrier phase meas-
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urements) for GPS observation length falling into the 30 km to 1500 km
interval. At early stages of processing of dual frequency measurements
integer ambiguity resolution for L1 and L2 observables is performed
with assistance of L1-L2 (Wide Lane) combination. All ambiguities are
float numbers.

l Code Diff— the solution is computed by using L1/L2 GPS/GLONASS
code measurements only.

l Failed, No Ephemeris— the GPS observation is not processed; the cor-
responding navigation file is absent,

l Failed, No Satellites— the GPS observation is not processed; the data
from satellites are absent.

Epochs Displays number of epochs in the common data time interval.

Orbit

Displays the ephemerides are used for processing the given GPS observation:
l Broadcast — for RTK and GPS observations, when only broadcast eph-
emerides were used.

l Precise — for GPS observations only, when only precise ephemerides
were used.

l Absent — for GPS observations only.

If the ephemerides are absent for the GPS observation time interval, the given
GPS observation are not post-processed.

GPS Satellites Displays the number of GPS satellites. It is the maximum number of common
GPS satellites observed by the base and rover in the common interval.

GLONASS Satel-
lites

Displays the number of Glonass satellites. It is the maximum number of com-
mon Glonass satellites observed by the base and rover in the common interval.

SBAS Satellites

Displays one of the following:
l for Europe — the number of EGNOS satellites.
l for USA — the number of WAAS satellites.

It is the maximum number of common satellites observed by the base and rover
in the common interval.

QZSS Satellites Displays the number of OZSS satellites. It is the maximum number of common
OZSS satellites observed by the base and rover in the common interval.

GAL Satellites Displays the number of Galileo satellites. It is the maximum number of com-
mon Galileo satellites observed by the base and rover in the common interval.

BDS Satellites Displays the number of BDS satellites. It is the maximum number of common
BDS satellites observed by the base and rover in the common interval.

PDOP
Displays the average value of total position dilution of precision (PDOP) for
common epochs interval. PDOP is equal to square root of sum-of-squares of
the HDOP and VDOP values.

HDOP Displays the average value of position dilution of precision in the horizontal
plane (HDOP), for common epochs interval.
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VDOP Displays the average value of position dilution of precision in the vertical plane
(VDOP), for common epochs interval.

Observation tab
The Observation tab of the Properties dialog for a GPS Observation allows you to view observation info. Fields
of the tab are described in the table below.

To open the tab:
1. In the GPS Obs tab from the Tabular view, select the required observation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Observation tab.

Fields of the Observation tab
Field Description

dX Displays the GPS observation's dX component (in Cartesian geocentric coordin-
ate system), in current units.

dY Displays the GPS observation's dY component (in Cartesian geocentric coordin-
ate system), in current units.

dZ Displays the GPS observation's dZ component (in Cartesian geocentric coordin-
ate system), in current units.

Azimuth Displays the GPS observation azimuth.

Elevation Angle Displays the GPS observation's elevation angle.

Distance Displays the GPS observation's distance, in current units.

dN Displays the GPS observation's dN component (in topocentric coordinates), in
current units.

dE Displays the GPS observation's dE component (in topocentric coordinates), in
current units.

dHt Displays the GPS observation's vertical component (in topocentric coordin-
ates), in current units.

Adjustment tab
The Adjustment tab of the Properties dialog for a GPS Observation allows you to view adjustment parameters of
an observation. Fields of the tab are described in the table below.

Zero value in the Res fields means that the GPS observation is included to the unclosed network, and does not con-
tain repeated GPS observations.

To open the tab:
1. In the GPS Obs tab from the Tabular view, select the required observation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Adjustment tab.
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Fields of the Adjustment tab
Field Description

Auto Reject

In this field you can select the status of the given GPS observation for adjust-
ment:

l Allowed— the GPS observation will be used in adjustment.
l Not Allowed— the GPS observation will not be used in adjustment.

Adjustment Status

Displays the status of the given GPS observation after adjustment:
l Not Adjusted— the GPS observation is not adjusted.
l Adjusted— the GPS observation is adjusted.
l AutoRejected— the GPS observation is not adjusted, because the vector
had the status Not Allowed before the adjustment procedure.

l Disable — the GPS observation is not adjusted, because the vector was
disabled before the adjustment procedure.

Res X Displays the residual of the X component (in Cartesian geocentric coordinate
system) of the GPS observation after adjustment.

Res Y Displays the residual of the Y component (in Cartesian geocentric coordinate
system) of the GPS observation after adjustment.

Res Z Displays the residual of the Z component (in Cartesian geocentric coordinate
system) of the GPS observation after adjustment.

Res n Displays the residual of the n component (in topocentric coordinates) of the
GPS observation after adjustment.

Res e Displays the residual of the e component (in topocentric coordinates) of the
GPS observation after adjustment.

Res u Displays the residual of the u component (in topocentric coordinates) of the
GPS observation after adjustment.

Res D Displays the residual of the GPS observation's distance after adjustment.

Res A Displays the linear residual of the GPS observation's azimuth after adjustment.

Res El Displays the residual of the GPS observation's elevation after adjustment.
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Quality Control tab
The Quality Control tab of the Properties dialog for a GPS Observation allows you to review observations, which
did not pass the quality test. Fields of the tab are described in the table below.

To open the tab:
1. In the GPS Obs tab from the Tabular view, select the required observation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality Control tab.

The pane displays information about highlighted GPS Observations (marked in red in the views) that did not pass
some of the quality control checks.

Fields of the Quality Control tab
Field Description

Ignore QC When ticked, all quality control tests are not performed for the selected obser-
vations.

Covariance Matrix tab
The Covariance Matrix tab of the Properties dialog for a GPS Occupation displays the six modified elements of
covariance matrix for the GPS observation and GPS Occupation. Fields of the tab are described in the table
below.

To open the tab:
1. In the GPS Occupations tab from the Tabular view, select the required occupation.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Covariance Matrix tab.

Fields of the Covariance Matrix tab
Field Description

Sigma X Displays the square root of the Cov [X,X] diagonal element for the RTK GPS
observation in the current units.

Sigma Y Displays the square root of the Cov [Y,Y] diagonal element for the RTK GPS
observation in the current units.

Sigma Z Displays the square root of the Cov [Z,Z] diagonal element for the RTK GPS
observation in the current units.

Corr XY Displays the dimensionless correlation factor X-Y for the RTK GPS obser-
vation. Corr[X,Y] =Cov[X,Y]/(SigmaX*SigmaY).

Corr XZ Displays the dimensionless correlation factor X-Z for the RTK GPS obser-
vation. Corr[X,Z] =Cov[X,Z]/(SigmaX*SigmaZ).

Corr YZ Displays the dimensionless correlation factor Y-Z for the RTK GPS obser-
vation. Corr[Y,Z] =Cov[Y,Z]/(SigmaY*SigmaZ).
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Base Antenna tab
The Base Antenna tab of the Properties dialog for a GPS Observation allows you to view and edit properties for
the antenna of the base. Fields of the tab are described in the table below.

To open the tab:
1. Select the required Observation at the GPS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Base Antenna tab.

Fields of the Base Antenna tab
Field Description

Antenna Type

Displays the model of the GPS antenna used at the base. To change the
antenna type, click and select other antenna type from the drop-down list. Also
you can create a custom antenna by clicking the Custom button. See "Adding
Custom Antenna Type" section on page 328 for more details.

NOTE
If the None antenna type is selected, the software will use zero values for
A1/A2 parameters, and in this case, the antenna phase center for L1 and L2
frequencies coincides with the Antenna Reference Point.

Antenna Height Displays the GPS antenna's height at the base station, in current units. To edit
the value, click on the highlighted column and type a new value.

Ant Height
Method

Displays the method used to measure the antenna height. You can change the
type of the method (slant or vertical) with the help of the drop-down list. See
picture below for details.

l Vertical— measured from the ground point to the antenna reference
point (ARP) located on the bottom of the receiver.

l Slant— measured from the ground point to the antenna slant height
measure mark (SHMM).
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Rover Antenna tab
The Rover Antenna tab of the Properties dialog for a GPS Observation allows you to view and edit properties for
a rover's antenna. Fields of the tab are described in the table below.

To open the tab:
1. Select the required Observation at the GPS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Rover Antenna tab.

Fields of the Rover Antenna tab
Field Description

Antenna Type

Displays the model of the GPS antenna used at the rover. To change the
antenna type, click and select other antenna type from the drop-down list. Also
you can create a custom antenna by clicking the Custom button. See "Adding
Custom Antenna Type" section on page 328 for more details.

NOTE
If the None antenna type is selected, the software will use zero values for
A1/A2 parameters, and in this case, the antenna phase center for L1 and L2
frequencies coincides with the Antenna Reference Point.

Antenna Height Displays the GPS antenna's height at the rover, in current units. To edit the
value, click on the highlighted column and type a new value.

Ant Height
Method

Displays the method used to measure the antenna height. You can change the
type of the method (slant or vertical) with the help of the drop-down list. See
picture below for details.

l Vertical— measured from the ground point to the antenna reference
point (ARP) located on the bottom of the receiver.

l Slant— measured from the ground point to the antenna slant height
measure mark (SHMM).
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Last Processing tab
The Last Processing tab of the Properties dialog for a GPS Observation allows you to view post-processing info.
Fields of the tab are described in the table below. These fields are related to the post-processed GPS observation
only. For RTK GPS observation, the field is empty

To open the tab:
1. Select the required Observation at the GPS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Last Processing tab.

Fields of the Last Processing tab
Field Description

Time Displays the time and data of the observation.

Elevation Mask

Displays an elevation cut-off angle (in degrees) for satellites used in data pro-
cessing. This parameter was entered in the GPS+ PostProcess (the General
tab) Process sub-menu option for the last post-processing of the GPS obser-
vation.

Satellite System

Displays the navigation system (either GPS and GLONASS or only GPS satel-
lites) that is used for postprocessing the GPS observation. This selection was
entered in the GPS+ PostProcess (the General tab) Process sub-menu option
for the last post-processing of the GPS observation.

Engine/Mode
Display the Engine Type and Engine Mode that were selected in the GPS+
PostProcess (the Engine tab) Process sub-menu option for last post-processing
of the GPS observation.

Troposphere
Model

Displays the current Troposphere model. This model was entered in the GPS+
PostProcess (the Troposphere tab) Process sub-menu option for the last post-
processing of the GPS observation.
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Meteo Model
Displays the current Meteo model. This model was entered in the GPS+
PostProcess (the Troposphere tab) Process sub-menu option for the last post-
processing of the GPS observation.

Meteo param at
height Displays the height for the basic meteo parameters.

Dry temperature Displays the temperature reduced to the dry humidity.

Pressure Displays the atmosphere pressure.

Humidity Displays the atmosphere humidity.

Constant Zenith
delay

Displays the period of time in hours (defined by the user in the Troposphere tab
of the Process sub-menu) during which the zenith delay is applied as constant.

TS Obs Properties dialog
The TS Obs tab from the Tabular view has two panels —left for the TS occupations and right for the
TS observations of selected occupation. Each of them has its own Properties dialog.

The Properties dialog for the TS occupation (the left pane of the TS Obs tab) contains the following tabs:
l "General tab" section below
l "Accuracy tab" section on the facing page
l "Instrument Type tab" section on page 248
l "Offset tab" section on page 248

To open the dialog:
1. In the left pane of the TS Obs tab from the Tabular view, select the required occupation .
2. Right-click and select Properties from the pop-up menu.

The Properties dialog for the TS observation (the right pane of the TS Obs tab) contains three tabs:
l "General tab" section on page 250
l "Observation tab" section on page 251
l "Offset tab" section on page 252
l "Adjustment tab" section on page 254
l "Quality Control tab" section on page 255
l "Image tab" section on page 256
l "Prism tab" section on page 256
l "Survey Session tab" section on page 256

To open the dialog:
1. Select the required observation in the right pane of the TS Obs tab of the Tabular view.
2. Right-click and select Properties from the pop-up menu.

General tab
The General tab of the Properties dialog for a TS occupation allows you to view and edit basic properties for an
occupation. Fields of the tab are described in the table below.

To open the tab:



Accuracy tab

247

1. Select the required occupation in the left panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Point Name Displays the name of the point where the Total Station was set. You can set
any point's name from the list.

# Displays the number of a TS occupation contained in the raw file. You can set
any number from the list.

Instrument Height
Displays the instrument height — the vertical distance from the Instrument
Center Mark to the ground, in current linear units. To edit the value, click on
the highlighted field and enter a new value.

Enabled
When ticked, the TS occupation is included in adjustment, coordinate
calculation and export. If this parameter is unchecked, adjustment, coordinate
calculation and export will ignore the TS occupations.

Accuracy tab
The Accuracy tab of the Properties dialog for a TS occupation allows you to view and edit accuracy properties
for an occupation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required occupation in the left panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Accuracy tab.

Fields of the Accuracy tab
Field Description

Instrument Cen-
tering Error

Displays the error of centering the Total Station position over the mark. This
error will be taken into account during adjustment of the network with the
given TS occupation. To edit the value, click on the highlighted field and enter
a new value.

Instrument Height
Error

Displays the measurement error of the Total Station height over the mark. This
error will be taken into account during adjustment of the network with the
given TS occupation. To edit the value, click on the highlighted field and enter
a new value.

Reflector Cen-
tering Error

Displays the error of centering the reflector position over the mark. This error
will be taken into account during adjustment of the network with the given TS
occupation. To edit the value, click on the highlighted field and enter a new
value.
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Reflector Height
Error

Displays the measurement error of the reflector height over the mark. This
error will be taken into account during adjustment of the network with the
given TS occupation. To edit the value, click on the highlighted field and enter
a new value.

Class
Displays the class which was selected for the TS occupation. To change the
class, click and select other class from the drop-down list. Also you can create
a custom class by clicking Custom.

Instrument Type tab
The Instrument Type tab of the Properties dialog for a TS occupation allows you to define the instrument type for
an occupation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required occupation in the left panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Instrument Type tab.

Fields of the Instrument Type tab
Field Description

Instrument Type

Displays the Instrument Type for the given TS occupation. To change the instru-
ment type, click and select other instrument type from the drop-down list. Also
you can create a custom instrument type by clicking the Custom button. See
"Adding TS Instrument Type" section on page 331 for details.

Offset tab
The Offset tab of the Properties dialog for a TS Occupation allows you to view and edit basic offset for an occu-
pation. Fields of the tab are described in the table below. The tab displays non-zero values when the imported
MAGNET Field job contains the Distance Offset and the Line Offset. See "Editing and viewing MAGNET Field
Offsets in the Job" section on page 345 for details.

To open the tab:
1. Select the required observation in the left panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Offset tab.

To obtain the coordinates of the offset point, select Compute Coordinates from the pop-up menu.
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Fields of the Offset tab
Field Description

Offset Along

Displays the distance from the "To Point" to the projection of the offset point
along the line "From Point-To Point", in current linear units. The field displays
non-zero values when the imported MAGNET Field job contains the Distance
Offset and the Line Offset.

To edit the value, click on the highlighted filed and enter a new value.

Offset Across

Displays the distance from the offset point to the line "From Point-To Point", in
current linear units. The field displays non-zero values when the imported
MAGNET Field job contains the Distance Offset and the Line Offset.

To edit the value, click on the highlighted filed and enter a new value.

Offset dHt

Displays the height difference between the ground point or the top of "To
Point"and the offset point, in current linear units. The field displays non-zero
values when the imported MAGNET Field job contains the Distance Offset
and the Line Offset.

To edit the value, click on the highlighted filed and enter a new value.

Offset Type
Displays the current type of the given offset. For the Distance Offset and the
Line Offset created in MAGNET Field, you see "From Observation Line"
type.

Distance Offset
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Line Offset

General tab
The General tab of the Properties dialog for a TS observation allows you to view and edit basic properties for an
observation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Point From Displays the name of the point where the Total Station is set. You cannot edit
this name.

# Displays the number of the TS observation contained in the raw file.

Date Displays the date and time of the total station measurement. You cannot edit
this field.

Code

Displays code of the TS observation. A TS observation can have only one
code. To edit the code, click on the highlighted field and select a new one from
the drop-down list of existing codes or enter a new codes, or remove the Code
and leave the field empty.
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String

Displays the string for the TS observation. The string entered for a TS occu-
pation is automatically displayed as string for the corresponding point in the
Points tab. Using a complex of string and codes allows you to automatically
create a line in the job. The software will automatically create a line between
points with the same Code and String values. See picture and table below for
details.

Control Code Displays the control code for the TS observation. See "Control Code field" sec-
tion on page 152 for details.

Control Code2 Displays the second control code for the TS observation. See "Control Code2
field" section on page 154 for details.

Source Displays the path of the raw data on the computer disk drive, local area net-
work, or storage media.

Enabled

When ticked (default setting for all point types), the point and all objects
related to the given points is included in adjustment, coordinate calculation and
export. If this parameter is unchecked, adjustment, coordinate calculation and
export will ignore the points and all objects related to the given points. A dis-
abled point is grayed-out in all views.

Observation tab
The Observation tab of the Properties dialog for a TS observation allows you to view and edit basic properties for
an observation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Observation tab.

Fields of the Observation tab
Field Description

Point To Displays the name of the point at which the reflector was set. You can set any
point's name from the list.

Type Displays the current type of the Total Station occupation. See "Type field" sec-
tion on page 154 for details.

Reflector Height
Displays the vertical distance from the center of the prism to a ground point, in
current linear units. To edit the value, click on the highlighted field and enter a
new value.

Horizontal Circle

For the SS, FS, Horizontal Resection/Vertical Resection/Resection types of
Total Station observation, the field displays the measured horizontal angle from
the previous to the next observation. For BKB type, the field displays the hori-
zontal circle reading when pointing to the backsight point. You cannot edit this
parameter.
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Zenith Angle Displays the vertical angle to the reflector measured from zenith. You cannot
edit this parameter.

Slope Distance Displays the slope distance between the TS station (Point From) and the TS
occupation (Point To). You cannot edit this parameter.

Vertical Angle Displays the vertical angle to the reflector measured from horizon. You cannot
edit this parameter.

Horizontal
Distance

Displays the distance between the TS station (Point From) and the TS occu-
pation (Point To) in the horizontal plane. You cannot edit this parameter.

Vertical Distance Displays the vertical angle to the reflector measured from horizon. You cannot
edit this parameter.

Note Displays any additional TS occupation's note. To edit the note, click on the
highlighted field and enter comments, if needed.

Exclude

Horizontal Circle When ticked, the Horizontal Circle measurement for this TS occupation is
excluded from the adjustment, calculating coordinates and export.

Vertical Angle If the box is checked, the Vertical Angle measurement for this TS occupation
is excluded from the adjustment, calculating coordinates and export.

Slope Distance If the box is checked, the Slope Distance measurement for this TS occupation
is excluded from the adjustment, calculating coordinates and export.

Offset tab
The Offset tab of the Properties dialog for a TS observation allows you to view and edit basic offset for an obser-
vation. Fields of the tab are described in the table below. The tab displays non-zero values when the imported
MAGNET Field job contains the Distance Offset and the Line Offset.

To open the tab:
1. Select the required observation in the right panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Offset tab.

To obtain the coordinates of the offset point, select Compute Coordinates from the pop-up menu.

Fields of the Offset tab
Field Description

Offset Along

Displays the distance from the "To Point" to the projection of the offset point
along the line "From Point-To Point", in current linear units. The field displays
non-zero values when the imported MAGNET Field job contains the Distance
Offset and the Line Offset.

To edit the value, click on the highlighted filed and enter a new value.
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Field Description

Offset Across

Displays the distance from the offset point to the line "From Point-To Point", in
current linear units. The field displays non-zero values when the imported
MAGNET Field job contains the Distance Offset and the Line Offset.

To edit the value, click on the highlighted filed and enter a new value.

Offset dHt

Displays the height difference between the ground point or the top of "To
Point"and the offset point, in current linear units. The field displays non-zero
values when the imported MAGNET Field job contains the Distance Offset
and the Line Offset.

To edit the value, click on the highlighted filed and enter a new value.

Offset Type
Displays the current type of the given offset. For the Distance Offset and the
Line Offset created in MAGNET Field, you see "From Observation Line"
type.

Distance Offset
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Line Offset

Adjustment tab
The Adjustment tab of the Properties dialog for a TS observation allows you to view adjustment data for an obser-
vation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the TS Obs tab of the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Adjustment tab.

Fields of the Adjustment tab
Field Description

Auto Reject
In this field you can select the GPS observation availability for Adjustment:

l Allowed — the GPS observation will be used in Adjustment.
l Not Allowed — the GPS observation will not be used in Adjustment.
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Field Description

Adjustment Status

Displays the status of the GPS observation after Adjustment:
l Not Adjusted — the TS observation is not adjusted.
l Adjusted — the TS observation is adjusted.
l AutoRejected — the TS observation is not adjusted, because the vector
had the status Not Allowed before the adjustment procedure.

l Disable — the TS observation is not adjusted, because the vector was
disabled before the adjustment procedure.

SDist Residual Displays the residual of the slope distance after adjustment for both enabled
and disabled TS observations.

HAngle Residual Displays the residual of the horizontal angle after adjustment for both enabled
and disabled TS observations.

Azimuth Residual Displays the residual of azimuth after adjustment for both enabled and disabled
TS observations.

VAngle Residual Displays the residual of the vertical angle after adjustment for both enabled
and disabled TS observations.

ZAngle Residual Displays the residual of the zenith angle after adjustment for both enabled and
disabled TS observations.

HDist Residual Displays the residual of the horizontal distance after adjustment for both
enabled and disabled TS observations.

VDist Residual Displays the residual of the vertical distance after adjustment for both enabled
and disabled TS observations.

Cross Residual Displays the residual of the horizontal angle represented in the linear measure
after adjustment for both enabled and disabled TS observations.

Zero value in the Residual fields means that the TS observation is included in the unclosed network, and does not
contain repeated TS observations.

The residuals for a disabled TS observation are calculated as differences between the values determined from the
inverse solution for the adjusted points and the values of measured angles and distance.

Quality Control tab
The Quality Control tab of the Properties dialog for a TS Observation allows you to review observations, which
did not pass the quality test. Fields of the tab are described in the table below.

To open the tab:
1. Select the required Observation in the right panel of the TS Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality Control tab.

The pane displays information about highlighted TS Observations (marked in red in the views) that did not pass
some of the quality control checks.
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Fields of the Quality Control tab
Field Description

Ignore QC When ticked, all quality control tests are not performed for the selected obser-
vations.

Image tab
Displays the images for the TS occupation, obtained from built in Camera on GPT-700*i and IS.

Prism tab
The Prism tab of the Properties dialog for a TS observation allows you to view information about the reflector's
prism. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the TS Obs tab of the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Prism tab.

Fields of the Prism tab
Field Description

Prism type Displays the type of the prism.

Prism Constant
Defines the parameter of the prism characterizing the difference between the
reflection plane and the center of the prism. Measurements will be recal-
culated if you change the value.

Survey Session tab
The Survey Session tab of the Properties dialog for a TS observation allows you to view information about the sur-
vey session of the observation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the TS Obs tab of the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Survey Session tab.

Fields of the Survey Session tab
Field Description

Surveyor Displays the name of the person who performed survey session.

Temperature Displays the temperature during the survey session in the current units.

Pressure Displays the pressure during the survey session in the current units.

Humidity Displays the humidity during the survey session in the current units.
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DL Obs Properties dialog
The DL Obs tab form the Tabular view has two panes — for the DL occupations and for the DL observations.
Each of them has its own Properties dialog.

The Properties window for the DL occupation (the left panel of the DL Obs tab) contains the following tabs:
l "General tab" section below
l "Quality Control tab" section on the next page

To open the dialog:
1. Select the required occupation in the left pane of the DL Obs tab of the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties window for DL observation (the right pane of the DL Obs tab) contains the following tabs:
l "General tab" section on the next page
l "Observation tab" section on page 259
l "Adjustment tab" section on page 260
l "Quality Control tab" section on page 260

To open the dialog:
1. Select the required observation in the right pane of the DL Obs tab of the Tabular view.
2. Right-click and select Properties from the pop-up menu.

General tab
The General tab of the Properties dialog for a DL occupation allows you to view and edit basic properties for an
occupation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required occupation in the left panel of the DL Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

# Displays the number of the DL run (DL occupation) contained in the current
job. You can set any number from the list.

From Displays the start leveling point of the job. You cannot select other point as
start point.

To Displays the finish leveling point of the job. You cannot select other point as
finish point.

Level Run Display the name of the leveling job created in a digital level.

Date Displays the start date (day/month/year) and time of the job creation. You can-
not edit the value.
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Field Description

Note Displays any additional DL run's note. To edit the note, click on the highlighted
field and enter your comments.

Distance Displays the sum of all backsight and foresight distances. You cannot edit the
parameter.

Balance Display the sum of differences between DL to BS point and DL to FS point of
the job. You cannot edit the value.

Enabled

When ticked, the DL run and all objects related to the given observations, are
included in adjustment, coordinate calculation and export. If unticked, adjust-
ment, coordinate calculation and export will ignore the DL run and all objects
related to the given occupations.

Quality Control tab
The Quality Control tab of the Properties dialog for a DL Occupation allows you to review occupations, which
did not pass the quality test. Fields of the tab are described in the table below.

To open the tab:
1. Select the required occupation in the left panel of the DL Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality Control tab.

The pane displays information about highlighted DL Occupations (marked in red in the views) that did not pass
some of the quality control checks.

Fields of the Quality Control tab
Field Description

Ignore QC When ticked, all quality control tests are not performed for the selected occu-
pations.

General tab
The General tab of the Properties dialog for a DL observation allows you to view and edit basic properties for an
observation. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the DL Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Level Run Display the name of the leveling job created in a digital level.You cannot edit
the parameter.
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Field Description

# Displays the number of the DL observation contained in the current job. You
cannot set any number from the list.

Note Display any additional DL observation's note. To edit the note, click on the
highlighted field and enter comments, if needed.

Date Displays the start date (day/month/year) and time of creating the measurement.
You cannot edit the value.

Source Displays the path of the raw data to the computer disk drive, local area net-
work, or storage media.

Enabled
When ticked, the DL observation and all objects related to it are included to
adjustment, coordinate calculation and export. If unticked, the adjustment,
coordinate calculation and export will ignore the DL observations.

Observation tab
The Observation tab of the Properties dialog for a DL observation allows you to view an observation. Fields of
the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the DL Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Observation tab.

Fields of the Observation tab
Field Description

Type

Displays the current type of the Digital Level observation. This field contains
the list of the DL observation types. You cannot select the other type from the
list:

l SS (side shot) — the measurement to a point that is not a BS/FS point,
or Changing Point/ Bench Mark point.

l BS (backsight) — the measurement to the previous occupation point in
the DL run.

l FS (foresight) — the measurement to the next occupation point in the
DL run.

l End of Changing Pt — the end measurement of the DL run to the point
that is used to carry the measurements forward in the DL run.

l End of Bench Mark — the end measurement of the DL run to the point
with known elevation.

Point Displays the name of turning or side shot point. You can select a point from the
list.

Ht. Measurement Displays the rod reading on the given point, in current linear units. You cannot
edit the measurement.

Vert Offset Displays the vertical offset from the horizontal plane for traverse and sideshot
points.
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Field Description

Distance Displays the measured distance from DL to the given point. You cannot edit
the measurement.

Instrument Elev-
ation

Displays the elevation of sight that includes the elevation of BS point and the
rod reading on BS point. You cannot edit the measurement.

Std Dev Displays the standard deviation for the level measurement. This value is cre-
ated in the Digital Level. You cannot edit the parameter.

Adjustment tab
The Adjustment tab of the Properties dialog for a DL observation allows you to view observation adjustment
details. Fields of the tab are described in the table below.

To open the tab:
1. Select the required observation in the right panel of the DL Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Adjustment tab.

Fields of the Adjustment tab
Field Description

AutoReject
Defines the status of the DL observation for Adjustment:

l Allowed — the DL observation will be used in Adjustment.
l Not Allowed — the DL observation will not be used in Adjustmen

Adjustment Status

Displays the status of the DL observation after Adjustment:
l Not Adjusted — the DL observation is not adjusted.
l Adjusted — the DL observation is adjusted.
l AutoRejected — the DL observation is not adjusted because the vector
had the status Not Allowed before the adjustment procedure.

l Disable — the DL observation is not adjusted because the vector was
disabled before the adjustment procedure.

Ht Residual Displays the adjustment residuals for the level measurements. You cannot edit
the value.

Elevation Displays the elevation on FS point that includes the elevation of sight and rod
reading on FS point. You cannot edit the value.

Quality Control tab
The Quality Control tab of the Properties dialog for a DL Observation allows you to review observations, which
did not pass the quality test. Fields of the tab are described in the table below.

To open the tab:
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1. Select the required occupation in the left panel of the DL Obs tab of the Tabular view
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Quality Control tab.

The pane displays information about highlighted DL Occupations (marked in red in the views) that did not pass
some of the quality control checks.

Fields of the Quality Control tab
Field Description

Ignore QC When ticked, all quality control tests are not performed for the selected obser-
vations.

Lines Properties dialog
The Lines tab of the Tabular view displays a table containing two panels. The left panel displays all polylines
(type, layers, plotting styles, codes and string) in the job, and the right panel displays all segments for the selected
polyline.

The Properties dialog for the polyline/area contains the following tabs:
l "Line tab" section below
l "Plotting styles tab" section on the next page
l "COGO tab" section on page 263
l "Photonotes tab" section on page 264

To open the dialog:
1. In the left panel of the Lines tab from the Tabular view, select the required line/area.
2. Right-click and select Properties from the pop-up menu.

The Properties window for the selected segments of the line contains the following tabs:
l "General tab" section on page 265
l "End Position tab" section on page 268

To open the dialog:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line Segment item.

Line tab
The Line tab of the Properties dialog for a polyline/area allows you to select type and a layer for the entity. Fields
of the tab are described in the table below.

To open the tab from the tabular view:
1. Select the required line/area in the left panel of the Lines tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click Line tab.
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To open the tab from the map view:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line item.
4. In the right panel, click the Line tab.

Fields of the Line tab
Field Description

Name Defines the name of the line. It can be empty. If specified, the name should be
unique.

Type

In this field you can select the type of the polyline:
l Line — unclosed polyline.
l Area — closed polyline.

When you select Area for a polyline with the Line type, the application auto-
matically adds a segment to close the existing polyline if the existing polyline
has more than one segment. When you select Line for a polyline which has the
Area type, the application automatically removes a segment to open the area.

Layer

Displays the Layer in which the polyline resides. The Layer sets the plotting
style for the polyline and all segments of the polyline. Every polyline has its
non-empty Layer. In this field, you can select any Layer from the list of user-
created layers.

Plotting styles tab
The Plotting styles tab of the Properties dialog for a polyline/area allows you to configure the layout of polylines
for map view and plotting. Fields of the tab are described in the table below.

To open the tab from the tabular view:
1. Select the required line/area in the left panel of the Lines tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click Plotting styles tab.

To open the tab from the map view:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line item.
4. In the right panel, click the Plotting styles tab.
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Fields of the Plotting styles tab
Field Description

Line Style

Displays the polyline style for Map View. The style can be chosen from the
list. If you set BYCODE or BYLAYER, the style of the polyline will be set
automatically to the style that was selected for the polyline's code, or polyline's
layer.

Line Width

Displays the polyline width for Map View. The width can be chosen from the
list. If you set BYCODE or BYLAYER, the width of the polyline will be set
automatically to the width that was selected for the polyline's code, or poly-
line's layer.

Line Color

Displays the polyline color for Map View. The color can be chosen from the
list. If you set BYCODE or BYLAYER, the color of the polyline will be set
automatically to the color that was selected for the polyline's code, or poly-
line's layer.

Area Fill Style

Displays the fill stile for closed polyline (area) in Map View. The fill style can
be chosen from the list. If you set BYCODE or BYLAYER, the fill style for
the polyline will be set automatically to the fill style that was selected for the
polyline's code, or polyline's layer.

Point Type

Displays the symbol for the point of the polyline in Map View. The symbol can
be chosen from the list. If you set BYCODE or BYLAYER, the point symbol
will be set automatically to the symbol that was selected for the polyline's
code, or polyline's layer.

Fill Transparency

Displays the transparency value for closed polyline (area) in Map View.
The value can be chosen from the list. If you set BYCODE or
BYLAYER, the value will be set automatically to the symbol that was
selected for the polyline's code, or polyline's layer.

Area Color

Displays the color for the closed polyline (area) in Map View. The color can
be chosen from the list. If you set BYCODE or BYLAYER, the area color
will be set automatically to the color that was selected for the polyline's code,
or polyline's layer.

Point Color

Displays the color for the point of the polyline in Map View. The color can be
chosen from the list. If you set BYCODE or BYLAYER, the point color will
be set automatically to the color that was selected for the polyline's code, or
polyline's layer.

COGO tab
The COGO tab of the Properties dialog for a polyline/area displays the distance/area info of the polyline/area.
Fields of the tab are described in the table below.

To open the tab from the tabular view:
1. Select the required line/area in the left panel of the Lines tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click COGO tab.
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To open the tab from the map view:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line item.
4. In the right panel, click the COGO tab.

Fields of the COGO tab
Field Description

Distance
Displays the summary length of the polyline, in current linear units. This dis-
tance can be of either geodetic, or grid, or ground type depending on the selec-
ted coordinate type for the current job.

Area
Displays the area of the closed line. This area can be of either geodetic, or
grid, or ground type depending on the selected coordinate type for the current
job.

Photonotes tab
The Photonotes tab of the Properties dialog for a polyline/area allows you to view and manage pictures attached
to a line. Fields of the tab are described in the table below.

To open the tab from the tabular view:
1. Select the required line/area in the left panel of the Lines tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click Photonotes tab.

To open the tab from the map view:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line item.
4. In the right panel, click the Photonotes tab.

The Photo Note Number field displays the number of the images for the polyline/area.

To see a picture, select it from the Photo Note Number drop-down list.

To add a picture:
1. Click Add Photo Note.

The Open dialog is displayed.
2. Navigate to the required picture and open it.

To remove a picture:
1. Select the required picture from the Photo Note Number drop-down list.
2. Click Remove Photo Note.



General tab

265

General tab
The General tab of the Properties dialog for a polyline segment allows displays the base information about the
segment. Fields of the tab are described in the table below.

To open the tab from the map view:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line Segment item.
4. In the right panel, click the General tab.

Fields of the General tab
Field Description

Type

Displays the type of selected segment. You can select one of the following seg-
ment type:

l Line
l Curve
l Curve by 2 points
l Curve by 3 points
l Bulge
l Circle

For Line type

Length Displays the distance of the segment (from the previous point to this point), in
current linear units. You cannot edit this value.

Azimuth Displays the end azimuth of the tangent to the given point (vertex) of the seg-
ment. You cannot edit this value.

For curves

Length Displays the distance of the segment (from the previous point to this point), in
current linear units. You cannot edit this value.

Turn
Defines the direction of the curve turn. The Right value stands for clockwise
direction, and the Left value stands for counter-clockwise direction. You can
edit the direction only for Curve segment type.

Radius Defines the radius of the curve.

Azimuth Displays the end azimuth of the tangent to the given point (vertex) of the seg-
ment. You cannot edit this value.
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Field Description

Deg Curve

Displays the angle in degrees used to compute the radius of curve whose curve
is 100 units long.

Using the degree of curve (DCV) parameter, the radius of the curve can be cal-
culated as follows:

Deg Chord

Displays the angle in degrees used to compute the radius of curve which chord
is 100 units long:

Using the degree of chord (DCH) parameter, the radius of the curve can be cal-
culated as follows:

Delta Displays the angle between the radii corresponding to the curve.

Chord Displays the length of the segment joining start and end points of a curve in the
current linear units.

Tangent
Displays the length of the segment going through the start point of the given
curve and perpendicular to the radii pf the curve in the start point. The length
of the tangent is in the current linear units.

Mid Ord Displays the distance from the midpoint of a chord to the midpoint of the cor-
responding curve (Middle Ordinate) in the current linear units.

External Displays the distance from the midpoint of the curve to the intersection point of
the tangents in the current linear units.
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Curve parameters

Deg curve
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Deg chord

End Position tab
The End Position tab of the Properties dialog for a polyline segment allows displays the information about the end
point of the segment. Fields of the tab are described in the table below.

To open the tab from the map view:
1. Select the required line/area in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. In the left panel, select the Properties: Line Segment item.
4. In the right panel, click the End Position tab.

Fields of the End Position tab
Field Description

End Northing Displays the end point northing coordinate in Ground / Grid coordinate system.
You cannot edit this value.

End Easting Displays the end point easting coordinate in Ground / Grid coordinate system.
You cannot edit this value.

End Azimuth Displays the azimuth of the tangent to the given point (vertex) for the current
segment. You cannot edit this value. See picture below for details.
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Surface Properties dialog
The Surfaces tab of the Tabular view displays a table containing all surfaces.

The Properties dialog for surfaces may displays different information, depending on the method of surface cre-
ation.

If the surface was created from points and/or lines and not converted from roads and lines, the Properties dialog
contains two tabs, described in the following sections:

l "General tab" section on the next page
l "Options tab" section on page 271

To open the dialog:
1. Select the required surface either in the Map view, or in the Surface tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

If the surface was created by conversion from a road, the Properties dialog two tabs, described in the following
sections:

l "General tab" section on the next page
l "Road tab" section on page 271

If the surface was created from a geoid, the Properties dialog contains only the General tab.
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General tab
The General tab of the Properties dialog for a surface allows you to view and edit basic info for the surface.
Fields of the tab are described in the table below.

To open the tab from the tabular view:
1. Select the required surface at the Surfaces tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click General tab.

To open the tab from the map view:
1. Select the required surface in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Name
Displays the name of the surface. To edit the name, click on the high-
lighted field and type a new name. The surface name is unique and the
field cannot be empty.

Focus Point

Displays the name of a focus point. If the column is empty, the triangulation is
completed in relation to the ground plane. If set to some existing point, the tri-
angulation will be done with respect to that point, that is as if the surface is
viewed from that point. You can select a point from the list of the job's points.

Number of Points Displays the quantity of points in the surface, including intersection points of
lines forming this model. You cannot edit this parameter.

Number of Tri-
angles

Displays the quantity of triangles created on the surface. You cannot edit this
parameter.

Comment Defines any additional information about the surface.

Min. Northing Displays the minimum value of northing coordinates of points included in the
surface. You cannot edit this parameter.

Max Northing Displays the maximum value of northing coordinates of points included in the
surface. You cannot edit this parameter.

Min. Easting Displays the minimum value of easting coordinates of points included in the sur-
face. You cannot edit this parameter.

Max. Easting Displays the maximum value of easting coordinates of points included in the
surface. You cannot edit this parameter.

Min. Elevation Displays the minimum value of elevation coordinates of points included in the
surface. You cannot edit this parameter.

Max. Elevation Displays the maximum value of elevation coordinates of points included in the
surface. You cannot edit this parameter.
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Field Description

Area

Displays the sum of areas of the triangle projections on the horizontal plane (if
the triangulation is done with respect to the ground plane) and the vertical
plane (if the triangulation is done with respect to a vertical plane from a focus
point for the given surface). You cannot edit this parameter.

Layer
Displays the name of the Layer in which the surface resides. The Layer sets
the plotting style for the surface. Every surface has to have a Layer. In this
field, you can select any Layer from the list of user-created layers.

Need Update
Displays the current status of the surface. If set to "No", the surface is not
changed, or automatic update is done. If set to "Yes", the surface is changed,
and automatic update of the changed surface is disabled.

Auto Update When unticked (default setting), automatic update of the changed surface is dis-
abled. If ticked, automatic update of the changed surface is enabled.

Options tab
The Options tab of the Properties dialog for a surface allows you to configure the parameters for triangles cre-
ating. Fields of the tab are described in the table below.

To open the tab from the tabular view:
1. Select the required surface at the Surfaces tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click Options tab.

To open the tab from the map view:
1. Select the required surface in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Options tab.

This tab is enabled only for surfaces which were created from points and/or lines and not converted from roads
and lines.

Fields of the Options tab
Field Description

with Interior
Angle <

Defines the minimal allowable interior angle of a created triangle in the cur-
rent angular units. The Interior Angle cannot be less than the defined value. By
default the field is empty.

with Area >
Displays the maximal allowable area of a triangle in the current linear units.
The Area cannot be more than the defined value. By default the value is
empty.

Road tab
The Road tab of the Properties dialog for a surface allows you to configure the parameters for triangles creating.
Fields of the tab are described in the table below.
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To open the tab from the tabular view:
1. Select the required surface at the Surfaces tab from the Tabular view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click Road tab.

To open the tab from the map view:
1. Select the required surface in the Map view.
2. Right-click and select Properties from the pop-up menu.

The Properties dialog is displayed.
3. Click the Road tab.

This tab is enabled only for surfaces which were created by conversion from a road.

Fields of the Road tab
Field Description

Interval Defines the interval between triangles set for creating the surface from the
road in the current linear unit.

Level

This value defines the level of the ground surface. After entering the value (not
empty), the application will calculate and display in graphic mode the cut and
fill for the surface of the road taking into account this level value. See "Level"
section below for details.

Road Displays the name of the road from which the surface was created.

Level
The picture displays the surface of the road without any relation to the ground (the field Level is empty):
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Then set the ground level in 10 meters and click the Update surface command. The picture displays the surface of
the road under the level and over the level and cut and fill areas of this surface:



MAGNET Tools Entities Properties

274

Road Properties
The Roads tab from the Tabular view has two panels — the left panel displays a table containing all roads, the
right panel displays details of the selected road — horizontal alignment, vertical alignment, and either X-sections
(cross sections) or road string set. Each of these objects has its own Properties dialog.

For detailed description see the appropriate sections:
l "Road Properties dialog" section below
l "Horizontal alignment properties dialog" section on page 277
l "Vertical alignment properties dialog" section on page 278
l "X-section Properties dialog" section on page 279
l "Road string set Properties dialog" section on page 280
l "Road String Properties dialog" section on page 280
l "Pair of the horizontal and vertical alignments Properties dialog" section on page 295
l "Horizontal element properties dialog" section on page 281
l "Vertical element Properties dialog" section on page 290
l "X-Section station Properties dialog" section on page 294

Road Properties dialog
The Properties dialog for a single road contains the following tabs:

l "General tab" section on the facing page
l "Alignment names tab" section on page 276
l "Station Equations tab" section on page 277

You may access the Properties dialog for a road for an already existing road, or while creating a new road.

To open the dialog for an existing road:
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1. In the left panel of the Roads tab from the Tabular view, select the required road.
2. Right click and select Properties from the pop-up menu.

The Properties: Road dialog is displayed.

To open the dialog when creating a new road:
1. In the Add group of the Add tab, click the Road icon.

The Add Road dialog is displayed.

General tab
The General tab of the Properties dialog for a road or the Add Road dialog contains the base road information and
its start coordinates.

You may access the General tab of the Properties dialog for a road for an already existing road, or while creating
a new road.

To open the tab for an existing road:
1. In the left panel of the Roads tab from the Tabular view, select the required road.
2. Right click and select Properties from the pop-up menu.

The Properties: Road dialog is displayed.
3. Click General tab.

To open the tab when creating a new road:
1. In the Add group of the Add tab, click the Road icon.

The Add Road dialog is displayed.
2. Click General tab.

Fields of the General tab
Field Description

Name Defines the name of the road. To edit the name, click on the highlighted field
and type a new name. The road name is unique and the field cannot be empty.

Start Point
Defines the road start point. You can select the desired point from the list.
After selecting the point, the Northing, Easting and Elevation fields will dis-
play the coordinates of the selected point.

Northing
Displays the road start point's northing coordinate in the current coordinate sys-
tem. You can edit the value, if the start point is not selected in the Start Point
drop-down list.

Easting
Displays the road start point's easting coordinate in the current coordinate sys-
tem. You can edit the value, if the start point is not selected in the Start Point
drop-down list.

Elevation
Displays the road start point's elevation coordinate in the current coordinate sys-
tem. You can edit the value, if the start point is not selected in the Start Point
drop-down list.

Start Sta/Chainage Defines starting station or chainage for the road.

Station Stakeout
Interval

Displays the Station Interval, for staking out the previous/next station. You can
edit the value.
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Field Description

Left Corridor Off-
set

Defines the left border for the Road Stakeout.

The parameter relates to the Roads with the String Set only and doesn't appear
for the roads with the X-sections.

Entering the value in the application does not change the view of the road in
this software. There is the following rule for creating the working corridor: the
value of the left corridor offset has to be less or equal to the value of the right
corridor offset.

Right Corridor Off-
set

Defines the right border for the Road Stakeout.

The parameter relates to the Roads with the String Set only and doesn't appear
for the roads with the X-sections.

Entering the value in the application does not change the view of the road in
this software. There is the following rule for creating the working corridor: the
value of the left corridor offset has to be less or equal to the value of the right
corridor offset.

Layer
Displays the Layer in which the road resides. The Layer sets the plotting style
for the road. In this field, you can select any Layer from the list of user-created
layers.

Alignment names tab
The Alignment names tab of the Properties dialog for a road or the Add Road dialog contains information about
alignments used in the road.

You may access the Alignment names tab of the Properties dialog for a road for an already existing road, or while
creating a new road.

To open the tab for an existing road:
1. In the left panel of the Roads tab from the Tabular view, select the required road.
2. Right click and select Properties from the pop-up menu.

The Properties: Road dialog is displayed.
3. Click Alignment names tab.

To open the tab when creating a new road:
1. In the Add group of the Add tab, click the Road icon.

The Add Road dialog is displayed.
2. Click Alignment names tab.

Fields of the Alignment names tab
Field Description

Horizontal Align-
ment Name

Defines the current horizontal alignment name. You can select other horizontal
alignment from the list.

Vertical Align-
ment Name

Defines the current vertical alignment name. You can select other vertical
alignment from the list.

X-Section Set
Name

Defines the current X-Section Set name. You can select other X-Section Set
from the list.
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Field Description

Road String Set
Name

Displays the current Road String Set name. You can select other Road String
Set from the list.

Station Equations tab
The Station Equations tab of the Properties: Road dialog or the Add Road dialog contains information about sta-
tion equations set, assigned to the road.

You may access the Station Equations tab of the Properties: Road dialog for an already existing road, or while
creating a new road.

To open the tab for an existing road:
1. In the left panel of the Roads tab from the Tabular view, select the required road.
2. Right click and select Properties from the pop-up menu.

The Properties: Road dialog is displayed.
3. Click Station Equations tab.

To open the tab when creating a new road:
1. In the Add group of the Add tab, click the Road icon.

The Add Road dialog is displayed.
2. Click Station Equations tab.

Fields of the Station Equations tab
Field Description

Station Equations
Set

Defines the station equations set, assigned to the road. Select the required set
from the drop-down list.

Horizontal alignment properties dialog
The Properties dialog for the horizontal alignment of the road contains only the General tab. See "General tab"
section below for details.

To open the dialog:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required horizontal alignment.
3. Right click and select Properties from the pop-up menu.

The Properties: Horizontal Alignment dialog is displayed.

General tab
The General tab of the Properties dialog for a horizontal alignment allows you to configure the base horizontal
element information. Fields of the tab are described in the table below.

To open the dialog :
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required horizontal alignment.
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3. Right click and select Properties from the pop-up menu.

The Properties: Horizontal Alignment dialog is displayed.

Fields of the General tab
Field Description

Name Defines the name of the horizontal alignment. You can rename this alignment.

Start Point

Defines the name of the horizontal alignment start point. You can select the
desired point from the list. After selecting the point, the Northing and the East-
ing fields display the coordinates of the selected point. These coordinates can-
not be changed for the selected point.

Northing
Defines the horizontal alignment start point's northing coordinate in the current
coordinate system (Grid or Ground). You can edit the value, when a point is
not selected in the Start Point field.

Easting
Defines the horizontal alignment start point's easting coordinate in the current
coordinate system (Grid or Ground). You can edit the value, when a point is
not selected in the Start Point field.

Start Sta/Chainage Defines the starting station or chainage for the horizontal alignment. You can
edit the value.

Vertical alignment properties dialog
The Properties dialog for the vertical alignment of the road contains only the General tab. See "General tab" sec-
tion below for details.

You may access the Properties dialog for a vertical alignment for an already existing vertical alignment, or while
creating a new vertical element.

To open the dialog for an existing vertical alignment:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required vertical alignment.
3. Right click and select Properties from the pop-up menu.

The Properties: Vertical Alignment dialog is displayed.

To open the dialog when creating a new vertical alignment element:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Do one of the following:

l Right click road item and select Add Vert Element from the pop-up menu.
l Right click vertical alignment item and select Add Vert Element from the pop-up menu.

The Add Vert Element dialog is displayed.

General tab
The General tab of the Properties dialog for a vertical alignment or Add Vert Element dialog allows you to con-
figure the base vertical element information. Fields of the tab are described in the table below.
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You may access the Properties dialog for a vertical alignment for an already existing vertical alignment, or while
creating a new vertical element.

To open the dialog for an existing vertical alignment:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required vertical alignment.
3. Right click and select Properties from the pop-up menu.

The Properties: Vertical Alignment dialog is displayed.

To open the dialog when creating a new vertical alignment element:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Do one of the following:

l Right click road item and select Add Vert Element from the pop-up menu.
l Right click vertical alignment item and select Add Vert Element from the pop-up menu.

The Add Vert Element dialog is displayed.

Fields of the General tab
Field Description

Name Defines the name of the vertical alignment. You can rename this alignment.

Start Point

Defines the name of the vertical alignment start point. You can select the
desired point from the list. After selecting the point, the Northing and the East-
ing fields display the coordinates of the selected point. These coordinates can-
not be changed for the selected point.

Elevation
Defines the vertical alignment start point's elevation coordinate in the current
coordinate system (Grid or Ground). You can edit the value, when a point is
not selected in the Start Point field.

Start Sta/Chainage Defines the starting station or chainage for the vertical alignment. You can edit
the value.

X-section Properties dialog
The Properties dialog for the X-Section of the road contains only the General tab. See "General tab" section
below for details.

To open the dialog:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required X-Section.
3. Right click and select Properties from the pop-up menu.

The Properties: X-Section dialog is displayed.

General tab
The General tab of the Properties dialog for a X-Section allows you to configure the base X-Section information.
Fields of the tab are described in the table below.

To open the dialog :
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1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required X-Section.
3. Right click and select Properties from the pop-up menu.

The Properties: X-Section dialog is displayed.

Fields of the General tab
Field Description

Name Defines the name of the X-Section. You can rename this X-Section.

Road string set Properties dialog
The Properties dialog for the Road String Set of the road contains only the General tab. See "General tab" section
below for details.

To open the dialog for:
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required Road String Set.
3. Right click and select Properties from the pop-up menu.

The Properties: Road String Set dialog is displayed.

General tab
The General tab of the Properties dialog for a Road String Set allows you to configure the base Road String Set
information. Fields of the tab are described in the table below.

To open the dialog :
1. In the left panel of the Roads tab from the Tabular view, select the required road and expand it.
2. Select the required Road String Set.
3. Right click and select Properties from the pop-up menu.

The Properties: Road String Set dialog is displayed.

Fields of the General tab
Field Description

Name Defines the name of the Road String Set. You can rename this Road String Set.

Road String Properties dialog
The Properties dilaog for the Road String (for the road with String Set) contains only the General tab. See Gen-
eral tab for detials.

To open the dialog :
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Expand the Road string set.
3. Right click the required Road String and select Properties from the pop-up menu.

The Properties: Road String dialog, opened at the General tab is displayed.

General tab
The General tab of the Properties dialog for a separate Road String allows you to configure the basic information
about the Road String. Fields of the tab are described in the table below.
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To open the dialog :
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Expand the Road string set.
3. Right click the required Road String and select Properties from the pop-up menu.

The Properties: Road String dialog, opened at the General tab is displayed.

Fields of the General tab
Field Description

Name Defines a Road String name. The Road String name is unique and the field can-
not be empty.

Order
Defines a Road String name. To edit the name, click on the highlighted field
and enter a new name. The Road String name is unique and the field cannot be
empty.

Horizontal element properties dialog
The Properties dialog for a horizontal element contain two tabs, described in the appropriate sections:

l General tab
l End Position tab

You may access the Properties dialog for an already existing horizontal segment, or while creating a new one.

To open the dialog for an existing horizontal element from the Tabular view:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the Horizontal Alignment item.
3. In the right panel, select the required horizontal element either in the table, or in the preview area.
4. Right click and select Properties from the pop-up menu.

The Properties: Horz Element dialog is displayed.

To open the dialog for an existing horizontal element from the Map view:
1. In the Map view, select the required horizontal element.
2. Right click and select Properties from the pop-up menu.

The Properties: Horz Element dialog is displayed.

To open the dialog when creating a new horizontal segment:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the Horizontal Alignment item and select Add Horz Element from the pop-up menu.

The Add Horz Element dialog is displayed.

General tab
The General tab of the Properties dialog for a horizontal element or the Add Horz Element dialog contains the
base horizontal element information.

You may access the Properties dialog for an already existing horizontal segment , or while creating a new one.

To open the dialog for an existing horizontal element from the Tabular view:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the Horizontal Alignment item.
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3. In the right panel, select the required horizontal element either in the table, or in the preview area.
4. Right click and select Properties from the pop-up menu.

The Properties: Horz Element dialog is displayed.
5. Click the General tab.

To open the dialog for an existing horizontal element from the Map view:
1. In the Map view, select the required horizontal element.
2. Right click and select Properties from the pop-up menu.

The Properties: Horz Element dialog is displayed.
3. Click the General tab.

To open the dialog when creating a new horizontal segment:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the Horizontal Alignment item and select Add Horz Element from the pop-up menu.

The Add Horz Element dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Type

l Line
l Curve
l Spiral TS to SC “Traverse-Spiral to Spiral-Curve“ direction means that
the start station of the spiral is the end station of the line, and the end sta-
tion of the spiral is the start station of the curve:

l Spiral CS to ST “Curve-Spiral to Spiral-Traverse“ direction means that
the start station of the spiral is the end station of the curve, and the end
station of the spiral is the start station of the line:

l Spiral CS to SC “Curve-Spiral to Spiral-Curve“ direction means that the
start station of the spiral is the end station of one curve, and the end sta-
tion of the spiral is the start station of the other curve.

l Intersection

See pictures below for details.

Length Defines the length of the horizontal element.

Start Sta/Chainage Displays the number of the start station/ chainage for the horizontal element.

Azimuth

Defines the azimuth of the tangent to the start point of the horizontal alignment.
You can edit this value only for the starting element of the road (in this case
the Tangential to previous element checkbox is disabled). To change the azi-
muth of all other elements, untick the Tangential to previous element checkbox
and type the desired value in the filed.

Tangential to pre-
vious element

If this parameter is ticked (default setting for all horizontal element types
except the first road element), the defined value of the azimuth will be used for
the next alignment as start azimuth, and you cannot edit the azimuth. Untick
the checkbox to edit the azimuth.
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Field Description

Turn Defines the direction of turn of the curve/spiral. The Right value stands for
clockwise direction and the Left value, for counter-clockwise direction.

Radius Defines either the radius of the curve, or the start radius of the spiral

Start Radius Defines the start radius of the spiral of CS to ST or CS to SC type.

End Radius Defines the end radius of the spiral of TS to SC or CS to SC type.

Deg Curve

Defines the angle in degrees used to compute either the radius of the curve
whose length is 100 units long:

Using the degree of curve (DCV) parameter, the radius of the curve can be cal-
culated as follows:

Start Deg Curve
Defines the angle in degrees used to compute either the start radius of the
spiral of the CS to ST or CS to SC type whose curve is 100 units long.

See the picture and formula in the description of the Deg Curve field.

End Deg Curve
Defines the angle in degrees used to compute either the start radius of the
spiral of the TS to SC or CS to SC type whose curve is 100 units long.

See the picture and formula in the description of the Deg Curve field.
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Field Description

Deg Chord

Defines the angle in degrees used to compute either the radius of the curve,
whose chord is 100 units long:

Using the degree of chord (DCH) parameter, the radius of the curve can be cal-
culated as follows:

Start Deg Chord
Defines the angle in degrees used to compute the start radius of the spiral of
the CS to ST or the CS to SC type, whose chord is 100 units long.

See the picture and formula in the description of the Deg Chord field.

End Deg Chord
Defines the angle in degrees used to compute the end radius of the spiral of the
TS to SC or the CS to SC type, whose chord is 100 units long.

See the picture and formula in the description of the Deg Chord field.

Chord Defines the length of the segment joining start and end points of a curve in the
current linear units.

Tangent Defines the length of the segment which touches the given curve in the current
linear units.

Mid Ord Defines the Middle Ordinate) — the distance from the midpoint of a chord to
the midpoint of the corresponding curve in the current linear units.

External Defines the distance from the midpoint of the curve to the intersection point of
the tangents in the current linear units.

Spiral Const
Defines the spiral constant value. The spiral constant is the square root of the
length multiplied by the radius of the spiral. The value is used to define a com-
pound curve.

Intersection Pt

Defines the name of the intersection point or the end point of the compound
curve. You can select the desired point from the list. After selecting the point,
the Northing and the Easting fields displays the coordinates of the selected
point. These coordinates cannot be changed for the selected point.
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Field Description

Northing
Defines the intersection point's or compound curve end point's northing coordin-
ate in the current coordinate system. You can edit the value, if a point is not
selected in the Intersection Pt list.

Easting
Defines the intersection point's or compound curve end point's easting coordin-
ate in the current coordinate system. You can edit the value, if a point is not
selected in the Intersection Pt list.

Spiral 1 Length

Defines the length of the first spiral of the compound curve. See picture below.

Spiral 2 Length Defines the length of the second spiral of the compound curve. See picture of
the intersection above, in the description of the Spiral 1 Length field.

Spiral Constant 1
Displays the square root of the length multiplied by the radius of the first spiral
for the compound curve. See picture of the intersection above, in the descrip-
tion of the Spiral 1 Length field.

Spiral Constant 2
Displays the square root of the length multiplied by the radius of the second
spiral for the compound curve. See picture of the intersection above, in the
description of the Spiral 1 Length field.

The Add Next Element checkbox is present when creating new elements.If this parameter is ticked (default setting
for all alignment types), after clicking OK in the current Add Horz Element dilaog, the next Add Horz Element
dialog automatically will appear.

The content of the tab depends on the type of the alignment, defined in the Type field.

For Line type of the horizontal element, the tab contains the following fields:
l Length
l Azimuth
l Tangential to previous element

For Curve the tab contains the fields:
l Length
l Turn
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l Radius
l Azimuth
l Tangential to previous element

And the curve parameters in the Curve group box in the current linear units
l Deg Curve
l Deg Chord
l Chord
l Tangent
l Mid Ord (Middle Ordinate)
l External

For Spiral TS to SC the tab contains the following fields:
l Length
l Turn
l Radius— the end radius of the curve.
l Azimuth
l Tangential to previous element

And the curve parameters in the Curve group box in the current linear units
l Spiral Constant
l Deg Curve
l Deg Chord

For Spiral CS to ST the tab contains the follwing fields:
l Length
l Turn
l Radius
l Azimuth
l Tangential to previous element

And the curve parameters in the Curve group box in the current linear units:
l Spiral Constant
l Deg Curve
l Deg Chord

For Spiral CS to SC the tab contains the following fields:
l Length
l Turn
l Radius
l Azimuth
l Tangential to previous element

And the curve parameters in the Curve group box in the current linear units:
l Spiral Constant
l Start Deg Curve
l Start Deg Chord
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l End Deg Curve
l End Deg Chord

For Intersection the tab contains the following fields:
l Intersection Pt
l Northing
l Easting
l Turn
l Spiral 1 Length
l Spiral 2 Length

And the curve parameters in the Curve group box in the current linear units:
l Spiral Constant 1
l Spiral Constant 2
l Deg Curve
l Deg Chord

Spiral TS to SC
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Spiral CS to ST

Spiral CS to SC
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Curve parameters

End Position tab
The End Position tab of the Properties dialog for a horizontal element or the Add Horz Element dialog contains
the coordinates of the end point of the horizontal alignment in the current linear units. You cannot edit these val-
ues.

You may access the Properties dialog for an already existing horizontal segment , or while creating a new one.

To open the dialog for an existing horizontal element from the Tabular view:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the Horizontal Alignment item.
3. In the right panel, select the required horizontal element either in the table, or in the preview area.
4. Right click and select Properties from the pop-up menu.

The Properties: Horz Element dialog is displayed.
5. Click the End Position tab.

To open the dialog for an existing horizontal element from the Map view:
1. In the Map view, select the required horizontal element.
2. Right click and select Properties from the pop-up menu.

The Properties: Horz Element dialog is displayed.
3. Click the End Position tab.

To open the dialog when creating a new horizontal segment:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the Horizontal Alignment item and select Add Horz Element from the pop-up menu.
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The Add Horz Element dialog is displayed.
3. Click the End Position tab.

Fields of the End Position tab
Field Description

End Sta/Chainage Displays the number of the end station/ chainage for the horizontal element.

End Northing Displays the northing coordinate of the end point of the horizontal element in
Ground / Grid coordinate system.

End Easting Displays the easting coordinate of the end point of the horizontal element in
Ground / Grid coordinate system.

End Azimuth Displays the azimuth of the tangent to the given point for the horizontal ele-
ment.

Entry and exit azumuth

Vertical element Properties dialog
The Properties dialog for the vertical element contains only the General tab. See the "General tab" section on the
facing page for its description.

You may access the Properties dialog for an already existing vertical segment , or while creating a new one.

To open the dialog for an existing vertical element from the Tabular view:
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1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the Vertical Alignment item.
3. In the right panel, select the required vertical element either in the table, or in the preview area.
4. Right click and select Properties from the pop-up menu.

The Properties: Vert Element dialog is displayed.

To open the dialog when creating a new vertical segment:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the Vertical Alignment item and select Add Vert Element from the pop-up menu.

The Add Vert Element dialog is displayed.

General tab
The General tab of the Properties dialog for a vertical element or the Add Vert Element dialog contains the base
vertical element information.

You may access the Properties dialog for an already existing vertical segment , or while creating a new one.

To open the dialog for an existing vertical element from the Tabular view:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the Vertical Alignment item.
3. In the right panel, select the required vertical element either in the table, or in the preview area.
4. Right click and select Properties from the pop-up menu.

The Properties: Vert Element dialog, opened at the General tab is displayed.

To open the dialog when creating a new vertical element:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the Vertical Alignment item and select Add Vert Element from the pop-up menu.

The Add Vert Element dialog, opened at the General tab is displayed

Fields of the General tab
Field Description

Type

Defines the type of a road vertical alignment. You can select one of the fol-
lowing types:

l Grade,
l Parabola,
l Circular Arc,
l Parabola Long Section,
l Arc Long Section.

If selecting a grade or parabola as the first element, then either a grade, or
parabola, or a circular arc can be the next element added to the vertical align-
ment.

If selecting a long section as the first element, the only either a parabola long
sections, or arc long sections can be the next element of the vertical alignment.

See pictures below for details.
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Field Description

Length

Defines the length of the vertical element. You can edit this parameters for the
grade, parabola and parabola long section. The length of the circular arc is auto-
matically calculated taking into account entered values of the Radius, Start
Grade and End Grade parameters. For the long section element, set 0 for the
start and end elements of the long section.

Sta/Chainage

Defines the number of the start station or chainage for a vertical element. You
can edit this parameter for a parabola long section and an arc long section and
cannot edit this parameter for grade, parabola, circular arc.

You can select chainage or station to use for the road center line position at the
Roads tab of the Display item from the Job Configuration dialog. See "Roads
tab" section on page 93 for details.

Start Grade

For grade vertical alignment type, displays the ratio of the grade length and
delta H (the difference between the elevations at the end station and the start
station of the grade element) multiplied by 100% .

For parabola and circular arc displays the start grade of the element, in per-
cents.

You can edit this parameter. If the grade is rising, the value should be set pos-
itive; if the grade is falling, the value should be set negative.

End Grade
For parabola and circular arc displays the end grade of the element, in per-
cents. You can edit this parameter. If the grade is rising, the value should be
set positive; if the grade is falling, the value should be set negative.

Radius
Defines the radius of the Circular Arc and Arc Long Section vertical element.
For the arc long section element, set 0 for start and end element of the long sec-
tion.

Elevation Defines the elevation on the station used for creating the long section.

The Add Next Element checkbox is present when creating new elements.If this parameter is ticked (default setting
for all alignment types), after clicking OK in the current Add Vert Element dialog, the next Add Vert Element dia-
log automatically will appear.

The content of this tab depends on the alignment type:

For Grade the tab contains the following fields:
l Length
l Grade
l Sta/Chainage

For Parabola the tab contains the following fields:
l Length
l Start Grade
l End Grade
l Sta/Chainage

For Circular Arc the tab contains the following fields:
l Radius
l Length
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l Start Grade
l End Grade
l Sta/Chainage

The vertical alignment can be described through a long section (parabola long section or arc long section). In this
case, three points are used to draw a compound curve. To set the compound curve in the vertical plane, you need
to add three long sections to the vertical alignment. When creating a complex curve, the heights for long sections
1, 2 and 3, and the length set for long section 2 will be used. See the picture of the compound curve below.

For Parabola Long Section the tab contains the following fields:
l Sta/Chainage
l Length
l Elevation

For Arc Long Section the tab contains the following fields:
l Sta/Chainage
l Radius
l Elevation

Rising and falling grades

Parabola
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Compound curve in the vertical plane

X-Section station Properties dialog
The Properties dialog for the X-Section station contains only the General tab. See "General tab" section below
for details.

You may access the Properties dialog for an already existing X-Section, or while creating a new one.

To open the dialog for an existing X-Section from the Tabular view:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the X-Section item.
3. In the right panel, select the required X-Section either in the table, or in the preview area.
4. Right click and select Properties from the pop-up menu.

The Properties: X-Section dialog, opened at the General tab is displayed.

To open the dialog when creating a new X-Section element:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the X-Section item and select Add X-Sectopn from the pop-up menu.

The Add X-Section dialog, opened at the General tab is displayed

General tab
The General tab of the Properties dialog for a X-Section element or the Add X-Section dialog contains the base
X-Section information.

You may access the Properties dialog for an already existing X-Section, or while creating a new one.

To open the dialog for an existing X-Section from the Tabular view:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Click the X-Section item.
3. In the right panel, select the required X-Section either in the table, or in the preview area.
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4. Right click and select Properties from the pop-up menu.

The Properties: X-Section dialog, opened at the General tab is displayed.

To open the dialog when creating a new X-Section element:
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Right click the X-Section item and select Add X-Sectopn from the pop-up menu.

The Add X-Section dialog, opened at the General tab is displayed

Fields of the General tab
Field Description

Sta/Chainage
Defines the station or chainage where the template is to be applied. If you set
"0", the selected template is applied from the road start point to the road end
point or to the point where a new template is applied.

Side Defines the left or right side of the road relative to the center line where this
template is to be used.

Template Displays the name of the current template. You can select other template from
the list of existing templates in the current job.

The Add Next X-Section checkbox is present when creating new elements.If this parameter is ticked (default set-
ting), after clicking OK in the current Add X-Section dialog, the next Add X-Section dialog automatically will
appear.

Pair of the horizontal and vertical alignments Properties dialog
The Properties dialog for the pair of the horizontal and vertical alignments (for the road with String Set) contains
only the General tab. See "General tab" section below for details.

To open the dialog :
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Select the required pair of the horizontal and vertical alignments
3. Right click and select Properties from the pop-up menu.

The Properties: Road String dialog, opened at the General tab is displayed.

General tab
The General tab of the Properties dialog for a Pair of the horizontal and vertical alignments of a road string set
allows you to view and edit basic properties for an observation. Fields of the tab are described in the table below.

To open the dialog :
1. In the left panel of the Roads tab from the Tabular view, expand the required road.
2. Select the required pair of the horizontal and vertical alignments
3. Right click and select Properties from the pop-up menu.

The Properties: Road String dialog, opened at the General tab is displayed.

Fields of the General tab
Field Description

Horizontal Align-
ment Name

Defines the current horizontal alignment name for the Road String. You can
select other horizontal alignment from the list for the given road.
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Field Description

Vertical Align-
ment Name

Defines the current vertical alignment name for the Road String. You can
select other vertical alignment from the list for the given road.

X-Sections Template Properties dialog
The X-Sections Template tab from the Tabular view displays a table containing two panels. The left panel displays
X-Section template, the right panel displays the offsets of the selected X-Section template. Each panel has its
own Properties dialog. See the descriptions in the appropriate sections:

l Properties dialog for X-Section template
l Properties dialog for X-Section Offset

Properties dialog for X-Section template
The Properties: X-Section Template dialog allows you to configure the basic information about a X-Section tem-
plate. Fields are described in the table below.

To open the dialog:
1. In the left panel of the X-Section Templates tab from the Tabular view, select the required X-Section tem-

plate.
2. Right click and select Properties from the pop-up menu.

The Properties: X-Section Template dialog is displayed.

Fields of the Properties: X-Section Template dialog
Field Description

Name
Defines the X-Section template name. To edit the name, click on the high-
lighted filed and enter a new name. The X-Section template name is unique
and the field cannot be empty.

Cut Slope (1:n)
Defines the horizontal increment of the slope for a unit of the vertical incre-
ment. The cut slope is used when the road surface is below the terrain. By
default, cut slope equals 0 (units in percent). You can edit the parameter.

Fill Slope (1:n)
Defines the horizontal increment of the slope for a unit of the vertical incre-
ment. The fill slope is used when the road surface is above the terrain. By
default, fill slope equals 0 (units in percent). You can edit the parameter.

Properties dialog for X-Section Offset
The Properties: X-Section Offset dialog allows you to configure the basic information about a X-Section offset.
Fields are described in the table below.

To open the dialog:
1. In the left panel of the X-Section Templates tab from the Tabular view, select the required X-Section tem-

plate.
2. In the left panel, select the required X-Section Offset.
3. Right click and select Properties from the pop-up menu.

The Properties: X-Section Offset dialog is displayed.
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Fields of the Properties: X-Section Offset dialog
Field Description

Name Defines the offset name of the X-Section offset. To edit the name, click on the
highlighted filed and enter a new name. You can leave the field empty.

Order Displays the order of the offset in the template. You can set any number from
the list of offset number.

Hz. Dist Defines the horizontal offset (in the current linear units) from the center line
for the offset. You can edit the value.

V Dist
Defines the vertical offset from the horizontal plane for the offset. You can
edit the value. When you enter this parameter, the Grade will be automatically
calculated and displayed in the appropriate field.

Grade
Defines the ratio of horizontal offset and vertical offset multiplied by 100%.
When you enter this parameter, the Vertical distance will be automatically cal-
culated and displayed in the appropriate field.

Hz. Offset from
CL

Defines the horizontal offset from the center line (in the current linear units)
for the start point of the given offset. It is calculated using the corresponding
values of the previous offsets and it is not editable.

V. Offset from CL
Defines the vertical offset from the horizontal plane for the start point of the
offset. It is calculated using the corresponding values of the previous offsets
and it is not editable.

Inverse Properties dialog
The Inverse tab from the Tabular view displays a table that lists the results of the inverse calculations. The Prop-
erties dialog for an inverse calculation displays its basic information.

To open the dialog:
1. In the Inverse tab from the Tabular view, select the required inverse calculation.
2. Right click and select Properties from the pop-up menu.

The Properties dialog is displayed.

Fields of Properties dialog for the Inverse
Field Description

From Displays the name of the start point (if the point has name) in the Inverse task.

To Displays the name of the end point (if the point has name) in the Inverse task.

Forward Azimuth

The calculated value depends on the selected coordinate system. If the global
coordinate system (WGS Lat,Lon,Ell.H / Datum Lat,Lon,Ell.H / Datum
Lat,Lon,Elevation) is selected in the Status bar, the horizontal geodesic azi-
muth from the "From" point to the "To" point is displayed. For Grid/Ground
coordinate system, selected in the Status Bar, grid/ground azimuth (bearing)
from the "From" point to the "To" point is displayed.
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Field Description

Backward Azi-
muth

The calculated value depends on the selected coordinate system. If the global
coordinate system (WGS Lat,Lon,Ell.H / Datum Lat,Lon,Ell.H / Datum
Lat,Lon,Elevation) is selected in the Status bar, the horizontal geodesic azi-
muth from the "To" point to the "From" point is displayed. For Grid/Ground
coordinate system, selected in the Status Bar, grid/ground azimuth (bearing)
from the "To" point to the "From" point is displayed.

Geodetic Distance Displays the length of the geodetic line (the shortest distance) between the two
points on an ellipsoid in the current unit.

Ground Distance

The calculated value depends on whether the Grid-to-Ground transformation is
activated or not. If Grid to Ground transformation is not activated, it will be the
geodetic distance multiplied by the scale factor, which is automatically cal-
culated taking into account the height of the first point. If Grid to Ground trans-
formation is activated, the Ground Distance displays a grid distance multiplied
by the scale factor calculated, taking into account the average job height.

Grid Distance
Displays the shortest distance between two points on a projection plane in the
current unit. This value will be displayed when a "Grid" coordinate system is
selected in the Status bar.

Slop Distance Displays the 3D distance between the points, in current unit.

Delev
Displays the difference in orthometric heights, in current unit. This value will
be displayed, if Ground or Grid or Datum Lat, Lon, Elevation is selected in the
Status bar.

Delta Ell. H
Displays the difference in ellipsoidal heights, in current unit. This value will be
displayed, ifWGS84 Lat, Lon, Ell.H or Datum Lat, Lon, Ell.H is selected in the
Status bar.

dN Displays the difference in Norting coordinates, in current unit. This value will
be displayed when a projection is defined in the Job Configuration.

dE Displays the difference in Easting coordinates, in current unit. This value will
be displayed when a projection is defined in the Job Configuration.

Note Displays a user comment. To edit the note, click on the highlighted field and
enter a user's comments.

Compare Surfaces Properties dialog
The Compare Surfaces tab from the Tabular view displays a table that lists the results of the inverse calculations.
The Properties dialog for surface comparing displays its basic information.

To open the dialog:
1. In the Compare Surfaces tab from the Tabular view, select the required comparison.
2. Right click and select Properties from the pop-up menu.

The Properties dialog is displayed.
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Fields of Properties dialog for the surface comparing
Field Description

Design Displays the name of the first surface/road from comparison.

Existing Displays the name of the second surface from comparison.

Level Displays the level of the horizontal pane from comparison.

Cut

If two surfaces were compared — displays the cut volume to correct the exist-
ing surface to the design surface. See Comparing two surfaces picture below.

If a surface and a level were compared — displays the cut volume to correct
the design surface to the specified level. See Comparing surfaces and a level
picture below.

Fill

If two surfaces were compared — displays the fill volume to correct the exist-
ing surface to the design surface. See Comparing two surfaces picture below.

If a surface and a level were compared — displays the fill volume to correct
the design surface to the specified level. See Comparing a surface and a level
picture below.

Area Displays the common area of two surfaces or a surface and a horizontal pane.

Note Defines any additional notes about comparison.

Comparing two surfaces
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Comparing surfaces and a level

Code properties dialog
The Properties dialog for a code allows you to configure the parameters of codes. It contains five tabs, described
in the appropriate sections:

l "General tab" section below
l "Line tab" section on the facing page
l "Point tab" section on page 302
l "Area tab" section on page 302
l "Surface tab" section on page 303

To open the dialog:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, right click the required code and select Properties from the pop-up menu.

The Properties: Code dialog is displayed.

General tab
The General tab of the Properties dialog for a code allows you to configure the basic code information. Fields are
described in the table below.
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To open the tab:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, right click the required code and select Properties from the pop-up menu.

The Properties: Code dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Name Displays the name of the code. You can edit the code's name, if the code is not
used for an object of the job.

Description Displays any additional text information about the code.

Type

In this field you can select the type of the code:
l Point — if you apply this type for a points of the job, you can use or not
use the points in a surface.

l Line — if you apply this type for a lines of the job, you can use or not
use the lines in a surface, and use or not use the lines as breakline in a
surface.

l Area — if you apply this type for a areas of the job, you can use or not
use the areas in a surface, use or not use the areas as breakline, and use
or do not use the areas as exclusion area (hole) in a surface.

Layer

Displays the Layer where the code resides. The Layer sets the plotting style
for the code. Every code has a non-empty Layer. In this field, you can select
any Layer from the list of user-created layers.

By default the selected Layer sets the plotting style of the code and all plotting
style (symbol and color for point; color, style and width for line; color, fill style
and fill transparency for area) automatically are set to BYLAYER. You can
change the plotting style.

Line tab
The Line tab of the Properties dialog for a code allows you to configure the plotting style for lines. Fields are
described in the table below.

To open the tab:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, right click the required code and select Properties from the pop-up menu.

The Properties: Code dialog is displayed.
3. Click the Line tab.
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Fields of the Line tab
Field Description

Line Color Displays the polyline color for Map View. By default the parameter is set to
BYLAYER. You can choose any color from the list.

Line Style
Displays the polyline style (solid, dashed, dashed-and-doted, doted) for Map
View. By default the parameter is set to BYLAYER. You can choose any
style from the list.

Line Width Displays the polyline width (from 1 to 10 pixels) for MapView. By default the
parameter is set to BYLAYER. You can choose any width from the list.

Point tab
The Point tab of the Properties dialog for a code allows you to configure the plotting style for points. Fields are
described in the table below.

To open the tab:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, right click the required code and select Properties from the pop-up menu.

The Properties: Code dialog is displayed.
3. Click the Point tab.

Fields of the Point tab
Field Description

Point Symbol Displays the point symbol in Map View. By default the parameter is set to
BYLAYER. You can choose any symbol from the list.

Point Color Displays the point color in Map View. By default the parameter is set to
BYLAYER. You can choose any color from the list.

Area tab
The Area tab of the Properties dialog for a code allows you to configure the plotting style for ares. Fields are
described in the table below.

To open the tab:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, right click the required code and select Properties from the pop-up menu.

The Properties: Code dialog is displayed.
3. Click the Area tab.
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Fields of the Area tab
Field Description

Area Color Displays the color of the closed polyline (area) in Map View. By default the
parameter is set to BYLAYER. You can choose any color from the list.

Area Fill Style Displays the fill stile for closed polyline (area) in Map View. By default the
parameter is set to BYLAYER. You can choose any fill style from the list.

Fill Transparency Displays the transparency value for closed polyline (area) in 3D View. By
default the parameter is set to BYLAYER.

Surface tab
The Surface tab of the Properties dialog for a code allows you to configure the plotting style for surfaces. Fields
are described in the table below.

To open the tab:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, right click the required code and select Properties from the pop-up menu.

The Properties: Code dialog is displayed.
3. Click the Surface tab.

Fields of the Surface tab
Field Description

Use in Surface
When ticked, the points, lines or areas with the code may be used in a surface.

When unticked, the points, lines or areas with the code cannot be used in a sur-
face.

Breakline

When ticked, the lines or areas with the code may be used as breakline in a sur-
face.

When unticked, the lines or areas with the given code cannot be as breakline in
a surface.

Exclusion Area

When ticked, the areas with the code will be used as exclusion area (hole) in a
surface.

When unticked, the areas with the code will not be as exclusion area (hole) in
a surface.

Code Attribute properties dialog
The Properties dialog for a code attribute allows you to configure the basic parameters of code attributes. Fields
of the dialog are described in the table below.

To open the dialog:
1. In the CAD group of the View tab, click the Codes icon.

The Codes view is displayed.
2. In the left panel, select the required code
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3. In the right panel, right click the required code attribute and select Properties from the pop-up menu.

The Properties: Code Attribute dialog is displayed.

Fields of the Properties: Code Attribute dialog
Field Description

Attribute Name Displays the name of the attribute. You can edit the attribute's name, if the cor-
responding code is not used for an object of the job.

Default Value

In this field you can enter or select from the list the default value for each
attribute's type. You can edit the attribute's default values, if the corresponding
code is not used for a object of the job. The field cannot be empty if you the
Required checkbox is ticked.

Type

Displays the type of the attribute. You cannot edit the type for the created
attribute. You can select one of the following types when creating a new attrib-
ute:

l Integer — any integer number
l Real Number — any real number
l Text — any alpha-numeric string that contains up to 255 characters
l Menu — you can select any attribute from a list. You can add and
remove any value and text to/from the list

l Date/Time — the current date and time
l Boolean — you can select True or False values.

Required When ticked, the attribute's value must be defined for code.

Layer properties dialog
The Properties dialog for a code allows you to configure the parameters of layers. It contains four tabs, described
in the appropriate sections:

l "General tab" section below
l "Properties tab" section on the facing page
l "Area tab" section on page 306
l "Avoidance tab" section on page 306

To open the dialog:
1. In the CAD group of the View tab, click the Layers icon.

The Layer view is displayed.
2. Right click the required Layer and select Properties from the pop-up menu.

The Properties: Layer dialog is displayed.

General tab
The General tab of the Properties dialog for a layer allows you to configure the basic layer information. Fields
are described in the table below.

To open the tab:
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1. In the CAD group of the View tab, click the Layers icon.

The Layer view is displayed.
2. Right click the required Layer and select Properties from the pop-up menu.

The Properties: Layer dialog is displayed.
3. Click the General tab.

Fields of the General tab
Field Description

Name Displays the name of the layer. You can edit the layer's name for any layer,
except the layer with zero name.

Note Displays any additional text information about the layer.

Breakline Type

In this field you can select one of the following types:
l Auto — when creating a surface, the polyline/area with the given layer
can be as boundary or breakline or exclusion,

l Breakline — when creating a surface, the polyline/area with the given
layer can be only breakline,

l Boundary — when creating a surface, the polyline/area with the given
layer can be only boundary,

l Exclusion — when creating a surface, the area with the given layer can
be only exclusion area.

Visible Defines the visibility of the layer. Layer is visible when checkbox is ticked.

Properties tab
The Properties tab of the Properties dialog for a layer allows you to configure the basic plot styles for a layer's
objects. Fields are described in the table below.

To open the tab:
1. In the CAD group of the View tab, click the Layers icon.

The Layer view is displayed.
2. Right click the required Layer and select Properties from the pop-up menu.

The Properties: Layer dialog is displayed.
3. Click the Properties tab.

Fields of the Properties tab
Field Description

Line Style Displays the polyline style (solid, dashed, dashed-and-doted, doted) for Map
View. You can choose any style from the list.

Line Width Displays the polyline width (from 1 to 10 pixels) for Map View. You can
choose any width from the list.

Color Displays the color for any objects with the given layer. You can choose any
color from the list for displaying in Map View.
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Field Description

Point Symbol Displays the point symbol in Map View. You can choose any symbol from the
list.

Area tab
The Area tab of the Properties dialog for a layer allows you to configure the plot styles for a layer's areas. Fields
are described in the table below.

To open the tab:
1. In the CAD group of the View tab, click the Layers icon.

The Layer view is displayed.
2. Right click the required Layer and select Properties from the pop-up menu.

The Properties: Layer dialog is displayed.
3. Click the Area tab.

Fields of the Area tab
Field Description

Area Fill Style Displays the fill style for closed polyline (area) in Map View. You can choose
any fill style from the list.

Fill Transparency Displays the transparency value for closed polyline (area) in 3D View.

Avoidance tab
The Avoidance feature is used in the machine control for alarming operator if the machine enter avoidance area;
and in the field software to avoid dangerous areas. Pictures below represent avoidance areas. MAGNET Tools
support this feature for import/export purposes.

Avoidance area for a line



Avoidance tab

307

Avoidance area for polygon/surface in the horizontal plane

LEGEND
#1; #2; #3— points

4— proximity,

5— boundary and avoidance areas.

The Avoidance tab of the Properties dialog for a layer allows you to configure the layer for avoidance boundaries.

To open the tab:
1. In the CAD group of the View tab, click the Layers icon.

The Layer view is displayed.
2. Right click the required Layer and select Properties from the pop-up menu.

The Properties: Layer dialog is displayed.
3. Click the Avoidance tab.
4. Configure the parameters as you need. Fields are described in the table below.

Fields of the Avoidance tab
Field Description

Avoidance Mode

Defines the mode of the avoidance option. Select the required radiobutton:
l Off— to turn the avoidance option off.
l 2D — to work in the horizontal plane only.
l 3D — to work in both horizontal and vertical planes
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Field Description

Avoidance Surface
mode

Defines the avoidance surface mode. Select the required option from the drop-
down list:

l Above — the avoidance boundary will be placed above the surface. The
alarm will be displayed if a measurement is performed within the avoid-
ance boundary. See the "Above avoidance mode" picture below.

l Below— the avoidance boundary will be placed below the surface. The
alarm will be displayed if a measurement is performed within the avoid-
ance boundary. See the "Below avoidance mode" picture below.

l Above/Below— the avoidance boundary will be placed both above and
below the surface. The alarm will be displayed if a measurement is per-
formed within the avoidance boundary. See the "Above/Below avoid-
ance mode" picture below.

l Outside — the avoidance boundary will be placed both above and below
the surface. The alarm will be displayed if a measurement is performed
outside of the avoidance boundary. See the "Outside avoidance mode"
picture below.

Avoidance Prox-
imity Defines the size of the avoidance area.

Above avoidance mode

Below avoidance mode

Above/Below avoidance mode
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Outside avoidance mode

LEGEND
1— surface

2— proximity

3— boundary area

Text properties dialog
The Properties dialog for a text allows you to configure the parameters of text objects. It contains two tabs,
described in the appropriate sections:

l "Text tab" section below
l "Location tab" section on the next page

To open the dialog:
1. Select the required text object either in the Map view; or at the Text tab from the tabular view.
2. Right click and select Properties from the pop-up menu.

The Properties: Text dialog is displayed.

Text tab
The Text tab of the Properties dialog for a text allows you to edit the basic properties of the text. Fields of the tab
are described in the table below.

To open the tab:
1. Select the required text object either in the Map view; or at the Text tab from the tabular view.
2. Right click and select Properties from the pop-up menu.

The Properties: Text dialog is displayed.
3. Click the Text tab.

Fields of the Text tab
Field Description

Contents Defines the content of the text box. You can type any text here.
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Field Description

Layer
Defines the Layer in which the Text resides. The Layer sets the plotting style
for the text. You can select any Layer from the list of layers available in the
job. The field cannot be empty.

Color Defines the text color for the Map view. If you set BYLAYER, the color of
the text will be set automatically by layer settings.

Angle Defines the angle rotation of the text box in degrees. By default, the values is
zero, which means horizontal orientation of the text.

Text Height Defines the height of the text in the current linear units.

Font Name Defines the font for the text. You can select any font from the list of available
fonts.

Bold Tick it to make the font bold.

Italic Tick it to make the font italic.

Underline Tick it to draw the line under the text.

Insertion Point Defines where the insertion point will be located on the text box.

Draw Box Tick it to draw a frame around the text.

Opaque Tick it to fill the text box with the background color; otherwise the text box is
transparent.

Location tab
The Location tab of the Properties dialog for a text allows you to edit the location of the text. Fields of the tab are
described in the table below.

To open the tab:
1. Select the required text object either in the Map view; or at the Text tab from the tabular view.
2. Right click and select Properties from the pop-up menu.

The Properties: Text dialog is displayed.
3. Click the Location tab.

Fields of the Location tab
Field Description

Start Point Defines the name of the start point of the text box. You can selected any exist-
ing point of the current job.

Northing Defines the grid northing coordinate of the start point.

Easting Defines the grid easting coordinate of the start point.

Height Defines the grid elevation coordinate of the start point.
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Class properties dialog
The Properties dialog for a TS measurement class allows you to configure the parameters of class. It contains
two tabs, described in the appropriate sections:

l "General tab" section below
l "Parameters tab" section below

To open the dialog:
1. In the Equipment group of the View tab, click the Classes View icon.
2. Select the required class.
3. Right click and select Properties from the pop-up menu.

The Properties: Class dialog is displayed.

General tab
The General tab of the Properties dialog for a TS measurement class allows you to edit the basic properties of the
class. Fields of the tab are described in the table below.

To open the tab:
1. In the Equipment group of the View tab, click the Classes View icon.
2. Select the required class.
3. Right click and select Properties from the pop-up menu.

The Properties: Class dialog is displayed.
4. Click the General tab.

Fields of the General tab
Field Description

Name Defines the name of the class. The class name is unique and the field cannot
be empty.

Note Defines any additional note about class.

Parameters tab
The Parameters tab of the Properties dialog for a TS measurement class allows you to edit the measurement char-
acteristics of the class. Fields of the tab are described in the table below.

To open the tab:
1. In the Equipment group of the View tab, click the Classes View icon.
2. Select the required class.
3. Right click and select Properties from the pop-up menu.

The Properties: Class dialog is displayed.
4. Click the Parameters tab.
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Fields of the Parameters tab
Field Description

Num Sets
Defines the set number of horizontal angle (HA) measurements. You can
select either direct, or single direct and reverse, or multiple direct and reverse
measurements of HA.

VA
Defines when the vertical angle (VA) will be measured. You can select either
vertical angle measurement for direct measurements only, or for first direct
and reverse measurements, or for all direct and reverse measurements of HA.

Dist

Defines when the distance will be measured. You can select either do not
measure the distance, or perform the distance measurement for first direct
measurements only, or for first direct and reverse measurements, or for all dir-
ect or all direct and reverse measurements.

Num Dist
Defines the number of measurements for distance determination. You can
select either one, or multiple measurements. Only the first distance meas-
urement is used in position calculation.The other ones are just recorded.

Hz Defines the tolerance value in the horizontal plane in current angular units. The
field is available for one or more direct and reverse measurements of the HA.

Hz (r+l)
Defines the tolerance value of the oscillation of the direction in the horizontal
plane in current angular units. The field is available for one or more direct and
reverse measurements of the HA.

Hz (r-l)
Defines the tolerance value of the oscillation of the collimation error in the hori-
zontal plane in current angular units. The field is available for one or more dir-
ect and reverse measurements of the HA.

VA
Defines the tolerance value in the vertical plane in current angular units. This
field is available when VA is measured either for one direct and reverse meas-
urements or for all direct and reverse measurements of HA.

Distance
Defines the tolerance value for the repeated distance measurements during one
set. The field is available when the value of the Num Dist parameter is more
than 1.

Dist Sets Dev
Defines the tolerance value for the repeated distance measurements during sev-
eral sets. The field is available when the value in the filed Dist is either 1DR,
or D, or RD.

Geoid properties dialog
To open the dialog, in the Geoid List table, select the required geiod, and select Properties from the context
menu.

Fields of the Geoid properties dialog
Field Description

Name Displays the geoid name

Datum Displays the reference datum of the geoid.
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Field Description

Path Displays the path to the geoid file location.

Minimum Latitude Displays the minimum value of the latitude that limits the use of this model.

Minimum Longitude Displays the minimum value of the longitude that limits the use of this model.

Maximum Latitude Displays the maximum value of the latitude that limits the use of this model.

Maximum Lon-
gitude Displays the maximum value of the longitude that limits the use of this model.

Datum properties dialog
To open the dialog:

1. In the Information group of the Job tab, click the Job Configuration icon.

The Job configuration dialog is displayed.
2. Select the Coordinate Systems item.
3. In the Datum field, click Custom.

The Custom Datums List is displayed.
4. Select the required datum.
5. Right click and select Properties from the pop-up menu.

The Properties: Datum dialog is displayed.

Fields of the Properties dialog for a datum
Field Description

Name Displays the name of the custom datum. The datum name is unique and the
field cannot be empty.

Ellipsoid Displays the name of the ellipsoid used to create the datum. You can select
any predefined ellipsoid from the list.

DX Displays the value of shift along the X axis in meters, which specifies a
coordinate transformation from the created datum to WGS84. The default is 0.

DY Displays the value of shift along the Y axis in meters, which specifies a
coordinate transformation from the created datum to WGS84. The default is 0.

DZ Displays the value of shift along the Z axis in meters, which specifies a
coordinate transformation from the created datum to WGS84. The default is 0.

RX Displays the value of the rotation angle between the X axes of the created
datum and WGS84 in arc seconds. The default is 0.

RY Displays the value of the rotation angle between the Y axes of the created
datum and WGS84 in arc seconds. The default is 0.

RZ Displays the value of the rotation angle between the Z axes of the created
datum and WGS84 in arc seconds. The default is 0.

Scale Displays the value of the scale factor in ppm, which specifies a coordinate
transformation from the created datum to WGS84. The default is 0.

Note Displays any additional note about the datum.
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Field Description

Alias
Displays the name of the datum, all available projection(s) for the datum auto-
matically will be available for the created custom datum. You can select any
datum from the list.

Projection properties dialog
To open the dialog:

1. In the Information group of the Job tab, click the Job Configuration icon.

The Job configuration dialog is displayed.
2. Select the Coordinate Systems item.
3. In the Projection field, click Custom.

The Custom Projections List is displayed.
4. Select the required projection.
5. Right click and select Properties from the pop-up menu.

The Properties: Projection dialog is displayed.

Fields of the Properties dialog for a projection
Field Description

Name Displays the name of thecustom projection. The projection name is unique and
the field cannot be empty.

Projection Type

Defines the name of the projection type. The following options are available:
l Transverse-Mercator
l Lambert
l Double Stereographic
l Stereographic
l Oblique Mercator
l Albers Equal Area
l Cassini-Soldner
l Mercator

Every projection has its own set of original parameters. After selecting the
type of projection, you can edit the parameters for this type.

Region

Displays the name of the region for which the given projection will be used.
You can use the existing regions (Africa, Asia, Australia and New Zealand
and so on) or enter a new name. If you enter a new name, the application cre-
ates a new folder with the entered name in the projection list. After clicking
OK the custom projection will be saved in the folder.

Notes Displays any additional note about the projection.

Datum

Displays the datum used for the projection. You can select any datum for the
given projection. After selection the custom projection, the datum will be auto-
matically set in the Datum drop-down list at the Setup tab of the Coordinate
Systems item from the Job configuration dialog
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Station Equations Set properties dialog
The Properties dialog for a Station Equations set allows you to view and edit name of a station equations set.

To open the dialog:
1. In the left panel of the Station Equations tab from the tabular view, select the required set.
2. Right click and select Properties from the pop-up menu.

The Properties: Station Equations Set dialog is displayed.

Fields of the Properties: Station Equations Set dialog
Field Description

Name Defines the name of the station equations set.

Station Equation properties dialog
The Properties dialog for a Station Equation allows you to view and edit parameters of a station equation.

To open the dialog:
1. In the left panel of the Station Equations tab from the tabular view, select the required set.
2. In the right panel, select the required station equation.
3. Right click and select Properties from the pop-up menu.

The Properties: Station Equation dialog is displayed.

Fields of the Properties: Station Equation dialog
Field Description

Name Defines the name of the station equation.

Back Station Defines stationing of the approaching segment, behind the spot, where station
equation is applied

Ahead Station Defines stationing of the departing segment, after the spot, where station equa-
tion is applied
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Options Dialog
MAGNET Tools data views may be modified to fit your preferences. You may edit options of any view at any
time by using the Options dialog.

To open the dialog, right click in the required view, and select the Options command from the pop-up menu.

For details see the following sections:
l "Tabular View Options dialog" section below
l "Roads View Options dialog" section below
l "Observations View Options dialog" section on the facing page
l "Map View Options dialog" section on page 319
l "3D View Options dialog" section on page 319
l "Occupation View Options dialog" section on page 320

Tabular View Options dialog
The data fields for each tab of the Tabular view can be shown/hidden and re-arranged according to your pref-
erence. You can change the order and visibility of the tab’s fields in the Options dialog.

To open the dialog for the current tab, right click on any place of the tab, and select the Options command from
the pop-up menu.

The dialog contains two lists for each pane of the tab. The Available columns list contains fields available for this
tab, the Selected columns list contains fields, which will be displayed in the tab.

You can create your own set of columns by using:
l the >> and << buttons to include/remove the selected fields to the Selected columns list
l the Move Up andMove Down buttons to modify the order of the selected columns.

Roads View Options dialog
The dialog contains six tabs for the various road components:

l Display Horizontal Elements tab
l Display Vertical Elements tab
l Display Cross Sections tab
l Display Road Strings tab
l Display Road String Alignments tab
l Graphic Views tab

To open the dialog, right click any place in the right pane of the Roads tab, and select the Options command from
the pop-up menu.

The Graphic View tab allows you to configure the layout of the road elements in graphic views. Fields of this tab
are described in the table below.
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Fields of the Graphic Views tab
Field Description

Show Grid Tick to display the coordinate grid

Show station name
on station Tick to display the station name for the station

Show station name
on cursor Tick to display the station name on the cursor position

Show station name
on status bar Tick to display the station name on the status bar.

The rest of the tabs allow you to configure the table views of road elements. The data fields for each tab can be
shown/hidden and re-arranged according to your preference.

Each tab contains two lists. The Available columns list contains fields available for a road element, the Selected
columns list contains fields, which will be displayed in the appropriate table.

You can create your own set of columns by using:
l the >> and << buttons to include/remove the selected fields to the Selected columns list
l the Move Up andMove Down buttons to modify the order of the selected columns.

Observations View Options dialog
The dialog contains four tabs where you can show or hide different elements in the Observations View. For more
information about each tab, refer to the appropriate section:

l "Window tab" section below
l "Labels tab" section on the next page
l "Selection tab" section on the next page
l "QAQC tab" section on page 319

Window tab
The Window tab of the Options dialogs for Map and Observation view allows you to configure base properties for
the view layout.

Fields of theWidows tab
Field Description

Show Grid Tick to display grid lines on the map.

Show Legend
Tick to display the Legend window describing the symbols used in the view.

NOTE
This field appears only in theOptions dialog for the Observation view.
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Field Description

Show Ellipses

Tick to display Ellipses in the view. The plane errors are represented as
ellipses with the semi-axes equal to Std e and Std n for the vector/point. The
vertical error is represented as a segment with the length equal to Std u for the
vector/point. See "Adjustment tab" section on page 222 for details.

NOTE
This field appears only in theOptions dialog for the Observation view.

Show background
map Tick to display Background images in the view.

Show scale bar Tick to display the Scale window with the scale info.

Background color Defines the background color for the view.

Open this window
automatically

when observation
appear

Tick it to open the Observation view automatically if the job contains obser-
vations or a new observation added to the job.

NOTE
This field appears only in theOptions dialog for the Observation view.

Labels tab
The Labels tab of the Options dialogs for Map and Observation views allows you to define, which information
should be displayed in the view.

The tab has two group boxes, defines the displayed information for static and kinematic points. Each of these
group boxes is divided to three group boxes:

l Show on map— checkboxes in it define which information will be shown in Map and Observation views
l Show on cursor— checkboxes in it define which information will be shown on the cursor position
l Show on status map— checkboxes in it define which information will be shown on the status bar

Tick the required checkboxes to define which information will be displayed in each position for static and kin-
ematic points.

Selection tab
The Selection tab of the Options dialogs for Map and Observation views allows you to define, which information
should be displayed in the view. Fields of the tab are described in the table below.

Fields of the Selection tab
Field Description

Show distance
Tick to display the length of the selecting the rectangle's diagonal in the Status
bar,when the user drags a rectangle over the map in the Map View or Obser-
vation view.

Show azimuth
Tick to display an azimuth from the first point to the last point in the Status bar,
when the user drags a rectangle over the map in the Map view or Observation
view.

Show dimensions
Tick to display dimensions of the selecting rectangle along the Easting and Nor-
thing axis correspondingly in the Status bar, when the user drags a rectangle
over the map in the Map view or Observation view.
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Field Description

Show area size Tick to display an area of the rectangle in the Status bar, when the user drags a
rectangle over the map in the Map View or Observation view.

QAQC tab
The QAQC tab of the Options dialog for the Observation view allows you to display the QAQC information. Field
is described in the table below.

Fields of the QAQC tab
Field Description

Show QAQC
information in tool-

tip

Tick to display the QC message for the selected object that failed QC. When
the user stops the mouse in the Observation view over that object the QC mes-
sage for that object appears in the tooltip along with all other information about
this object.

Map View Options dialog
The dialog contains three tabs where you can show or hide different elements in the Map View. For more inform-
ation about each tab, refer to the appropriate section:

l "Window tab" section on page 317
l "Labels tab" section on the previous page
l "Selection tab" section on the previous page

3D View Options dialog
The dialog contains three following tabs where you can show or hide different elements in the 3D View. For more
information about each tab, refer to the appropriate section:

l "Window tab" section below
l "Selection tab" section on the next page
l "Labels tab" section on the next page

Window tab
The Window tab of the Options: 3D View dialog has settings for displaying or hiding the gird and settings allows
to fill 3D objects in different ways. Fields of the tab are described in the table below.

Fields of theWindows tab
Field Description

Fill mode

Defines the filling mode for the 3D objects. You may select one of the fol-
lowings:

l Wireframe
l Solid
l Wireframe & Solid
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Field Description

Show Grid

Defines the style for displaying the Grid. You may select one of the following
options:

l None (turn off the Grid)
l Grey scale
l Color

Background color Defines the background color for the 3D View.

Show background
images

Tick to display Background images on the 3D view. Background images will
be shown only on the surface.

Selection tab
The Selection tab of the Options: 3D View dialog allows you to configure displaying of the parameters for the
selecting rectangle in the Status Bar. Fields are described in the table below.

Fields of the Selection tab
Field Description

Show distance

Tick to display the length of the selecting the rectangle diagonal in the Status
bar, when the user drags a rectangle over the map on the 3D View. This option
works only if all vertexes of the selecting rectangle are located inside the 3D
object.

Show azimuth
Enable to display an azimuth of the selecting rectangle diagonal (from the first
point to the last point)in the Status bar, when the user drags a rectangle over
the map on the 3D View.

Labels tab
The Labels tab of the Options: 3D View dialog allows you to define, which information should be displayed in the
view.

The tabs has three group boxes, defines the displayed information for points:
l Show on map— checkboxes in it define which information will be shown on map of 3D view
l Show on cursor— checkboxes in it define which information will be shown on the cursor position
l Show on status map— checkboxes in it define which information will be shown on the status bar

Tick the required checkboxes to define which information will be displayed in each position for static and kin-
ematic points.

Occupation View Options dialog
The dialog contains three following tabs where you can show or hide different elements in the 3D View. For more
information about each tab, refer to the appropriate section:

Show tab
The Show tab of the Options dialog for the Occupation view allows you to how or hide the coordinate grid and
legend window.
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Fields of the Show tab
Field Description

Show grid Tick to display grid lines on the Occupation view.

Show legend Tick to display the Legend window describing the symbols used in the view.

Occupation view tab
In the Occupation tab of the Options dialog for the Occupation view you can select the display mode of the Occu-
pation View:

l Show occupations by receivers— the vertical axis of the occupation view graph represents the serial num-
bers of the receivers used for data collection.

l Show occupations by points— the vertical axis of the occupation view graph represents the names of the
points where the data was collected.

QAQC tab
The QAQC tab of the Options dialog for the Occupation view allows you to display the QAQC information.
Fields are described in the table below.

Fields of the QAQC tab
Field Description

Show QAQC
information in tool-

tip

Tick to display the QC message for the selected object that failed QC. When
the user stops the mouse in the occupation view over that object the QC mes-
sage for that object appears in the tooltip along with all other information about
this object.
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MAGNET Enterprise
The Enterprise option in the application which allows you to connect with the MAGNET Enterprise service to get
the possibility to upload or download data to the project on the sever and communicate with the company members
in the chat. Open the Enterprise tab of the MAGNET Tools ribbon run the Enterprise option.

To connect with the MAGNET Enterprise web server, click the Logon icon. For details see "Enterprise logon"
section below.

To create a new Project Inbox and see all available Projects, click the Connect to Project icon. For details see
"Enterprise: Connect to Project" section on the facing page.

To upload a file in the Project Inbox, click the Upload files icon. For details see "Enterprise: Uploading files" sec-
tion on page 325.

To download a file from the Project Inbox, click the Download files icon. For details see "Enterprise: Download
files" section on page 326.

To start chatting with the company members, click the Chat icon. For details see "Enterprise: Chat" section on
page 324.

To automatically receive the coordinates of the measured point in the real time to the current job, click the Real
time icon. For details see "Enterprise: Real time" section on page 326.

To change the connection option with Enterprise web server, click the Options icon. For details see "Enterprise:
Options dilaog" section on page 325.

Enterprise logon
In the Logon dialog you can enter login (e-mail) and password provided by the Enterprise administrator of your
company or by dealer to connect to the Enterprise server.

To open the dialog, in the Common group of the Enterprise tab, click the Logon icon.

When the Save login checkbox is ticked, the login will be stored and you do not need to enter the login for the next
session.

When the Save password checkbox is ticked, the password will be stored and you do not need to enter the pass-
word for the next session.

When the Auto logon on startup checkbox is ticked, the connection with the server will be set automatically after
starting the application. The Save login and Save password must be ticked to use this option.

To start a connection, click Logon. After the connection is established:
l the Logon button changes into the Logout button,
l all fields and all checkboxes of the Logon dialog are disabled,
l all icons of the Enterprise tab are enabled.

To stop the connection, click Logout. After disconnecting with the Enterprise server:
l the Logout button changes into the Logon button,
l all fields and all checkboxes of the Logon window are enabled,
l all icons of the Enterprise option are disabled.
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Enterprise: Connect to Project
You can create a Project Inbox on the Enterprise service. Only after creating a project you can upload / download
data to the project. You can create unlimited number of projects.

To create a project, enter a name in the New project field and click the Create button.
1. In the Common group of the Enterprise tab, click the Connect to Project icon.

The Project dialog is displayed.
2. In the New Project editbox, type the name of the new project.
3. Click Create.

The project is created.

In the Enterprise option of the application you can not assign additional user(s) to the Project Inbox(es).

An Administrator or Project Manager can assign additional user(s) to the project in the Enterprise web server.

The Available list displays all the projects to which you have access. In this filed you can select one project as the
current project: highlight a desired project in the field and click the Connect button.

Before starting the Real Time logging, you have to connect to the same project, which was selected in the
MAGNET Field job. Receiving of the measured point coordinates automatically is performed within one Project.

See also "Enterprise: Inboxes Structure" section below for more information about the Inbox.

Enterprise: Inboxes Structure
Enterprise service allows you to store data in inboxes which have the following structure:

The first level is the Major inbox is Company. Each company has a Company Inbox. The company Administrator
will create a MAGNET Enterprise company account. The Administrator will then add users to this company
account. All users that are added will have access to the Company Inbox. The Administrator can set the different
role for the added users.

NOTES
These steps are performed on the Enterprise web server only (not in the Enterprise option of the applic-
ation).

There are four roles for users in the Enterprise web server. The table displays the privileges are asso-
ciated with the role:

Privileges Administrator Consultant Project
Manager

Project Team
Member

Create a MAGNET Enterprise company account YES NO NO NO
Add / remove a user to the company account YES NO NO NO
Set a role for other users YES NO NO NO
Assign additional users to the Project Inbox(es) YES NO NO NO
Download data from all users Inboxes YES NO YES NO
View online / offline devices connected to the
server YES YES YES NO

View available licenses YES NO YES NO
Set a notification for the added users YES YES YES YES
Create / edit / remove any Inbox, upload a new file to
a personal Inbox YES YES YES YES
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Use the chat with the added users YES YES YES YES
View and edit My Profile YES YES YES YES
View and edit To Do List YES YES YES YES
View Map YES YES YES YES
View Weather YES YES YES YES
View and use Store YES NO NO NO

The next level is a Project. You can define the project name in the Project Manager window. All your data can be
stored in the Project inbox.

NOTE
If a user creates a project in the application only that user is assigned to the project. An Administrator or
Project Manager can then assign additional users to the project in the Enterprise web server.

The third level of inbox is an User. For any role you can upload data to the personal Inbox or Inbox for which you
was assigned. If your role is Administrator or Project Manager you can download from all users Inboxes and if
your role is Project Team Member you can typically download only from their Inbox.

Inbox hierarchy

Enterprise: Chat
In the Chat window you to send a text message to the selected user(s) of your company. Also you can receive a
text message from any user of the company.

To open the dialog, in the Common group of the Enterprise tab, click Chat icon.

The Create chat table displays a list of the company users:
- the icon displays the user who is connected to the Enterprise server at the moment (online
user),
- the icon displays the user who is not connected to the Enterprise server at the moment (offline
user).

In this table you can select any user and create a chat for the user or a group of users. Check one or few users and
click Create chat. The application creates a Chat tab in the dialog.

The Create chat button is enabled when the following conditions are met:
l a user or group of user are checked in the Attendants field,
l the connection with the server is established.

The Chat tab contains three fields:
l left field displays a list of the users in the chat. You cannot add/remove a user from the list.
l top right field displays the text message that was sent and messages about presence status of the user ("...is
online" or "...is offline").

l bottom right field displays the entered message. Click Send or use the Ctrl + Enter keyboard shortcut to
post the message to the chat.
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NOTE
You can send a text message to both online user or offline user. The online user will immediately
receive themessage, the offline user will receive themessage after establishing the connection with the
server.

NOTE
You can create unlimited number of chats with different sets of the users.

Enterprise: Options dilaog
In the dialog you can edit your account (e-mail and password) and options of connection with the Enterprise
server.

To open the dialog, in the Common group of the Enterprise tab, click Options icon.

When the Auto logon on startup checkbox is tiked, the connection with the server will be set automatically after
starting the application.

When the Restore connection on disconnect checkbox is ticked, the application will automatically try to restore
the broken connection.

When the Connect to last connected project at startup checkbox is ticked, the application will automatically con-
nect with the project which was selected for the previous connection with the Enterprise server.

When the Show inboxes only for connected project checkbox is ticked, the right panel of the Upload files dialog
and the left panel of the Download files dialog will display the connected project only. This checkbox has the
same functionality as the Show inboxes for connected project only checkbox from the Download files and Upload
files dialogs.

Click OK to save the configured options and close the dialog.

Enterprise: Uploading files
In the Upload files dialog you can upload selected files to the server.

To open the dialog, in the Files group of the Enterprise tab, click Upload files icon.

In the left panel of the window you can select the required files: click Add and select files in the Open dialog.

To delete a file from the left panel, select the files and click Remove.

In the right panel select the folder where you want to store the files. Click Upload to start uploading selected files
to the selected Inboxes. The Progress window displays the uploading to the server in progress.

The Upload button is enabled when the following conditions are met:
l in the left panel files are selected,
l in the right panel Inboxes are checked,
l the connection with the server is established

NOTE
When the "Show inboxes for connected project only" checkbox is ticked, the right panel of theUpload
files dilaog displays the connected project. You can connect with any project, by using theConnect to
Project andReal time icons. See "Enterprise: Connect to Project" section on page 323 and "Enter-
prise: Real time" section on the next page for details.
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Enterprise: Download files
In the Download files dialog you can download a file from the server to the computer.

To open the dialog, in the Files group of the Enterprise tab, click Download files icon.

In the left panel of the dialog you can select the corresponding Inbox. The right panel of the dialog displays the
files located in the Inbox. Check the desired files.

Click Select and navigate to the required folder in the computer where the files will be saved . The Target dir-
ectory field displays the path to the folder for saving the downloaded files.

Click Download to start downloading selected files to the selected Inboxes. The Progress window displays down-
loading from the server to the computer in progress.

The Download button is enabled when the following conditions are met:
l in the left panel a folder is selected,
l in the right panel files are checked,
l the desired folder in the computer is selected
l the connection with the server is established

TIP
If your role is Project TeamMember you can typically download only from your Project Inbox and from
the Project Inbox of other user(s) where your account was assigned by the Enterprise administrator of
your company.

TIP
If your role is Administrator or Project Manager you can download from all company users Inboxes.

NOTE
When the "Show inboxes for connected project only" checkbox is ticked, the left panel of theDownload
files dialog displays only the connected project. You can connect with any project, by using theCon-
nect to Project andReal time icons. See "Enterprise: Connect to Project" section on page 323 and
"Enterprise: Real time" section below for details.

:

Enterprise: Real time
In the Real time dialog you can automatically receive the coordinates(not raw data and observations) of measured
or added points from MAGNET Field in real time. The measured / added points will automatically send from the
MAGNET Field to the MAGNET Enterprise and then send to the current job of the application. The Points tab dis-
plays the points.

To open the dialog, in the Realtime group of the Enterprise tab, click Real time icon.

To perform the real time import from MAGNET Field to the application job, two conditions must be met:
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l MAGNET Field user and you have to belong to the same company,
l MAGNET Field user and you have to be connected to the same project.

In the Project field select the required project. If you select the Project with which the connection was established
in the Connect to Project dilaog the Connect button is disabled. If you select a Project for which you did not set a
connection, click Connect to establish the connection with the project. After connecting to the project, the Con-
nect button is disabled.

If a user from the MAGNET Field side has a connection with the project, the Sessions table displays the user
name, device name and ID of the device connected to the MAGNET Enterprise. Each line in the Sessions table
displayed the connected device to the project.

To update information in the Sessions table, click Refresh.

Select a session and click Start. It starts uploading data to the MAGNET Enterprise from the receiver/controller,
where MAGNET Field runs. To finish the session, click Stop.

After sending the measured/added points to the application current job, the Points tab will display the points in the
WGS-84 or a Ground coordinate systems.
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How To
This chapter contains a set of short recommendations which help you quickly perform useful operations in the soft-
ware. The following topics are available:

l "Adding Custom Antenna Type" section below
l "Adding TS Instrument Type" section on page 331
l "Adding custom datum to the datum list" section on page 333
l "Adding custom projection to the projection list" section on page 334
l "Adding geoid to the job" section on page 335
l "Creating background map for work area" section on page 336
l "Creating custom report" section on page 340
l "Drawing Contour Lines for surface" section on page 343
l "Editing and viewing MAGNET Field Offsets in the Job" section on page 345
l "Importing control points to a job" section on page 354
l "Performing Adjustment" section on page 355
l "Performing Grid to Ground Transformation" section on page 360
l "Performing Localization" section on page 368
l "Performing Datum Transformation" section on page 376
l "Creating custom filter" section on page 383
l "Importing filters" section on page 383
l "Exporting filters" section on page 384
l "Creating custom format file" section on page 384

Adding Custom Antenna Type
Each antenna type has unique phase center parameters (for L1 and L2 frequencies, respectively) obtained through
either NGS calibration or TPS calibration. These parameters are viewable, but not editable in the Antennas List
window. See "Antenna List" section on page 207 for details.

However, you can add user-defined antenna types to the antennas list, as well to display, to edit, and to remove
antennas from the antennas list.

The custom antenna is stored in the user's folder and is saved after updating the version of the software. You can
add a new antenna type to the antennas list in the following ways:

l By using the Custom button at the Antenna tab of the Properties dialog for a GPS Occupation. See
"Antenna tab" section on page 230 for details.

1. Right click in the GPS Occupations tab of the tabular view
2. At the Antenna tab of the Properties dialog for a GPS Occupation, click Custom.

The Custom Antennas List dialog is displayed. It contains custom antennas which were previously
entered.

3. Click Add.

The New Custom Antenna dialog is displayed.
4. Configure the parameters as you need. See description of tabs below.
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5. When finished, click OK.

The new custom antenna is added.
l By using the Custom button at the Base Antenna tab or Rover Antenna tab of the Properties dialog for a
GPS observation. See "Base Antenna tab" section on page 243 or "Rover Antenna tab" section on page 244
for details.

1. At the Base Antenna tab or Rover Antenna of the Properties dialog for a GPS Observation, click
Custom.

The Custom Antennas List dialog is displayed. It contains custom antennas which were previously
entered.

2. Click Add.

The New Custom Antenna dialog is displayed.
3. Configure the parameters as you need. See description of tabs below.
4. When finished, click OK.

The new custom antenna is added.
l At the Antennas List window. See "Antenna List" section on page 207 for details.

1. Right click in the Antennas List window.
2. Select New Custom Antenna from the pop-up menu.

The Custom Antennas List dialog is displayed. It contains custom antennas which were previously
entered.

3. Click Add.

The New Custom Antenna dialog is displayed.
4. Configure the parameters as you need. See of tabs below.
5. When finished, click OK.

The new custom antenna is added.

The New Custom Antenna dialog has three tabs, described in the appropriate sections:
l "General tab" section below
l "Parameters tab" section on the next page
l "PCV tab" section on page 331

After entering all needed parameters in the tabs, click the OK button to store the antenna parameters. You can
see the antenna name in

General tab
The General tab of the New Custom Antenna dialog allows you to configure the basic parameters of the custom
antenna. Fields are described in the table below.

Fields of the General tab
Field Description

NGS Name
Defines the standard NGS (http://www.ngs.noaa.gov/ANTCAL/) or TPS
antenna name. This name displays in the 'Antenna number and type' line of the
RINEX observation file and in the corresponding line of the TPS raw data file.

Name Defines the antenna name used in the software interface.

Manufacturer Defines the antenna manufacturer.
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Field Description

Note
Defines any additional information for the selected antenna. For NGS cal-
ibration this field contains a part number of the antenna. For TPS calibration
this filed contains "TPS Calibration".

Antenna cal-
ibration set

Defines the type of antenna calibration. The absolute calibration is a default
setting. You can select only the absolute calibration for the custom antenna.
The NGS and TPS calibration contains the absolute and relative calibrations:

l Relative — the antenna offsets and phase center variations are com-
puted with respect to the AOAD/M_T antenna

l Absolute — the recalculated relative calibration that takes into account
the absolute values for AOAD/M_T antenna.

Parameters tab
The Parameters tab of the New Custom Antenna dialog allows you to configure parameters of your custom
antenna. Fields of the are described in the table below. See picture below for details.

Fields of the Parameters tab
Field Description

Radius Defines the antenna's radius in millimeters.

L1 Base Offset
(A1)

Defines the vertical offset measured from ARP (Antenna Reference Point) to
the phase center for GPS frequency L1 in millimeters.

L2 Base Offset
(A2)

Defines the vertical offset measured from ARP (Antenna Reference Point) to
the phase center for GPS frequency L2 in millimeters.

L1 Plane Offset
(C1)

Defines the vertical offset measured from the antenna slant height measure
mark (SHMM) to the phase center for GPS frequency L1 in millimeters.

L2 Plane Offset
(C2)

Defines the vertical offset measured from the antenna slant height measure
mark (SHMM) to the phase center for GPS frequency L2 in millimeters.

L1 Easting Offset
(E1)

Defines the easting offset of the phase center for GPS frequency L1 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters.

L2 Easting Offset
(E2)

Defines the easting offset of the phase center for GPS frequency L2 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters.

L1 Northing Offset
(N1)

Defines the norting offset of the phase center for GPS frequency L1 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters.

L2 Northing Offset
(N2)

Defines the norting offset of the phase center for GPS frequency L2 from the
ARP (Antenna Reference Point) in the horizontal plane in millimeters.

Measured Height
Method

Defines the method used to measure the antenna height. You can measure the
antenna height in two ways:

l Vertical — measuring from the ground point to the antenna reference
point (ARP) located on the bottom of the receiver.

l Slant — measuring from the ground point to the antenna slant height
measure mark (SHMM).
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Antenna parameters

PCV tab
The PCV tab of the New Custom Antenna dialog allows you to configure antenna phase center variations. Fields
of the tab are described in the table below.

Fields of the PCV tab
Field Description

PCV, GPS L1 Defines the correction values (in millimeters) for L1 phase center.

PCV, GPS L2 Defines the correction values (in millimeters) for L2 phase center.

Adding TS Instrument Type
Each Total Station has unique parameters. These parameters are viewable, but not editable in the TS Instruments
window. See "TS Instruments" section on page 209.

However, you are able to add a user-defined instrument types to the TS Instruments list, to display, to edit and to
remove the instrument from the window. The custom instrument is stored in the user's folder and is saved after
updating the version of the software. You can add a new instrument type at the Instrument Type tab of the Prop-
erties dialog for the left panel of the TS Obs tab. See "Instrument Type tab" section on page 248 for details.

To add a new custom TS instrument:
1. Right click in the left panel of the TS Obs tab from the Tabular view.
2. Select Properties from the pop-up menu.
3. The Properties dialog for a TS Occupation is displayed.
4. Click the Instrument Type tab.
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5. Click Custom.

The Custom TS Instrument List dialog is displayed. It contains custom TS instruments which were pre-
viously entered.

6. Click Add.

The New Custom TS Instrument dialog is displayed.
7. Configure the parameters as you need. See of tabs below.
8. When finished, click OK.

The new custom TS instrument is added.

The New Custom TS Instrument dialog has two tabs, described in the appropriate sections:
l "General tab" section below
l "Parameters tab" section below

General tab
The General tab of the New Custom TS Instrument dialog allows you to configure the basic parameters of the
instrument. Fields are described in the table below.

Fields of the General tab
Field Description

Name Defines the unique name of the device.

Manufacturer Defines the instrument manufacturer.

Note Defines any additional notes for the selected instrument.

Parameters tab
The Parameters tab of the New Custom Antenna dialog allows you to configure parameters of your custom
antenna. Fields of the are described in the table below. See picture below for details.

Fields of the Parameters tab
Field Description

EDM

Defines the value of the first component for the calculation of the distance
determination error when using this device. The distance determination error of
the instrument is calculated by the formula:

PPM

Defines the value of the second component for the calculation of the distance
determination error when using this device. The distance determination error of
the instrument is calculated by the formula:

Vert. Accuracy Defines the error of the vertical angle measurement, in seconds.

Horz. Accuracy Defines the error of the horizontal angle measurement, in seconds.
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Field Description

Max. Distance Defines the maximum range for this device.

Adding custom datum to the datum list
You can create your own custom datum in the current job and then use this datum for other jobs. For creating a
custom datum the application uses the Helmert Transformation Strict Formula . The "Custom datum to WGS-84"
transformation direction is used in the algorithm of creating a new custom datum.

To add a custom datum:
1. In the Information group of the Job tab, click the Job Configuration icon.

The Job configuration dialog is displayed.
2. In the left panel, select the Coordinate Systems item.
3. In the right panel, open the Setup tab.
4. In the Datum field, click Custom.

The Custom Datums List dialog is displayed. It contains custom datums which were previously entered.
5. Click Add.

The New Custom Datum dialog is displayed.
6. Configure the parameters as you need. Fields are described in the table below.
7. Click OK.

The custom datum is created.

Fields of the General tab of the New Custom Datum dialog
Field Description

Name Defines the name of the custom datum. The datum name is unique and the field
cannot be empty.

Ellipsoid Defines the name of the ellipsoid used to create the datum. You can select any
predefined ellipsoid from the list.

DX Defines the value of shift along the X axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84. The default is 0.

DY Defines the value of shift along the Y axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84. The default is 0.

DZ Defines the value of shift along the Z axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84. The default is 0.

RX Displays the value of the rotation angle between the X axes of the created
datum and WGS84 in arc seconds. The default is 0.

RY Displays the value of the rotation angle between the Y axes of the created
datum and WGS84 in arc seconds. The default is 0.

RZ Displays the value of the rotation angle between the Z axes of the created
datum and WGS84 in arc seconds. The default is 0.

Scale Defines the value of the scale factor in ppm, which specifies a coordinate trans-
formation from the created datum to WGS84. The default is 0.
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Field Description

Note Defines any additional note about the datum.

Alias When you select a datum from the list, all available projection(s) for the selec-
ted datum automatically will be available for the created custom datum.

These parameters (shifts, rotations, and scale) specify a coordinate transformation from the newly created ref-
erence datum to WGS84 using the following equation:

Adding custom projection to the projection list
You can create your own custom projection in the current job and then use this projection for other jobs.

To add a custom projection:
1. In the Information group of the Job tab, click the Job Configuration icon.

The Job configuration dialog is displayed.
2. In the left panel, select the Coordinate Systems item.
3. In the right panel, open the Setup tab.
4. In the Projection field, click Custom.

The Custom Projections List dialog is displayed. It contains custom projections which were previously
entered.

5. Click Add.

The New Custom Projection dialog is displayed.
6. Configure the parameters as you need. Fields are described in the table below.
7. Click OK.

The custom projection is created.

Fields of the General tab of the New Custom Projection dialog
Field Description

Name Defines the name of the custom projection. The projection name is unique and
the field cannot be empty.
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Field Description

Projection Type

Defines the name of the projection type. The following options are available:
l Transverse-Mercator
l Lambert
l Double Stereographic
l Stereographic
l Oblique Mercator
l Albers Equal Area
l Cassini-Soldner
l Mercator

Every projection has its own set of original parameters. After selecting the
type of projection, you can edit the parameters for this type.

Region

Defines the name of the region for which the projection will be used. You can
use the existing regions (like Europe, Australia, etc.) or enter a new name. If
you enter a new name, the application creates a new folder with the entered
name in the projection list. The custom projection will be saved in this folder.

Note Defines any additional note about the datum.

Datum

Defines the datum used for the projection. You can select any datum for the
given projection. After selection the custom projection, the datum will be auto-
matically set in the Datum drop-down list at the Setup tab of the Coordinate
Systems item from the Job configuration dialog

Adding geoid to the job
To add a required geoid to the Geoid list of the MAGNET Tools:

1. In the Coordinate Systems group of the Process tab, click the Geoids icon.

The Geoid List dialog is displayed.
2. Click Add.

The Open dialog is displayed.
3. From the Format name drop-down list, select the required type of the geoid file.
4. Navigate to the required file and open it.

The geoid is added to the geoid list.

You may also use the Geoid List button at the Setup tab of the Coordinate Systems item from the Job Con-
figuration dialog to access the Geoid List dialog.

Geoid List dialog
The dialog contains the table, which list the available geoids:
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Fields of the Geoid properties dialog
Field Description

Icon
Displays the symbol of the geoid. If a geoid file is found in the corresponding
folder and it can be used for calculation, the icon is . If a geoid file is not
found in the corresponding folder to use for calculation, the icon is .

Name Displays the geoid name

Datum Displays the reference datum of the geoid.

Path Displays the path to the geoid file location.

Minimum Latitude Displays the minimum value of the latitude that limits the use of this model.

Minimum Longitude Displays the minimum value of the longitude that limits the use of this model.

Maximum Latitude Displays the maximum value of the latitude that limits the use of this model.

Maximum Lon-
gitude Displays the maximum value of the longitude that limits the use of this model.

Buttons of the Geoid properties dialog
Button Description

Add Click it to add a geoid to the list. See "Adding geoid to the job" section on the
previous page for details.

Remove Click it to remove a geoid from the list.

Export Click it to convert a selected geoid to the Topcon Geoid (*.gff) file format.

Creating background map for work area
If the you have a digital image in one of the following formats: JPEG (*.jpg), Bitmap (*.bmp) or TIFF (*.tif), to
georeference the image using MAGNET Tools in the desired coordinate system, you need to have the picture
points in the desired coordinate system.

NOTE
The georeferenced image— an image for which the relationship between pixel coordinates and real
datum/grid/ground/local coordinates is established.

The minimal number of picture points needed to calculate parameters between the image and real coordinate sys-
tems depends on the calculation method:

l Translation method — requires at least two points. In this case, MAGNET Tools calculates:
l the offsets of the origin of coordinates along two axes (E and N or Latitude and Longitude)
l the average of the scale values

If you add three or more picture points for this method, MAGNET Tools will also calculate the
plane residuals for each picture point and display these values graphically on the image and in the
tabular form on the control point list.

l Translation with Rotation method — requires at least three points. In this case, MAGNET Tools cal-
culates:
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l the offsets of the origin of coordinates along two axes (E and N or Latitude and Longitude)
l the average of the scale values
l an angle of image rotation

If you add four or more picture points, MAGNET Tools will calculate the plane residuals for each
picture point and will display these values graphically on the image and in the tabular form on the
control point list.

To georeference an image in the MAGNET Tools:
1. At the Status bar, select the required coordinate system, MAGNET Tools will calculate the correlation

between this coordinate system and the image coordinate system.
2. In the Spatial group of the View tab, click the Background images icon.

The Background images dialog is displayed.
3. Click Add Image.

The Add Image dialog is displayed.
4. If needed, select the required file type from the Format name drop-down list.
5. Navigate to the required file and open it.

If the image is not georeferenced, MAGNET Tools automatically opens the Set Georeference dialog. The
dialog displays the image in the pixel coordinate system.

6. At the toolbar, click .

The Georeference options dialog is displayed.
7. From the Georeference Method drop-down list, select the required method. See the description of methods

above.
8. From the Labels color drop-down list, select the color for labels, which will be placed on the picture during

georeference process.
9. Click OK.
10. At the toolbar, click Add Point.
11. The cursor changes into .

12. Identify and left-click the required point on the image using a photographic sketch of ground point.

The Add georeference point dialog is displayed.
13. Define the label and coordinate of the geo-point in the appropriate editboxed, or select an existing point

from the Point list.
14. Cilck OK.

MAGNET Tools automatically marks the point on the image and it to the table for the marked point.
15. Repeat for all required points. If needed to delete a point, select it in the table and click Delete Point(s).
16. When finished adding points, click Calculate to determine the relationship between pixel coordinates and

real datum/grid/ground /local coordinates.

The dialog displays the image in the current coordinate system.
17. Click Save and Close.

The Save dialog is displayed.
18. Save the file as you need. MAGNET Tools creates two files:
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l The transformed image in the same format as the source.
l ESRI World File Format

To add a georeferenced image to the Map view and Observation view:
1. In the Spatial group of the View tab, click the Background images icon.

The Background images dialog is displayed.
2. From the Available images table, select the required image.
3. Click >>.

The image is added to the Images used in this job table.
4. Click Close.

To remove a georeferenced image from the Map view and Observation view:
1. In the Spatial group of the View tab, click the Background images icon.

The Background images dialog is displayed.
2. From the Images used in this job table, select the required image.
3. Click <<.

The image is removed from the Images used in this job table.
4. Click Close.

To convert an image to another coordinate system:
1. In the Spatial group of the View tab, click the Background images icon.

The Background images dialog is displayed.
2. From the Available images table, select the required image.
3. Click Convert Image.

The Save dialog is displayed.
4. Click Advanced Options.
5. Select the required linear and angular units; and the coordinate type from the appropriate drop-down lists.
6. Save the file as you need. MAGNET Tools creates two files:

l The transformed image in the same format as the source.
l ESRI World File Format

Background Images dialog
In the dialog you can:

l see all available images for the current job
l add any georeferenced image to the list of the available images for the current job
l select from the list an image to display in the current job
l convert an existing image to any coordinate system
l georeference an image — see Creating background map for work area for details.

NOTE
A georeferenced image is an image for which the relationship between pixel coordinates and real datum/-
grid/ground /local coordinates is established.

The dialog contains two tables: Available images and Images used in this job. Fields of the tables are described in
the tables below.
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Fields of the Available images table
Field Description

File Name

Displays a file's name of the available raster or vector image in the job. In this
field the following symbols can be applied:

— available raster image

— available vector image

Path Displays the path to the image file on the computer disk drive, local area net-
work, or storage media.

Type Displays the image type. It can be vector and raster image file.

Coordinate Sys-
tem Displays the coordinate system of the image file.

Linear unit Displays the linear units of the image file.

Angular unit Displays the angular units of the image file.

Top left corner - X Displays x-coordinate of top-left corner of the image in the coordinate system
of the image file.

Top left corner - Y Displays y-coordinate of top-left corner of the image in the coordinate system
of the image file.

Fields of the Images used in this job table
Field Description

File Name

Displays a file's name of the available raster or vector image in the job. In this
field the following symbols can be applied:

— raster image in the job's current coordinate system. This image
can be shown in the Observation View and Map View

— vector image in the job's current coordinate system. This image
can be shown in the Observation View and Map View

— raster image in a coordinate system different from the job's cur-
rent coordinate system. This image cannot be shown in the Observation
View and Map View

— vector image in a coordinate system different from the job's cur-
rent coordinate system. This image cannot be shown in the Observation
View and Map View

Path Displays the path to the image file on the computer disk drive, local area net-
work, or storage media.

Type Displays the image type. It can be vector and raster image file.

Coordinate Sys-
tem Displays the coordinate system of the image file.
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Buttons of the Background images dialog
Field Description

Add Image Click it to add the image to the list of available images. See Creating back-
ground map for work area for details.

Remove Image Click it to delete selected background images from the left table.

Convert Image Click it to transform the selected image to any coordinate system. See Creating
background map for work area for details.

Creating custom report
Report customizing allows you to create your own type of report to include or exclude certain information from
already generated reports. For example let us create a report for adjusted GPS network that contains the following
items:

l the coordinates of network points in the datum and current grid coordinate system with standard deviations
for the horizontal and vertical planes after adjustment,

l the adjustment results for the network.

To create a report for adjusted GPS network:
1. In the Report group of the Report tab, click the Report Configuration icon.

The Report Configuration dialog is displayed.
2. Click New report.
3. Type the name for the new report and press Enter.
4. In the Report item templates list, select the Point Summary item and click >> to add it to the Included

report items list. This template contains the coordinates of network points
5. In the Included report items list, select the Point Summary item and click Options.
1) To configure a customized report, click the icon in the Report group.

The Report Configuration window contains:
- The list of the available reports. You see the installed by default types of reports (the types of reports
created by a Topcon programmer and included in the MAGNET Tools installation) and custom type
reports (the types of reports created by user).
Note: You can delete default and custom types reports from the window.
- The set of editable templates for creating a custom report.

2) To create a new report, click the button and enter the desired name of your report in the

new icon . The Included report items panel is empty. You need to add a desired tem-

plates to this panel from Report item templates panel.
3) The 'Point Summary' template contains the coordinates of network points. Select the template in the
left panel and click the double arrows button to copy this item to the right panel:
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4) Click the button to edit this report. In the General tab of the Options: Point Report

Options you can select the desired component for the report. By default the right panel of the window
contains coordinates in Latitude\Longtitude\El. height or Northing\Easting\Elevation or X/Y/Z form:

This description means that the report will display the coordinate type which is set in the Status Bar. For
example, if the Grid is set in the Status Bar - the report will display only Northing\Easting\Elevation
coordinates.
5) Your new report has to contain two independent sets of coordinates: in the datum and in the current
grid coordinate system. You need to remove (using the button ) the default items from the

report (in the right panel) and copy the separate components of grid and datum coordinate systems from
the left panel to the right panel (using the button ):

6) Using this technique, add the standard deviations for the horizontal and vertical planes:

7) To show only adjusted points in the report, select the corresponding point's type:
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8) Click the button to save the selected components of the adjusted point report and to close the win-
dow.

Click
9) The 'Adjustment' template contains the adjustment results for the given network. Select the template
in the left panel and click the double arrows button to copy this item to the right panel:

10) Click the button to edit this report. The General tab of the Options: Adjustment Report

Options window displays the Adjustment template panel. By default, the Adjustment template panel con-
tains the list of macros with corresponding comments. You can edit this template: delete the lines,
update the comments.

11) To restore the original set of the macros in the Adjustment template panel, click the button

.
12) To save own set of the macros in the Adjustment template panel, click the button .

13) To see the full list of the macros, click the button . After clicking the button two panels

are displayed. The Marcos panel contains the list of all available macros for Adjustment template, the
Comment panel contains the comment for each macro. You cannot edit the macros and comment in
these panels:

To copy any macro to the Adjustment template panel, double-click any macro in the Macros panel.
14) To save any change in the Adjustment template panel and close the Options: Adjustment Report
Options window click the button .
15) To close the Options: Adjustment Report Options window without saving any changes, click the
button .
Note:MAGNET Tools has three templates with macros: Adjustment, Localization and Project.
16) Select the desired format for your report. MAGNET Tools allows you to select either HTML or
Microsoft Word or Microsoft Excel or PDF file format. Let us select PDF:
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17) If you want to check what your created report displays, click the button in the Report

Configuration window:

18) To save the whole report, close the Report Configuration window. After that the report’s list will
display your created report.

Drawing Contour Lines for surface
You can plot contour lines for an existing surface. The Map View and 3D View display these counter lines.

TIP
Contour lines are lines joining the surface’s points with equal elevation.

You can use contour lines to:
l visualize the relief of the surface
l detect and correct the surface created.

NOTE
MAGNET Tools creates contour lines only for surfaceswhich do not have a focus point.

To plot contour lines using MAGNET Tools, do the following:
1. In the Spatial group of the View tab, click the Contour Lines icon.

The Contour Lines dialog is displayed.
2. From the Surfaces list, select the required surface.
3. Tick the Enable contour lines for the surface checkbox.
4. Review the contour lines parameters. If needed, change them. Fields are described in the table below.
5. Click OK.
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Fields of the Contour Lines dialog
Field Description

Enable contour
lines for the sur-

face

When ticked, the contour lines will be calculated and plotted for the selected
surface.

Major lines

Interval
Defines a contour interval between major lines in current job linear units. By
default, the interval for the major contour lines is calculated taking into account
the maximum and minimum elevations of the job points.

Layer
Defines the layer for major contour lines. The layer can not be empty. Type the
name of the new layer, or select an existing one from the drop-down list. The
layer will be automatically created.

Line Style Defines the plotting style for major contour lines.

Line Width
Defines the width for major contour lines. You can select the width value from
the drop-down list from 1pt to 10pt.

By default, the major lines has the width 2 pt.

Line Color Defines the color for major contour lines. You can select the color from the
drop-down list.

Minor Lines

Interval
Defines a contour interval between minor lines in current linear units. By
default, the interval for minor lines is calculated as the contour interval for
major lines divided by 5.

Minors per major Defines the number of minor contour lines between two major contour lines.
By default, this value is set to 5.

Layer
Defines the layer for minor contour lines. The layer can not be empty. Type the
name of the new layer, or select an existing one from the drop-down list. The
layer will be automatically created.

Line Style Defines the plotting style for minor contour lines.

Line Width
Defines the width for minor contour lines. You can select the width value from
the drop-down list from 1pt to 10pt.

By default, the minor lines has the width 1 pt.

Line Color Defines the color for minor contour lines. You can select the color from the
drop-down list.

Show height Defines the visibility of elevation labels for major or for major and minor lines
of the surface in the Map View.

Show hachure
Defines the visibility of the hachures for major or for major and minor lines of
the surface in the Map View. The hachures are used to show the orientation of
the slope (they show the slope downwards).
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Field Description

Fill levels

When ticked, the gradient fill (a color spectrum from red to blue) will be cal-
culated and plotted for the selected surface. The number of colors depends on
the contour interval for minor contour lines and the maximum and minimum
elevation of the job points. Any color is editable. Click for the desired
color, then select a custom color in the Color dialog.

A surface with displaying the value of elevation for major lines in the Map view

A surface with displaying the hachures for major lines in the Map view

Editing and viewing MAGNET Field Offsets in the Job
MAGNET Field allows you to determine the coordinates of an inaccessible point using the measured point(s) and
distance and angle offsets. MAGNET Field job can contain offsets data from GPS points and offsets from TS
points.

When you perform a survey with GPS receiver, MAGNET Field will allow use the following offset types:
l Offset Line
l Azimuth & Offsets

When you performs a survey with Total Station, MAGNET Field allows the following offset types:
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l Horizontal angle offset
l Horizontal/Vertical Angle Offset
l Distance offset
l Hidden Point
l Two Lines Intersection
l Lines and corner
l Line and Offset
l Plane and corner

See sections below for details.

Offset Line
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point, using two points and addi-
tional distance offsets' measurements. Offset point lies on the perpendicular to the line “Start Point - End Point”.
This offset can be performed from both existing points and measured points.

Offset Line

After importing the MAGNET Field job with Offset Line data into the current MAGNET Topcon job, you can see
the Offset tab in the Properties dialog for the point. The offset point has the icon. See "Offset tab" section on
page 226 for details.

You can edit the offset values in this tab. To obtain the coordinates of the offset point, save the entered values by
clicking OK and then click Compute Coordinates.

Azimuth & Offsets
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point, using one measured point
and distance and angle measurements from this point to the offset point. This offset can be performed from both
existing point and measured point.

Azimuth & Offsets

After importing the MAGNET Field job with Azimuth & Offsets data into the current MAGNET Tools job, you
can see this offset in:
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l the Offset tab in the Propertiesdialog for the corresponding GPS occupation, if the offset was performed
from a measured point. The Original Name of this GPS occupation is "Start Point". The offset point cal-
culated from the GPS occupation and the linear and angular offsets has the icon. See "Offset tab" sec-
tion on page 232 for details.

l the Offset tab in the Properties dialog for the point, if the offset was performed from an existing point. The
offset point calculated from the existed point and the linear and angular offsets has the icon. See "Offset
tab" section on page 226 for details.

You can edit the offset values in these tabs. To obtain the coordinates of the offset point, save the entered values
by clicking OK and then click Compute Coordinates.

Horizontal Angle Offset
Determination of the horizontal (2D) coordinates of an inaccessible center of pipe / tree / pillar using distance and
angle measurements.

Horizontal Angle Offset

After importing the MAGNET Field job with Horizontal Angle Offset data into the current MAGNET Tools job,
the right panel of the TS Obs tab displays two measurements performed for calculating this offset point. In this
case MAGNET Tools applies the same Point to name for Side and Center type measurements:

Point From Point To Horizontal Circle Slope Distance Type

A Offset Point 35 12 33 150.55 Side

A Offset Point 35 10 11 Center

You cannot edit the offset values in MAGNET Tools job.

Horizontal/Vertical Angle Offset
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point using distance and angle
measurements.
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Horizontal /Vertical Angle Offset

After importing the MAGNET Field job with Horizontal/Vertical Angle Offset data into the current MAGNET
Tools job, the right panel of the TS Obs tab displays two measurements performed for calculating this offset point.
In this case MAGNET Tools job applies the same Point to name for Vertical and Horz. Vertical type meas-
urements:

Point From Point To Horizontal Circle Slop Distance Zenith Angle Type

A Offset Point 45 12 34.000 100 91 12 16.000 Vertical

A Offset Point 46 10 15.000 84 15 12.000 Horz. Vertical

You cannot edit the offset values in MAGNET Tools job.

Distance offset
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point using distance and angle
measurements, and additional distance offsets measurements, for example made by the tape.
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Distance Offset

After importing the MAGNET Field job with Distance Offset data into the current MAGNET Tools job, the right
panel of the TS Obs tab and the Offset tab of the Properties dialog for TS occupation displays all entered offset
values for calculating the offset point coordinates:

Point From Point To Type Offset Along (m) Offset dHt (m) Offset
Across (m) Offset Type

A Offset Point SS 2.34 0.56 -1.12 From Obser-
vation Line

You can edit the offset values in the TS Obs tab and the Offset tab for the given TS occupation. See "Offset tab"
section on page 248 for details. To obtain the coordinates of the offset point, click Compute Coordinates.

Hidden Point
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point using distance and angle
measurements to two prisms located on the rod.
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Hidden Point

After importing the MAGNET Field job with Hidden Point data into the current MAGNET Tools job, the right
panel of the TS Obs tab displays all measurements performed for calculating this offset point. In this case
MAGNET Tools job applies the same Point to name for Missing Pttype measurements:

Point From Point To Horizontal Circle Slop Distance Zenith Angle Type

A Offset Point 45 00 00.000 100.00 90 00 00.000 Missing Pt.

A Offset Point 45 10 15.000 101.00 91 00 00.000 Missing Pt.

You cannot edit the offset values in MAGNET Tools job.

Two Lines Intersection
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point, as intersection of two aux-
iliary lines. The user creates these lines (by two points) and performs distance and angle measurements of the
line’s points.
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Two Line Intersection

After importing the MAGNET Field job with Two Line Intersection data into the current MAGNET Tools job, the
right panel of the TS Obs tab displays all measurements performed for calculating the offset point. In this case
MAGNET Tools applies the same Point to name for Line type measurements:

Point From Point To Horizontal Circle Slop Distance Zenith Angle Type

A Offset Point 45 00 00.000 100.00 91 00 00.000 Line

A Offset Point 62 00 00.000 140.00 92 00 00.000 Line

A Offset Point 130 00 00.00 110.00 91 00 00.000 Line

A Offset Point 102 00 00.00 129.00 93 00 00.000 Line

You cannot edit the offset values in MAGNET Tools job.

Lines and Corner
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point, as intersection an auxiliary
line and a plane. The user creates a line (by two points) and a vertical plane passing through the offset point.
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Lines and Corner

After importing the MAGNET Field job with Lines and Corner data into the current MAGNET Tools job, the
right panel of the TS Obs tab displays all measurements performed for calculating the offset point. In this case
MAGNET Tools applies the same Point to name for Line and Corner type measurements:

Point From Point To Horizontal Circle Slop Distance Zenith Angle Type

A Offset Point 78 00 00.000 110.00 91 00 00.000 Line

A Offset Point 59 00 00.000 78.00 92 00 00.000 Line

A Offset Point 37 00 00.000 93 00 00.000 Corner

You cannot edit the offset values in MAGNET Tools job.

Line and Offset
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point, using an auxiliary line and
additional distance offsets measurements, for example made by the tape. The user creates a line (by two points),
then performs distance and angle measurements of the line’s points and distance measurements (from this line) to
the offset point.
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Lines and Offset

After importing the MAGNET Field job with Lines and Offset data into the current MAGNET Tools job, the right
panel of the TS Obs tab displays all measurements performed for calculating the offset point. In this case
MAGNET Tools applies the same Point to name for Line type measurement, and displays the additional distance
offsets measurements for the last Line measurement :

Point From Point To Horizontal
Circle

Slope
Distance

(m)
Zenith Angle Type

Offset
Along
(m)

Offset
dHt
(m)

Offset
Across
(m)

A Offset Point 78 00 00.000 110.00 91 00 00.000 Line

A Offset Point 59 00 00.000 78.00 92 00 00.000 Line 2.34 1.11 -3.45

You can edit the offset values in the TS Obs tab and the Offset tab for the TS occupation. To obtain the coordin-
ates of the offset point, click Compute Coordinates. See "TS Obs tab" section on page 148 and "Offset tab" sec-
tion on page 248 for details.

Plane and Corner
Determination of the horizontal and vertical (3D) coordinates of an inaccessible point, as intersection of a line of
site and a plane defined by three points. The user creates three auxiliary points, then performs distance and angle
measurements to these points, and angle measurements to the offset point.
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Plane and Corner

After importing the MAGNET Field job with Plane and Corner data into the current MAGNET Tools job, the
right panel of the TS Obs tab displays all measurements performed for calculating the offset point. In this case
MAGNET Tools applies the same Point to name for Planeand Corner type measurements:

Point From Point To Horizontal Circle Slop Distance Zenith Angle Type

A Offset_Point 80 00 00.000 200.40 29 00 00.000 Plane

A Offset_Point 82 00 00.000 253.00 28 00 00.000 Plane

A Offset_Point 101 00 00.00 256.00 27 00 00.000 Plane

A Offset_Point 105 00 00.00 30 00 00.000 Corner

You cannot edit the offset values in MAGNET Tools job.

Importing control points to a job
The application allows importing a text coordinate file that does not contain information about the coordinate sys-
tem and linear units. The file contains ONLY the values of coordinates. To import the point coordinates in the cor-
responding coordinate system, you have to:

l know this coordinate system or projection,
l set this coordinate system / projection as current before importing.

As an example, let us import the coordinate file in SPC-83 grid system, zone Ohio (North) for NAD83 datum,
where grid coordinates are in US Feet and comma delimiter is used in the format:
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To import control points to a job:
1. Open or create a job.
2. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.
3. In the Format name drop-down list, expand the Coordinates item and select the Name,N,E,Z,Code item.
4. Click Advanced options.
5. From the Linear unit drop-down list, select USFeet.
6. From the Coordinate type drop-down list, select Grid.
7. From the Projection drop-down list, select USA/SPC83/Ohia(North).
8. From the Datum drop-down list, select NAD83.
9. From the Point Control drop-down list, select Control.
10. Navigate to the required file and open it.
11. The Points tab will display the points coordinates for the following settings in the Status Bar:

Performing Adjustment
MAGNET Tools allows you to perform inner or constraint adjustment of TS, GPS, and DL observations, jointly or
separately. Adjustment of the network - is a final procedure for obtaining coordinates of the network points from
the Fixed control points in the pre-defined coordinate system. Only after adjustment of the network, which con-
sists of closed figures, it is possible to obtain not statistical evaluations but realistic errors of the points coordin-
ates of the given network.

To run the adjustment, in the Adjustment group of the Process tab, click the Adjustment icon. The Least Squares
method of adjustment is used by default for adjustment of any network. Also, for TS networks, you can select the
traverse adjustment by Compass Rule or Traverse Unadjusted closure methods after clicking on the arrow under
the Adjustment icon. See "Adjustment Types" section on page 360 for details.
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Inner constraint adjustment - adjustment is performed in the horizontal or vertical plane from an arbitrary point
(selected by MAGNET Tools). Constraint adjustment - adjustment is performed in the plane, in which you fixed a
point of the job.

The basic information about adjustment in MAGNET Tools:

You can select the dimension of the network adjustment. Use the Adjust Dimension drop-down list, at the General
tab of the Adjustment item from the Job Configuration dialog. See "General tab" section on page 100 for details.
By default, this set to AUTO. This setting means that the type of control points will define the dimension of the
adjustment (for GPS observations with baseline length less than 200 km):

l If a control point(s) is not selected, the plane and vertical adjustments (2D+1D) are separately performed
from an arbitrary point.

Diagnostic results before and after adjustment

l If a control point(s) is fixed only in the horizontal plane, only the horizontal adjustment (2D) is performed.
The vertical adjustment are not performed.
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Diagnostic results before and after adjustment

l If a control point(s) is fixed only in the vertical plane, only the vertical adjustment (1D) is performed. The
horizontal adjustment are not performed.

Diagnostic results before and after adjustment

l If a control point(s) is fixed in both planes, the adjustment (2D+1D) will be separately done for both planes,
respectively.
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Diagnostic results after adjustment

When a job contains one or more GPS observations with the vector length more than 200 km, the
adjustment is simultaneously performed in 3D space for all GPS observations.

Diagnostic results after adjustment

You can select the current criterion for rejecting of the bad observations. Use the Rejection Criterion group box,
at the General tab of the Adjustment item from the Job Configuration dialog. See "General tab" section on
page 100 for details. It has two options:

l By Quality Control— the application will reject the following network components from the adjustment
with residuals worse than the values set at the Quality Control item of the Job configuration dialog. See
"Point Precisions tab" section on page 118 for details. These residuals are calculated in the process of
adjustment for the closed figures and/or for repeated observations in the network:

l all plane components of the GPS observations and distances and/or horizontal angles of the TS obser-
vations for the plane adjustment,

l all height components of the GPS observations and vertical angles of the TS observations for the ver-
tical adjustment.

l Tau Criterion— the application will reject the following network components from adjustment with a Tau
value more than Tau_critical. These residuals are calculated in the process of adjustment for the closed fig-
ures and/or for repeated observations in the network:

l all plane components of the GPS observations and distances and/or horizontal angles of the TS obser-
vations for the plane adjustment,

l all height components of the GPS observations and vertical angles of the TS observations for the ver-
tical adjustment.

The formula for calculating Tau: Tau = (RES) / δRes,

where (RES) - designates the residual calculated for the corresponding component of the observation,

δRes - the RMS residual error.
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NOTE
The value of Tau_critical depends on the number of degrees of freedom and the selected level of
confidence in the Confidence Level field .

Before adjustment of a network, GPS\TS\DL point coordinates are re-computed using corresponding observations
and analysis of the given network is carried out.

Adjustments of GPS observations will use the selected datum. Adjustments of TS and DL observations will use
the sphere of the mean Earth radius. All of these adjustments will take into account the parameters of the geoid in
the current job.

While analyzing, the network testing is interrupted and the Adjustment Analysis dialog will display. This dialog
shows information about the tests being executed and possible issues with the data that could prevent accurate net-
work adjustment. In this dialog you can:

l continue the adjustment without any changes of data by clicking Continue.
l stop the adjustment by clicking Cancel.
l to view the preliminary computed coordinates by clicking the Save Preliminary Coordinates.

Also clicking the hyperlink in the window, the network or subnetwork in the Observation View automatically is
highlighted. See the picture below.

If you change a data of the job after starting of the adjustment (for example delete a point ), the Adjustment Ana-
lysis window will contain the Restart button. To perform the adjustment of the updated network, you need click
the button and an analysis of them will be done again.

After the adjustment is completed, the Adjustment Result dialog will display. This dialog shows the final results
of adjustment:

l the type of the network adjustment.
l the quantity of the adjusted points.
l the quantity of the fixed points and weighted points.
l the quantity of the used and rejected observations.
l errors of unit weight (UWE) and UWE bounds. See "What is UWE" section on the next page for details.
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l the list of the rejected observations (if the observations are exist).
l the list of the points, which did not pass the Quality Control test.

The Points tab of the Tabular view, displays the standard deviation of the northing/easting/height coordinates for
the adjusted point. The adjusted point has the symbol.

Adjustment Types
In MAGNET Tools you can select the following adjustment method:

l Least Squares — statistical method for providing a best fit for survey point positions, and detecting and
automatic rejecting error measurements (blunders) by minimizing the sum of the squares of measurement
residuals. This type is used by default for adjustment of GPS, TS and DL networks

l Compass Rule — this method assumes that the precision in angles or directions is equivalent of the pre-
cision in distances. This method works for closed TS traverses or TS traverses between two fixed control
points

l Unadjusted closure — calculates the TS network coordinates from the original station coordinates without
estimating the accuracy. If the network has duplicate measurements, only one measurement will be used to
compute the coordinates

What is UWE
UWE is a coefficient which displays how the precision of GPS observations (vectors) in the network (closed fig-
ure) changes after adjustment with respect to the precision obtained after processing the GPS observations. If you
got UWE close to 1, the average precision of each GPS observation after adjustment is not worse than the aver-
age precision after processing. Using UWE , you can calculate the precision of the vectors after adjustment:

UWE bounds are the min/max values of UWE for the given network with a successful result of adjustment (only
for closed figure(s)).

NOTE
Themost reliable results of the network adjustment are obtained when UWE is within the bounds.
Therefore, the centimeter precision of the network points can be archived only when the UWE value
does not exceed the upper bound.

Performing Grid to Ground Transformation
The application supports two methods for setting the relation between Grid and Ground coordinate systems. One
method performs scaling and rotation relative to some point of the network or job, other method performs scaling
and rotation relative to the origin of the Grid coordinate system.

To use any of these methods:
1. In the Information group of the Job tab, click the Job configuration icon.

The Job Configuration dialog is displayed.
2. In the left panel, select the Coordinate Systems item.
3. From the Projection drop-down list, select the required projection. The link with some Ground coordinate

system will be found through it.
4. Tick the Grid->Ground checkbox and click ... to the right from it.
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The Grid->Ground dialog is displayed.
5. Define the transformation method:

l If the you know the coordinates of a point in both coordinate systems (Grid and Ground) and also
rotation of these systems — select Ground Origin radiobutton. See "Creating a ground projection rel-
ative to a point" section on page 365 for details.

l If you know the value of the scale factor between grid and ground coordinate systems or the average
height of the network, then to find the relation between Grid to Ground coordinate systems — select
the Parameters radiobutton. See "Creating a ground projection relative to origin of a grid system"
section on page 366 for details.

Grid->Ground dialog
The Grid->Ground dialog allows you to configure the transformation method of the grid->ground coordinate trans-
formation.

To configure the grid->ground transfromation:
1. In the Information group of the Job tab, click the Job Configuration icon.

The Job configuration dialog is displayed.
2. In the left panel, select the Coordinate Systems item.
3. In the right panel select the Setup tab.
4. From the Project drop-down list, select the required projection.
5. Tick the Grid->Ground checkbox and click ... to the right from it.

The Grid->Ground dialog is displayed.
6. Define the transformation method, by selecting the appropriate radiobutton:

l Ground Origin – the method performs scaling and rotation relative to some point of the job.
l Parameters – the method performs scaling and rotation relative to the origin of the Grid coordinate
system.
NOTE
Depending of the transformationmethod, the dialog displays different set of transformation parameters.

7. Configure the transformation parameters as you need. Fields are described in the tables below.
8. Click OK.

Fields of the Grid->Ground dialog for the Ground Origin method
Field Description

Ground Origin

Select the radiobutton to use the Ground Origing transformation method. It per-
forms scaling and rotation relative to some point of the job.

See "Creating a ground projection relative to a point" section on page 365 for
details.

Origin Point Defines the name of the original point in the Grid coordinate system. Select the
required point from the drop-down list.

Northing (m)
Defines the North coordinate of the origin point.

This field is filled in automatically of you have selected the origin point in the
Origin Point drop-down list.If needed, you may change the value.
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Field Description

Easting (m)
Defines the East coordinate of the origin point.

This field is filled in automatically of you have selected the origin point in the
Origin Point drop-down list. If needed, you may change the value.

Ground Azimuth

Defines the ground azimuth of a line (common for Grid and Ground networks)
between two points which have coordinates in the Ground coordinate system.
See picture below.

If you know the value, you may specify it in editbox; or you may use the Com-
pute button to select the line points (in the Ground coordinate system) to cal-
culate the azimuth. See "Calculating Ground Azimuth" section below for
details.

Grid Azimuth

Defines the grid azimuth of a line (common for Grid and Ground networks)
between two points which have coordinates in the Grid coordinate system. See
picture below.

If you know the value, you may specify it in editbox; or you may use the Com-
pute button to select the line points (in the Grid coordinate system) to calculate
the azimuth. See "Calculating Grid Azimuth" section below for details.

Scale Factor
Defines the Combined Scale Factor for the current original point.

The value is automatically calculated by the MAGNET Tools, basing on the
specified Origin point. If needed, change the value.

Fields of the Grid->Ground dialog for the Parameters method
Field Description

Parameters

Select to use the Parameters transformation method. It performs calculating
plane ground coordinates by scaling, offsetting, and rotation of grid coordin-
ates. If a rotation angle is present between these coordinate systems, the applic-
ation can rotate the ground coordinate system relative to the origin of the Grid
coordinate system (centre of the projection).

See "Creating a ground projection relative to origin of a grid system" section on
page 366 for details.

Scale Factor (list)
Defines the current type of the Grid to Ground transformation. Select either
Scale Factor or Average Job Height from the drop-down list, depending which
information you have.

Average Job
Height (m)

Defines the average height of the network (job). You can edit the value when
Average Job Heigh is selected in the Scale Factor drop-down list.

NOTE
Combined Scale Factor = Vertical scale factor / Horizontal Scale Factor;
Vertical scale factor = 1 + Average Job Height / Mean_Earth_Radius.

Scale Factor (edit-
box)

Defines the Combined Scale Factor. You can edit the value when Scale Factor
is selected in the Scale Factor drop-down list.

NOTE
Combined Scale Factor = Vertical scale factor / Horizontal Scale Factor;
Vertical scale factor = 1 + Average Job Height / Mean_Earth_Radius.
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Field Description

Mapping Scale

Defines the Mapping or Horizontal Scale Factor. You can edit the value when
Average Job Height is selected in the Scale Factor type list.

NOTE
Combined Scale Factor = Vertical scale factor / Horizontal Scale Factor;
Vertical scale factor = 1 + Average Job Height / Mean_Earth_Radius.

Northing Offset

Defines the Northing Offset of the Ground coordinate system from the selected
Grid coordinate system. You can edit the value. See picture below for details.

The final northing coordinate in the Ground will be calculated as follow:

Easting Offset

Defines the Easting Offset of the Ground coordinate system from the selected
Grid coordinate system. You can edit the value. See picture below for details.

The final easting coordinate in the Ground will be calculated as follows:

Azimuth Rotation
Defines the rotation angle between the Grid and Ground coordinate systems.
The application rotates the ground coordinate system relative to the origin of
the Grid coordinate system (see picture). You can edit the value.

Calculating Azimuth
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Northing and Easting offsets

Azimuth rotation

Calculating Azimuth
To calculate ground/grid azimuth:

1. At the Setup tab of the Coordinate Systems item from the Job configuration dialog, select the "Grid" item
from the Coordinate type drop-down list.

2. In the Grid->Ground field, click ....

The Grid->Ground dialog is displayed.
3. In the Ground Azimuth or Grid Azimuth field, click Compute.

The Compute Azimuth dialog is displayed.
4. Select the from and to points from the appropriate drop-down lists.
5. In needed, in the Add to Azimuth editbox, type the additional value for azimuth
6. In the Azimuth field, review the result if needed, correct the input.
7. Click OK.
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Creating a ground projection relative to a point
This method calculates an offset vector in the horizontal plane between coordinates of a point (let’s call this point
as the origin point) in the grid and ground coordinate systems and, using this offset, computes the ground coordin-
ates from the grid coordinates. If a rotation angle is present between these coordinate systems, the application can
rotate a grid or ground coordinate system relative to this point. Also application takes into account a scale factor
between these coordinate systems:

After determining the relation between both coordinate systems, the application will recalculate ground coordin-
ates from the grid coordinate system and vice versa.

Initial configuration:
l In the Job Configuration dialog, the desired grid projection is set in the Projection drop-down list.
l In the Job Configuration dialog, the Grid coordinate system is set in the Coordinate type drop-down list.
l In the Grid->Ground dialog, the Ground Origin radiobutton is selected.

In the Grid->Ground dialog, do the following:
1. From the Origin Point drop-down list, select the origin point in the Grid coordinate system.

The MAGNET Tools calculates the Combined Scale Factor, and displays it in the Scale Factor editbox.
You can edit the value.
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2. In the Northing (m) and Easting (m) editboxes, specify the Grid coordinates of the original point in the hori-
zontal plane only.

3. To take into account the rotation between two networks in this transformation, you may specify one of fol-
lowing information:

l In the Ground Azimuth editbox, type the required ground azimuth value; or click Compute to auto-
matically calculate it. See "Grid->Ground dialog" section on page 361 for details.

l In the Projection Azimuth editbox, type the required ground azimuth value; or click Compute to auto-
matically calculate it.

4. Click OK.

The application assigns grid coordinates of the origin point to the ground coordinates of this point, rotates,
scales the network. The applications allows you to perform both grid to ground transformation and ground to
grid transformation of the job points. The Observation View and Points tab display both networks in the
Ground and Grid coordinate systems.

Creating a ground projection relative to origin of a grid system
This method calculates plane ground coordinates by scaling, offsetting, and rotation of grid coordinates. If a rota-
tion angle is present between these coordinate systems, the application can rotate the ground coordinate system rel-
ative to the origin of the Grid coordinate system (centre of the projection).

Creating Ground by only scaling Grid
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Creating Ground by only rotation Grid

Creating Ground by only shifting Grid

After determining the relation between both coordinate systems, the application will recalculate ground coordin-
ates from the grid coordinate system and vice versa.

Initial sets configuration:
l In the Job Configuration dialog, the desired grid projection is set in the Projection drop-down list.
l In the Job Configuration dialog, the Grid coordinate system is set in the Coordinate type drop-down list.
l In the Grid->Ground dialog, the Parameters radiobutton is selected.

In the Grid->Ground dialog, do the following:
1. From the Scale Factor drop-down list, select one of the following, depending which is known:

l Scale Factor—if the scale factor is know. If so, type the required value in the Scale Factor editbox.
l Avg Job Height—if the average job height is known. If so, type the required value in the Avg Job
Height (m) editbox. The Scale Factor will be automatically calculated and used in the trans-
formation: Scale_Factor = (1+ Avg.Job Height/Mean_Earth_Radius), where Mean_Earth_Radi-
us=6371000.0 m
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2. In the Azimuth Roation editbox, specify the angle of rotation.

The application performs rotation of the Ground relative to the origin of the Grid coordinate system.
3. In the Northing Offset and Easting Offset editboxes, type the required offsets to shift the Ground system

from the selected Grid type in the desired plane. The final coordinates will be calculated as:

4. Click OK.

The application shifts, rotates, scales the network. The applications allows you to perform both grid to
ground transformation and ground to grid transformation of the job points. The Observation View and Points
tab display both networks in the Ground and Grid coordinate systems.

Performing Localization
Localization in the application is calculation of transformation parameters between any datum or any grid and
ground coordinate systems to determine the point coordinates in the given coordinate system. To perform loc-
alization you has to have two independent sets of coordinates for the same point or some points in the job.

NOTE
Two sets of coordinates are independent if there is no relation between them.

When you select Grid or Datum in the Status bar, the Points tab of the Tabular view, will display the coordinates
of the points in either the grid or the datum coordinate system:

When you select Ground in the Status bar, thePoints tab of the Tabular view will display the coordinates of the
points in the Ground coordinate system only:
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To start localization using these two sets of coordinates
1. In the Coordinate Systems group of the Process tab, click the Localization icon.

The Localization dialog is displayed. See "Localization dialog" section on page 372 for details.
2. Click Add Point.
3. In the WGS Point and Local Point columns, select a localization point.
4. In the Use column, select the type of the localization for the points.

NOTE
InMAGNET Tools horizontal localization and vertical localization are performed separately.

5. Add at least three pair of points.
6. Click Compute parameters.

MAGNET Tools calculates the following seven parameters to use them for transformation of all the job
points:

l Four parameters in the horizontal plane:
l offset vector (DX, DY) in the horizontal plane between the origins of the coordinate systems
l rotation angle between the Grid/ Datum and Groundcoordinate systems
l scale between the Grid/ Datum and Groundcoordinate systems

l Three parameters in the vertical plane:
l vertical offset between the Grid/ Datum and Groundcoordinate systems (H0)
l the North component of the vertical deflection (Deflection North)
l the East component of the vertical deflection (Deflection East)
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If a geoid is present in the job, the application will use this geoid to calculate orthometric elevations.

NOTE
We recommend using a geoid for calculating orthometric elevations. Calculating orthometric elevations
without a geoid for points inGround coordinate system can lead to errors in orthometric elevations.

The application allows you to select the following ways for the plane localization:
l using only the stereographic projection on WGS-84,
l using only the stereographic projection on any datum,
l using any predefined or created projection

If you perform a task of transformation of WGS-84 coordinates into Ground coordinates for a network where the
maximum distance between the local points is less than 5 kilometers, you can use the simplest localization.

To do this type of localization, do not select any projection or datum in the Setup tab of the Coordinate Systems
item from the Job configuration dialog. The Localize to list will contain only WGS-84 coordinate system. In this
case the plane localization will use only the stereographic projection on WGS-84 datum.

If you know which datum is used for the local coordinate system, you can use this datum in localization.

To do this type of localization, select the desired datum in the Datum list at the Setup tab of the Coordinate Sys-
tems item from the Job configuration dialog. The Localize to list will contain WGS-84 and the selected datum:

If you select the local datum, the plane localization will use the stereographic projection on the selected datum.
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If you know which projection is used for the local coordinate system, you can use this projection in localization.
To do this type of localization, select the desired projection in the Projection list at the Setup tab of the Coordinate
Systems item from the Job configuration dialog.

If you select the desired projection as the current coordinate system in the Status bar or the Coordinate type list at
the Setup tab of the Coordinate Systems item from the Job configuration dialog, the Localize to list will contain
WGS-84 datum, datum for the selected projection and the projection itself:

In this case this projection and corresponding datum will be used in the process of calculation of localization para-
meters. Such approach to the calculation of the localization parameters between two coordinate systems is more
rigorous method, than using the stereographic projection for a unknown local projection. This way allows increas-
ing the distance between localization points (up to some hundred of kilometers depending on the type of the pro-
jection) without loss in transformation precision.

After selecting the desired projection/datum for the local system, clickCompute parameters to calculate the loc-
alization parameters. The calculated parameters will be displayed on the right panel of the Localization dialog.
These parameters will be used to convert Grid/Datum coordinates into local coordinates, and vice versa. The
Points tab of the Tabular view will display the coordinates of the points in Ground and Grid/Datum coordinate sys-
tems:

To perform localization you can select one, two, three and more pairs of the localization points. For each case the
application will calculate a different set of transformation parameters and residuals. The table displays which
parameters are calculated in the process of localization, some parameters can be set to zero depending on the
used number of the localization pairs of points.

PARAMETERS
ONE

PAIR

TWO

PAIRS

THREE

PAIRS

FOUR

PAIRS
DX,DY- horizontal offset between two coordinate systems CALC CALC CALC CALC
H0 - vertical offset between two coordinate systems CALC CALC CALC CALC
Scale - combined Scale factor CALC CALC CALC CALC
Rotation - rotation between two coordinate systems 0 CALC CALC CALC
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Deflection North, Deflection East- Deflection components 0 0 CALC CALC
N Residual, E Residual - residuals on the horizontal plane 0 0 CALC CALC
Ht Residual - residuals on the vertical plane 0 CALC 0 CALC

NOTE
We do not recommend using ONE point localization, when both coordinate systems have
non-zero rotation angle. In this case the accuracy of transformation can be incorrect.

Localization dialog
Fields of the left panel of the Localization dialog

Field Description

WGS Point

Displays a list of points from the Grid/ Datum set of coordinates which are
used in the localization.

To add a point to the column, click Add Point and select the required point
from the list of all points of the job.

To remove a point from the column, select the required point in the column and
click Remove Point.

Local Point

Displays a list of points from the Ground set of coordinates which are used in
the localization.

To add a point to the column, click Add Point and select the required point
from the list of all points of the job.

To remove a point from the column, select the required point in the column and
click Remove Point.

Use

Displays the type of the localization for the given pair of points.
l Horizontal and Vertical — the pair is used in the horizontal localization
and the vertical localization

l Horizontal — the pair is used in the horizontal localization
l Vertical — the pair is used in the vertical localization
l None — the pair is not used in the localization

N Residual
Displays the Northing residual for the localization point after computing the
transformation parameters. The value will be calculated when three and more
pairs of points are used in the localization.

E Residual
Displays the Easting residual for the localization point after computing the
transformation parameters. The value will be calculated when three and more
pairs of points are used in the localization.

Ht Residual
Displays the residual on the vertical plane for the localization point after com-
puting the transformation parameters. The value will be calculated when two
or more than three pairs of points are used in the localization.
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Field Description

Localize to

Displays the list which can contain the following datum and projection:
l WGS-84
l a datum which was selected from the Datum drop-down list of the Setup
tab for the Coordinate System item from the Job configuration dialog

l a projection which was selected from the Projection drop-down list of
the Setup tab for the Coordinate System item from the Job configuration
dialog

If you select WGS-84 from the list, the plane localization will use only the ste-
reographic projection on the WGS-84 datum.

If you select a datum from the list, the plane localization will use the ste-
reographic projection on the selected datum.

If you select a projection from the list, this projection and corresponding datum
will be used in the process of calculation of localization parameters. Such
approach to the calculation of the localization parameters between two coordin-
ate systems is more rigorous method, than using the stereographic projection
for a unknown local projection. This way allows increasing the distance
between localization points (up to some hundred of kilometers depending on the
type of the projection) without loss in transformation precision.

Origin Point

In the list you can select one of the following:
l Calculate Center point (default setting) — the geometrical center of
pairs of points, which is used in localization, becomes the center of the
default map projection

l First point from Localization List— the first pair of points, which is
used in the localization, becomes the center of default map projection.

Fields of the right panel of the Localization dialog
Field Description

DX Displays the projection of the offset vector in the horizontal plane between the
origins of coordinate systems on the X axis.

DY Displays the projection of the offset vector in the horizontal plane between the
origins of coordinate systems on the Y axis.

Rotation Displays the rotation angle between the Grid/ Datum and Groundcoordinate
systems.

Scale Displays the scale factor between the Grid/ Datum and Groundcoordinate sys-
tems.

H0 Displays the vertical offset between the Grid/ Datum and Groundcoordinate
systems.

Deflection North Displays the North component of the vertical deflection.

Deflection East Displays the East component of the vertical deflection.
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Field Description

Origin Lat
Displays the latitude coordinate of the first localization point from the Grid/
Datum set in the coordinate system which is selected in the Localize to drop-
down list.

Origin Lon
Displays the longitude coordinate of the first localization point from the Grid/
Datum set in the coordinate system which is selected in the Localize to drop-
down list.

Origin Ell. H
Displays the ellipsoidal (geodetic) height of the first localization point from the
Grid/ Datum set in the coordinate system which is selected in the Localize to
drop-down list.

Origin Northing Displays the northing coordinate of the first localization point from the Ground
set in Ground coordinate system.

Origin Easting Displays the easting coordinate of the first localization point from the Ground
set in Ground coordinate system.

Origin H Displays the orthometric height of the first localization point from the Ground
set in Ground coordinate system.

Keep Scale 1.000

When ticked, the scale factor is set to one and is not calculated when cal-
culating of the transformation parameters. When untiked (default settings), the
scale factor will be calculated when calculating of the transformation para-
meters.

Apply legacy
method

For the horizontal localization MAGNET Tools supports two methods of cal-
culation of the localization parameters, i.e. Rotation, Scale, DX and DY:

l Default method - a separate calculation of the localization parameters.
This mode is applying in the MAGNET Tools and MAGNET Field from
version 2.0.

l Legacy method - a combined calculation of the localization parameters.
This mode was applied in the MAGNET Tools and MAGNET Field up
to version 1.2.and all versions of Topcon Tools and TopSURV. Also this
mode is applied in the current version of the Pocket 3D and 3D-Office.

When ticked, the Legacy method is set. When untiked (default settings), the
Default method is set.

When you import Topcon 3D Localization file (*.gc3) into the opened job and
select the legacy method (in the Advanced options field), the Legacy method is
set automatically in the Localization dialog.

Projection

Displays the name of the projection to which the previous localization was per-
formed. The field is empty in the following cases:

l the localization is not performed yet,
l the localization was performed using a stereographic projection on
WGS-84 or on any datum.

Datum Displays the name of the datum to which localization was performed.
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Buttons of the Localization dialog
Field Description

Add Point

Click it to add a localization point to the Localization dialog.

After clicking the list of all points will appear in the WGS Point column. Select
a point from the Grid/ Datum set first, then in the Local Point column, select
the corresponding point from the Ground set.

Remove Point To remove a localization point from the Localization dialog, select a point and
click the button.

Compute para-
meters

Click to start the localization. Before this make sure that the columns WGS
Point and Local Point are not empty and contain the points from the inde-
pendent sets.

Close Click to close the dialog.
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Performing Datum Transformation
The Datum Transformation option allows you to:

l determine an unknown datum parameters with respect to the WGS84 datum
l redefine the parameters of the existing datum with respect to the WGS84 for a local area.

For the datum transformation you has to have two sets of coordinates for three or more points:
l one set in the WGS-84 coordinate system
l other set in unknown (new) coordinate system

Let us assume that the file with points in WGS-84 coordinate system has format "Name, WGS84_Lat, WGS84_
Lon,WGS84_Ell.H". But the file with points in unknown (new) coordinate system is in the known Grid coordinate
system (format ""Name, N, E, Ell.H""). To perform the datum transformation, using the files, take the following
steps:

1. Create a new job.
2. In the Information group of the Job tab, click the Job Configuration icon.

The Job Configuration dialog is displayed.
3. Select the Setup tab of the Coordinate Systems item.
4. From the Coordinate type drop-down list, select "WGS84 Lat,Lon,Ell.H.".
5. Import the file with points in WGS-84 coordinate system to the job.
6. The Points tab from the Tabular view displays all imported points:

7. In the Information group of the Job tab, click the Job Configuration icon.

The Job Configuration dialog is displayed.
8. Select the Setup tab of the Coordinate Systems item.
9. In the Datum field, click Custom.

The Custom Datums List dialog is displayed.
10. Click Add.

The New Custom Datum dialog is displayed.
11. Configure the datum parameters as you need. Fields are described in the table below.

NOTE
For a new local datum, whose parameters are calculated, a reference ellipsoid should be defined.
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12. Click OK.

The newly created datum is displayed in the Custom Datums List dialog.

13. Close the Custom Datums List dialog.
14. In the Projection field at the Setup tab, click Custom.

The Custom Projections List dialog is displayed.
15. Click Add.

The New Custom Projection dialog is displayed.
16. Configure the projection parameters as you need. Fields are described in the table below.

NOTE
For a new local projection the corresponding "Central meridian" should be defined.
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17. Click OK.

The newly created projection is displayed in the Custom Projections List dialog.

18. Close the Custom Projections List dialog.
19. From the Coordinate type drop-down list, select "Grid".
20. From the Projection drop-down list, select the newly created projection.
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21. Import the file with points in Grid coordinate system to the job.
22. The Points tab from the Tabular view displays all imported points:

NOTE
In comparison with the localization, where two sets of coordinates (Datum/Grid andGround ) are inde-
pendent and do not have a predefined relation between two coordinate systems, for datum transformation
both sets of coordinates have relation between them. After importing these sets to a job, MAGNET Tools
will display coordinates of all points in each coordinate system.

23. In the Coordinate Systems group of the Process tab, click the Datum Transformation icon, to start datum
transformation using these two sets of coordinates.

24. The Datum Transformation dialog is displayed.
25. Click Add Point.
26. Select required points from the WGS Point and Local Point drop-down lists. You need to select three or

more pairs.
27. Click Compute Parameters.

MAGNET Tools will calculate the following seven parameters to transfer coordinates from the WGS-84
coordinate system into the new datum, and visa-versa.

l Three values of shift along the X/Y/Z axis from the created datum to WGS-84 in meters. They will
be displayed in the DX, DY and DZ fields.

l Three values of rotation angle between the X/Y/Z axis of the created datum and WGS-84 in arc
seconds. They will be displayed in the RX, RY and RZ fields.
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l The value of the scale in ppm, which specifies a coordinate transformation from the created datum
to WGS84. It will be displayed in the Scale field.

Also MAGNET Tools computes residuals for the corresponding axes and displays them in the N Residual,
E Residual, and U Residual fields and total values of the residuals, which is displayed in the Total RMS
field.

28. To save the calculated transformation parameters, click Save. If the datum exists in the MAGNET Tools
datum list, the warning message will appear:

l click Yes, to save the overwrite new parameters for this datum name
l click No, to save the new parameters under a new datum name.

Fields of the General tab of the New Custom Datum dialog
Field Description

Name Defines the name of the custom datum. The datum name is unique and the field
cannot be empty.

Ellipsoid Defines the name of the ellipsoid used to create the datum. You can select any
predefined ellipsoid from the list.

DX Defines the value of shift along the X axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84. The default is 0.

DY Defines the value of shift along the Y axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84. The default is 0.

DZ Defines the value of shift along the Z axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84. The default is 0.

RX Displays the value of the rotation angle between the X axes of the created
datum and WGS84 in arc seconds. The default is 0.

RY Displays the value of the rotation angle between the Y axes of the created
datum and WGS84 in arc seconds. The default is 0.

RZ Displays the value of the rotation angle between the Z axes of the created
datum and WGS84 in arc seconds. The default is 0.

Scale Defines the value of the scale factor in ppm, which specifies a coordinate trans-
formation from the created datum to WGS84. The default is 0.

Note Defines any additional note about the datum.

Alias When you select a datum from the list, all available projection(s) for the selec-
ted datum automatically will be available for the created custom datum.

Fields of the General tab of the New Custom Projection dialog
Field Description

Name Defines the name of the custom projection. The projection name is unique and
the field cannot be empty.
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Field Description

Projection Type

Defines the name of the projection type. The following options are available:
l Transverse-Mercator
l Lambert
l Double Stereographic
l Stereographic
l Oblique Mercator
l Albers Equal Area
l Cassini-Soldner
l Mercator

Every projection has its own set of original parameters. After selecting the
type of projection, you can edit the parameters for this type.

Region

Defines the name of the region for which the projection will be used. You can
use the existing regions (like Europe, Australia, etc.) or enter a new name. If
you enter a new name, the application creates a new folder with the entered
name in the projection list. The custom projection will be saved in this folder.

Note Defines any additional note about the datum.

Datum

Defines the datum used for the projection. You can select any datum for the
given projection. After selection the custom projection, the datum will be auto-
matically set in the Datum drop-down list at the Setup tab of the Coordinate
Systems item from the Job configuration dialog

Datum Transformation dialog
Fields of the left panel of the Datum Transformation dialog

Field Description

WGS Point

Displays a list of points from the WGS-84 datum set of coordinates which are
used in the datum transformation.

To add a point to the column, click Add Pointand select the required point
from the list of all points of the job.

To remove a point from the column, select the desired point in the column and
click Remove Point.

Local Point

Displays a list of points from unknown (new) datum set of coordinates which
are used in the datum transformation.

To add a point to the column, click Add Pointand select the required point
from the list of all points of the job.

To remove a point from the column, select the desired point in the column and
click Remove Point.

N Residual Display the northing residual for the pair point after computing the trans-
formation parameters.
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Field Description

E Residual Display the easting residual for the pair point after computing the trans-
formation parameters.

U Residual Display the vertical residual for the pair point after computing the trans-
formation parameters.

Total RMS

Displays total values of the residuals calculated as:

Fields of the right panel of the Datum Transformation dialog
Field Description

Ellipsoid Display the name of the ellipsoid used to create the datum. You can select any
predefined ellipsoid from the list.

DX Display the value of shift along the X axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84.

DY Display the value of shift along the Y axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84.

DZ Display the value of shift along the Z axis in meters, which specifies a coordin-
ate transformation from the created datum to WGS84.

RX Display the value of the rotation angle between the X axes of the created
datum and WGS84 in arcseconds.

RY Display the value of the rotation angle between the Y axes of the created
datum and WGS84 in arcseconds.

RZ Display the value of the rotation angle between the Z axes of the created
datum and WGS84 in arcseconds.

Scale Display the value of the scale factor in ppm, which specifies coordinate trans-
formation from the created datum to WGS84.

Buttons of the Datum Transformation dialog
Field Description

Add Point

Click the button to add a point to the datum transformation to the Datum Trans-
formation dialog. After clicking the button, the list of all points will appear in
the WGS Point column. Select a point from the WGS-84 datum set, then in the
Local Point column select the corresponding point from an unknown (new)
datum set.

Remove Point To remove a point from the Datum Transformation dialog, select a point and
click the button.

Compute para-
meters

Click it to start the datum transformation. Before this make sure that the WGS
Point and Local Point columns contain tree or more points from the cor-
responding sets.
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Field Description

Save

To save the calculated transformation parameters for the datum in the Datum
Transformation dialog, click the button. If the datum exists in the MAGNET
Tools datum list, a warning message will appear.

l click Yes to save the new parameters for this datum name
l click No to save the new parameters for a new datum name. After that
Save datum window appears.

Close Click it to close the dialog

Creating custom filter
The filter function allows you to display/hide points, occupations, observations in MAGNET Tools views. Fil-
tering data is performed by type, time, quality control test and code. Hidden points, occupations, and observations
will be excluded from processing, adjustment, exporting, and reports.

The MAGNET Tools allows you to create your own filters. To do so:
1. In the Filters group of the View tab, click the Filters icon.

The Filters dialog is displayed.
2. Click New filter.

The New filter dialog is displayed.
3. In the Filter Name editbox, type the name for the filter.
4. At the criteria tabs, configure the filter criteria. See the description of tabs in the appropriate sections:

l By Type. See "By Type tab" section on page 388 for details.
l By Code. See "By Code tab" section on page 388 for details.
l By QAQC. See "By QAQC tab" section on page 389 for details.
l By Time. See "By Time tab" section on page 389 for details.
l By Source. See "By Source tab" section on page 389 for details.

5. When finished, click OK.

The filter is created and displayed in the filters list. Note, that is has the icon.

Importing filters
MAGNET Tools allows you to import the filters to external filter (*.tf) files. You may import one or several fil-
ters fro, one file. They will appear as custom filters.

To import filters:
1. In the Filters group of the View tab, click the Filters icon.

The Filters dialog is displayed.
2. Click Import filters.

The Open dialog is displayed.
3. Navigate to the required filter (*.tf) file, and open it.

The filters appear in the filter list as custom ones.
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Exporting filters
MAGNET Tools allows you to export the pre-defined and custom filters to external filter (*.tf) files. You may
export one or several filters to one file.

To export filters:
1. In the Filters group of the View tab, click the Filters icon.

The Filters dialog is displayed.
2. Select the required filters.
3. Click Export filters.

The Save As dialog is displayed.
4. Navigate to the required folder, and File Name editbox, type the name for the file.
5. Click Save.

Creating custom format file
MAGNET Tools allows you to create a custom text format for coordinates files; GPS and TS vector files; and
Code/Layer library files. The created file format will be included into the format list for import and export.

To create custom format of the file:
1. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.

2. In the Format name drop-down list, click .

The Custom Format Properties dialog is displayed.
3. In the Format name editbox, type the name for the new format.
4. From the File type drop-down list, the required data type.
5. In the Available items list, select a required element.
6. Click >>.

The item is added to the Included items list.
7. Repeat steps 5 and 6 to add all the required parameters. If needed, use the Move Up andMove Down but-

tons to arrange their sequence.
8. If needed, tick the Header in first row checkbox.
9. In the Format file extension editbox, type the extension of the data file.
10. If needed, tick the Fixed width checkbox. When ticked, you may define the width of each item, by using the

Width field of the Included items list.
11. From the Separator drop-down list, select the required separator of items in the data file.
12. From the Lat/Lon format drop-down list, select the required format of Latitude and Longitude.
13. Click OK to save the custom file format and close the Custom Format Properties dialog.

Fields of the Custom Format Properties dialog
Field Description

Format name Defines the name of the custom file format.
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Field Description

File type

Defines the type of the data in file. The following types are available:
l Coordinates
l TS Observations
l GPS Observations
l Code/Layer library — this option available only for import.

Available items Contains the available items for the selected file type.

Included items Contains items, selected for custom file format.

Header in first
row Tick to treat first row of the data file as a header.

Format file exten-
sion Defines the extension of the data files for this format.

Fixed width Tick to manually define the width of each item, by using the Width field of the
Included items list.

Separator Defines the separator of items in the data file.

Lat/Lon format Defines the format of Latitude and Longitude coordinates in data file.

Example: Creating of a file format which allows import/export coordinates file.

Let us create a file format which allows import/export of the following coordinates file. The coordinates are in
SPC83 grid system, zone Ohio (North), linear units are US Feet:

To import the coordinate file on to an opened MAGNET Tools job:
1. In the Information group of the Job tab, click the Job Configuration icon.

The Job Configuration dialog is displayed.
2. Select the Setup tab of the Coordinate Systems item.
3. From the Projection drop-down list, select the required projection.
4. From the Coordinate type drop-down list, select "Grid".
5. Select the Units item.
6. From the Linear Unit drop-down list, select the required linear unit.
7. Click OK to save the settings and close the Job Configuration dialog.
8. In the Exchange group of the Job tab, click the Import icon.

The Import dialog is displayed.

9. In the Format name drop-down list, click .

The Custom Format Properties dialog is displayed.
10. In the Format name editbox, type the name of the created format.
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11. From the File type drop-down list, select "Coordinates" (this is for our example file).
12. In the Available items list, select the Name, Northing, Easting and Height elements.
13. Click >>.

The items are added to the Included items list.
14. Confirm, that the Header in first row checkbox is not ticked.
15. In the Format file extension editbox, type the extension of the file.
16. From the Separator drop-down list, select "Comma" (this is for our example file).
17. From the Lat/Lon format drop-down list, select the required format of Latitude and Longitude.
18. Click OK to save the custom file format and close the Custom Format Properties dialog.
19. The newly created format is added to the Format name drop-down list of the Import dialog.
20. Select the newly created format.
21. Navigate to the location of the coordinates file and select it.
22. Click Open to import the coordinate file into the job.
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Filters Dialog
The dialog displays a list of the filters predefined in the program and filters created by the user. Using the filters
allows you to display/hide points, occupations, observations in MAGNET Tools views. Filtering data is performed
by type, time, quality control test and code. Hidden points, occupations, and observations will be excluded from
processing, adjustment, exporting, and reports.

In this dialog you can:
l create unlimited number of filters with individual names for each set of hidden / displayed objects.
l select the current (created or predefined) filter from the filter list. The name of the current filter is dis-
played in the filter combo box.

l export / import any filter from / to MAGNET Tools.

The following filtration types are available:
l By Type
l By Code
l By Time
l By QAQC (Quality Analysis Quality Control)
l By Source

By default, the filter is set to None and all objects are displayed in the job.

To open the dialog, in the Filter group of the View tab, click the Filters icon.

Fields of the Filters dialog
Field Description

Name
Displays the name of the filter. For the predefined (created by Topcon pro-
grammers) filter, the icon is used, for the custom (created by a customer) fil-
ter, the icon is used.

Buttons of the Filters dialog
Button Description

New Filter Click it to create a new custom filter. See "Creating custom filter" section on
page 383 for details.

Delete Click it to delete the selected custom filter.

Properties

Click it to open the Properties dialog for the selected filter. This window con-
tains five tabs, where you can review and edit the filtering conditions:

l By Type. See "By Type tab" section on the next page for details.
l By Code. See "By Code tab" section on the next page for details.
l By QAQC. See "By QAQC tab" section on page 389 for details.
l By Time. See "By Time tab" section on page 389 for details.
l By Source. See "By Source tab" section on page 389 for details.

Export filters Click it to export the selected filter from MAGNET Tools. See "Exporting fil-
ters" section on page 384 for details.
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Button Description

Import filters Click it to import a filter (*.tf format) to the MAGNET Tools. See "Importing
filters" section on page 383 for details.

By Type tab
The By Type tab appears in the either New Filter; or Edit Filter; or View Filter dialog.

It allows you to create or edit a custom filter; or view a predefined filter which will hide/display object of the job
depending on their type. There are two groups of the objects in the list of criterions: points and observations.

The points group contains types of points which do not belong to any GPS, RTK, TS, DL observations.

The observations group can include the types of points and occupations related to corresponding observations. In
this group you may select independently these objects from the given observation type. An object marked in red is
hidden, an object marked in green are displayed. By default all objects in the tab are marked in green.

NOTE
The point which belongs to different data types simultaneously (for example, both aGPS and TS point)
is hidden only if all data types the point belongs to are hidden.

By Code tab
The By Code tab appears in the either New Filter; or Edit Filter; or View Filter dialog.

It allows you to create or edit a custom filter; or view a predefined filter which will hide/display points of the job
based on their codes.

In the Codes to filter editbox you can type a code name using the asterisk (*) or a question mark (?) wildcards.

Using two checkboxes each of which has two different options with different names in the tab you can hide/dis-
play the points from the job by the following rules:

If the first checkbox has the Hide data with the given codes condition:
l the points with these codes will be hidden in all views.
l the points without the codes will be displayed in all views, if the second checkbox has the Exclude objects
without codes condition.

l the points without the codes will be hidden in all views, if the second checkbox has the Include objects
without codes condition.

If the first checkbox has the Show only data with given codes condtition:
l the points with these codes will be displayed in all views.
l the points without the codes will be hidden in all views, if the second checkbox has the Exclude objects
without codes condition.

l the points without the codes will be displayed in all views, if the second checkbox has the Include objects
without codes condition.

If the second checkbox has the Exclude objects without codes condition:
l the points without the codes will be displayed in all viewers, if the first checkbox has the Hide data with
the given codes condition.

l the points without the codes will be hidden in all viewers, if the first checkbox has the Show only data with
given codes condition.

If the second checkbox has the Include objects without codes condition:



By Time tab

389

l the points without the codes will be hidden in all viewers, if the first checkbox has the Hide data with the
given codes condition.

l the points without the codes will be displayed in all viewers, if the first checkbox has the Show only data
with given codes condition.

By Time tab
The By Time tab appears in the either New Filter; or Edit Filter; or View Filter dialog.

In this tab you can create or edit a custom filter which will hide/display GPS and TS occupations with the cor-
responding points of the job based on the time interval. You can specify the start and end time for two independent
time intervals.

To use the first time interval, tick the Use first time interval checkbox, and specify the time and date period in the
appropriate fields.

To use the second time interval, tick the Use second time interval checkbox, and specify the time and date period
in the appropriate fields.

The tab also contains the checkbox which has two different conditions with different names. It allows you hide/dis-
play the objects from the defined time interval:

l If it has the Hide data within time interval(s) condition, the given objects for which the occupations are
fully within the given interval will be hidden in all views.

l If it has the Show only data within non-empty time interval(s) contition, only the given objects for which the
occupations are fully within the given interval will be displayed in all views.

By QAQC tab
The By QAQC tab appears in the either New Filter; or Edit Filter; or View Filter dialog.

In this tab you can create or edit a custom filter which will  hide/display the objects which did not pass the Quality
Control test. The object marked in red is hidden, the object marked in green is displayed. By default all objects in
the tab are green.

By Source tab
The By Source tab appears in the either New Filter; or Edit Filter; or View Filter dialog.

In this tab you can create or edit a custom filter which will hide/display GPS and TS occupations with the cor-
responding points of the job based on the folder/file from which the data is taken.

In the Filter by source editbox you can enter the folder/file.

The tab also contains checkbox which has two different conditions with different names:
l If it has the Hide data without source condition, the objects whose data was taken from other source will be
hidden

l If it has Show data without source condition, the objects whose data was taken from other source will be
displayed.
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Symbols In MAGNET Tools
This chapter contains description of the symbols are used in Tabular View and Observation View. See the appro-
priate section for details:

l "Symbols for the Points tab" section below
l "Symbols for the GPS Occupations tab" section on page 392
l "Symbols for the GPS Obs tab" section on page 393
l "Symbols for the left panel of the TS Obs tab" section on page 394
l "Symbols for the right panel of the TS Obs tab" section on page 394
l "Symbols for the left panel of the DL Obs tab" section on page 394
l "Symbols for the right panel of the DL Obs tab" section on page 395
l "Symbols for the Surfaces tab" section on page 395
l "Symbols for the left panel of the Lines tab" section on page 395
l "Symbols for the X-Section table view" section on page 395
l "Symbols in the X-Section Template tab" section on page 396
l "Symbols in Road String Set or separate Road String table view" section on page 396
l "Symbols in the table view of horizontal alignment" section on page 396
l "Symbols in the vertical alignment table view" section on page 396

Symbols for the Points tab
These symbols of points are used in the Icon field at the Points tab of the Tabular View.

Symbols of points are marked red if the point did not pass Quality Control test. To identify why the test failed for
the point, click Properties on the pop-up menu and select the Quality Control tab.

Symbol passed/not passed Quality Con-
trol test Description

Manual point. The point added to the job by using the
command COGO -> Inversein the Main Menu or click-
ing Add Point in the Toolbar.

Unknown point. The non-control point imported to the job
from a coordinate file.

Fixed Both coordinates point. You can set this status for
any point in the Control field.

Fixed Horizontal coordinates point. You can set this
status for any point in the Control field.

Fixed Vertical coordinates point. You can set this status
for any point in the Control field.
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Symbol passed/not passed Quality Con-
trol test Description

Stakeout point. The point imported to the job from a
MAGNET Field job.

Design point. The point imported to the job from a
MAGNET Field job or a coordinate file.

Point coordinates calculated by means of COGO.

Adjusted point.

TS station.The point imported to the job from a
MAGNET Field job or a TS Observation file.

TS point. The point imported to the job from a MAGNET
Field job or a TS Observation file.

TS BackSight point. The point imported to the job from a
MAGNET Field job or a TS Observation file.

RTK base point. The point imported to the job from a
MAGNET Field job.

Topo Point. The point collected during a static RTK
measurement. The point imported to the job from a
MAGNET Field job.

Auto Topo Point. The point collected during a kinematic
RTK measurement. The point imported to the job from a
MAGNET Field job.

Unprocessed GPS Static point. The point imported to the
job from a GPS raw data file.

Unprocessed GPS Stop point in the stop&go meas-
urements. The point imported to the job from a GPS raw
data file.

Unprocessed GPS Go point in the stop&go measurements
or kinematic point in the kinematic measurements. The
point imported to the job from a GPS raw data file.
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Symbol passed/not passed Quality Con-
trol test Description

Processed GPS Static point. The point imported to the job
from a GPS raw data file.

Processed GPS Stop point in the stop&go measurements.
The point imported to the job from a GPS raw data file.

Processed GPS Go point in the stop&go measurements or
kinematic point in the kinematic measurements.The point
imported to the job from a GPS raw data file.

Tape Measurement point. The point imported to the job
from a MAGNET Field job.

GPS offset point.

PTL (point to line) offset point.

Traverse point for digital level observation.The point
imported to the job from a MAGNET Field job or DL
Observation file.

Level point for digital level observation. The point impor-
ted to the job from a MAGNET Field job or DL Obser-
vation file.

Scan point. The point imported to the job from a
MAGNET Field job or Field Scan Data file or Photo
Fieldbook file.

Image measured point. The point imported to the job from
a MAGNET Field job

Symbols for the GPS Occupations tab
These symbols are used in the Icon field at the GPS Occupations tab of the Tabular View.

Symbols are marked red if the GPS Occupation did not pass Quality Control test. To identify why the test failed
for the point, click Properties on the pop-up menu and select the Quality Control tab.

Symbol passed/not passed Quality Con-
trol test Description

RTK base station occupation
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Symbol passed/not passed Quality Con-
trol test Description

Topo occupation (the static occupation in the RTK sur-
vey)

Auto Topo Occupation (the kinematic occupation in the
RTK survey)

Processed Static GPS occupation

Processed Stop GPS occupation in the stop&go meas-
urements

Processed Go GPS occupation in the stop&go meas-
urements or Kinematic GPS occupation in the kinematic
measurements

Symbols for the GPS Obs tab
These symbols are used in the Icon field at the GPS Obs tab of the Tabular View.

Symbols are marked red if the GPS Observation did not pass Quality Control test. To identify why the test failed
for the point, click Properties on the pop-up menu and select the Quality Control tab.

Symbol passed/not passed Quality Con-
trol test Description

RTK GPS observation from a base station to a Topo
point

RTK GPS observation from the base station to an Auto
Topo point

Unprocessed Static GPS observation

Unprocessed Stop GPS observation for the stop&go meas-
urements

Unprocessed Go GPS observation for the stop&go meas-
urements or Kinematic GPS observation for the kin-
ematic measurements

Processed Static GPS observation

Processed Stop GPS observation for the stop&go meas-
urements
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Symbol passed/not passed Quality Con-
trol test Description

Processed Go GPS observation for the stop&go meas-
urements or Kinematic GPS observation for the kin-
ematic measurements

Symbols for the left panel of the TS Obs tab
This symbol is used in the Icon field in the left panel of the TS Obs tab of the Tabular View.

Symbol Description

TS station

Symbols for the right panel of the TS Obs tab
These symbols are used in the Icon field in the right panel of the TS Obs tab of the Tabular View.

Symbols are marked red if the TS Observation did not pass Quality Control test. To identify why the test failed for
the point, click Properties on the pop-up menu and select the Quality Control tab.

Symbol passed/not passed Quality Con-
trol test Description

SideShot (SS) measurement

ForeSight(FS) measurement

BackSight (BS) measurement

BackSightBearing (BKB) point measurement

Horizontal Resection / Vertical Resection / Resection
observation

Symbols for the left panel of the DL Obs tab
This symbol is used in the Icon field in the left panel of the DL Obs tab of the Tabular View.

Symbols are marked red if the DL Occupation did not pass Quality Control test. To identify why the test failed for
the point, click Properties on the pop-up menu and select the Quality Control tab.

Symbol passed/not passed Quality Con-
trol test Description

DL run (DL Occupation)
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Symbols for the right panel of the DL Obs tab
This symbol is used in the Icon field in the right panel of the DL Obs tab of the Tabular View.

Symbols are marked red if the DL Observation did not pass Quality Control test. To identify why the test failed
for the point, click Properties on the pop-up menu and select the Quality Control tab.

Symbol passed/not passed Quality Con-
trol test Description

BackSight level measurement

ForeSight level measurement

SideShot level measurement

Symbols for the Surfaces tab
These symbols are used in the Icon field in the left panel of the Surfaces tab of the Tabular View.

Symbol Description

Updated Surface without Focus Point

Not updated Surface without Focus Point

Updated Surface with Focus Point

Not updated Surface with Focus point

Symbols for the left panel of the Lines tab
These symbols are used in the Icon field in the left panel of the Lines tab of the Tabular View.

Symbol Description

Unclosed line

Closed polyline (area)

Symbols for the X-Section table view
This symbol is used in the Icon field in the left panel of the Roads tab of the Tabular View for the X-Section ele-
ment.

Symbol Description

X-Section
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Symbols in the X-Section Template tab
This symbol is used in the Icon field in the left panel of the X-Section Template tab of the Tabular View.

Symbols Description

X-Section Template

Symbols in Road String Set or separate Road String table view
This symbol is used in the Icon field for the Road String Set or separate Road String table view.

Symbols Description

Road String Set or separate Road String

Symbols in the table view of horizontal alignment
The symbols are used in the Icon field in the horizontal alignment table view.

Symbols Description

Line

Curve

Spiral

Intersection

Symbols in the vertical alignment table view
These symbols are used in the Icon field in the vertical alignment table view.

Symbols Description

Grade

Parabola

Circular Arc

Parabola Long Section

Arc Long Section
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